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INTRODUCTION

The term media occupies a very special place in today’s world. It has become as
important as food and clothing. There is no denying the fact that media is playing a
very significant role in making the world smaller. Through various mass media whether
it is radio, television, newspaper or the World Wide Web (WWW), we are able to
connect with people all over the world. Social networking sites like Facebook and
Twitter have risen to prominence through their roles in bringing justice to those who
rightly deserve the same and for mobilizing the masses. The print and electronic
media have also highlighted the activities on these networking sites making them
more popular than ever before. Media can be thus technically defined as New
Media and Digital Media. New Media refers to on-demand access to content anytime,
anywhere, on any digital device, as well as interactive user feedback, creative
participation. Another aspect of new media is the real-time generation of new,
unregulated content. Most technologies described as ‘New Media’ are digital, often
having characteristics of being manipulated, networkable, dense, compressible and
interactive. Some examples also include the Internet, Websites, computer multimedia,
video games, CD-ROMS and DVDs. New media does not include television
programs, feature films, magazines, books or paper-based publications – unless they
contain technologies that enable digital interactivity. Wikipedia, an online
encyclopaedia, is an example, combining Internet accessible digital text, images and
video with Web-links, creative participation of contributors, interactive feedback of
users and formation of a participant community of editors and donors for the benefit
of non-community readers. Facebook is an example of the social media model, in
which most users are also participants.

The rise of new media has increased communication between people all over
the world and the Internet. It has allowed people to express themselves through
blogs, Websites, pictures, and other user-generated media. Flew (2002) stated that,
“As a result of the evolution of new media technologies, globalization occurs.”
Globalization is generally stated as more than expansion of activities beyond the
boundaries of particular nation states. Globalization shortens the distance between
people all over the world by the electronic communication and expresses this great
development as the ‘death of distance’. New Media has also recently become of
interest to the global espionage community as it is easily accessible electronically in
database format and can therefore be quickly retrieved and reverse engineered by
national governments. Particularly of interest to the espionage community are
Facebook and Twitter, two Websites where individuals freely disclose personal
information that can then be sifted through and archived for the automatic creation
of records on both people of interest and the average citizen.  This book, New
Media and Advertising, follows the SIM format or the self-instructional mode
wherein each Unit begins with an Introduction to the topic followed by an outline of
the Objectives. The detailed content is then presented in a simple and an organized
manner, interspersed with Check Your Progress questions to test the understanding
of the students. A Summary along with a list of Key Words and a set of Self
Assessment Questions and Exercises is also provided at the end of each unit for
effective recapitulation.
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1.0 INTRODUCTION

In this unit, you will learn about the computers and role of IT in communication.
One of the most powerful innovation in human history is the computer. After the
advent of the computer, people are able to do a staggering amount of computations
at dazzling speeds. People can access, organize and display information in the
blink of an eye.

Technically, we may define a computer as a programmable machine as it
can follow and implement a programmed list of instructions and also respond to
new instructions that is given to it to perform some task. Nowadays, however, the
term is generally used to refer to the laptop and desktop computers that we use. A
computer is an electronic machine that can store, organize and find information,
do calculations and control other machines.

1.1 OBJECTIVES

After going through this unit, you will be able to:

 Define the computer system

 List the different components of a computer system

 Explain the various input devices, output devices and storage devices

 Discuss the role of information technology in communication



Introduction to
Computers

NOTES

Self-Instructional
2 Material

1.2 THE COMPUTER SYSTEM

The term computer is derived from the word compute, which means to calculate.
A computer is an electronic machine which can perform calculations and control
operations that can be expressed either in numerical or logical terms. For this, a
computer receives input (using input devices) in the form of instructions (known as
programs), processes it (using processors) and then produces the desired output
(using output devices).

A computer can be viewed as a system which consists of a number of
interrelated components that work together with the aim of converting data into
information. The physical parts that make up a computer include an input unit, a
central processing unit, an output unit, and a memory unit (see Figure 1.1). All
these parts are referred to as hardware.

Fig. 1.1 Hardware Components of a Computer

The Input Unit

The basic task of an input unit is to gather data and convert it into a computer-
understandable form, that is, in the binary form (form of 0s and 1s). It accepts
instructions and data with the help of input devices. An input device is an
electromechanical device used to feed data into the computer. Some of the
commonly used input devices include the keyboard, pointing devices, scanner,
optical character recognition, magnetic ink character reader, bar code reader,
digital camera, and microphone.

Keyboard

A keyboard is the most commonly used input device. It comprises different keys
(see Figure 1.2) using which the user can enter data into the computer, and execute
commands. It resembles a regular typewriter with a few additional keys. Data is
entered into the computer by simply pressing the keys. The layout of the keyboard
has changed very little ever since it was introduced. In fact, the change in its
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technology has been the addition of more keys that provide additional functionality.
The number of keys on a typical keyboard varies from eighty-two to 108 keys.

 

Enter keySpacebarALT key
Shift key

Control key Cursor keys Numeric 
key pad

Delete
Num Lock key

Backspace
key Print screenFunction keysEscape key

Tab keyTab key

Caps
Lock key

Fig. 1.2 Keyboard

Pointing devices

A pointing device is used to communicate with the computer by pointing to locations
on the monitor screen. Such devices do not require keying of characters; instead
the users can move a cursor on the screen and perform move, click, or drag
operations. Some of the commonly used pointing devices are mouse, joystick,
trackball, light pen, and touch screen.

Mouse

Mouse is a small hand-held pointing device used to move the cursor on the screen,
issue commands, and select an option from a group of choices. It allows us to
create graphic elements on the screen, such as lines, curves, and freehand shapes.

A mouse has generally two or three buttons on its top; the one on the left is
known as the left button and the other on the right is known as the right button.
It may be classified as a mechanical mouse or an optical mouse (see Figure 1.3),
based on the technology it uses.

 Mechanical mouse: It comprises a rubber ball at the bottom surface. As
the mouse is moved on a flat surface, the rubber ball rotates to move the
mouse pointer on the screen. A mechanical mouse is the most common and
least expensive pointing device.

 Optical mouse: It uses a light beam instead of a rotating ball to detect the
movement. As the user rolls the mouse on a flat surface, the cursor on the
screen also moves in the direction of the mouse’s movement.

(a) Mechanical mouse (b) Optical mouse

Fig. 1.3 Types of Mouse
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Joystick

A joystick (see Figure 1.4) is a device that moves in all directions and controls the
movement of the cursor. The joystick offers three types of control, namely digital,
glide, and direct. The digital control allows limited movement like up, down, left,
and right. The glide and direct controls allow movements in all directions (360
degrees). The direct control joysticks can also respond to the distance and speed
with which the stick is moved by the user. The basic design of a joystick consists
of a stick attached to a plastic base with a flexible rubber sheath. This plastic base
has a circuit board beneath the stick. The electronic circuitry in the joystick measures
the movement of the stick from its central position and sends the information for
processing.

(a) Joystick used in computers (b) Joystick in mobile phones

Fig. 1.4 Joysticks

Earlier, joysticks were mainly used in computer games and applications, such as
flight simulators, training simulators, CAD/CAM systems, and for controlling
industrial robots. They were extensively used to enhance the gaming experience
as they provide movement in all directions. Nowadays, joysticks are also used in
mobile phones (see Figure 1.4(b)) as a built-in tool to help in navigating, and
accessing various built-in features or applications of the mobile phones.

Trackball

Trackball (see Figure 1.5) is another pointing device that is similar to a ball nestled
in a square cradle. It functions as an alternative to a mouse. In general, a trackball
is a mouse turned upside down. It has a ball, which can be rotated by fingers in
any direction, and the cursor moves accordingly. The size of the ball in the trackball
varies from as large as a cue balls to as small as a marble. Since it is a static
device, instead of rolling the mouse on the top of the table the ball on the top is
moved by using fingers, thumbs, and palms. This pointing device comes in various
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shapes and forms but with the same functions. The three shapes, which are
commonly used are a ball, button, and a square.  The main advantage of a trackball
is that it requires less desk space than a mouse.

Fig. 1.5 A Trackball

Light pen

A light pen (see Figure 1.6) is a hand-held electro-optical pointing device that
helps in drawing images and selecting objects on the display screen by directly
pointing to the objects. When it touches (or is aimed at) the monitor, light is detected
from the screen, enabling the computer to identify the location of the pen on the
screen. Although named light pen, it actually does not emit light; instead it contains
photocell to detect the presence of light.

Fig. 1.6 A Light Pen

Touch screen

A touch screen (see Figure 1.7) is a special kind of display screen device which
allows the direct selection or activation of the computer function when somebody
touches the screen. Essentially, it registers the input when a finger or other object
is placed on the screen. The advantage of touch screen is that the information can
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be accessed with minimum effort. Moreover, it does not require any additional
peripheral device to input data.  The disadvantage of touch screen is that it is
expensive and not suitable for inputs of large amount of data.

Fig. 1.7 A Touch Screen

Typically, touch screens are used in information providing systems like hospitals,
airlines and railway reservation counters, ATMs, and so on.

Scanner

A scanner is used to convert text or an image in printed form to an electronic
representation which can be viewed on the screen. It scans the input data using a
light beam and transforms it to an ASCII code (code used by a computer to
represent the characters you find on your keyboard—alphabets, numbers,
punctuation marks, and so on) and graphics. Note that most of the scanners come
with a utility program that allows them to communicate with the computer and
save the scanned image as graphic file on the computer. Moreover, they can store
images in both greyscale and colour mode.

Some of the commonly used scanners are as follows:

 Hand-held scanners: These scanners (see Figure 1.8(a)) are small in size
and are available in different resolutions (measure the quality of an image).
They are available in either greyscale or in colour. While scanning a document,
this scanner is moved a number of times over the document to obtain the
best results.

 Flat-bed scanners: These scanners (see Figure 1.8(b)) are more expensive
than hand-held scanners. It scans the document, image or texts in one go.
While scanning, the document is placed on the flat glass surface and the
light sensors move over the document to scan it.

 Sheet-fed scanners: These scanners (see Figure 1.8(c)) are similar to
flat-bed scanners. However, while scanning a document, the document is
moved across a stationary scan head. It allows only a paper to be scanned
rather than books or other thick objects.

 Drum scanners: These scanners (see Figure 1.8(d)) are very expensive
and produce high-resolution images. They have a scanning photomultiplier



NOTES

Self-Instructional
Material 7

Introduction to
Computers

tube. While scanning a document, a drum rolls over the entire document
around the tube. Since drum scanners provide high resolution, and are mostly
used when a scanned image has to be enlarged.

      (a) Hand-held (b) Flat-bed      (c) Sheet-fed (d) Drum

Fig. 1.8 Types of Scanners

Optical character recognition (OCR)

OCR is a process to scan printed pages as images on a flat-bed scanner and then
use the OCR software in order to recognize the letters as ASCII text. The OCR
software has tools to acquire the image from a scanner and recognize the text. In
the OCR system (see Figure 1.9), a book or a magazine article is directly inputted
into an electronic computer file, and then this file is edited by a word processor.
The first major use of OCR was in processing petroleum credit card sales drafts.
Over time, other applications evolved, including cash register tape readers, scanners,
and so on.

Fig. 1.9 An OCR System

Using an OCR system, one can consolidate data entry and reduce data entry
errors. The result of OCR is very human readable and can be used with many
printing techniques. However, it is a very expensive input device, and if the document
is not typed properly, it becomes difficult for the OCR to recognize the characters.
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Magnetic ink character reader (MICR)

MICR (see Figure 1.10) is an input device that is used to read the characters
printed in magnetic ink. It reads the characters by examining their shapes in a
matrix form and the information is then passed on to the computer. It provides a
secure, high-speed method of reading and processing information. MICRs are
generally used in banks to read the cheque number and branch code which are
located at the bottom of the cheques.

Fig. 1.10  Magnetic Ink Character Reader

Bar code reader

A bar code reader is used to read the bar code. A bar code is a machine-readable
code in the form of parallel vertical lines of varying widths (see Figure 1.11(a)).
Bar codes are commonly used for labelling goods that are available in supermarkets
and for numbering books in libraries.

The bar code reader (see Figure 1.11(b)) senses and reads the bar codes
using reflective light. The information recorded in the bar code reader is then fed
into the computer, which recognizes the information from the thickness and spacing
of bars.

(a) Bar code (b) Bar code reader

Fig. 1.11  Bar Code Reader
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Digital camera

A digital camera (see Figure 1.12) is a device which stores images digitally rather
than recording them on a film. It comprises an electrical sensor and a memory
card. The images are stored in the memory card and can be seen after they are
captured. The images can also be transferred to the computer and can be printed,
edited or sent over the Internet.

Fig. 1.12 A Digital Camera

The major advantage of a digital camera is that making photos is both inexpensive
and fast because there is no requirement of film processing.

Microphone

A microphone (see Figure 1.13) or simply mic, is an input device used to convert
sound waves into an electric representation of sound waves. Microphones are
commonly used in telephones, for recording or for amplifying. A microphone is
used as one of the means to communicate over the Internet using a computer.
Note that a microphone is connected to the sound card, which is an expansion
card used to generate sounds through external speakers.

Fig. 1.13  A Microphone

The Central Processing Unit (CPU)

CPU, also known as processor, is referred to as the brain of a computer system.
It takes the data, processes it, and converts the data into meaningful information.
It is an extensive and highly complex set of electronic circuits which executes
instructions from stored programs. It controls all internal and external devices,
performs arithmetic and logical operations, and operates only on the binary data.
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CPU consists of three main subsystems, namely arithmetic logic unit,
registers, and control unit. These subsystems work together to provide operational
capabilities to the computer.

Arithmetic logic unit (ALU)

ALU contains the electronic circuitry for executing all arithmetic (+, –, *, /) and
logical (<, >, =, <=, >=, < >) operations on the data provided to it. Whenever an
arithmetic or a logical operation is to be performed, the data required for performing
the operation is sent from the main memory to the ALU. The operation takes
place and the result is returned to the main memory. If, for example, addition of
two numbers, say, 2 and 3, is to be performed, the data 2 and 3 are sent to the
ALU from the main memory. ALU performs the addition (2 + 3) and finally sends
the output (5) to the main memory. ALU comprises the following two units.

 Arithmetic unit: It is responsible for performing and carrying out arithmetic
calculations, such as addition, subtraction, multiplication and division.

 Logic unit: It performs logical operations based on the instructions
provided to it. It can compare letters or special characters or numbers and
then can take action on the basis of the result of comparison. Logical
operations of the logic unit test for three conditions, namely equal to
condition, less than condition and greater than condition. The result of
a logical operation can be either true or false.

Registers

Registers are special purpose, high-speed temporary memory units which contain
different types of information like data, addresses, instructions and the intermediate
results of calculations. Basically, they contain the information that the CPU is
currently working on.

Registers can be considered as the working memory of the CPU. They
work under the direction of the control unit for accepting, holding, and transferring
data or instructions.

Control unit (CU)

The control unit (CU) contains circuitry that uses electrical signals for directing the
computer system, for carrying out or executing the stored program instructions. It
directs other parts of the system to execute program instructions by communicating
with both the arithmetic logic unit and the memory. It does not execute program
instructions by itself. It resembles an orchestra leader who himself does not play a
musical instrument but directs other people to play instruments in a harmonized
manner.
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The control unit controls the I/O (input/output) devices and transfer of data
to and from the primary memory. The control unit itself is controlled by the individual
instructions in programs located in the primary memory.

The Output Unit

The output unit is formed by attaching the output devices to a computer. The basic
functioning of the output device is just the opposite of the input device, that is, the
data is fed into the computer system through the input device while the output is
taken out from the computer through the output device.

Output devices take the machine-coded output results from the CPU and
convert them into a form that is easily readable (such as characters or graphics) to
human beings. The outputs, which can be easily understood and used by human
beings, are in the form of hard copy and soft copy. The physical (printed) form of
output is known as the hard copy. The electronic version of an output which
usually stays in the computer memory and/or on the disk is known as the soft
copy. Some commonly used output devices are printer, plotter, visual display unit,
and speaker.

Printer

A printer prints information and data from the computer onto a paper. Some printers
print only textual information, whereas others can print graphics as well. Printers
are classified into two basic categories, namely impact printers and non-impact
printers.

Impact printers

Impact printers work by physically striking a head or a needle against an ink
ribbon to make a mark on the paper. Though multiple copies can be printed, they
are slow in terms of number of characters per second. Impact printers are classified
into line printers and character printers. Line printers print a single line at a time
and the printing speed varies between 300 to 3000 lines per minute approximately.
Character printers print a single character of the text at a time and the printing
speed varies from 30 to 600 characters per second approximately. Some of the
impact printers are as follows:

 Dot matrix printer or wire matrix printer: It uses the oldest printing
technology and prints one character at a time. It consists of a print head
which strikes the printer ribbon situated between the paper and the print
head pin. As the head stamps onto the paper through the inked ribbon, a
character is produced that is made up of dots. The speed of dot matrix
printers is measured in characters per second (cps). These printers are
inexpensive and have low operating costs. However, these printers are very
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noisy, print only in black, and produce low-quality printouts. Figure 1.14
shows a dot matrix printer.

Fig. 1.14  A Dot Matrix Printer

 Daisy wheel printer or letter quality printer: It prints professional quality
documents. It is named so because the print head of this printer resembles
a daisy flower and the printing arms look like the petals of the flower. The
print heads of these printers are made of plastic or metallic wheels. A raised
character is placed on the tip of each of the daisy wheel’s petals. Each petal
has an appearance of a letter (upper case and lower case), number or
punctuation mark on it. To print, the print wheel is rotated around until the
desired character is under the print hammer. The petal is then struck onto
the paper, creating the character. Unless the print wheel is physically replaced,
daisy wheel printers cannot print graphics and cannot change fonts. These
printers are slower and more expensive than dot matrix printers. However,
if the appearance of the correspondence is important and you do not need
graphics, a daisy wheel printer is a better choice. Figure 1.15 shows a
daisy wheel printer.

Fig. 1.15  A Daisy Wheel Printer

 Drum printer: It prints a line in a single operation. It contains a large rotating
drum mounted horizontally and positioned in front of a very wide, inked
ribbon. This inked ribbon is positioned in front of the paper. The drum
contains characters moulded on the surface in columns around its
circumference. The drum spins continuously to allow a continuous high-
speed printing. Drum printers are much faster than character printers but
they tend to be quite loud and often produce a lower print quality. These
printers are very expensive and their character fonts cannot be changed.
Figure 1.16 shows a drum printer.
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Fig. 1.16  A Drum Printer

Non-impact printers

Non-impact printers do not involve any contact between the print head and the
surface that it prints on. These printers provide higher speed in terms of characters
per second. Some of the non-impact printers are as follows:

 Inkjet printer: It places extremely small droplets of ink onto the paper to
create a character or an image. It has a print cartridge with a small series of
electrically heated chambers. These chambers are attached to the print head
with a series of small nozzles that spray ink onto the surface of the paper. As
the print head moves back and forth across the page, it prints a character
by shooting small droplets of ink onto the paper. Inkjet printers print
documents at a medium pace, but slow down while printing a multicoloured
document. These printers are commonly used at homes. Figure 1.17 shows
an inkjet printer.

Fig. 1.17 An Inkjet Printer

 Laser printer: It provides the highest quality text and images for personal
computers today. It is a very fast printer, which operates on the same principle
as that of a photocopy machine. Most laser printers can print text and graphics
with a high-quality resolution. They are also known as page printers because
they process and store the entire page before actually printing it.  In laser
printers, the document to be printed is converted into a series of ON and OFF
commands to the laser, which creates corresponding pulses of light. A spinning
mirror deflects the laser beam and creates a horizontal line across the surface
of a light-sensitive drum. After a horizontal line is created, the drum rotates
(normally about 1/300 of an inch) and the laser draws the next horizontal line.
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These printers are more expensive but useful for volume printing as they are
very fast. Figure 1.18 shows a laser printer.

Fig. 1.18  A Laser Printer

Plotter

A plotter is a pen-based output device that is attached to a computer for making
vector graphics (images created by a series of many straight lines). It is used to
draw high-resolution charts, graphs, blueprints, maps, circuit diagrams, and other
line-based diagrams. Plotters are similar to printers, but they draw lines with the
use of a pen. Thus, they are able to produce continuous lines, whereas printers
can only simulate lines by printing a closely spaced series of dots. Different coloured
pens are used by multicolour plotters for drawing different coloured lines. Colour
plots can be made by using four pens (cyan, magenta, yellow, and black) and
need no human intervention to change them. There are two different types of
plotters, which are as follows:

 Drum plotter: It consists of a long cylinder known as the drum. The paper
that is to be printed is placed over the drum. The drum can rotate in either
clockwise or anti-clockwise direction under the control of plotting
instructions sent by the computer. Figure 1.19(a) shows a drum plotter.

 Flat-bed plotter: It consists of a stationary horizontal plotting surface on
which a paper is fixed. This plotter is capable of working on any standard,
that is, from A4 size paper to big beds. Figure 1.19(b) shows a flat-bed
plotter.

(a) Drum plotter (b) Flat-bed plotter

Fig. 1.19 Plotters
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Visual display unit (VDU)

A VDU, also known as a monitor, is the most basic and commonly used output
device for viewing and displaying images. A VDU is similar to a television where
images are represented in the form of pixels—the smallest unit of resolution.

VDUs are available in a monochrome or a colour display. A monochrome
uses only one colour (usually white, green, or black) to display the text on contrasting
background. A colour display commonly presents 256 colours at one time from
a selection of over 256,000 choices.

VDUs can be developed using one of the two technologies, namely cathode
ray tube or liquid crystal display.

Cathode ray tube (CRT) monitor

A CRT is a vacuum tube which is used as a display screen for a computer output
device. In CRTs, the screen pixels are made from phosphor. An electron beam
(cathode ray) is emitted by the electron gun towards the specified position to
strike the phosphor. This causes the phosphor to emit light and results in the display
of an image. The electron beam scans the screen multiple times per second. A
CRT uses three electron guns to scan dots or stripes of green, red and blue phosphor
coated on the screen. Figure 1.20 shows a CRT monitor.

Fig. 1.20  A CRT Monitor

Liquid crystal display (LCD) monitor

An LCD screen (see Figure 1.21(a)) is lighter, portable, and compact as compared
to a CRT monitor. It is used in smaller computers like personal digital assistants
(PDAs) and laptops. In addition, LCD is commonly used in digital watches and
cellular phone displays.

An LCD screen comprises different layers (see Figure 1.21(b)). The rearmost
layer is known as the backlight which is a fluorescent light source. There are two
polarizing filters and light passes through the first filter. The polarized light then
passes through a layer containing thousands of liquid crystals aligned in small
containers known as cells. These cells are aligned in rows across the screen; one
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or more cells make up one pixel. Three liquid crystal cells make up one pixel.
Each of these three cells has a red, green or a blue filter. Light that passes through
the filtered cells creates the colours on the LCD.

(a) LCD screen (b) Layers in LCD

Fig. 1.21  A Liquid Crystal Display Monitor

Speaker

A speaker (see Figure 1.22) is used to generate sound as an output. It generates
sound by converting the electric signals into sound waves which enable us to hear.
It can be attached to the computer using a sound card or may be provided inside
the computer by the manufacturer.

Fig. 1.22  Speakers

The Memory Unit

The memory unit is used to store the input data, intermediate results during the
course of calculations, and the final results. The memory of a computer can be
considered as ‘cells’ which are broken down into smaller parts known as bits. A bit
is the basic unit of memory. It is the smallest unit of information on a computer. A
single bit can hold either one of the two values, 0 or 1, and is represented by ‘b’ (in
lower case). Memory can be divided into two categories, namely primary memory
and secondary memory.

Primary memory

The primary memory, also known as the main memory, stores data and instructions
for processing. Logically, it is an integral component of the CPU, but physically, it
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is a separate part placed on the computer’s motherboard (also known as the
main board). It can be further classified into two types, namely random access
memory and read-only memory.

Random access memory (RAM)

RAM is the memory where the operating system, application programs and current
data are temporarily stored so that the processor of the computer can access
them quickly when required. It is volatile in nature which means that the information
stored in it remains as long as the power is switched on. As soon as the power is
switched off, the information contained is lost.

Read-only memory (ROM)

The ROM is the memory which contains contents that once written can only be
read and used but cannot be modified. These contents are prewritten by the
manufacturer. Every computer comes with a small amount of ROM which contains
the boot firmware (called BIOS). This holds information that enables the computer
system to perform start operations and transfers the control to the operating system.
Unlike RAM, it is non-volatile in nature, that is, the contents of ROM are not lost
even in case of a sudden power failure.

Secondary memory

The secondary memory, also known as the auxiliary memory, is used for storing
instructions and data, since the main memory is temporary and limited in size. This
memory is less expensive and has a much larger storage capacity than the primary
memory. Instructions and data stored on such storage devices are usually permanent
in nature and can be removed only when the user wants, or if the device is destroyed.
Note that unlike CPU registers and the main memory, the secondary memory is
not directly accessible to the processor. The processor can access the secondary
memory via the main memory, that is, firstly, the information from the secondary
memory is shifted to the main memory, and then to the processor.

Some commonly used secondary storage devices are floppy disk, magnetic
tape, hard disk, and optical disk.

Floppy disk

A floppy disk (see Figure 1.23(a)) simply known as a floppy is a data storage
device which is a mylar (a thin polyester film) disk coated with a magnetic material.
It is enclosed in a square plastic body which provides protection to the disk surface.

Floppy disks are read and written by a floppy disk drive (FDD) which is
a device that performs operations on a disk, including rotating the disk, reading,
and writing data onto the disk. These are portable and can be used to carry data
easily from one machine or device to another. These are available in two sizes —
5¼ and 3½ inch. The 5¼-inch floppy can store up to 1.2 MB of data and the 3½-
inch floppy can store up to 1.44 MB of data.
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(a) Floppy (b) Disk showing tracks and sectors

Fig. 1.23  Floppy Disk

The surface of floppy disk is divided into tracks and sectors (see Figure 1.23(b)).
Tracks are series of concentric circles where data is recorded. Each track contains
the same number of bytes and, hence, the amount of data is limited to the size of
the innermost track. The track is divided into sectors. A sector is an imaginary pie
of slices formed with the intersection of tracks.

Magnetic tape

A magnetic tape (see Figure 1.24) appears similar to the tape used in music
cassettes. It is a plastic tape with magnetic coating. The data is stored in the form
of tiny segments of magnetized and de-magnetized portion on the surface of the
material. The magnetized portion of the surface refers to the bit value ‘1’, whereas
the demagnetized portion refers to the bit value ‘0’. Magnetic tapes are available
in different sizes, but the major differences are the speed at which the tape is
moved past the read/write head and the density of the recorded information. The
amount of data or the number of binary digits that can be stored on a linear inch of
tape is known as its recording density.

 

Fig. 1.24  A Magnetic Tape

Magnetic tapes are very durable and can be erased as well as reused. These
tapes are cheap and reliable storage media for organizing archives and taking
backup. However, these are not suitable for data files that need to be revised or
updated often, because it stores data in a sequential manner.

Hard disk

A hard disk (see Figure 1.25), also known as a hard drive or a fixed disk, is a
storage device that can store a large amount of data (up to 160 GB approximately).
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In other words, these storage devices have the capacity to store data equivalent to
1000s floppies. A hard disk consists of a stack of disk platters that spin on the
spindle. Platters are made up of aluminium alloy or glass substrate  with a magnetic
material coating and protective layers. Each platter is divided into tracks which
are further divided into smaller sectors. Each platter has two heads (read/write),
one on the top of the platter and the other on the bottom; so, a hard disk with three
platters would have six surfaces and six heads.

Fig. 1.25  Hard Disk

Hard disks are read and written by a hard disk drive. The reading and writing of
the data is done with a read/write head. The platters rotate at a high speed and the
read/write head records data onto the disk or reads data from it.

Optical disk

Apart from magnetic tape and magnetic disk, a new storage medium, which is
gaining popularity, is the optical disk. An optical disk is a circular, flat, plastic disk
coated with material. Bits in an optical disk may be stored in the form of highly
reflective areas and significantly less reflective areas, and from this the stored data
may be read upon illumination with a narrow-beam source like a laser diode.
These disks are capable of storing enormously high amount of data in a limited
amount of space. The optical disk storage system consists of a rotating disk coated
with a thin layer of metal (aluminium, gold, or silver) that acts as a reflective surface
and a laser beam, which is used as a read/write head for recording data onto the
disk. The two most commonly used optical disks are as follows:

 Compact disk (CD): It has a shiny and a silver-coloured surface and is of
12 cm in diameter. It can store approximately 650MB to 800MB of data.
Originally, it was developed only for storing music (in the form of digital
audio), but now it can also store textual data and graphics files. CDs are
broadly divided into two categories, which are as follows:

o CD-recordable (CD-R): The data can be written only once and once
the data is written, it cannot be deleted or modified.

o CD-rewritable (CD-RW): The data can be written, erased and rewritten
many times.
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Fig. 1.26  A Compact Disk

 Digital video disk (DVD): It is an optical disk that resembles a CD.
However, it holds much more data as compared to a CD. It can store up to
8.5 GB of data which makes it a very useful storage medium. DVDs are
broadly divided into two categories, which are as follows:

 DVD-recordable (DVD-R): The data can be written only once.

 DVD-random access memory (DVD-RAM): The data can be written,
erased and rewritten many times.

Fig. 1.27  A Digital Video Disk

Check Your Progress

1. List the hardware components of a computer system.

2. What types of controls are provided by a joystick?

3. What is the advantage of a trackball over a mouse?

4. Define bar code.

5. What is the function of the arithmetic and the logic units?

1.3 ROLE OF INFORMATION TECHNOLOGY IN
COMMUNICATION

The significance of IT is well recognized today. It has become must for the survival
of business houses, with constantly growing need for qualitative information
technology. One of the major components of information technology, that has
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gained increased popularity, is the computer. The presence of computer technology
can be seen in every sphere of modern life including rail/air reservations, weather
forecasting, medical diagnosis, banking, hotels and office automation.

Definition and Uses of Information Technology

The term Information Technology or IT as it is commonly called, refers to the
technology that uses computer software and hardware for the purpose of processing
data and producing useful information.

The Information Technology Association of America (ITAA) defines IT as
the study, design, development, implementation, support or management of
computer-based information systems, particularly software applications and
computer hardware for the purpose of converting, storing, protecting, processing,
transmitting and securely retrieving information.

Today, IT impacts every length and breadth of our life and is now an integral
part of our day-to-day activities. It covers a wide range of activities like a simple
information storage or retrieval, hardware installation, data management,
communication over networks and software development, etc.

Uses of Information Technology

IT can mean different things to different people. Information technology and its
applications are used widely across every section of society, business, education,
government, etc. Household devices like televisions, telephones, radios, microwave
ovens, dishwashers, washing machines and mobile phones, all involve information
technology in one form or another. E-mail, Word processors, spreadsheet software,
the Internet and communication software have redefined the way people work
and are now an integral part of our daily lives.

Some of the common uses of information technology are:

 Telecommunications through the use of e-mail, telephonic exchange,
remote data transfer, etc.

 Publishing whether online or through printed material.

 Weather forecasting uses computer systems to process data in order
to predict upcoming weather patterns.

 Commerce through the selling of goods over the Internet (e-commerce)
by using computers to manage accounts, stock control, etc.

 Industries use IT in many processes, such as Computer Aided Design
(CAD), control of manufacturing systems, Database Management
Systems (DBMS), Enterprise Resource Planning (ERP), Management
Information System (MIS) and Remote Sensing.

 Banking in its current form relies heavily on IT to perform transactions,
store huge amounts of financial information, and interact with customers
and partners.
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 IT Enabled Services like Business Process Outsourcing (BPO) and
Knowledge Process Outsourcing (KPO).

 Administration, whether of a business, an educational institution or
public entity is enhanced by the use of IT.

Information Systems: Uses and Needs

It refers to a system of persons, data records and activities through which data
and information in an organization can be processed, besides including the
organizations manual and automated processes. Computer-based information
systems are the field of study for information technology, elements of which are
sometimes called an ‘information system’.

A prime asset of most companies today is the information they hold—in
terms of people, experience, know-how, innovations. For most market competition
to be successful a firm much possess strong information infrastructure and maintain
an extensive database. At the core of all these elements of information  systems
lies information technology infrastructure which connects and provides a framework
for all the relevant organizational activities.

Depending upon the areas of application an information system can have
varied components and processes. Some of the most common uses of information
system are given below.

Information Systems essentially have three attributes which universally govern
all its areas of application and the way of implementation. The process of
implementing an information system starts with data assimilation, analysis and finally
ends with the distribution of processed information and data to multiple users. The
three attributes are as follows:

 Data assimilation/collection: Computers help in the easy collection
of data from multiple sources using modern technology, such as the
Websites, news feeds, blogs, etc. Primary data can also be collected
using computers as a source of storing customer habits, online surveys,
user polls, etc.

 Data analysis/conversion: Applications for data analysis and
conversion are abundantly available for computer users. These can
be customized to process on the basis of predefined rules to save
time or manually operated in case of unique data.

 Distribution of processed information:  Once all the data has been
collected, cleaned and analysed it is instantly distributed to multiple
users using networks, such as intranets, extranets and the Internet
which monitor responses to all user requests and monitor access to
the information.

Since most organizations and businesses require information to perform
daily operational tasks and make decisions that control the direction of the firm,
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hence it is imperative to sustain efficiency and effectiveness of these tasks and
decisions by using information systems.

The need for information systems in an organization can be explained by
knowing how these various kinds of information systems support and drastically
increase the efficiency of each process in an organization. Some of the different
kinds of information systems used in businesses are:

 Executive support system: It is designed to help the top-level
management to make important strategic decisions for the firm. The
information system collects, analyses and summarizes relevant internal
and external information to facilitate this activity.

 MIS: It basically summarizes information collected from the internal
sources of an organization and turns them into management reports.

 Decision Support System (DSS): It helps the management to make
tough decisions pertaining to the organization by collecting data and
processing it using ‘what-if’ models and extensive spreadsheets to
display outcomes of that model.

 Knowledge Management System (KMS): It is mainly used by
businesses to create and share information across the organization.
The sources of information in a KMS could be internal or external.
Further categorization of collected information is done to make it easier
for access and distribution.

 Transaction Processing System (TPS): The routine work in an
organization could be placed on transactional processing systems which
are designed to perform repetitive tasks with speed and accuracy.

 Office automation system: General information systems which help
in improving the productivity of the employees and facilitate them by
providing easy to convenient ways to work are known as office
automation systems. By using Microsoft OneNote, for example, an
employee can write a report and share it simultaneously with multiple
users while being at home.

Computer Applications in Offices

Application of computers has made office management very efficient. Earlier, office
jobs were very slow as compared to these days. Modernization of office started
after the typewriter was introduced which did not much help in increasing the
efficiency of office management. When a document was prepared, it followed
long steps of preparation. The material used to be handwritten or be dictated to
steno/typist, then the same would be typed as a draft which was followed by final
check by the person who was to put his signature before sending. Corrections and
other changes made, used to be retyped and again the matter used to be approved.
After approval of the draft, required numbers of copies were made. The Typist
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had to put carbon papers for making requisite number of copies. If more copies
were required, it involved retyping.

Advent of copier made this task easy and additional number of copies could
very easily be obtained. Advent of computer revolutionized the office and made it
more efficient and quick. Matter once made, used to be saved and changes and
modifications could be incorporated very easily within a few minutes only. If more
number of copies were required, the same be obtained within no time.  Addition
of more gadgets such as scanner and advanced printers, made the document
handling very efficient.

For sending letters or documents, postal system was used earlier. With the
appearance of telex machines, matter could be transmitted to long distances. Advent
of fax machines made such tasks very easy and fast. Documents or letters were
transmitted as it is. It was something like sending a photocopy directly to someone
sitting at a long distance.

Application of computer system in the office has led to office automation.

Office Automation

In general, there are three basic activities of an office automation system which are
as follows:

 Information storage and application: This involves keeping of
records, forms and documents and creating and editing files, images
or spreadsheets. Files are created with Word processors, spreadsheets
and image or database applications. There may be documents that
use more than one application. For example, in a report, apart from
written texts, there may be tables, figures, etc., and this may require
the use of a Word processor, spreadsheet and graphic application
also. Word processing is the most basic and commonly used
application. Modern Word processors come with many features.
These contain a set of commands for formatting, editing and printing
text documents. Word processors provide templates which are
preformatted document. These templates automatically setup things
such as font size, styles of paragraph, headers and footers, and page
numbering to relieve users from resetting characteristics of document
when a new record is created. The advent of desktop publishing has
added new features in manipulation of text. With the combination of a
Word processing feature, advanced page design and layout features,
desktop publishing packages are capable of creating newsletters,
leaflets and other documents. These combine photographs with text,
charts, drawings and other graphic images.

Office automation uses image handling software also. Visual
information has diagrams, graphics, photographs, tables and charts.
Editing of these images after conversion to digital files is not possible
in the way it is done with text files. A Word processor treats each
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character or word as an object whereas an entire image is treated as
one object by an imaging software. Computerized images are very
effective in visual presentations or speeches. There are presentation
software packages that create multimedia presentations using media
like video, sound, graphics and text in an integrated package.
Spreadsheet programs can manipulate numeric data. Spreadsheet
programs have simplified record keeping, storing business and financial
information. Ability to use variables in proforma statements is especially
useful among other uses of spreadsheet. Many businesses use
spreadsheets for financial management, financial projection and
accounting.

 Information exchange: This activity comprises of receipt and
dispatch section of an office. Sending information, as letters or
documents and receiving them, are primary tasks under this. Exchange
of information is the next most important component. Information can
be transfered in many ways. It can be sent by post, special courier,
fax or e-mail. For exchanging information electronic transfer is very
fast. Similarly, there will be receipt from other offices. Electronic mail,
voice mail and facsimile are mostly used (e-mail) in offices. Systems,
available today, permit transfer of information in ‘real time’ mode.
They also permit online conversations and video conferencing.

Office automation systems these days are capable of sharing
information electronically as well as simultaneously, between more than
one user. These are also termed as groupware systems. Electronic
meeting system is one type of groupware that allows exchange of
information amongst participants, geographically dispersed or even
within the same office or other offices located at a distance in real-
time mode. Long-distance electronic transfer or sharing requires a
medium, usually a telephone line, to transfer data.

Many offices use just a local area network of computers in which the
server is connected through some kind of medium to the Internet. For
communicating within an establishment, no external line is required.
Such electronic sharing systems gave birth to telecommuting. This has
provided another option for employees to work from home. Software
these days permit voice as well as facsimile transmission. E-mail uses
a common set of standards for communication over the network to
forward messages in electronic form. E-mail can be forwarded to
more than one recipient.

Electronic mailing systems come with security features. They have
capability of automatic messaging and mail management systems.
Facsimile (or fax) transmissions deal with the image. Use of fax has
reduced substantially after the emergence of e-mail. Fax messages
can be sent through computer system too.
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 Information management: Proper handling of information and office
resources is information management.

For planning and scheduling too, office automation systems are used.
Short-term information and long-term information pertaining to various
plans such as financial, allocation of workforce, marketing expenditures
and strategy, inventory purchases, and many others that may arise
from time to time. Various activities within the office and various
projects are controlled by task management or scheduling systems.

People, Tools and the Workplace

Factors affecting the office automation system must be considered before launching
an office automation system or upgrading an existing office automation system.
These factors are budget, physical space, trained and skilled employees, changes
in infrastructure for communication and other considerations. Office automation
system requires use of skilled persons and it is important to provide training to the
users and to select the system that fits best.

 Training: People who constitute the office automation are users and
providers of the automation systems. Also, there are personnel having
tools, software and hardware, management information scientists,
executives, mid-level workers secretaries, etc. This warrants proper
training of personnel. With more refinement and maturity of technology,
need for special training will reduce as specialists are making systems
more and more user friendly and modern versions will have much
more capabilities such as built-in teaching capability.

 Making choice: There are many office automation systems available
to suit different business areas of all shapes and sizes. Such systems
typically involve substantial investment, so a careful study between
various systems is to be made by managers and business owners.
Primary factors for this include cost and time of installing the system,
and condition of the present facility. Other factors are: technical support,
compatibility issues and system complexity. These determine allocation
of resources like time and money, needed for training.

With continued growth of hi-tech new economy more and more sophisticated
systems are appearing in the market. The aim is to achieve a completely paperless
office.

To support these activities, resources like hardware, software and stationery
related to the work are required. Hardware means computer machine and printer.
There are a good number of software available as ‘office suite’. These are software
programs to meet the requirements of office.  An office suite consists of the following
software programs:

 Word processing: For example, MS Word of MS Office

 A spreadsheet: For example, MS Excel of MS Office
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 A presentation tool: For example, MS PowerPoint of MS Office

 A database: For example, MS Access of MS Office

 Image handling software: For example, MS Paint, MS Imager of
Microsoft and Adobe Photoshop of Adobe

The main office suites available these days are:

 Microsoft Office

 IBM/Lotus SmartSuite

 AppleWorks

 Corel WordPerfect

 Sun StarOffice

 OpenOffice (freeware)

Check Your Progress

6. Define the term information technology.

7. What is the significance of DSS?

1.4 ANSWERS TO CHECK YOUR PROGRESS
QUESTIONS

1. The hardware components of a computer system are the input unit, processor,
output unit, and the memory unit.

2. The joystick offers three types of control, namely digital, glide, and direct.
The digital control allows limited movement like up, down, left, and right.
The glide and direct controls allow movements in all directions (360 degrees).
Direct control joysticks can also respond to the distance and speed with
which the stick is moved by the user.

3. A trackball requires less desk space than a mouse.

4. A bar code is a machine-readable code in the form of parallel vertical lines
of varying widths.

5. The arithmetic unit is responsible for performing and carrying out arithmetic
calculations such as addition, subtraction, etc. The logic unit performs logical
operations based on the instructions provided to it.

6. The term Information Technology or IT as it is commonly called, refers to
the technology that uses computer software and hardware for the purpose
of processing data and producing useful information.

7. DSS helps the management to make tough decisions pertaining to the
organization by collecting data and processing it using ‘what-if’ models and
extensive spreadsheets to display outcomes of that model.
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1.5 SUMMARY

 A computer is an electronic machine which can perform calculations and
control operations that can be expressed either in numerical or logical terms.

 An input device is an electromechanical device used to feed data into the
computer.

 A keyboard is the most commonly used input device. It comprises different
keys using which the user can enter data into the computer, and execute
commands.

 A scanner is used to convert text or an image in printed form to an electronic
representation which can be viewed on the screen.

 OCR is a process to scan printed pages as images on a flat-bed scanner and
then use the OCR software in order to recognize the letters as ASCII text.

 A bar code reader is used to read the bar code. A bar code is a machine-
readable code in the form of parallel vertical lines of varying widths. Bar
codes are commonly used for labelling goods that are available in
supermarkets and for numbering books in libraries.

 CPU, also known as processor, is referred to as the brain of a computer
system. It takes the data, processes it, and converts the data into meaningful
information

 The control unit (CU) contains circuitry that uses electrical signals for directing
the computer system, for carrying out or executing the stored program
instructions. It directs other parts of the system to execute program instructions
by communicating with both the arithmetic logic unit and the memory

 A CRT is a vacuum tube which is used as a display screen for a computer
output device. In CRTs, the screen pixels are made from phosphor. An
electron beam (cathode ray) is emitted by the electron gun towards the
specified position to strike the phosphor.

 The Information Technology Association of America (ITAA) defines IT as
the study, design, development, implementation, support or management of
computer-based information systems, particularly software applications and
computer hardware for the purpose of converting, storing, protecting,
processing, transmitting and securely retrieving information.

1.6 KEY WORDS

 Computer: An electronic machine which can perform calculations and
control operations that can be expressed either in numerical or logical terms.

 Hardware: The physical parts that make up a computer, such as an input
unit, a central processing unit, an output unit, and a memory unit.
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 Input Device: An electromechanical device used to feed data into the
computer.

 Light Pen: A hand-held electro-optical pointing device that helps in drawing
images and selecting objects on the display screen by directly pointing to
the objects.

1.7 SELF ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. What are the various hardware components of a computer system?

2. What functions does each unit of CPU perform?

3. What are the advantages of transistors over vacuum tubes?

4. Write short notes on the following:

(i) Magnetic ink character reader

(ii) Bar code reader

(iii) Drum printer

(iv) Joystick

(v) Visual display unit

5. What are the different types of printers?

6. What are the different types of plotters?

Long-Answer Questions

1. Explain the computer system with the help of block diagram.

2. What are the different types of pointing devices? Explain.

3. Write a detailed note on role of IT in communication.
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2.0 INTRODUCTION

In this unit, you will learn about the characteristics of computer system and basic
concepts of an operating system. An operating system has two main objectives:
convenience and efficiency. An operating system is designed in such a way that it
makes the computer system more convenient to use and allows the system to use
its resources in an efficient manner. Every computer has an operating system that
helps the computer to manage, allocate and schedule the computer resources that
serve the requirement of each user.

2.1 OBJECTIVES

After going through this unit, you will be able to:

 Discuss the characteristics of computer system

 Define OS with user and system view

 Explain the functions and services of OS

 Understand the process scheduling

 Explain memory and resource management

2.2 CHRACTERISTICS OF COMPUTERS

If any computer can carry out a large number of calculations in a short period of
time, it can be called a ‘powerful’ computer. Ignoring all the limiting factors of the
other hardware, according to the above definition, the CPU makes a computer
powerful. Computers are powerful for different reasons. They operate with amazing
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reliability, speed, and accuracy. Huge amounts of data and information can be
stored in computers. Computers also permit their users to communicate with other
users.

Speed

A computer can perform billions of actions in a second. The important factors that
determine the speed of a computer are:

 The amount of data that the CPU can execute in a given period of time

 CPU’s clock speed 

Clock speed

Clock speed is the rate at which a CPU implements instructions. An internal clock
that regulates the rate at which instructions are executed and coordinates all the
various computer components exists in every system. The CPU needs a
predetermined number of clock ticks to execute each instruction it receives. 

If this clock runs faster, the CPU will execute more instructions per second.
Clock speeds are expressed in megahertz MHz (Mega means million and hertz
means times per second) or gigahertz (GHz). For example, 200 MHz means 200
million times per second whereas 200 GHz means 200 billion times per second.

Reliability

‘Failures are usually due to human error, one way or another.’ We can depend on
the modern computer because the electronic components in these have a very low
failure rate. The high reliability of the components of a computer ensures that the
computer consistently gives good results.

Accuracy

Computers process large amounts of data and produce error-free results if
(and only if) the input data is correct and the instructions it receives are input
properly. If the input data is inaccurate, the resulting output will certainly be incorrect.
So, the accuracy of a computer’s output depends mainly on the accuracy of the
data input.

Storage

A computer can store huge amounts of data. Using the availability of the modern
storage devices, the computer can transfer data quickly from storage to memory,
process the data, and then reserve the data again for further use.

Diligence

Computers are highly consistent compared to human beings. They never suffer
from human traits like boredom, tiredness and lack of concentration. Therefore,
computers score over human beings in performing repetitive and voluminous tasks.
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Versatility

Computers are capable of performing any task following a series of logical steps.
They are versatile machines, but their capability is limited only by human intelligence.
In today’s fast developing, technology-savvy world, it is almost impossible to find
an area where computers are not being used. Banks, railway/air reservation, hotels,
weather forecasting and many more—computers are essential in every sector.

Power of Remembering

In human memory, information that is less important is relegated to the back of the
mind and forgotten with the progression of the time; whereas a piece of information
once stored (or recorded) in the computer can never be forgotten and can be
retrieved at any time! Therefore, information can be retained as long as desired.
We can use secondary storage (a type of detachable memory) for this purpose.

No Intelligence Quotient (IQ)

Computers have no real intellect or common sense unlike the human brain.
Computers are still not complex enough to understand and analyze and act
accordingly like the brain does. These can only follow rules and instructions preset
by the programmer. Traditional machines manages to replicate and bear a
resemblance to human intellect because programmers try to make the computer
react just like a human brain by programming a set of rules and instruction for the
computer to follow. Like the human brain, the computer can hardly innovate and
invent new ideas. The computer is faster than the human brain at doing logical
things and computations. Only by using preset algorithms (or programs) to merge
current ideas, computer can do creative innovation (which only shows a limited
range of creativity). However, the brain is capable of imagination. It is better at
interpreting the outside world and can create new ideas.

No Feelings

The human brain always acts under the influence of emotions, but computers act
only on logic. Many of our actions are based on our emotions. It has been already
proved by researchers that brains act on emotions. However,  computers act
completely on logical bits following the programmers’ instructions that are absolute.
No other factors have any effect on them, because all actions performed by
computers are based on the coding.

2.3 OPERATING SYSTEM

In simple terms, the operating system is defined as a program that is running at all
times on the computer (usually called the kernel). It is a program that acts as an
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interface between the computer users and the computer hardware (see Figure
2.1). It manages the computer hardware and controls and coordinates the use of
hardware among various application programs. The operating system also provides
a way in which the various computer resources, such as hardware, software, and
the data can be used in a proper and efficient manner.

An operating system has two main objectives: convenience and efficiency.
An operating system is designed in such a way that it makes the computer system
more convenient to use, and allows the system to use its resources in an efficient
manner. Some operating systems are designed for convenience (for example, PC
operating systems), some for efficiency (for example, mainframe operating systems),
and some for the combination of both.

Fig. 2.1 Components of a Computer System

An operating system can be compared to a government. Though like a government,
it does not perform any useful function by itself, but it provides an environment for
the other programs so that they can do useful work. There are two viewpoints
from which we can understand the role of an operating system: the user point of
view and the system point of view.

User View

In case of a stand-alone environment, where a single user sits in front of a personal
computer, the operating system is designed basically for the ease of use, and
some attention is also paid to system performance. However, since these systems
are designed for a single user to monopolize the resources, there is no sharing of
hardware and software among multiple users. Therefore, no attention is paid to
resource utilization.

In case of a networked environment, where multiple users share resources
and may exchange information, the operating system is designed for resource
utilization. In this case, the operating system ensures that the available processor
time, memory, and I/O (Input/Output) devices are used efficiently, and no individual
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user tries to monopolize the system resources. In case, the various users are
connected to a mainframe or a minicomputer via their terminals, no attention is
paid to usability of individual systems. However, in case the users are connected
to the servers via their workstations, a compromise between individual usability
and resource utilization is made while designing the operating system.

In case of handheld systems, the operating system is basically designed for
individual usability as these systems are mostly stand-alone units for individual
users. Finally, the computers which have little or no user view, such as embedded
systems, the operating system for such systems is basically designed to ensure that
these system will run without user intervention.

System View

As discussed earlier, the computer system consists of many resources, such as
CPU time, memory and I/O devices, which are required to solve a computing
problem. It is the responsibility of the operating system to manage these resources,
and allocate them to various programs and users in a way such that the computer
system can be operated in an efficient and fair manner. Thus, from the system’s
point of view, the operating system primarily acts as a resource allocator.

The operating system also acts as a control program that manages the
execution of user programs to avoid errors and improper use of computer system.
It also controls the I/O devices and their operations.

Functions of Operating System

The important function of an operating system are discussed in the following sections.

Resource Management: Computer resources include main memory (RAM),
storage devices (floppy disk and hard disk drives) and input, and output devices
(keyboard, mouse, monitor, printer). The operating system is responsible for:

 Allocating and deallocating the memory space as needed by various
application programs.

 Functioning as a secondary storage management. All application programs,
compilers and loaders are stored in the secondary storage (hard disk).

 Dealing with input and output to and from other connected hardware
devices, such as printers, hard disks, modems and scanners.

File Management: The OS is responsible for the creation and deletion of
files/directories and the mapping of these files/directories on to the secondary
storage.

Security Management: The OS is responsible for protecting the resources
and information of a computer system from destruction and misuse.

Operating System Services: The OS is responsible for providing a set of
services to programs and users of those programs. The main services include:
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 Program Execution: It loads the program requested by the user into
the memory.

 Error Detection: It generates messages to each application or user
about the status of the operations that have been performed. It constantly
detects and corrects errors generated by the system.

 Resource Utilization: It ensures efficient utilization of the computer’s
resources.

An operating system is a set of instructions stored on a storage device, such as
hard disk, Compact Disk Read Only Memory (CD-ROM) or floppy disk. When
you switch on a computer, the power on routine activates and a set of power on
routine activities is performed. These power on routine activities verify the devices
attached to the Central Processing Unit or CPU, such as keyboard, hard disk,
floppy disk, CD-ROM and printers for their proper functioning. The instructions
for these power on routine activities are stored in the Read Only Memory (ROM).
ROM is permanent in nature and stores the data even when the power is switched
off. However, ROM stores only a few kilobytes of instructions due to its finite
size. As a result, the power on routine activities are stored permanently in the hard
disk as operating system and are transformed from the hard disk into the Random
Access Memory (RAM) at the time of booting the computer.

RAM is also called main memory, which is volatile in nature and as a result,
the programs and instructions are temporarily stored in it and are lost on power
failure. Secondary memory, such as hard disk is non-volatile and thus retains
information even in case of power failure. For example, if you are working in
Microsoft Word and saving your content in the main memory, the content will be
erased from the main memory if the computer is switched off. When the contents
are saved in a specific file, they are transferred into secondary memory.

An operating system is loaded into the computer memory in the following two
ways:

 Loaded from Boot ROM.

 Loaded from the hard disk when the computer is switched on.

If an operating system is already present in ROM, the computer is booted
up immediately when the CPU is switched on. These operating systems are best
suited for handheld devices, such as laptop and briefcase computers. However,
these operating systems are difficult to update as ROM is a permanent memory
and contents stored in it cannot be erased.

If the operating system is loaded from the hard disk when the computer is
switched on, then it stores the booting instructions in the RAM. The CPU starts
executing your instructions when the operating system gets loaded into the RAM
of your computer. Figure 2.2 shows the booting process of an operating system
from the hard disk.
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Fig. 2.2 Booting Process of an Operating System

When the computer is switched on, ROM starts executing Power On Self
Test (POST). POST checks the hardware devices attached to the computer before
the booting process starts. The primary boot executes the first physical sector
from the disk called the boot sector. The secondary boot verifies the drivers which
are installed in the computer. A driver is a software that is used for communicating
with various devices attached to the computer. There are two kinds of operating
systems namely Character User Interface (CUI) and Graphical User Interface
(GUI). CUI is not user friendly and allows you to type each and every command
for interacting with the operating system. For example, DOS is a CUI operating
system. GUI is a user friendly interface that eliminates the need of typing commands
on the computer. For example, Windows is a GUI operating system.

Services of an Operating System

An operating system acts as a platform for developing the application programs.
The major services provided by an operating system are as follows:

 It acts as an extended machine.

 It acts as a resource manager.

 It acts as a constant application program interface.

An operating system acts as an extended machine by translating your
commands into machine language instructions. The CPU executes these machine
language instructions and the operating system retranslates the output back into a
user understandable language. Figure 2.3 shows the extended machine view of an
operating system.

The n number of users are busy in developing and compiling their application
programs or are working in the text editor. These users interact with the operating
system through system calls or shell. The operating system interacts with the
computer hardware to execute the users jobs.

An operating system acts as a resource manager by controlling and allocating
various hardware and software resources to different users in an optimal and
efficient mode. The task of resource management becomes essential in multiuser
operating systems, where different users compete for the same resources. An
operating system manages the resources in the following two ways:

 Time multiplexing

 Space multiplexing
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Fig. 2.3 The Extended Machine View of an Operating System

Time multiplexing defines the sharing of resources based on fixed time slices.
For example, the operating system allocates a resource, such as CPU to program
A for a fixed time slice. When the time slice is over, the CPU is allocated to
another program B. If program A needs more CPU attention, then the CPU is
again allocated to program A after the time slice allocated to program B is over.
Space multiplexing defines the concurrent sharing of resources among different
programs. Sharing of a hard disk and main memory are examples of space
multiplexing.

Figure 2.4 shows the functions of an operating system.
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Fig. 2.4 The Functions of an Operating System
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An operating system manages files, resources and CPU utilization that a
user needs to perform various tasks. An operating system performs the following
functions:

 Process Management: It is a process that helps in the management of
different processes. A process is a set of sequential steps for performing
a task. In other words, for an operating system a process is an instance
of a program. Process management is necessary for proper execution
of any program.

 Memory Management: It is a process, which manages storage system
of a computer. The organization and management of a computer storage
system is important for an operating system. An operating system
allocates memory to the various processes.

 Resource Management: The I/O subsystem is required to monitor
and manage wide variety of I/O devices. These I/O devices vary with
respect to their functionality, data rate, speed and software support.

Process Management

A process goes through various states for performing several tasks. The transition
of a process from one state to another occurs depending on the flow of the
execution of the process. It is not necessary for a process to undergo all the
states.

The various process states are as follows:

 New: It indicates that the process has just been created.

 Ready: It indicates that the process is waiting for a chance to be allocated
the CPU time for execution.

 Running: It indicates that the process has been allocated the CPU time
and is executing the tasks.

 Waiting: It indicates that the process is waiting for the completion of either
another process or an I/O task, such as reading a file.

 Terminated: It indicates that the process has finished its execution and all
the tasks in the process are complete.

Scheduling Queues

All the processes, which enter in a system, are first put into the ready queue and
then from the ready queue these processes are picked by the CPU for execution.
This queue is stored as a linked list in the system memory. The ready queue has a
header that contains the pointers for the first and final Printed Circuit Board or
PCB in the form of a list. Every PCB includes a pointer that points to the next
PCB in the ready queue. Figure 2.5 shows the concept of scheduling queues for
process scheduling.
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Fig. 2.5 Queuing Representation of Process Scheduling

The ready queues are represented by rectangles. The circles in the queue
represent the resources that serve the queue and the arrows represent the flow of
information. When a process enters in a system, it is put into the ready queue
where the process has to wait until it is allowed to enter in CPU for execution.
When a process enters in CPU, it starts executing the process. During the execution
of a process, the following events occur:

 A process is placed in the ready queue when it generates an I/O request.
 A process may initiate a new sub process and it has to wait for execution

until the sub process completes its execution.
 If an interruption occurs, then a process might be removed from CPU

and is placed again in the ready queue.

Scheduling is the technique through which threads, processes or data flows
are specified access to system resources, for example processor time and
communications bandwidth. Typically, this is done to balance a system efficiently
or to attain a quality of service.

The scheduler is mainly concerned with the following processes:
 Throughput: The number of processes that complete their execution per

time unit.
 Latency: It specifically includes the turnaround or the total time between

submission of a process and its completion and response time or the
amount of time it takes, when a request was submitted until the first response
is produced.

 Fairness/Waiting Time: It refers to equal CPU time to each process or
more generally appropriate times according to each process’ priority.

In reality, these targets often conflict, for example throughput versus latency.
Hence, a scheduler is implemented for an appropriate negotiation. Operating
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systems include three distinct types of schedulers, a long-term scheduler, a mid
term or medium-term scheduler and a short-term scheduler. Each type implies the
relative frequency with which these functions are performed. The scheduler is an
operating system module that selects the next job to be admitted into the system
and the next process needs to be run.

 Long-Term Scheduler: A long-term scheduler selects a process from a
number of processes and loads it in the system memory for execution. A
long-term scheduler works with the batch queue which contains low priority
programs and selects the batch process for execution. It controls the degree
of multiprogramming, which refers to the total number of processes present
for execution in the system memory. If the degree of multiprogramming is
stable, then the average rate of process creation is equal to the average
departure rate of process. This scheduler has more time to decide which
process should be executed first, because there is a long time gap between
the execution of two processes. This scheduler provides the best performance
by selecting the processes from both, the I/O bound process and the CPU
bound process. The I/O bound processes spend most of their time in I/O
operations. CPU bound processes are the processes that spend most of
their time in instruction execution rather than generating I/O requests.

 Medium-Term Scheduler: This is another type of scheduler that is generally
used by the time sharing operating system. This scheduler is known as
medium-term scheduler. The main idea of introducing a medium-term
scheduler is that it improves the mixing of various processes, which includes
both, CPU and I/O bound processes with the help of swapping. Swapping
is a method of moving processes in and out from the memory. The medium-
term scheduler temporarily removes processes from main memory and
places them on secondary memory, such as a disk drive or vice versa.

 Short-Term Scheduler: A short-term scheduler is also known as CPU
scheduler. This scheduler selects a process from different processes, which
are ready for execution and allocates CPU to the selected process. This
type of scheduler executes a process once in every 100 milliseconds and
hence it is very fast and selects a process for CPU frequently.

Memory Management

An act of managing computer memory is described as memory management. The
major requirement of the memory management is to provide ways to dynamically
allocate portions of memory to program at their requests and then making it free
after use when it is no longer needed.

A computer uses two types of storage, main memory and secondary memory.
The main memory stores temporarily the instructions to be executed by the
computer. The CPU of a computer retrieves instructions from main memory for
the execution. On the other hand, secondary memory is constituted by various
secondary storage devices, such as magnetic disks and magnetic tapes, which
store information permanently in the form of files.
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Main memory, RAM, is the temporary read/write memory of a computer
but faster than the secondary storage device. Main memory is a set of locations
defined by sequentially numbered addresses for storing programs for execution
and each location contains a binary number. You can access each byte of RAM
directly without reading the previous bytes sequentially.

Each byte in a RAM has an address. The addresses are usually sequential
hexadecimal numbers. Mostly, the addresses of RAM start from 00000.

The memory address that is referred to an instruction can be mentioned in
two ways. When the exact location of a byte in RAM is mentioned, the addressing
scheme is called absolute addressing. The address itself is called an absolute
address.

Address Binding

A program is a set of sequential instructions which are given to a computer. The
programs are usually stored in a secondary storage device as an executable file.
When you run a program, the computer reads the instructions and loads them as
process in the ready queue.

A ready queue is a collection of processes which are to be executed by a
computer. The operating system selects a process sequentially from the ready queue
and executes it.

The transformation of a source code to an executable program is done in
various phases. Figure 2.6 shows how a source code is transformed into an
executable program.

Source
Code

Main Program

Source
Code

Function A

Source
Code

Function B

Compiler or Assembler

Object
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Main Program

Object
Code

Function A

Object
Code
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Function a, and Function B
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Dynamic Link
Library

Runtime Dynamic
Linking Memory

Fig. 2.6 Sequence of Transformation of Source Code into an Executable Program
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The source code is converted into a machine readable form known as object
code. A linker combines various object codes that have been compiled or assembled
separately into a format, known as load module.

The compiler is a program that transforms a source program written in any
computer language, such as C, COmmon Business Oriented Language or COBOL
or PROgramming LOGic or Prolog into an object code, which is understandable
to the computer. An assembler is a program that converts an assembly language
program into object code.

A linker is a program that combines multiple number of object codes. A
loader is a program that loads program into memory for execution. There are
three types of loading. These are described as follows:

 Absolute: It loads a program into a specific or fixed location in the
memory.

 Relocatable: It loads a program at any random location in the memory.
Relative addressing is used in relocatable loading.

 Dynamic: It loads a function, when the function is called for the first
time. In other words, a loader does not bind any external reference of
an object code until the external reference is used.

Address binding is the process of generating memory addresses, where the
instructions and data of a program are to be stored. Address binding can be
classified into two types: static and dynamic.

 Static: It resolves the addresses of instruction and data before execution.
In other words, the addresses of instructions and data in the memory
are known before loading them. Static binding can be of two types:

o Compile Time: It resolves the addresses of instruction and data at
the time of compilation of a program. The compilers or assemblers
generate absolute addresses for the symbolic addresses of variables
and function names at the time of compilation.

o Load Time: It resolves the addresses of instruction and data at the
time of loading the program in memory, but in some cases, the value
of an address is not known at compile time. In the first phase, the
compiler or assembler converts the symbolic addresses into relative
addresses. In the next phase, loader transforms the relative address
into an absolute address.

 Dynamic: It determines the address, where instructions and data are
to be loaded at the execution time.

Logical and Physical Address Space

The location in main memory is uniquely identified by an address. This is called
physical address of main memory, RAM. The addresses generated by the CPU
are known as logical or virtual addresses. While writing a program, the programmer
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refers to only logical addresses because referring to physical addresses is not
allowed.

The set of all logical addresses in main memory is called logical address
space. The set of all physical addresses is called physical address space. These
logical addresses are converted into physical addresses and the procedure to
convert a logical address into a physical address is called memory mapping.

The hardware unit that converts a logical address into a physical address is
called Memory Management Unit (MMU). There are several methods for memory
mapping and the simplest one uses a relocation register. The base address of a
program is loaded at the relocation register. A physical address is calculated by
adding the value of the relocation register to the value of logical address.

Memory Partitioning

Main memory is divided into certain fixed size or variable sized partitions. In fixed
partitioning scheme, each part or slot can be of equal or unequal size. In variable
size partitioning, the memory is partitioned on runtime depending upon the
requirement of the programs running on the computer. In variable size partitioning,
which is also known as dynamic partitioning, no fixed partition of memory exists.
The operating system occupies only a certain part of memory, when it is loaded on
a computer and the rest of the memory is used by the user applications.

In equal size partitioning, an application is loaded into one or more slots.
The applications occupy a certain number of memory space slots according to
their requirement. For example, the memory space of capacity, 128 MB is divided
into 8 equal size slots of size 16 MB, each. Two applications, X and Y require 32
and 50 MB, respectively. In this case, application X requires 2 slots of memory
and application Y requires 4 slots of memory. The 14 MB memory space ((4 *
16) – 50) which is allocated to an application Y, will remain unused. This unused
space is called fragment and the concept is called fragmentation.

In unequal size partitioning, an application is loaded into a slot whose capacity
is greater than or equal to the memory requirement of the application. For example,
a 64 MB memory is divided into 5 slots of the capacity 8 MB, 8 MB, 16 MB and
32 MB. The two applications, X and Y require 8 and 10 MB memory space,
respectively. Application, X is loaded into one of the 8 MB memory space.
Application Y is loaded into the 16 MB slot and 6 MB memory space will remain
unused. Application Y could also be allocated the 32 MB space but in that case,
22 MB memory space will remain unused. An operating system aims to optimize
memory utilization. Figure 2.7 shows how memory is divided in to fixed size equal
and unequal slots.

In equal size partitioning, the 64 MB RAM has been divided into 8 parts of
the memory size 8 MB each where the operating system occupies the first part.
Application 1 needs 24 MB memory space and thus occupies three slots of 8 MB
each. Application 2 requires 8 MB memory space and occupies a single slot, and
the rest of the slots remain unused.
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Fig. 2.7 Fixed Partitioning with Equal and Unequal Size Slots

In unequal size partitioning, the memory has been divided into five parts or
slots of different sizes. The operating system occupies the first slot. Application 1
requires 24 MB memory space and occupies three slots, and application 2 requires
8 MB memory space and occupies only a single memory slot.

Another approach used for partitioning the main memory is dynamic
partitioning. In this method, there are no fixed size static partitions in memory. The
memory partitions are created in runtime while allocating memory space to
processes. For example, the size of main memory in a computer is 32 MB. A
process needs 2 MB memory space for execution. So, a memory partition of 2
MB size is created and allocated to that process.

Resource Management

In resource management, the resources of distributed system are divided into two
broad categories, I/O devices and files. Files are the central element in a distributed
system as they provide input to an application for execution and the output of the
execution is also recorded in the files.

For each I/O operation, you need to access the files that are stored on
disks or on specialized servers which are only assigned with the function of managing
file system. In order to achieve a high rate of data transfer and increase
performance, CPU enhances the rate of processing I/O operations of files. As the
client has to access remote files, then it becomes critical to access the files in case
of a distributed system.

Distributed File System

Distributed File System (DFS) is a part of distributed system that provides uniform
interface to all the files and makes files sharable on a network. DFS helps in
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managing and controlling the communication between the file system and the
distributed operating system. Figure 2.8 depicts the architecture of DFS.

Fig. 2.8 Architecture of DFS Network

In order to explain DFS, you need to understand the resource management
concepts, such as file service, file server and client.

 File Service: It is a part of software that specifies how a file system
offers services to the clients and what all services does it offer.

 File Server: It is a machine where files are stored. It also implements
file services.

 Clients: These are the users of the files and file services. The various
operations, such as read, write, create, open and close are performed
by these clients on files. The files should be accessed by clients in such
a manner so that the throughput of network increases and the
communication delay decreases. Also, the distributed file system must
hide the hardware-related complexities of files from the client, so that
the file system should be transparent to clients and appear as a centralized
file system.

Remote File Access

In a distributed system, files are located on specialized servers. These servers are
responsible for holding large disks for storing files, such as Redundant Array of
Inexpensive (Independent) Disks or RAID. These disks provide either the entire
file or a part of file that is requested by a host to perform I/O operations or data
processing. This mechanism is known as remote file access. It provides transparency
to an end user who can access any file remotely, regardless of its location.

You can perform remote file access in following ways:

 Uploading: In this method, the queries are sent to the location of files
for processing. This method reduces the bottleneck that occurs in the
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network but leads to overloading of server because all the processing is
done at the server side.

 Downloading: In this method, files are sent to host or client side. This
mechanism is considered as a simple and efficient method when a client
requires the entire file for processing. The problem associated with this
method is that when a portion of file is required, the entire file is
processed. In such a case, this method becomes expensive and uses a
lot of disk space and time in downloading a complete file.

 Remote Access: In this method, the client remotely access the files
that are present in the network. The client does not interfere with the
application that is running either at the server side or at the client side. If
the application is running at the server side, then the client sends the
query to the server. The query is processed at the server and the result
is forwarded to the client. If the application is running at the client side,
then a portion of the requested file is transmitted to the client and
processing of query is done locally. Moreover, an operating system stores
files in the cache to avoid repeated searching.

Remote file access uses cache for increasing the performance of network
by reducing the network traffic and disk I/O because, in remote file access
transferring of the complete file is not required.

Cache Mechanism

Cache is a temporary storage area where blocks of files are stored for fast recovery.
If the desired block is not present in the cache, then a copy of this block is accessed
from the file server where it is stored.

Cache contains data, which is a copy of master file stored on server. This
means when the end user modifies the copy of data, the master copy also needs to
be modified so that consistency of data can be maintained. The cache always
consist of more data than it requires in order to satisfy different requests,
simultaneously. Figure 2.9 shows the working of cache in distributed system.

Client Server

Query

Server
Disks

Query

Query

Query

Query

Cache

Cache
Data

Clients Disk

Data

Data

Data

Fig. 2.9 Working of Cache in Distributed System
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In cache mechanism, the client machine requests a query and searches its
local cache for the required block of data. If the client machine is not able to find
the required data, then it searches the required block in the server cache. Again, if
the client machine does not get the required block the query is transferred to the
server. The server performs the required searches and stores the desired block
into its cache from where the block is transferred to the client’s cache.

If the data in the cache is modified, then the modified data is sent back to
the server for permanent storage to maintain data consistency.

Check Your Progress

1. What do you understand by clock speed of CPU?

2. Define OS.

3. What are the main services of an OS?

4. Write a note on DFS.

2.4 ANSWERS TO CHECK YOUR PROGRESS
QUESTIONS

1. Clock speed is the rate at which a CPU implements instructions.

2. Operating system is defined as a program that is running at all times on the
computer (usually called the kernel). It is a program that acts as an interface
between the computer users and the computer hardware

3. The main services of OS are:

 Program Execution: It loads the program requested by the user into
the memory.

 Error Detection: It generates messages to each application or user
about the status of the operations that have been performed. It constantly
detects and corrects errors generated by the system.

 Resource Utilization: It ensures efficient utilization of the computer’s
resources.

4. Distributed File System (DFS) is a part of distributed system that provides
uniform interface to all the files and makes files sharable on a network. DFS
helps in managing and controlling the communication between the file system
and the distributed operating system.

2.5 SUMMARY

 Computer can carry out a large number of calculations in a short period of
time, it can be called a ‘powerful’ computer. A computer can perform billions
of actions in a second.
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 A computer can store huge amounts of data. Using the availability of the
modern storage devices, the computer can transfer data quickly from storage
to memory, process the data, and then reserve the data again for further
use.

 Computers process large amounts of data and produce error-free results if
(and only if) the input data is correct and the instructions it receives are
input properly.

 The operating system is defined as a program that is running at all times on
the computer (usually called the kernel). It is a program that acts as an
interface between the computer users and the computer hardware.

 An operating system has two main objectives: convenience and efficiency.

 RAM is also called main memory, which is volatile in nature and as a result,
the programs and instructions are temporarily stored in it and are lost on
power failure.

 Secondary memory, such as hard disk is non-volatile and thus retains
information even in case of power failure.

 A process goes through various states for performing several tasks. The
transition of a process from one state to another occurs depending on the
flow of the execution of the process.

 Scheduling is the technique through which threads, processes or data flows
are specified access to system resources, for example processor time and
communications bandwidth.

 An act of managing computer memory is described as memory management.
The major requirement of the memory management is to provide ways to
dynamically allocate portions of memory to program at their requests and
then making it free after use when it is no longer needed.

 Distributed File System (DFS) is a part of distributed system that provides
uniform interface to all the files and makes files sharable on a network.

 Cache is a temporary storage area where blocks of files are stored for fast
recovery. If the desired block is not present in the cache, then a copy of this
block is accessed from the file server where it is stored.

2.6 KEY WORDS

 Operating System: It is a set of programs that manages computer hardware
resources and provides common services for application software.

 System Call: It is a mechanism used by an application for requesting a
service from the operating system.

 Kernel: It is the central part of an operating system which manages the
operations of the computer and the hardware.
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EXERCISES

Short-Answer Questions

1. Discuss the characteristics of computer system.

2. What are the view points from which we can understand the role of an OS?

3. What are the main services of an OS?

4. What are the various states of a process?

Long-Answer Questions

1. Explain the functions of operating system with the help of examples and
illustrations.

2. What are the services of an operating system? Explain.

3. Explain the working of cache in distributed system with the help of examples.

2.8 FURTHER READINGS

Rajaraman, V. 2004. Fundamentals of Computers, 4th edition. New Delhi:
Prentice Hall India Pvt. Limited.

Sanders, Donald H. 1983.Computers Today, 1st edition. New York: McGraw-
Hill.

Laudon, Jane P. and Kenneth C. Laudon. Management Information System:
Managing the Digital Firm. New Jersey: Prentice Hall, 2007.

Senn, James A. Analysis and Design of Information System. New York:
McGraw-Hill, 1984.



DOS and Windows

NOTES

Self-Instructional
50 Material

UNIT 3 DOS AND WINDOWS
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3.0 INTRODUCTION

In this unit, you will learn about the DOS, Windows and types of operating system.
DOS is a single user and single task operating system. Monolithic architecture
consists of a single layer that performs all the functions of the operating system.
MS DOS supports monolithic architecture. You will also learn about internal and
external DOS commands. In DOS, the internal commands reside in
COMMAND.COM which loads into the memory when the computer system is
started and these commands do not reside on disk. The external commands are
files that do reside on disk and have an extension of .COM, .EXE or .BAT. Windows
10 is the most recent version of the operating system from Microsoft. Officially it
was released in 2015 and was initially offered free of charge to legitimate users of
Windows 7 and Windows 8.1. This new version combines features from those
two previous installations to suit the users in a better way for both desktop/laptop
computers as well as mobile devices.

3.1 OBJECTIVES

After going through this unit, you will be able to:

 Discuss the basics of DOS

 Describe the internal and external DOS commands

 Understand the Windows 10 operating system
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 Find, rename, copy, and delete files or folders, and retrieve deleted files
and folders

 Use Windows 10 shortcuts

 Discuss the different types of operating system

3.2 DOS

Microsoft Disk Operating System (MS DOS) is a single-user operating system
built by Microsoft. It was the most commonly used operating system for PC in the
1980s and Microsoft’s first commercialized operating system. It was the same
operating system that Microsoft developed for IBM’s personal computer as a
Personal Computer Disk Operating System (PC DOS) and was based on the
Intel 8086 family of microprocessors. MS DOS uses Command Line Interface
(CLI) that requires knowledge of a large number of commands. Now Graphical
User Interface (GUI) based operating systems are becoming popular, hence MS
DOS lost its appeal quickly though it was the underlying basic operating system
on which early versions of GUI based Windows operating system ran. Even today
you will find that Windows Operating Systems continue to use and support MS
DOS within a Windows environment. MS DOS was initially released in 1981 and
till now eight versions of it have been released. Today, Microsoft has stopped
paying much attention to it and is focusing primarily on the GUI based Windows
Operating Systems.

3.2.1 What is DOS?

Microsoft Disk Operating System (MS DOS) is a single user, single tasking
operating system. MS DOS has a command line, text-based/non-graphical user
interface commonly referred to as Character-based User Interface (CUI). When
the computer is switched on, a small program checks all internal devices, electronic
memory and peripherals. Once this process is completed, MS DOS is loaded.

DOS prompt

The DOS prompt known as the command prompt looks like C:\> or D:\> where
‘C’,‘D’ represent the hard drives of the computer system. All commands are typed
at the DOS prompt. Enter key is pressed to view the output of the typed command.
If the command is correctly typed desired output would be displayed. Otherwise
an error message (Bad command or filename/Invalid parameter) is displayed on
the screen.
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3.2.2 DOS Commands: Internal and External

In Table 3.1, the internal DOS commands are tabulated in detail.

Table 3.1 Internal DOS Commands

Command Syntax Explanation Example Notes 

DATE DATE Displays the system’s current date and 
prompts to enter the new date. 

C:\>DATE The current date is: Fri 05/09/2003 
Enter the new date: <mm-dd-yy>: 

TIME TIME Displays the current time and prompts 
the user to enter the new time. 

C:\>TIME The current time is: 12:55:25.34 
Enter the new time: 

VER VER Displays the windows version. C:\>VER Displays the Windows version 
installed on your computer. 

PROMPT PROMPT [Text] Changes the MS DOS command prompt 
to the specified text. If the command is 
typed without any parameters then the 
default prompt setting is restored. 

D:\>PROMPT Changes the prompt to the default 
setting. 

COPY COPY <Source> 
<Destination> 

Creates a copy of the specified file and 
places it in the specified location, file 
will exist at the specified location as 
well as the source location. 

C:\DATA> 
MOVE 
HELLO.TXT 
\LETTER 

Creates a copy of HELLO.TXT in 
the LETTER folder of the C: drive. 

REN REN <Path> 
<01dfile> <Newfile> 

Renames the old file name by the 
specified new file name. 

C:\DATA>REN 

HELLO.TXT 

Hi.TXT 

Renames ‘HELLO.TXT’ as ‘Hi.TXT’ 

DFL /FRASF DEL 

<Path><Filename> 

Deletes the specified file present in the 

Specified path/location from the hard 
disk. 

C:\DATA>DEL 

Hi.TXT 

Deletes the file ‘Hi.TXT’ located in 

the ‘DATA’ folder of the C: drive. 

TYPE TYPE <Filename> Displays the contents of a text file. C:\DATA>TYPE 
TMP.TXT 

Displays the contents of TMP.TXT. 

DIR DHKDrive/ 
Directory - 
Name Name> 

Displays all the sub-directories and files 
of the specified drive/directory. It also 
shows the size of the files and the date 
and time they were last modified. 

C:\>DIRD: Displays all the contents (files and 
directories) of the D: drive. 

DIR/P DHKDrive/ 
Directory -Name>/P 

Displays the contents of directory one 
screen at a time and pauses until any 
other key is pressed to continue the 
display. 

C:\>DIR 
DATA/P 

Displays the contents of the ‘DATA’ 
directory by pausing the screen. 

DIR/W DIR <Drive/ 
Directory>/W 

Displays the contents of the directory 
width-wise. It omits file size, date and 
time of creation of file so that more files 
can be displayed at one time on the 
screen. 

C:\>DIR 
DATA/W 

Displays the contents of the ‘DATA’ 
directory width-wise. 

DIR/W/P DIR <Drive/ 
Directory>/W/P 

The Wide and Pause display option can 
be combined. 

C:\>DIR 
DATA/W/P 

Displays the contents of the ‘DATA’ 
directory width-wise and by pausing 
the screen. 

CD CD<Directory-
Name> CD\ -
Directly takes to the 
root directory. 

Displays the name of the current 
directory if no parameter is specified 
with the command. Changes the current 
directory to the specified directory. 

C:\>CDDATA\ 
SUBDATA 

Changes the current directory to 
‘DATA\SUBDATA’. 

MD 
MD <Drive/ 
Directory-Name> 

Creates a new directory in the specified 
location. 

C:\>MD 
‘HELLO’ 

Creates a directory named ‘HELLO’ 
in the C: Drive. 

RD RD 
<Directory-
Name> 

Removes the specified directory. C:>RD HELLO To remove a directory first you 
should come to one level above the 
current directory and then remove 
command should be given. This 
command will delete the ‘HELLO’ 
directory from the C:drive. 

Wild cards

Wild card characters can be used in specifying filenames in DOS. There are two
types of wild cards. These are: (?,*).

? It is used to represent any single character in the file name.

SYNTAX: C:\ DIR BA?.TXT
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any single character.

Examples: BAT.TXT, BAG.TXT, BAR.TXT, BAD.TXT, etc.

* It is used to represent one or more characters in a file name.
SYNTAX: C:\ DIR CON*.TXT

Displays all the text files in the C: drive starting with ‘CON’.

Examples: CONCEPT.TXT, CONCATENATE.TXT,
CONTEMPT.TXT, CONSOLE.TXT, etc.

Table 3.2 shows external DOS Commands

Table 3.2 External DOS Commands

Command Syntax Explanation Example Notes 

LABEL LABEL Makes, changes, or deletes the label of 
volume of a disk. 

C:\>LABEL Displays the current volume label 
and volume serial number. Also 
prompts to enter a new label. 

EDIT EDIT Starts MS DOS editor, which produces 
and changes ASCII files. 

C:\>EDIT Opens the MS DOS editor. 

ATTRIB ATTRIB[+A | –A] 
[+R | –R]  
[+H | –H] [+S | –S] 
<file name> + sets 
an attribute + 
Clears an attribute 
A-Archive attribute 
R-Read only 
attribute. H-Hidden 
file attribute 
 S-System file 
attribute 

Displays or changes file attributes. C:\>ATTRIB+H +R 
FIRST.TXT 

Sets the attributes of ‘FIRST.TXT’ as 
Read only and hidden. 

XCOPY XCOPY 
<Source> 
<Destination> 

Copies files and subdirectories to the 
specified location. 

C:\>XCOPY 

C:\DATA 

C:\INFO 

Copies the entire contents of the 
‘DATA’folder to ‘INFO’folder. If the 
‘DATA’ folder contains ‘ami’ 
subdirectories, then they will also be 
copied to the 'INFO' folder. 

TREE TREE 

[Drive:][Path] 

[/F][/A] 

Displays directory paths and files in each 
subdirectory. 
/F – Displays file names in each listed 
directory. 
/A – Specifies the alternative characters 
(plus signs, hyphens, etc.) used to draw. 
the tree listing. 

TREE C: 

 

 

TREE D: 

Lists a tree listing of the C drive. 

 

 

List a tree listing of the D drive. 

DELTREE DELTREE 
<Directory-
Name> 

Deletes a directory and all the sub-
directories and files in it. 

C:\>DELTREE 
TEMP 

Prompts the user for confirmation. If 
user selects ‘Y’ (Yes) then the 
directory ‘TEMP’ and all its sub-
directories will be deleted. 

Concept of file

A file is created with the help of another application program. A user, for instance,
may create a text document in Notepad. So the application program in this case in
Notepad and the file is a Notepad file.

It is a portion of a software program that is used to store data, information,
settings, and/or commands used with that program. Examples of files are Word
document files, Excel files, PowerPoint presentation files, database files, and so
on.
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Apart from the normal application program files such as MS Word, MS
Excel, MS PowerPoint, a computer system includes other file types also. These
are as follows:

 Batch file: A batch file allows the users of MS Windows and MS DOS
to generate a list of commands for running in sequence after the execution
of the batch file. A batch file can be used for running the commands that
are frequently run, deleting files, moving files, etc. No special
programming skills are required for a simple batch file and can be
prepared by users who have a basic knowledge of MS DOS commands.

An instance of a batch file is a file that is somewhat similar to an icon on
the Mac OS or a shortcut in Windows. Similar to a shortcut, batch files
can be used for running one or more commands and/or programs through
the command line. Another popular instance of a batch file is a simple
boot file called autoexec.bat, which is loaded every time the OS is
loaded. It works on computers with early Windows. This batch file had
all the required commands and programs used for running MS DOS
and Windows every time the computer started.

 Executable file: It is a file that performs different functions or operations
on a computer. Since an executable file is compiled, unlike a data file, it
is generally not readable. On an IBM compatible computer, the common
executable files are .COM, .BAT, .BIN and .EXE. Other types of
executable files can also be there depending on the operating system
and its setup.

 System file: A file that is being used by an operating system and cannot
be deleted or changed without the stopping of the operating system is
known as a system file. Since these files are in use by the operating
system, generally they cannot be deleted.

A system file is also an attribute that can be added to any file in Microsoft operating
systems that allows the OS to know the file is an important system file. Files that
are marked as system files will also be hidden files.

Naming files

A filename is a special type of string which is used for identifying a file stored on
the file system of a computer.

A filename is divided in two parts: basename (the primary filename) and the
extension (which indicates the type of file related to a certain format of file).

A filename includes one or more of the following components:

 Protocol (or scheme) — Method of accessing (e.g., ftp, http, file, etc.)

 Host (or network ID) — Host name, IP address, domain name, or the
network name of LAN (e.g., wikipedia.org, 207.142.131.206,
\\MYCOMPUTER, SYS:, etc.)
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(e.g., C:, /, SYSLIB, etc.)

 Directory (or path) — Directory tree (e.g., /usr/bin, \TEMP,
[USR.LIB.SRC], etc.)

 File – Base name of the file

 Type (format or extension) — Indicates the nature / type of the content
of the file (e.g., .txt, .exe, .dir, etc.)

 Version — Revision number of the file

An extension name of a computer file is usually a three-character addition after the
file’s name. This extension assists IBM compatible computers, such as those running
Microsoft Windows, in identifying the program to relate the file with and correctly
open the file.

Given below are the characters that cannot be used in filenames or directory
names in most operating systems.

\, /, :, *, ?, “, <, > and |

Limitations of MS DOS

 It has a text based user interface where the commands have to be typed for
each operation that the user wants to perform. The user is expected to
remember the commands as well as their syntax.

 It is a single user, single task operating system and the working is limited to
one megabyte of memory. 640 kilobytes of the memory is used for the
application program.

 It does not allow using long file names. The user is restricted to eight-character
file names with three-character extensions.

3.3 WINDOWS

Windows 10 is a personal computer operating system. It was developed and
released by Microsoft as part of the Windows NT family of operating systems. It
was officially unveiled in September 2014 after a brief demo at Build 2014. The
first version of the operating system entered a public beta testing process in October.
Its consumer release took place on July 29, 2015.

Versions

Windows 10 is available in different versions on the basis of editions.

1. Home and Pro are the two baseline editions. Home edition is chiefly
designed for use in PC and tablets while Pro version includes additional
features that support business environment and power users.

2. These versions are organisational editions that add features to facilitate
centralized control of many installations of the OS within an organization.
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Enterprise, Education, Pro education, Enterprise LTSB and Mobile
Enterprise are the organisational editions.

The Windows user interface was revised to handle transitions between a mouse-
oriented interface and a touchscreen-optimized interface. It was based on available
input devices—particularly on 2-in-1 PCs. Both interfaces include an updated Start
menu which incorporates elements of Windows 7’s traditional Start menu with the
tiles of Windows 8. The first release of Windows 10 also introduces:

 A virtual desktop system

 A window and desktop management feature called Task View

 Microsoft Edge web browser

 Support for fingerprint and face recognition login

 New security features for enterprise environments

 DirectX 12 and WDDM 2.0 to improve the operating system’s graphics
capabilities for games.

Fig. 3.1 Action Center of Windows 10

Start, Shutdown, Restart and Desktop Icons

The Windows 10 Getting Start app offers a short guided tour to WindowC app.
Click the Start button and click the Get Started icon (shown here) from the Start
menu.
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The new Get Started app offers a short introduction to Windows 10. It also
includes a short introductory video.

Like most apps, the Get Started app lists icons along the left edge. If you
cannot see the icons’ labels then click the hamburger menu icon (shown in the
margin) in the app’s upper-left corner. Clicking that icon in any app expands the
app’s left pane, letting you see labels next to the mysterious icons.

Click the Power button at the bottom of the left column, and Windows will
at the very least display options to Shut down and Restart.

Desktop Icons

Your desktop icons may be hidden. To view them, right-click (or press and hold)
the desktop, select View and select Show desktop icons. To add icons to your
desktop such as This PC, Recycle Bin and more:

1. Select Start > Settings > Personalization > Themes > Desktop icon
settings.

2. Under Desktop Icons, check the boxes next to the icons you would like
to have appear on your desktop. 

3. Select Apply and OK.
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4. Note: You may not be able to see your desktop icons properly if you are in
tablet mode. You can find the program by searching for the program name
in File Explorer. To turn off tablet mode, select action center on the
taskbar (next to date and time), and then select Tablet mode to turn it on
or off.

Files and Folders: Finding, Renaming, Copying

Find your files in Windows 10 using one of these methods.

 Search from the taskbar. Type the name of a document (or a keyword
from it) into the search box on the taskbar, then select Find results in
documents at the top of the search results pane. You will see results for
documents across your PC and OneDrive.

 Search File Explorer. Open File Explorer from the taskbar or Start
menu, then select a location from the left pane to search or browse. For
example, select This PC to look in all devices and drives on your computer,
or select Documents to look only for files stored there.

 To add an icon for This PC to your desktop: Select Start > Settings >
Personalization > Themes > Desktop Icon Settings. In the pop-up
window, select the check box next to Computer > Apply > OK
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It is needless to say the importance of folder system. Folder Options is an important
aspect in Windows operating system. Folders are the building blocks of file
organization and storing. Most users are expected to know how to access Folders
and open the folder option, but incase you do not know, we are there for you. You
can do multiple things with folder, copy files from one folder to another, delete
items from a folder, hide a folder and show that hidden folder. We are discussing
some easy steps which you may find helpful.

Opening Folder Options in Windows 10

1. Open the File Explorer.

2. Tap on View and click on Options.

3. If you want to open folders in just a single click, then select the single click
option. By default opening folders with double click is enabled.
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4. Under View Tab, you can enable options by reading them. For e.g. you can
hide hidden folders or show them. Similarly you can disable thumbnail views
and many more. In case you want to go back to default settings, just
hit Restore Defaults.

 

5. The search folder will help you how you would like to search items from
your computer. Since search is an important and prominent feature in
Windows 10, so checking right options is very important. We recommend
to keep the default settings.
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Press Enter or click the desktop when you are through, and you are off. Or you
can click the filename or folder name to select it, wait a second, and click the
name again to change it.

Using shortcuts to rename files or folders

Some people click the name and press F2; Windows automatically lets
you rename the file or folder.

Renaming multiple folders

1. Start Windows Explorer. To do so, click Start, point to All Programs, point
to Accessories, and then click Windows Explorer.

2. Select multiple files in a folder. ...

3. After you select the files, press F2.

Type the new name, and then press ENTER.

Copying a file or folder

1. If you are using Windows 10, click or tap the Start button and choose
the File Explorer button from the left-hand side. It is the one that looks
like a folder.

Windows 8 users can search for This PC from the Start screen.

Tip: Both versions of Windows also support opening File Explorer or This
PC with the Windows Key + E keyboard shortcut.

2. Find the folder where that the file is located by double-clicking any folders
or subfolders necessary until you reach the file.

If your file is located on a different hard drive than your primary one, click
or tap This PC from the left-hand side of the open window and then choose
the correct hard drive. If you don’t see that option, open the View menu at
the top of the window, choose Navigation pane, and finally click or tap
the Navigation pane option in that new menu.

Note: If you’re given a permissions prompt that says you need to confirm
access to the folder, just continue through.

Tip: It’s likely that your file is located deep inside several folders. For
example, you might have to first open an external hard drive or disc, and
then two or more subfolders before you reach the file that you want to
copy.

3. Click or tap just once on the file that you want to copy. The file will become
highlighted.

Tip: To copy more than one file at once from that folder, hold down
the Ctrl key and select each additional file that should be copied.
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4. With the file(s) still highlighted, access the Home menu at the top of the
window and select the Copy option. Anything you just copied is now stored
in the clipboard, ready to be duplicated elsewhere.

5. Navigate to the folder where the file should be copied to. Once there, open
the folder so that you can see any files or folders that already exist inside (it
might even be empty).

Note: The destination folder can be anywhere; on a different internal or
external hard drive, DVD, in your Pictures folder or on your Desktop,
etc. You can even close out of the window where you copied the file, and
the file will remain in your clipboard until you copy something else.

6. From the Home menu at the top of the destination folder, click/tap the Paste
button.

Note: If you’re asked to confirm the paste because the folder requires
administrator permissions to paste files, go ahead and provide that. This
just means that the folder is considered important by Windows, and that
you should be careful when adding files there.

Tip: If you chose the same folder that has the original file, Windows will
either automatically make a copy but will append the word “copy” to the
end of the file name (just before the file extension) or ask you to either
replace/overwrite the files or skip copying them.

7. The file selected from Step 3 is now copied to the location you chose in
Step 5.

Remember that the original file is still located where it was when you copied
it; saving a new duplicate did not affect the original in any way

Directory Tree

It is a hierarchy of directories that consists of a single directory. It is called the
parent directory or top level directory, and all levels of its subdirectories.

Steps to export directory tree of a folder in Window 10

1. Navigate to the folder and select it.

2. Press Shift, right-click mouse, and select “Open command window here”.

3. In command prompt, type tree/f/a > tree.txt and press Enter. 

4. Open “tree.txt” file in MS Word.

5. The dialog box “File Conversion - tree.txt” will open.

6. For “Text encoding” tick the “MS-DOS” option and press Ok.
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Mounting a drive in Windows 10

Use the Windows key + X keyboard shortcut to open the Power User menu and
select Disk Management. Right-click the new empty drive you want to mount as
a folder and select New Simple Volume. Select the “Mount in the following empty
NTFS folder” option and click Browse.

Partitioning a hard drive

1. Search “hard disk partitions” at the Start Menu or Search tool. Enter into
the Windows 10 Disk Management interface.

2. Right-click hard disk and select “Shrink Volume”. Enter the amount of space
youwant to shrink in MB as shown below then click on the Shrink button.

Disk management

1. Right-click the bottom-left corner (or Start button) on the desktop to open
Quick Access Menu, and then choose Disk Management.

2. Use Windows+R to open Run, type diskmgmt.msc in the empty box and
tap OK.

3. Open Disk Managementin Computer Management.

Placing and Sizing of Windows 10

Right-click on the Taskbar and choose Cascade. This will put the window on the
screen. Stretch the window out to the desired size and close it. It should open that
size next time.

Using Shortcuts

Copy, paste, and other general keyboard shortcuts

Press this key To do this

Ctrl + X Cut the selected item
Ctrl + C (or Ctrl + Insert) Copy the selected item
Ctrl + V (or Shift + Insert) Paste the selected item
Ctrl + Z Undo an action
Alt + Tab Switch between open apps
Alt + F4 Close the active item, or exit the

active app
Windows logo key + L Lock your PC
Windows logo key + D Display and hide the desktop
F2 Rename the selected item
F3 Search for a file or folder in File

Explorer
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F4 Display the address bar list in
File Explorer

F5 Refresh the active window
F6 Cycle through screen elements

in a window or on the desktop
F10 Activate the Menu bar in the

active app
Alt + F8 Show your password on the

sign-in screen
Alt + Esc Cycle through items in the

order in which they were
opened

Alt + underlined letter Perform the command for that
letter

Alt + Enter Display properties for the
selected item

Alt + Spacebar Open the shortcut menu for the
active window

Alt + Left arrow Go back
Alt + Right arrow Go forward
Alt + Page Up Move up one screen
Alt + Page Down Move down one screen
Ctrl + F4 Close the active document (in

apps that are full-screen and let
you have multiple documents
open at the same time)

Ctrl + A Select all items in a document
or window

Ctrl + D (or Delete) Delete the selected item and
move it to the Recycle Bin

Ctrl + R (or F5) Refresh the active window
Ctrl + Y Redo an action
Ctrl + Right arrow Move the cursor to the

beginning of the next word
Ctrl + Left arrow Move the cursor to the

beginning of the previous word
Ctrl + Down arrow Move the cursor to the

beginning of the next paragraph
Ctrl + Up arrow Move the cursor to the

beginning of the previous
paragraph

Ctrl + Alt + Tab Use the arrow keys to switch
between all open apps

Alt + Shift + arrow keys When a group or tile is in focus
on the Start menu, move it in
the direction specified
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Start menu, move it into another
tile to create a folder

Ctrl + arrow keys Resize the Start menu when it’s
open

Ctrl + arrow key (to move to an item) + Spacebar Select multiple individual items
in a window or on the desktop

Ctrl + Shift with an arrow key Select a block of text
Ctrl + Esc Open Start
Ctrl + Shift + Esc Open Task Manager
Ctrl + Shift Switch the keyboard layout

when multiple keyboard layouts
are available

Ctrl + Spacebar Turn the Chinese input method
editor (IME) on or off

Shift + F10 Display the shortcut menu for
the selected item

Shift with any arrow key Select more than one item in a
window or on the desktop, or
select text in a document

Shift + Delete Delete the selected item without
moving it to the Recycle Bin
first

Right arrow Open the next menu to the right,
or open a submenu

Left arrow Open the next menu to the left,
or close a submenu

Esc Stop or leave the current task

Changing Date and Time on Windows 10

The two ways to change date and time on Windows 10 are:

Method 1: Change them in Control Panel.

Step 1: Click the bottom-right clock icon on the desktop, and tap Change date
and time settings in the pop-up small window.
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Step 2: As the Date and Time window opens, click Change date and time to
continue.

Tip: You can also follow the path of Control Panel/Clock, Language, and Region/
Date and Time to open the above-mentioned window.

Step 3: In the Date and Time Settings window, respectively change date and time,
and then tap OK to confirm the changes.
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Step 1: Access PC settings.

Step 2: Open Time and language.

 

Step 3: Click Change on the right to move on.
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Step 4: Modify date and time, and tap Change to bring the changes into effect.

 

Deleting Files and Folders, and Retrieving Deleted Files

To delete a file or folder, right-click its name or icon, then choose Delete from
the pop-up menu. This simple yet surprising trick works for files, folders, shortcuts,
and just about anything else in Windows. To delete in a hurry, click the offending
object and press the Delete key.

To delete a file or folder permanently, go to the Desktop on your Windows
10 OS. In the Properties, select the drive for which you want to delete the files
permanently. Now, under Settings for selected location, click the radio button
for Don’t move files to the Recycle Bin. Remove files immediately when deleted.

To provide Administrator permission to delete a folder

i. Right click the folder you are trying to delete.

ii. Click Properties.

iii. Select the ‘Previous Versions’ tab. ...

iv. Select an older version of the folder that you want to delete under the
‘Previous Versions’ tab.

v. Click ‘Restore’ button. ...

vi. Click ‘Yes’ to restore the folder when prompted.
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There are three ways to recover deleted files in Windows 10.

(i) Recovering deleted files in Windows 10 using Restoring previous
version

 Open My PC and then navigate to the folder where your deleted file was
placed.

 Right click on that folder and click on Restore to previous version.

Check out file now, hope this will bring your deleted file back. This method
sometimes does not work as might be your deleted files erased permanently. 

(ii) Recovering deleted files in Windows 10 using Backup option

 Open Control Panel and check for System and Security.

 Tap on Backup and Restore option.

 Choose Restore my files.

By completing this check  the missing file again. Hope now it is available at its
place. If still you are unable to locate your file then you need to go for Recovery
software.

(iii) Recover deleted files in Windows 10 using Recovery software

This is the easiest and quickest way to retrieve your deleted files from your
computer.

Recuva is the best software to recover all your deleted stuff. This is a free software
available among all by which you can easily recover all deleted files

Recovering permanently deleted files

To recover the permanently deleted files, follow these steps:

 Navigate to the folder or the location where the file was stored before being
deleted.

 Make a right click on the folder and select the option “Restore previous
versions”.

 You will get an option to recover the folder.

If you don’t see an option “Restore previous versions”, don’t panic, here’s
what you going to do –

 Navigate to Control Panel, or type Control Panel in Run Window (Windows
Key and R together).
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 Go to System >System Protection (on the left hand side of the panel)

 Turn on System Protection.

 You will see the options to Turn on protection on available drives.

 Select a drive and click on configure.

.
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click on “OK”.

 Now you will see the “Restore previous versions” on a particular folder.

Now repeat the aforementioned steps to Restore previous versions.

If you are lucky enough you will get your files. Do not lose hope as there is
still a way. You can also use third party software to do the job for you. One of the
best software for this task is Advanced Disk Recovery tool which will recover
your permanently deleted files in Windows 10 in a few clicks.

Emptying the Recycle Bin

1. Find the Recycle Bin icon on the desktop.

2. Right click (or press and hold) and select Empty Recycle Bin.
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Data Back Up

Creating a backup with Windows 10

i. Open Control Panel.

ii. Click on System and Security.

iii. Click on Backup and Restore (Windows 7).

iv. On the left pane, click the Create a system image link.

v. Under “Where do you want to save the backup?” ...

vi. Using the “On a hard disk” drop-down menu, select the storage to save the
backup.

vii. Click the Start backup button

Backing up your computer

There are several ways to back up your PC.

1. Select the Start button, then select Control Panel > System and
Maintenance > Backup and Restore.

2. Do one of the following:

 If you have never used Windows Backup before, or recently upgraded
your version of Windows, select Set up backup, and then follow the
steps in the wizard.

 If you have created a backup before, you can wait for your regularly
scheduled backup to occur, or you can manually create a new backup
by selecting Back up now.

 If you have created a backup before, but want to make a new, full
backup rather than updating the old one, select Create new, full
backup, and then follow the steps in the wizard.

Task Manager

The Task Manager is an advanced tool that comes with Windows 10. It provides
a number of tabs that allow you to monitor the applications, processes and services
running on your computer.
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If you want to use Task Manager to view and stop processes with high-resource
usage, you first need to know how to open the tool. Here are a few ways to open
Task Manager:

I. Right-click the Taskbar and click on Task Manager.

II. Open Start, do a search for Task Manager and click the result.

III. Use the Ctrl + Shift + Esc keyboard shortcut.

IV. Use the Ctrl + Alt + Del keyboard shortcut and click on Task Manager.

V. Use the Windows key + X keyboard shortcut to open the power-user
menu and click on Task Manager.

If this is your first time opening Task Manager, the tool will probably open in
compact mode, which only lists running applications. Click the More details button
to access Task Manager in advanced mode.
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Check Your Progress

1. What is MS DOS?

2. Why is DOS prompt required?

3. What are the two baseline editions of Windows 10?

4. What is a directory tree?

5. What are the steps to sizing the Window?

3.4 TYPES OF OS

All operating systems consist of similar components and perform almost similar
functions but the methods and procedures for performing these functions are
different. Operating systems are classified into following categories based on their
distinguishing features:

 Single user operating systems
 Multiuser operating systems
 Batch processing or job scheduling operating systems
 Multiprogramming operating systems
 Multitasking operating systems
 Parallel operating systems
 Distributed operating systems
 Real time operating systems

There system are explained in detail as follows:

Single User Operating Systems

It allows a single user to access a computer at a time. These computers have
single processor and execute single program. The resources, such as CPU and I/
O devices are constantly available to the user in a single user operating system for
operating the system. As a result, the CPU sits idle for most of the time and is not
utilized to its maximum. A single user operating system is divided into two categories:

 Single user, single tasking operating system.

 Single user, multitasking operating system.

The single user, single tasking operating system allows a single user to execute
one program at a time. MS DOS and Palm OS for Palm handheld computers are
examples of single user, single tasking operating system.

Single user, multitasking operating system allows a single user to operate
multiple programs at the same time. For example, you can perform calculations in
Excel sheet, print a Word document and download a file from the Internet
concurrently. Mac OS, Windows 95, Windows 98, Windows NT Workstation
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computers are the examples of single user, multitasking operating system. Figure
3.2 shows the working of a single user operating system.

A single user operating system executes an application program of a user
through hardware interaction and gives the result back to the user.

Fig. 3.2 Single User Operating System

Multiuser Operating Systems

It allows various users to access the different resources of a computer
simultaneously. The access is provided using a network that consists of various
personal computers attached to a mainframe computer. These computers send
and receive information to a multiuser mainframe computer. Therefore, the mainframe
computer acts as a server and the other personal computers act as clients for that
server. UNIX, Virtual Memory System or VMS, Multiple Virtual Storage or MVS,
Windows 2000 and Novell NetWare are the examples of multiuser operating
systems.

The advantage of using multiuser operating system is that it facilitates the
sharing of data and information among different users. Hardware resources, such
as printers and modems are also shared using the multiuser operating system.

The limitation of using a multiuser operating system is the expensive hardware
required for mainframe computer. Another limitation is that it reduces the
performance of the computer as multiple users work on it. Figure 3.3 shows the
working of a multiuser operating system.

Fig. 3.3 Multiuser Operating System
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Batch Processing or Job Scheduling Operating Systems

The batch processing operating system places the users jobs on an input queue
and these jobs are stored as a batch. The batch monitor executes these batches at
a definite interval of time. The batch monitor accepts the commands for initializing,
processing and terminating a batch. These jobs are executed through interaction
with the hardware and the operating system gives the output back to different
users. The batch processing operating system automatically executes the next job
in the batch and reduces user intervention during the processing of jobs.

It has high turn around time. The turn around time is the time taken between
submitting the job and getting the output which includes the information related to
the jobs included in a batch. The turn around time is reduced using high speed
storage access devices, such as magnetic disk.

The batch monitor executes the batches based on the process of job
scheduling that sequences different jobs on First-Come-First-Served (FCFS) basis.
You can also set the priorities for different batches and the highest priority job is
executed before the other batches. Figure 3.4 shows the working of a batch
processing operating system.

Fig. 3.4 The Batch Processing Operating System

Multiprogramming

Multiprogramming allows multiple users to execute multiple programs using a single
CPU. The multiprogramming operating system executes different processes
concurrently using a time multiplexed CPU by implementing the concept of CPU
slicing between them. CPU time slicing enables operating systems to execute
multiple jobs concurrently. The CPU switching between the programs is so fast
that the response time for users is fractions of seconds. The operating system uses
an interactive computer system that provides shared access to different resources.
The operating system stores multiple jobs in main memory and CPU immediately
switches to the next job in sequence, when the previous executing process comes
in wait stage. The previous executing process comes in wait stage due to an interrupt
or requirement of I/O operations. Therefore, a multiprogramming operating system
increases the utilization of CPU by reducing its idle time. UNIX, Windows 95,
Windows NT, OS/2 and Amiga are examples of multiprogramming operating
systems. Figure 3.5 shows the working of a multiprogramming operating system.
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Fig. 3.5 Multiprogramming Operating System

Multitasking Operating Systems

Multitasking operating systems support the concept of multitasking. Multitasking
is the ability of a system to handle a number of tasks or jobs simultaneously. A
multitasking operating system is also called time sharing system with the
multiprogramming feature. A time sharing system contains multiple user terminals
that are connected to the same system to work simultaneously. The
multiprogramming feature of the time sharing system allows multiple programs to
reside in main memory and various scheduling algorithms are used to allocate
CPU time to the processes. The time interval during which a user process gets the
CPU allocation is known as time slice, time slot or quantum. The CPU executes a
process until the allotted time slice expires. Figure 3.6 shows the working of a time
sharing system.

Fig. 3.6 Time Sharing System

Parallel Operating Systems

Parallel Operating System is used to interface multiple networked computers to
complete tasks in parallel. A parallel operating system performs by dividing sets of
calculations into smaller parts and then distributing them on a network between
the machines.
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It consists of multiple processors sharing the clock, bus, memory and
peripheral devices. Parallel operating systems are also known as multiprocessor
or tightly coupled operating systems. Multiprocessor systems are divided into
following categories:

 Symmetric multiprocessing

 Asymmetric multiprocessing

In symmetric multiprocessing, each processor runs a shared copy of
operating system. The processors can communicate with each other and execute
these copies concurrently. Thus, in a symmetric system all the processors share an
equal amount of load. Encore’s version of UNIX for the Multimax computer is an
example of symmetric multiprocessing system. In this system, various processors
execute copies of UNIX operating system, thereby executing m processes if there
are m processors.

In short, the term symmetric multiprocessing depicts the architecture of a
multiprocessor system where two or more similar processors are connected via a
high bandwidth link or simply a bus. These types of systems are run by one operating
system and each processor of the multiprocessor system has equal access right to
all the I/O devices connected to the system.

Asymmetric multiprocessing is based on the principle of master–slave
relationship. One of the processors runs the operating system and that processor
is called the master processor. The other processors run user processes and are
known as slave processors. In other words, the master processor controls,
schedules and allocates the task to the slave processors. Asymmetric
multiprocessing is more common in extremely large systems, where one of the
most time consuming activities is processing I/O requests. In asymmetric system,
the processors do not share equal load. For example, the processor, which supports
the math coprocessor to handle floating point calculations is based on asymmetric
multiprocessing system.

Distributed Operating Systems

In this type of operating system, user requests are processed independently at
more than one location, but with shared and controlled access to some common
facilities. A system, which consists of multiple parts located at or embedded in
geographically dispersed physical locations is called a distributed system. In other
words, in a distributed system the workload is spread between two or more
computers linked together by a communication network.

Different computers communicate with each other using communication links,
such as telephone lines and buses. Heterogeneous computers include computers
with different configurations, such as workstations, microcomputers, minicomputers
and mainframe computers. These computers are referred to as nodes. The
processors in distributed operating system do not share clock, memory and
peripheral devices. Each processor has its own resources. Distributed operating
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distributed operating system, which is a collection of workstations in a transparent
distributed system. Amoeba is being widely used in the field of academics, industry
and government for the last five years. It runs on the Scalable Processor
ARChitecture or SPARC, Sun 3/50 and Sun 3/60 operating systems.

The design of distributed operating systems is based on following two models:

 Client–Server model

 Peer-to-Peer model

In client–server model, the client sends a resource request to the server and
the server, in turn, provides the requested resource as the response, back to the
client. Figure 3.7 shows the client–server model.

Fig. 3.7 The Client–Server Model

In peer-to-peer model, all the computers behave as peers as well as clients.
These clients communicate with each other for exchange of their resources. Figure
3.8 shows the peer-to-peer model.

Fig. 3.8 The Peer-to-Peer Model

Real time operating system is an operating system intended to serve real time
application requests.

The human brain works on the principle of real time operating system. Real time
operating systems are used in medical imaging systems, airline reservation systems,
home appliances controller systems and nuclear weapon systems. Examples of
real time operating systems are Vx Works and QNX. Real time operating systems
are divided into two categories:

 Hard real time systems

 Soft real time systems
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Hard real time systems ensure the completion of critical tasks within the
well defined constraints. These systems are considered a failure, if the critical
tasks are not completed within the defined constraints.

An example of a hard real time system is a flight controller system. If the
end user fails to respond to an action within the allotted time, it could lead to an
unstable aircraft, which could cause a crash.

In soft real time systems, a single failure of any type does not lead to critical
failure. For example, if a Digital Versatile/Video Disc or DVD player cannot process
a frame that is the playback stutters, but you can continue watching the video.

Timesharing

A multiprogrammed batch system does not permit real time interaction between
users and computer as the user commands needed for executing jobs are prepared
as scripts of Job Control Language (JCL) and submitted to the batch system. As
users are not permitted to submit the job script input and observe or take output
directly, takes many days to debug and correct the mistakes in program
development. The solution to the above problem was the introduction of ‘Interactive
Time Shared Multiprogramming’ techniques. This enabled many users to interact
with the computer system simultaneously, each one using a separate terminal
keyboard and monitor connected to the system. Actually, each user is given a
small time quantum (say, 100 milliseconds) to apply commands and receive
responses from the computer system in a round robin fashion. If there are 10
users, each will be served 100 milliseconds in every one second. Because of this
fast switching of execution among users, each one feels that the entire computer
system time is available for his/her own use. This drastically improved the ease of
use of computers and reduced the job processing time and program development
time. With this interactive time sharing technology, a single computer system is
made available to many people, simultaneously for doing many different types of
tasks.

The hardware of computer system is normally very costly. In a multiuser
system, as many users are sharing this costly hardware and the cost is shared
among many users, and the resource utilization is also high. However, as the
operating system has to switch between many users in a short time, there are
some unproductive computations called overheads computations done for job
switching and associated work.

Check Your Progress

6. What is multitasking?

7. What are the two categories of real time OS?
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3.5 ANSWERS TO CHECK YOUR PROGRESS

QUESTIONS

1. Microsoft Disk Operating System (MS DOS) is a single user, single tasking
operating system. DOS has a command line, text-based/non-graphical user
interface commonly referred to as Character-based User Interface (CUI).
When the computer is switched on, a small program checks all internal
devices, electronic memory and peripherals. Once this process is completed,
MS DOS is loaded.

2. The DOS prompt known as the command prompt looks like C:\> or D:\>
where ‘C’,‘D’ represent the hard drives of the computer system. We need
DOS prompt because all commands are typed at the DOS prompt. Enter
key is pressed to view the output of the typed command. If the command is
correctly typed, desired output would be displayed. Otherwise an error
message (Bad command or filename/Invalid parameter) is displayed on the
screen.

3. Home and Pro are the two baseline editions of Windows 10.

4. A directory tree is a hierarchy of directories that consists of a single directory,
called the parent directory or top level directory, and all levels of its
subdirectories.

5.  Right-click on the Taskbar and choose Cascade. That should put the
window on the screen. Stretch the window out to the desired size and close
it. It should open that size next time.

6. Multitasking is the ability of a system to handle a number of tasks or jobs
simultaneously.

7. Real time operating systems are divided into two categories:

(i) Hard real time systems

(ii) Soft real time systems

3.6 SUMMARY

 Microsoft Disk Operating System (MS DOS) is a single-user operating
system built by Microsoft. It was the most commonly used operating system
for PC in the 1980s and Microsoft’s first commercialized operating system.

 Windows 10 is a personal computer operating system developed and
released by Microsoft as part of the Windows NT family of operating
systems.

 Home and Pro are the two baseline editions. Home edition is designed for
use in PC and tablets while Pro version includes additional features that
supports business environment and power users.
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 The Windows 10 Getting Start app offers a short guided tour to Windows
10. To open the app, click the Start button and click the Get Started icon
from the Start menu.

 A directory tree is a hierarchy of directories that consists of a single directory,
called the parent directory or top level directory, and all levels of its
subdirectories.

 Single user operating systems allows a single user to access a computer at
a time. These computers have single processor and execute single program.

 Multiuser operating systems allows various users to access the different
resources of a computer simultaneously. The access is provided using a
network that consists of various personal computers attached to a mainframe
computer.

 The batch processing operating system places the users jobs on an input
queue and these jobs are stored as a batch. The batch monitor executes
these batches at a definite interval of time.

 Multiprogramming allows multiple users to execute multiple programs using
a single CPU.

 Multitasking operating systems support the concept of multitasking.
Multitasking is the ability of a system to handle a number of tasks or jobs
simultaneously. A multitasking operating system is also called time sharing
system with the multiprogramming feature.

 Parallel operating system is used to interface multiple networked computers
to complete tasks in parallel.

 In distributed operating systems user requests are processed independently
at more than one location, but with shared and controlled access to some
common facilities.

3.7 KEY WORDS

 MS DOS: Microsoft Disk Operating System is a single user, single tasking
operating system. It has a command line, text-based/non-graphical user
interface commonly referred to as Character-based User Interface (CUI).

 Action Center: It notifies the user(s) whenever items have to be modified.
It also helps keep Windows running smoothly.

 Start Menu: It is a user interface element used in Microsoft Windows
operating systems. It provides a central launching point for application and
tasks. Depending on the operating system or window manager, the menu
might have different names.
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3.8 SELF ASSESSMENT QUESTIONS AND

EXERCISES

Short-Answer Questions

1. What is DOS prompt?

2. What are the limitations of MS DOS?

3. What are the various editions available with Windows 10?

4. Write the steps for renaming files and folders.

Long-Answer Questions

1. Explain some of the internal and external commands of MS DOS.

2. Write the procedure to partition a hard drive.

3. What are the various ways to change date and time in Windows 10?

4. What are the ways to retrieve deleted files and folders?

5. How do you create back up data with Windows 10?

6. Explain the various types of operating system.
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4.0 INTRODUCTION

In this unit, you will learn about the MS Word, Excel, PowerPoint and Access.
Microsoft Word (MS Word or Word) is a program which is used for creating
documents. It is used by the organization or standalone user to create documents,
reports and notes. Word provides the facilities of creating reports and pictures
and thus, manifests your idea on the paper.

Microsoft Excel (MS Excel or Excel) is the program that is used for creating
the Excel sheets or worksheets. It is used by businessmen and individuals for
storing data and its interpretation. It is a part of MS Office, which provides the
facilities of storing data in the form of table that contains rows and columns. This
program helps in doing the tasks at a faster speed as all the calculations are
performed using formulas and functions.

Microsoft PowerPoint (MS PowerPoint or PowerPoint) is a program which
is used for creating presentations. It is used by the working professionals, students
and politicians for creating attractive presentations. It consists of information in the
form of text and various visual aids such as graphics, pictures and video, which
keeps the audience interested.

Microsoft Access, also known as Microsoft Office Access, is a database
management system from Microsoft that combines the relational Microsoft Jet
Database Engine with a graphical user interface and software development tools.
It is a member of the Microsoft Office suite of applications, included in the
Professional and higher editions or sold separately.
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You will also learn about the adobe Photoshop. Photoshop has evolved
from old artistic and technical traditions. Earlier, traditional techniques were used
to rework images, but now, technology has changed everything and various new
compatible software are used to apply these old techniques. Photoshop is a software
that plays with colors and images to form a final workable product. It is used to
give an aesthetically appealing visual look to almost every document that is created
in the digital world today.

4.1 OBJECTIVES

After going through this unit, you will be able to:

 Discuss the significant features of MS Word 2010

 Format word documents using bullets, numbering and styles with the help
of illustrations

 Enhance the documents using table, border, page setup, header and footer

 Discuss the important features of MS Excel 2010

 Understand the working with cells

 Discuss important features of Microsoft PowerPoint 2010

 Create and edit slides of a presentation

4.2 MS WORD

Microsoft Word is used for the creation of documents. It is the most commonly
used format for storing information and sending it through e-mails. There are several
interactive features in MS Word 2010 that help in making the documents productive
and innovative. Here, we will explore some features such as the management of
various files in the word documents, management of the information in a secured
way and various shortcuts and tips to access different commands.

File Management

File management provides the facility to organize the files by saving them in the
computer and drives such as disk drive, USB drive, etc. The saved file can then
be searched and opened later on. Also, the files can be moved from one location
to another as the need be. To better understand the features and functions included
in file management, it is essential for you to know about the File menu of MS
Word 2010.

To make you comfortable with the various aspects of file management, a
detailed description of the File menu is given below:

File Menu

In the previous version of Microsoft Office there was no File Menu. Instead,
there was an Office Button. This is shown in the following screenshot.
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The Office Button has been replaced by the File Menu in Microsoft Office
2010. Whenever File Menu is clicked, a backstage view of Microsoft Office is
visible. In MS Office 2010 File Menu, allows users to easily access frequently
used commands.

A screenshot displaying File Menu is shown below:

When you click on the File menu, various options related to the file are
displayed.

A screenshot displaying the options is shown below:
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Creating a new document

To create a new document in MS Word. Follow the following steps.

1. Go to the file menu in the ribbon interface.

2. Click on New option, you will see the new blank document template.

Inside File tab you will find six main sections and six buttons.

 The six sections present inside File are as follows:

 Info: Info section gives important information related to file, by specifying
its properties. It enables youto protect documents, check for issues and
manage versions.

 Recent: The Recent section is by default selected is. This section
shows all the Recent Documents and Recent Places. Recent
Documents are the word documents which can be opened just by
clicking. Recent Places are the places where these recent documents
are being saved. If a user wants to quickly access recent documents, he
should check the option Quickly access this number of Recent
Documents by selecting the number from a drop down box. All
documents will appear on the left hand side. You can recover documents
which have not been saved by clicking Recover Unsaved Documents
button.

 New: New section helps you to create new documents. By default, the
Blank Document is the template selected, however the user can choose
any template,.

 Print: Print section enables you to print the files with the available settings
and a preview of the Print section is shown on the right hand side of the
window.

 Save & Send: There are different options present inside Save & Send
option. Send Using E-mail allows user to send the file with the help of
email. In Save to Web option you need to login with the help of Windows
Live ID. After that, you click on Save As option to save the file at the
location which you want. The Save to SharePoint option is similar to
Save to Web option. In Publish as Blog Post option, user can create
blog post by incorporating the present document. This helps to publish
blogging contents online. In Change File Type option, the user can
change the extension of the file type. In Create PDF/XPS Document
option user can convert word document to PDF or XPS format.

 Help: In case of any need, the user can click on Help button. The Help
button also lets you know about updates related to the Office.

The six buttons which are present inside File are as follows:

 Save: Save button helps in saving the document which you are, currently
working upon. Suppose, you are saving the document for the first time
then it will ask you the location where you want to save it..
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 Save As: Save As button is used when you want to rename the document
and save it in another location.

 Open: Open button is used when you want to open a document which
has already been saved.

 Close: Close button is used when you want to close the documents
which you are currently working upon.

 Options: Options button is used when the user wants to apply various
Word options related to the file.

 Exit: Exit button is used to exit documents. Before you exit, you are
asked whether you want to save the document or not.

Saving a document

In MS Word 2010, files are saved in the default format, which is .docx. This is
because .docx format is more secured and damages can be easily recovered.
Some other formats of saving the files in Microsoft Word are .docm, .dotx and
.dotm, which are explained as follows:

.docm file format is used when the document is to be saved in macro-
enabled documents.

.dotx file format is used when the document is to be saved in document
template.

.dotm file format is used when the document is to be saved in macro-
enabled template.

There are many ways of saving the files but these are optimized for the
specific uses.

Steps to save the documents are as follows:

1. Click the File tab which is present on the left hand side of the ribbon.

2. Click the Save As option.

3. Select the drive and folder where you want to save the file.

4. Go to the File name textbox to write the name of the file.

5. Select the format in which you want to save the File. By default, the file
format in which the file is saved is .docx.

6. Click on Save button to save the file.
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This can also be done by clicking the Save icon present on the Quick
Access Toolbar. The keyboard shortcut for saving a word document is Ctrl+S.

Saving a document in PDF or XPS format

There are two methods for saving a document in PDF or XPS format, both are
given below:

1. One method of saving the file in Pdf or Xps format is with the help of Save
As button.

2. Another method of saving the file in Pdf or Xps format is with the help of
Save & Send section.

Here are the steps for saving a document in PDF or XPS format using Save As
option:

1. Go to the File tab which is present in the ribbon.

2. Inside File tab, click on the button Save As. The Save As dialog box
appears.

3. Choose PDF extension from Save as type which will save the word file in
PDF format. In order to save the file as an XPS Document, choose XPS
Document extension.

To save a document in PDF or XPS format using Save & Send option, follow the
following steps:

1. Go to the File tab which is present in the ribbon.

2. Inside File tab click on the section Send & Save.

3. Click on the button Create PDF/XPS Document.
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The screenshot after clicking on Create PDF/XPS Document is given
below:

 

4. Click on Create PDF/XPS button, present on the right hand side of the
dialog box. After clicking on Create PDF/XPS button, the Publish as
PDF or XPS dialog box appears.

5. After that Click on Publish button to publish the document in PDF format.
If the user wants to publish the document in XPS format then user should
choose XPS Document from the Save as type drop box.

Moving file into a specific folder

Steps to move the file into a specific folder are as follows:

1. Clickthe file which you want to move.

2. Hold the left click of the mouse on the file and drag that file to the specific
folder.

Opening the document

Steps to open documents are as follows:

1. Click the File tab which is present on the left hand side of the ribbon.

2. Click the option Open.

3. Select the location of the file, that is, the appropriate drive and folder from
where you want to open the file.

4. Select the file which you want to open.

5. Click on Open button to open the file.
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Deleting Text

You can delete or remove the text from the document that is no longer required.
To do so follow the given steps.

 For deleting text to the Left of the insertion point, press the Backspace Key
on the keyboard.

 For deleting text to the Right of the insertion point, press the Delete Key on
the keyboard.

 For deleting a Range of Text, first select the text that you want to delete or
remove and then press the Delete Key on the keyboard.

Copying and Moving Text

You can copy and paste the same text that exists in your opened document to
other regions or locations of the same document. Moreover, you can copy and
paste the text to another document also. This saves your time. MS Word also
allows you to move the selected text from one region of the document to another
region as per your requirement. To do this just cut and paste or drag and drop the
selected text to the desired location or region.

Copying and Pasting Text

By copying a text you can create duplicate or replica of the selected text. To do
this follow the steps given below.

1. Select the text that is to be copied.

2. On the Home Tab, click on the Copy command or simultaneously press the
CTRL + Ckeys on the keyboard. Alternatively, you can right-click on the
selected text and then select Copy.

3. Position the insertion point in the text where the text has to be copied.

4. On the Home Tab, click on the Paste command or simultaneously press the
CTRL + V keys on the keyboard.

5. The copied and pasted text will appear at the position specified by you.

Cut and Paste Text

1. Select the range of text that you have to cut and move to the new specified
position. On the Home Tab, click on the Cut command or simultaneously
press the CTRL + X keys on the keyboard. Alternatively, you can right-
click on the selected text and then select Cut command.

2. Position the insertion point in the document where the text has to be moved.
On the Home Tab, click on the Paste command or simultaneously press the
CTRL + V keys on the keyboard. The text will be moved to the specified
location in the document.
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Find and Replace

In the document let us use the Find and Replace command for changing the word
‘Word’ to ‘MS Word’. To do so, follow the steps given below.

1. On the Home Tab, click on the Replace command.

2. When you click on the Replace command, then the Find and Replace dialog
box will appear.

3. In the Find what: field, type the text (in our case ‘Word’) that you want to
find in the document.

4. In the Replace with: field, type the text (in our case ‘MS Word’) with which
you want to replace. Now click on Find Next. Now press ‘Replace’ to
change the word.

5. MS Word will quickly find the first instance of the text ‘Word’ and highlight
it in gray color.

6. Now check your document to Review the text and confirm that the word
you wanted to replace is done successfully. If there are more than one word
to be replaced in the document then select the command ‘Replace All’. All
the words in the document will be replaced and an update will be displayed
on the screen that how many words are changed and replaced.

Printing a new document

After creating the document in MS Word 2010, you can save, share and print
your document to view it offline. MS Word provides various options for printing
the document. You can preview your document before printing using the Print
pane so that you can make necessary modifications.

The MS Word provides the very significant feature ‘Custom Printing’ which
helps you in printing only the part text or selected text of the document when you
do not want to print the whole or entire document, because by printing unnecessary
pages you will be wasting the printing paper. Using the Custom Printing option
you can print either several or numerous individual or separate pages or a specified
range of pages. Word permits you to specify or identify and select the exact pages
from the document for printing.

Printing Document using Custom Print

To print a specific range of pages and individual pages you have to enter the individual
page numbers and the range of page numbers. Remember that each entry has to be
separated with a comma, for example 2, 5, 8, 15, 20-25, 41-54, and so on.

1. Click on the File Tab to open the Backstage view. Click on the option
Print.

2. The Print pane dialog box will appear. Click on the arrow that appears
next to the field ‘Print All Pages’ in the ‘Settings’ option. A menu will
be displayed, select the option ‘Custom Print’.
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3. To do Custom Printing, in the field ‘Pages:’ enter the page numbers
(individual page numbers or range of page numbers) that has to be printed.

4. Click on ‘Print’ to print the preferred pages.

Print Preview

The ‘Print Preview’ feature of MS Word helps you to view on the screen how the
printed version of the document would look like before printing a hard copy. In
latest versions of the MS Word (MS Word 2010 Onwards), there is ‘NO’ Print
Preview Tab or Option. As an alternative, click on the File Tab then on the option
Print from the menu that appears on the left side. The Print pane will be
displayed. In the Print pane, click on the ‘Page Setup’ option to open Page
setup dialog box. In the Page setup dialog box define the Margins, Paper
Size and Layout options for setting the document text so that the text remains
within the printable area.

The Ribbon Interface

Ribbon View is a substitute that provides the facilities of accessing the commands
for applications. It is organized using a horizontal bar. It provides an easy way to
access the commands, as all the commands are organized using tabs and groups.
With the help of Ribbon, performing various actions to the Office application is
easy. Ribbon is dynamic in nature, which implies that behavior changes as the size
of Microsoft Office changes.

‘Ribbon’ is a set of toolbars which displays the commands and tools for
performing various tasks. In Microsoft Office 2003, user worked with the classic
drop down menu and toolbar and users were able to work with them easily and
quickly. With the release of Microsoft Office 2007, the new term ‘Ribbon’ was
proposed that refers its own implementation of tabbed toolbars bearing
heterogeneous controls, known as ‘The Fluent User Interface’, which swapped
the menus and toolbars with a single ‘Office Menu’. MS Word, PowerPoint,
Access and Excel implemented ‘Ribbon’ in MS office 2007.

With the release of MS Office 2010, however, ‘ribbon’ was implemented in
the rest of the MS Office applications and added end user customization support
for its end user. MS Office 2010 ribbon is great, flexible and easy to use.

Screenshot for Ribbon is as shown:
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If you click on any tab or groups, each button and each dropdown menu
will perform different actions

For example: When one clicks on the Home tab or any other tab, various
options are displayed. With the help of these options, one can change the
Formatting, Orientation, Layout, Caption, and Proofing of the MS Office
Application.

As an example in MS Word 2010, the labeling of the commands and menus
is as shown in the screenshot:

 

 Tab: It shows different types of commands for creating MS Offices
applications. You can see the commands by clicking on the particular tab.

 Quick Access Toolbar: It is a way to provide quick access view to the
most frequently used commands. By default, Save, Undo and Redo buttons
are visible on the Quick Access Toolbar.

 Contextual Tabs: It displays the Commands for a particular selected
object. When the user draws any shape, a Contextual tab called Drawing
Tools appears.

 Minimize Ribbon: You can minimize the ribbon in the following ways:

o By clicking on minimize ribbon button.

o By double clicking the tab on the ribbon.

o By right clicking the tab from the contextual menu and selecting
minimize ribbon button.

o By pressing Ctrl+F1 button.

 Help: For getting any help, you can click on Help button or by clicking on
the File tab and selecting Help from the menu.

 Dialog Box launcher: You can see the Dialog box launcher or the Task
pane by clicking on the Clipboard Task Pane.

 Group: Set of all correlated commands which appear in each tab.

 Gallery: Gallery contains the option list and additional choices are displayed
as thumbnail preview.

Formatting Paragraph and Text in MS Word

Formatting word document is necessary in order to create an effective document.
In case of formatting, you format a text, letters, words, pictures, paragraphs, and
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so on. It can be applied to any portions of word documents. There are four types
in which formatting are classified, which are character, document, section and
paragraph. There are various tools which let you format the word documents. You
can apply font and paragraph formatting; create bullet and numbering to show the
information in point. You can also apply various styles to enhance the text. In this
section, you will learn to format a word document by applying different formatting
effects.

Paragraph and Font Formatting

Font and paragraph formatting is one of the most important styles of formatting. If
you do not apply any style, then font and paragraph formatting are applied by
default. It is applied to keep the documents simple and appealing.

Paragraph Formatting

Paragraph formatting is used to change the appearance of paragraph. It is present
in the Home tab of ribbon view. You can apply the Paragraph Formatting by
selecting the paragraph. It contains various controls for providing a quick access
to many frequently used functions. All options of paragraph formatting are found in
the paragraph group.

The screenshot of Paragraph Formatting is as shown:

The available buttons and icons of the Paragraph Formatting toolbar are
shown:

 Bullets button of the formatting toolbar helps in creating and

removing the bullets of the selected paragraph.

 Numbering button of the formatting toolbar helps in creating and

removing the numbers of the selected paragraph.

  Multilevel list button of the formatting toolbar provides you the

facility of adding numbered lists of items, using multiple levels.

  Decrease Indent button decreases the indentation level of the

paragraph.

 Increase Indent button increases the indentation level of the

paragraph.
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  Sort button helps in sorting the text, number and date to either

ascending or descending order.

  Show/Hide shows or hides the formatting symbols of various

sections of adocument. Arrow symbol denotes tab and dot denotes
space. It is set from left to right direction.

  Align Text Left button of the formatting toolbar helps in alignment

of text, number, paragraph and object to left.

 Align Center button of the formatting toolbar helps in alignment of

text, number, paragraph and object to center.

  Align Text Right button of the formatting toolbar helps in alignment

of text, number, paragraph and object to right.

  Align Justify button of the formatting toolbar helps in alignment of

text, number, paragraph and object to both left and right margins.

  Line and Paragraph spacing of the dropdown menu helps in

changing the amount of space between the paragraphs when selected.
You can choose any space by clicking on the dropdown menu.

 Shading dropdown box helps you to add colored background to
the area of text which is selected.

 Bottom Border dropdown box helps in selecting the borders

from optionsin the dropdown menu. By default, “Bottom Border” is
selected. You can change border to Top Border, Left Border, Right
Border etc. You can add and remove the border around any texts,
pictures or paragraphs.

Spelling and Grammar Checking

MS Word provides significant feature ‘Proofing’ for checking the text in the
document by using the option ‘Spelling & Grammar’. If you have made mistakes
in the document while typing the text then you can use the numerous proofing
features provides by MS Word to produce error-free and professional documents.
You can check the spellings in the document and after making necessary correction
you can change the corrected spelling in the whole document.

Running a Spelling and Grammar Check

1. To start the proofing of the document text, on the Review Tab go to the
Proofing group option and then select the command Spelling & Grammar.
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2. The Spelling pane will be displayed on the right side of the screen. MS
Word will provide one or more suggestions for every error in the
document text. Select the correct suggestion to modify the error if you
want and then click on ‘Change’ to change this specific error or click
on ‘Change All’ to modify the similar error in the whole document. If
you do not want to modify or change the error then click on ‘Ignore’
for ignoring this error or click on ‘Ignore All’ for ignoring the similar
errors in the whole document. Generally, the error is highlighted by a
red line in the document text.

3. MS Word will go through each error in the document till you review all the
errors in the current document. When you review the last error in the
document then the dialog box will be displayed on the screen to confirm
that the checking of spelling and grammar is now completed. Click on OK.

4. You can also manually modify or correct the spelling errors in the document
when no suggestions are provided by MS Word.

Ignoring Errors

Do not entirely depend upon the Spelling and Grammar check as it may not be
correct always. Essentially while checking errors in grammar, it is possible that MS
Word may not notice various grammatical errors. It is also possible that at times the
Spelling and Grammar check option may mark any spelling as incorrect while actually
it is correct, for example name of people or place which is not included in the MS
Word predefined dictionary. Use the following options for checking a spelling or
grammatical error.

Checking ‘Spelling Errors’

 Ignore: When you click on ‘Ignore’ option then the MS Word will skip
checking the marked word, i.e., it will not be changed.

 Ignore All: When you click on ‘Ignore All’ option then the MS Word will
not only skip checking the marked word, i.e., it will not be changed, but it
will also skip checking all other occurrences or instances of the similar
word in the current MS Word document.

 Add: When you click on ‘Add’ option then MS Word will add the marked
word to the existing predefined dictionary so that it will not be marked
as error again. Before clicking on the Add option check the spelling of
the word to ensure that the marked word is spelled accurately.
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Checking ‘Grammar Errors’

MS Word provides detailed explanation for each marked ‘Grammar Error’ that
why it is incorrect. It also displays some related example sentences or phrases to
explain the concept, as shown in the given Illustration. These examples will help you
in determining whether to change the marked sentence or phrase by clicking on the
Change option or to ignore it by clicking on the Ignore option.

Change: When you click on the Change option then MS Word will modify or change
the marked sentence or phrase in the document with the suggestion that you have
selected.

Ignore: When you click on the Ignore option then MS Word will skip checking the
word or phrase in the document without making any change or modification to it.

Automatic Spelling and Grammar Checking

By default, MS Word will automatically check the Spelling and Grammar errors in
the document. Hence, there is no need to perform a separate checking in the document
for spelling and grammar. MS Word indicates these errors by distinct colored and
wavy lines.

 If the word is marked with the red wavy line then it indicates that it is a
misspelled word, i.e., the spelling of the marked word is incorrect.

 If the word or sentence is marked with the blue wavy line then it indicates
that it is a grammatical error, i.e., either the usage of word is grammatically
incorrect or the sentence includes misused words.

The misused word is also termed as a ‘contextual spelling error’. This term is
used when the spelling of the marked word is correct but it is used incorrectly. For
example, while writing a letter if you start with the phrase ‘Deer Mr./Ms. XYZ’
then the word ‘Deer’ will be a misused word or a contextual spelling error. The
spelling of the word Deer is correct but in the letter it is used at incorrect place. The
correct word to be used is ‘Dear’.

Correcting the Spelling Errors

To correct the Spelling Errors, follow the steps given below.

1. Place the insertion point at the word marked as error by MS Word. Now
right-click the marked underlined word. The menu with spelling suggestions
will appear.

2. Select the spelling that is correct for your document from the list of suggested
spellings as shown below in the Illustration.

3. MS Word will change the marked word with the corrected spelling in the
document.
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Word Count

Total number of words in a Word document is displayed on the status bar at the
bottom of the Word window. If it is not displaying then right-click the status bar
and then click Word Count.

 

Table of Contents (TOC)

Table of Contents gives a quick reference point or an abstract overview to the
reader where the reader can find data or content.

Inserting Table of Contents:

TOC is inserted in the document at the position, where the cursor is placed and it
is not inserted from the starting place of the document.

Steps to insert table of content are as follows:

1. Create a blank document.

2. Click on References tab from the Ribbon view.

3. Click on the Table of Content option under Table of Content group.
A dialog box opens which shows different type of Table of Content
options.

Table of Content Fields: This is another method of adding fields in Table
of Content.

Steps to add entries in Table of Content are as follows:

1. Click on the Insert tab.

2. Click on the Quick Parts which comes under Text group and select
the option Field.

3. Then, a Field dialog box opens.

4. Select the option TC.Then type some text in Text Entry text box and
click OK button.

5. For displaying the entries, click on the Table of Content option in the
Reference tab. Then, click on the option Insert Table of Contents.

6. Then, a Table of Content dialog box opens.

7. Click on the Options in this dialog box, then, a Table of Content
Options dialog box opens.

8. Uncheck the Styles and check the Table entry fields options and then
click OKbutton.
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Updating the Table of Contents: If you want to change the some content
in the document then you can update it by using following steps:

1. Click on the Reference tab. Select Table of Contents under it and
choose any one style for creating TOC. An example of Table of
Contents is as shown:

Contents

9. Updating The Table Of Contents
7

12. Adding Entries To A Table Of Contents
7

14. Removing Entries From A Table Of Contents
8

2. Then click on Update Table, a dialog box Update Table of Contents
will be opened click on the OK button of that dialog box.

3. Update the content of table according to your need.

Removing entries from the Table of Content: You can also remove the
entries from the Table of Contents.

Steps to remove entries from the Table of Content are as follows:

1. Click on the Reference tab.

2. Click on Add Text option under the Table of Contents group.

Working with Tables, Columns and Sections

Table

Table consists of the rows and columns. Rows are horizontal and columns are
vertical. At the intersection of the rows and column there is a cell which contains
the text. We can format the tables according to our requirements.

Creating a table

 Go to the Insert tab and click on the Table option.

 Move your cursor over the grid, the table will appear in the document. We
can add the desired number of rows and columns in the table. Left click on
the grid when the size of the table is appropriate.
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The screenshot of the table created using the grid is as shown:

 Sometimes, the required table might be greater in size than that is available
in the grid. In that case, click on the Insert Table button and enter the
size manually.

The screenshot of the table created manually is as shown:

 Below the grid, there are other options that can be used to design the
table according to the requirement.
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The screenshot showing the other options available for creating a table is as
shown:

Deleting the table

 Click on the table. Table layout will be displayed on the top.

 Click on the Delete button.

 Select the Layout tab if this is not already selected.

 Click on the Delete Table button. This will delete the table. Other actions
can also be performed on the table according to the requirement.

The screenshot of Delete Tableis as shown:
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Column

Insert Column

 Click on the table. Go to the Layout tab.

 In the Layout tab, go to the Rows and Columns section.

 Click on Insert Right or Insert Left for inserting a column on the left and
right side of the particular column.

The screenshot of inserting a column on left or right of a selected column in
a table is as shown:

Insert Row

 Click on the table. Go to the Layout tab.

 In the layout tab, go to the Rows and Columns section.

 Click on Insert Above or Insert Below button for inserting a row above
or below the row where the cursor is present.

The screenshot of inserting a row above or below a selected row in a table
is as shown:
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Sections

Section means splitting the cells or table into different parts or sections.

1. Splitting the cells

 Go to the particular cell in the table. Then, go to the layout menu.

 Click on Split Cells button. Split cells dialog box appears that prompts
to enter the number of rows and columns.

 Specify the rows and columns. The cell will be divided into sections.

The screenshot of Split Cells is as shown:

2. Splitting the table

 Go to a particular row in the table from where you want to divide the
table. Go to the Layout bar.

 Click on Split Table Button. The table will be divided into sections.
The row that was selected will be the first row of the second table of the
split tables.
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The screenshot of Split Table is as shown:

 

Borders and Shading

With Microsoft, the user can apply border to a table. You can also provide different
shades to the table of your choice.

Applying Border to a table

 Select the table to which you want to apply the border.

 Click the Border button to select the border from different types of border.

 You can delete the border by selecting No Border option.

The screenshot of Border option is as shown:
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Use the ‘Border’ option

 Select the table. Click the Border button, a list will appear. Click on border
and shade option.

 A dialog box will appear, select border from that dialog box.

 Choose the border of your choice and color and apply it to the table.

The screenshot of Borders options is as shown:

 

Adding shades to the table

 Select the row or column you want to shade. Go to Border button.

 Select Borders and Shading option from the list. A dialog box will appear.
Select Shading tab and select the color of your choice.

 Apply the shade to the row or column. The row or column will get shaded.

The screenshot of Shading option is as shown:
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Page Setup and Break

Break: In word, a new page begins after the previous page is completely filled
but with the help of break, the user can force the text to start from the new page.

Insert page break

 Open the document. Go to the location from where you want to start a new
page.

 Go to the Insert tab and click Page Break. New page will start from the
insertion point.

The screenshot of Insert page break is as shown:

Page Setup: This option is present in Page Layout tab. It helps in setting the
orientation of the page in the document. It also includes options for setting margins
on a page and page break. By default, the orientation of a page is selected as
Portrait. You can also choose landscape mode. Let’s learn about margin.

The screenshot of Page Setup dialog box is as shown:
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Margin

 Open the document; go to Page Layout option and click on Marginstab.
A listwill appear. Click on Custom Margin option available.

 A dialog box will appear that specify the margins you want to keep for the
document.

The screenshot of selecting the Margins option is as shown:

 

Line spacing

To format line spacing, follow the steps given below.

1. Select the text in the document.

2. Click the Line and Paragraph Spacing command in the Paragraph group on
the Home tab.

3. Select the desired spacing option from the drop-down menu.

4. From the drop-down menu, you can also select Line Spacing Options to
open the Paragraph dialog box.
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Page length

You can set the page length using the size command of page setup group of page
layout menu in the ribbon interface as shown below.

Header or Footer

Header and footer are the important parts of any document. They are used for
representing information about the document such as the page number, heading of
the document etc. Header is present on the top of the document and footer is
present at the bottom of the document.

Adding Header or Footer

 Click on the Insert tab. After this, click on either Header or Footer
whichever you want to apply to the document. A list appears from which
you can select the header you want to apply to the document.

 When you select the header, it will appear in the editable form in which you
can write whatever you want to add.

The screenshot of inserting the header in the document is as shown:
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Editing the Header or Footer

 Click on the Insert tab. Select header or footer whichever you want to
edit. A list will appear with the option Edit Header.

 Click the Edit Header button. The header is now available in editing form
so that you can edit it.

The screenshot of Edit Header is as shown:

Inserting special symbols and pictures

You can insert the symbols in a Word document using the symbol command in the
insert tab in the ribbon interface. When you click on the symbol command, it
shows the various types of symbols which can be selected as per the requirements.

You can also insert the pictures in the document form the available pictures
using the pictures command in the insert tab. Click on the Insert tab on the Ribbon
interface and select pictures. On the window that appears, go to the location
where the picture is located and click Insert.

To wrap text around an image follow the given steps.

1. Select the image. The Format tab will appear.

2. Click the Format tab.

3. Click the Wrap Text command in the Arrange group.
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4. Select the desired menu option. The text will adjust based on the option
you have selected. ...

5. Move the image around to see how the text wraps for each setting.

Hyphenation Off

To turn off auto hyphenation in Word 2010, follow the steps given below

1. Go to the Page Layout tab > Page Setup group.

2. Click Hyphenation.

3. Select None.

Types of justifications

There are several types of justification:

 Left-justification: All lines in the paragraph butt up against the left text
margin. No extra spaces are added to the line.

 Center-justification: All lines in a paragraph are centred between the left
and right text margins. No extra spaces are added to the line.

 Right-justification: All lines in a paragraph butt up against the right text
margin. No extra spaces are added to the line.

 Fill-justification. All lines in a paragraph are expanded so they butt up
against both the left and right text margins. Space is added, between words
and characters, as necessary to fill out the line.

Cursor movement and control

You can move the cursor to another location by moving the pointer and then
clicking, or by using the keyboard. To type anywhere else in the document, you
need to move the cursor to that place. Here are a couple of ways to do that:

 With your mouse, move the cursor just to the left of “During,” and then click
to insert the cursor. Then start typing.

 Press the UP ARROW (  ) on your keyboard to move the cursor up one
line at a time. Then press the LEFT ARROW (  ) to move the cursor left,
one character at a time. 

Bullets and Numbering

Bullets and numbering allow you to present information in the simple ways. With
the help of bullets and numbering, information is separated easily in the form of list.
This helps in saving the space in the document. Bullet and numbering option are
available in the paragraph group on the Home tab. Microsoft Word lets you to
create bulleted and numbered lists, to specify different lines or topics. Once you
create bulleted and numbered list, each time you press enter, same bullets are
added to your list. If you want to add another bullet, then you can choose different
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bullets and numbering from the Home tab.If you hit enter twice, then you will
return to the earlier level. If you hit enter twice at the end of the list, then the list will
be terminated.

The screenshot of bullet and numbering list is as shown:

 

Bulleted list

The screenshot of different types of bullets that can be used to create a bulleted
list are as shown:

 

Custom bullet

You can define your own bullet using Define New Bullet option. When you click
on this option, following dialog box appears. This holds option for setting picture,
symbol and font of the bullet character. It also contains the options for alignment
and for seeing the preview of the page.

The screenshot of Define New Bullet dialog box is as shown:
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Numbered list

Numbered list dialog box contains different types of numbered lists like Recently
Used Numbered Format, Numbering Library and Document Number Formats.

The screenshot of different types of numbered list is as shown:

Custom Numbering

You can define your own numbering using Define New Number Formats option.
When you click on this option, a dialog box appears containing options for setting
number format. It also contains the options for alignment and for seeing the preview
of the page.

Font Formatting

Font formatting is used to change the appearance of words or a single character.
It is present in the Home tab of ribbon view. You can apply the Font formatting by
highlighting the text.

Font Formatting contains the various controls for providing a quick access
to many frequently used functions.

The screenshot of Font Formatting is as shown:
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The available buttons and icons of the Font Formatting toolbar are as
follows:

  Font dropdown box of the Font Formatting helps in
changing the font of text or number when selected. You can choose any
font by clicking on the dropdown menu. The default font in Word is
Calibri (Body).

 Font Size dropdown box of the Font Formatting helps in
changing the size of the text when selected. You can choose any size by
clicking on the dropdown menu. The default font size in Word is 11.

  Grow Font button of the Font Formatting helps in increasing the
size of the text when selected.

 Shrink Font button of the Font Formatting helps in decreasing the

size of the text when selected.

 Change Case dropdown menu of the Font Formatting helps in changing
the case of the selected text.

For example:

Suppose you have written “Hello”. You want to change the uppercase letter to
lowercase, then you can choose Change Case dropdown menu to do that.

The screenshot of Change Case is as shown:
 

 

  Clear Formatting menu of the Font formatting helps in clearing

the formatting by selecting that particular area. It is useful in situation
where you want to remove entire formatting at once.

  Bold button of the Font Formatting toolbar helps in making selected

text or numbers bold and in removing bold formatting when the text or
numbers are already bold.

 Italics button of the Font Formatting toolbar helps in making selected

text or numbers italics and in removing italics formatting when the text
or numbers are already italics.
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making selected text or numbers underline and in removing underline
formatting in already underlined text or numbers. You can choose any
type of line from Underline dropdown menu.

  Strikethrough button draws one straight line throughout the
selected word.

For example:

Consider the following sentence “See the effect”. If you apply Strikethrough effect
by selecting the words then the same sentence will look as shown: “See the effect”.

  Subscript button helps in making selected text or character look smaller

without changing its Font size. It places them below the other characters.

For example:

Consider the following set of character “a5b.” If you apply Subscript effect by
selecting number 5, then the following set of character will look as shown: “a

5
b.”

  Superscript button helps in making selected text or character look

smaller without changing its Font size. It places them above the other
characters.

For example:

Consider the following set of character “a5b.” If you apply Superscript effect by
selecting number 5, then the following set of characters will look as shown: “a5b.”

  Text Effects dropdown menu of the Font Formatting toolbar helps

in drawing colored line around the text. You can choose any color from
dropdown menu.

For example:

Consider the following sentence “See the effect”. If you apply Text Effect by
selecting the text then the same sentence will look as shown: “See the effect”

 Highlight button of the Font Formatting toolbar highlights the text or

number with the specified color. By default, “Yellow” color is selected. You
can choose any color from the drop down menu. You can add and remove
the color by clicking the specific color.

 Font Color button of the formatting toolbar helps in changing the

color of the text. By default, “Red” color is selected. You can choose any
color from the drop down menu.
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Page Numbering

For adding Page Numbers to the Header section or Footer section simply click
on the Page Number command to select the option Top of Page or Bottom of
Page as shown below in the Illustration.

 

Inserting date and time

You can insert date and time in a document by simply click on date and time
command in the insert tab. Follow the steps Insert  Date and Time. After using
this you will see date and time in the document.

Format Painter

To use the format painter, use the following steps.

1. Select the text or graphic that has the formatting that you want to copy.

2. On the Home tab, click Format Painter.

3. Use the brush to paint over a selection of text or graphics to apply the
formatting. This only works once. To change the format of multiple selections
in your document, you must first double-click Format Painter.

4. To stop formatting, press ESC.
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Shortcut Keys for Various Tasks

Some of the shortcut keys for various tasks in MS Word are shown in the table
below:

Table 4.1 MS Word Shortcuts

Using Keyboard Shortcut

Action
Keystrokes

Creation of new document
CTRL+N
Saving a document
CTRL+S
Opening a document
CTRL+O
Printing a document
CTRL+P
Closing a document
CTRL+W
Selecting an entire document
CTRL+A
Copying a text
CTRL+C
Cut specific text
CTRL+X
Paste specific text
CTRL+V
Undo
CTRL+Z
Redo
CTRL+Y
Bold
CTRL+B
Italics
CTRL+I
Underline
CTRL+U
Alignment of text to the left
CTRL+L
Alignment of text to the right
CTRL+R
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Alignment of text to the justify
CTRL+J
Alignment of text to the center
CTRL+E
Finding the text
CTRL+F
Replacing the text with particular text
CTRL+H
Adding and removing 6 point of spacing before a paragraph
CTRL+0
Opening font preferences windows
CTRL+D
Inserting link
CTRL+K
Indentation of a paragraph
CTRL+M
Creating an hanging indent
CTRL+T
Creating a bullet point
CTRL+SHIFT+L
Changing the font
CTRL+SHIFT+F
Increasing selected font to 1 point to 12 point
CTRL+SHIFT+>
Increasing selected font to 1 point
CTRL+]
Decreasing selected font to -1 to -12 point
CTRL+SHIFT+<
Decreasing selected font to -1 point
CTRL+[
Viewing or hiding non printing characters
CTRL+SHIFT+*
Moving contents to the beginning
CTRL+‘!
Moving contents to the end
CTRL+“!
Deleting Word to the right of the cursor
CTRL+Del
Deleting Word to the left of the cursor
CTRL+Backspace
Moving cursor to the end
CTRL+END
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Moving cursor to the beginning
CTRL+HOME
Resetting default font to the highlighted text
CTRL+SPACEBAR
Changing text to heading one
CTRL+ALT+1
Inserting time
SHIFT+ALT+T
Inserting date
SHIFT+ALT+D
To Save As file
F12
Spell Checker
F7
Opening Help
F1

Check Your Progress

1. How can the ribbon be minimised?

2. State the uses of header and footer.

4.3 MS EXCEL

Let us analyse the different features of MS Excel.

The Ribbon Interface

Ribbon interface in Microsoft Word 2010 is same as that of Microsoft Excel
2010, the only difference lying with the changes in commands. With the help of
ribbon performing various tasks with the spreadsheet becomes easy.

Screenshot for Ribbon is shown as:

If you click on any tab or groups, each button and dropdown menu will
perform different actions
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Customizing the Ribbon

Follow these steps to customize the ribbon:

1. Right click on any tab or group and click on the Customize the Ribbon
option. Excel Options dialog box will appear.

Screenshot displaying Excel Options is as shown:

2. Choose the command which you want to add. Here, Copy command has
been selected. Next, click on New Group button (in order to add commands
the user needs to create a custom group first). Click on Add button in order
to add selected commands to the New Group.

3. Click on OK button. Copy command will be added to New Group which
is seen under Home Tab after the Editing option.

Screenshot displaying New Group is as shown:

Excel 2010 Backstage View

Backstage view has been previously introduced in MS Word 2010. Most of the
features of backstage view remain the same. Some modifications are discussed as
follows:
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Protect Workbook under Permission tab of Info option includes two more
choices. They are:

 Protect Current Sheet: This option protects current sheet from
unauthorized access. Here you set a password for protecting current
worksheet. You can also specify which type of changes people can make
in this worksheet by checking them on allow all users of this workbook
to list.

Snapshot of Protect Worksheet is as shown:

 Protect Workbook Structure: By using this option you can protect
entire workbook to be changed by unauthorized users. It provides two
levels of protection. These are as follows:

1. Protect Workbook for Structure: It protects the structure of the
worksheet from unwanted modifications. For example unauthorized
users can not add new worksheet or delete an old and cannot change
the order of the sheets.

2. Protect Workbook for Windows: It is not checked by default. If
you check Windows then the book is protected also from resizing any
windows you have inserted in your workbook like charts, pictures,
shapes etc.

Screenshot of Protect Structure and Windows is as shown:

As shown, in both the above cases Password is optional.
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In order to unprotect, click on Unprotect Worksheet or Unprotect
Workbook. You are asked for password, if set.

Creating, Opening and Working with Excel Documents

Microsoft Excel is used for storing the data in the form of table. It is used by
several organizations to perform complex calculations, statistical analysis and
tracking income and expenses. It uses pie charts, slicers, sparklines to easily analyze
the data. Excel 2010 provides very interactive features which help in analyzing
and visualizing the data in productive and innovative ways. In this chapter, you will
learn about the essential features of MS Excel, various ways of building Worksheets,
methods of formatting and filtering data, management of Excel worksheets and
various shortcut commands to perform the task easily.

File Management

File management is the task of maintaining the newly created folders or the existing
folders in the computer. It involves various tasks such as saving the folder,
maintaining the data and many more.

Saving a document

In Microsoft Excel 2010, files are saved in .xlsx format. There are different ways
of saving the files in the computer depending upon the requirements. When the
files are saved in .xlsx format, you can use new features provided by Excel such as
Sparkline and Slicers which are not supported by other file formats.

Steps to save the documents in Excel are as follows:

1. Go to the File tab which is present on the left hand side of the ribbon.

2. Go to the Save As options on the left most side of the screen.

The screenshot of Save As option is as shown:

3. Choose the drive and folder where you want to save the file.
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The screenshot displaying specific Drive and Folder is as shown:

4. Go to the File name textbox to write the name of the file.

5. Choose the format in which you want to save the File. By default, the
file format is .xlsx.

6. Click the Save button to save the file.

Saving a Document as PDF

Excel 2010 provides enables the user to store documents as PDF files, while
sharing them with others. PDF stands for Portable Document Format.

To save an Excel file in PDF format follow these steps:

 First click on the File tab present on the top left corner of MS Excel or
press Alt+F as a shortcut to File tab.

 After this click on Save As option.

 Now, enter the filename. When you are asked to select the type of file,
choose PDF. You can select Standard for high quality printing or select
Minimum size if you desire a file of small size.
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Screenshot displaying the Save as type option is as follows:

 Finally, click on Save button to save file in PDF format.

Opening a document

Steps to open the document are as below:

1. Go to the File tab which is present on the left hand side of the ribbon.

2. Go to the Open option on the left most side of the screen.

The screenshot showing Save As option is as shown:

3. Choose the appropriate drive and folder from where you want to open the
file.

4. Choose the file which you want to open.

5. Go to the Open option to open the file.
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You can save the important files in the Libraries so that you can access the
specific folder and files easily. The Libraries option appears on the left hand side
of the screen.

Deleting a spreadsheet

Follow the steps given below to delete a spreadsheet.

1. Open the Excel workbook containing the sheet that you want to delete.

2. Click the tab at the bottom of the window for the worksheet that you want
to delete. 

3. Click the Home tab at the top of the window.

4. Click the arrow under the Delete button in the Cells section of the ribbon
at the top of the window, then click the Delete Sheet button.

5. Click the Delete button to confirm that you want to delete the sheet.
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Reordering spreadsheets

You can change the order of sheets as per your need in a file by simply click, hold
and drag on the sheet tab at the bottom of the window.

Renaming a spreadsheet

You can follow the steps given below to rename a spreadsheet:

 Double-click on one of the existing worksheet names.

 Right-click on an existing worksheet name, then choose Rename from the
resulting Context menu.

 Select the worksheet you want to rename (click on the worksheet tab) and
then select the Sheet option from the Format menu. This displays a submenu
from which you should select the Rename option.

Duplicating/Copying sheets in a workbook

Using Move or Copy command, you can make one copy of a worksheet, multiple
specific worksheet or all worksheets into active workbook or another workbook.

1. Select the workbook you need to copy.

2. Right click on sheet tab and select Move or Copy option. An illustration is
shown below.

3. In the Move or Copy dialog box, specify the following settings.

 From To book, you can specify the workbook where the worksheets
will be copied into.

 Specify the position of the copied sheets, you can choose it after all of
the existing sheets.

 Check Create a copy option, if you don’t check this option, the selected
worksheets will be moved into another workbook.
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4. And then click OK, it will copy the selected worksheets one time into the
specified workbook. The screenshot is given below.

Working with Cells

Excel file is a workbook that contains one or more worksheets. Formatting Excel
sheet improves the presentation of the worksheet and makes it easy to use. By
default, each Excel file has three worksheets.

Entering data and Text formatting

To insert data in the spreadsheet, you can select the row or column where you
want to insert the data or insert new rows and column in between.

Formatting Cells

Microsoft Excel has 16,384 columns and 1,048,576 rows. Cell is intersection of
rows and columns where you can enter data in the cell. There are many options to
format cell and text. We are going to learn how to change colour, style of cell,
alignment of text, etc. There are four ribbon groups such as Font, Alignment,
Number and Styles. Font command is used to change font, font size, and style
of text such as Bold, Italic and Underline, change border, change the cell color
and text color. Alignment command is used to set alignment of text and merging
the cells. Number command is used to select cells and set number format such as
percentage, date, etc. Cell styles option in Styles group is used to set specific
color to cell.

Steps to change the Font are as follows:

1. Select a cell in which you want to set a specific font.

2. Click on Font option from the Font on Home tab.

3. Select the desired font from drop down list to apply the font.
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The screenshot of selecting the Font is as shown:

To change a font size

Steps to change a font size are as follows:

1. Select a cell in which you want to set specific font size.

2. Click on Font Size from the Font on Home tab. There are two options for
increasing and decreasing fonts.

3. Select font size from drop down list. Otherwise, click on increasing font or
decreasing font.

If you click on increasing font option, text size increases according to the
selection. If you click on decreasing font option, text size decreases according to
the selection.

The screenshot of selecting the Font Size is as shown:
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To set Bold, Italic and Underline option

Steps to set Bold, Italic and Underline are as follows:

1. Select a cell in which you want to set style such as Bold, Italic and
Underline.

2. Click on Style option in Font group on Home tab. There are three options
such as Bold, Italic and Underline.

An example of Bold, Italic and Underline is as shown:

Bold  
 

Welcome 

Italic 
 

Welcome 

Underline 
 

Welcome 

3. Text appears according to selection.

The screenshot of selecting the font style is as shown:

To change text alignment

Steps to change text alignment are as follows:

1. Select the cell.

2. Click on the Home tab.

3. Click on vertical Alignment and horizontal Alignment commands in
Alignment group.

In vertical Alignment, there are three options:

1. Top Align: Text set to the top of the cell.

2. Middle Align: Text set to the middle of the cell.

3. Bottom Align: Text set to the bottom of the cell.
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In horizontal Alignment, there are three options:

 Align Text Left: Text set to the left of the cell.

 Center: Text set to the center of the cell.

 Align Text Right: Text set to the right of the cell.

Text aligns according to the selection.

The screenshot of selecting the Alignments is as shown:

The given screenshot shows vertically Middle Align and horizontally Center
alignment.

Applying cell styles

Cell styles contain the formatting of font and cell. You can directly use cell styles to
set the range of cells. Excel 2010 has in-built cell styles that you can use. You can
also create your own cell style.

Steps to apply cell style are as follows:

1. Select the cell.

2. Click on cell styles in Styles group on Home tab.

3. Select cell style that you want to apply on the cell. Cell is now displayed
according to the style selected.
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The screenshot of the cell style is as shown:

Selecting Cells or Range

When you edit sheets in MS Excel 2010, you often need to select cells, copy
cells, set a range for deleting cells, and also search for data within the cells of a
worksheet. To select a particular cell, select that cell or use arrow keys to reach
that cell.

For the selection of range, click on first cell and then drag to the last cell or
instead of dragging, just hold SHIFT key and use arrow keys to reach the last cell.
For selecting all cells in worksheet, press CTRL+A.

Inserting and Deleting Rows and Columns

To insert rows and column in a worksheet, follow the steps given below.

1. Select the cell or row or column where you want to insert row/column.

2. Click the drop-down arrow attached to the Insert button in the Cells group
of the Home tab. The screenshot is given below.

3. Select the one of the option in the drop down menu as per requirement.
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Sorting and Filtering Information

In MS Excel, you can store enormous data. If you want to arrange the data, you
can use Sort command. Filter command is used to find any specific information
from specific column. In Excel 2010, Sort and filter command are available
together in Editing group on Home tab. Both the commands are described in
further subsections.

Sort: Sort is most commonly used command to arrange the list of data in
alphabetical order. In Excel, there are two basic sorting methods such as A to Z
and Z to A. For example, if you want to arrange employee name in ascending
order, click on A to Z in Sort & Filter option. Sort command is used to visualize
the data such that it increases understanding and makes data easily searchable.

Sort Data in single column

Steps to Sort Data in single column are as follows:

1. Select a column in which data needs to be sorted.

2. Click on Sort & Filter option in Editing group on Home tab. It displays
drop down list.

The screenshot of selecting Sort & filter is as shown:

3. Click on Sort Largest to Smallest option. It displays Sort Warning dialog
box.

The screenshot of Sort Warning dialog box is as shown:
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There are two options which are as follows:

 Expand the selection: Sort selected column with other columns data.

 Continue with the current selection: Sort only selected single column.

4. Click on Expand the selection.

5. Click on Sort button.

The screenshot of selecting Sort button is as shown:

To Sort multiple data

Steps to Sort multiple data are as follows:

1. Select whole table in Excel sheet.

2. Click on Sort & Filter option in Editing group on Home tab. It displays
drop down list.

The screenshot of selecting Sort & Filter is as shown:
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3. Click on Custom Sort. It shows Sort dialog box as shown in the screenshot:

4. Select the column that you want to sort in Sort by drop-down box.

5. Select type of sort in Sort On list.

6. Select Values option if you want to sort text, number or date and time.

7. Select Cell color, Font color, Cell icon option if you want to sort data by
format.

8. Select order in Order list.

9. Add Level is used to add another column to sort by. Copy Level is used
to copy a column to sort by. Delete Level is used to delete selected entry.
Up or down arrows are used to change the order of the Column.

The screenshot displaying the options in Sort dialog box is as shown:

10. Click OK button. It displays a table which is as shown in the screenshot:
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Filter

You can find any value, information quickly in worksheet using Filter command.
You can filter more than one column of data. Filter command creates a list of
data. Therefore, you can see any information from a list. Let’s learn how to use
filter command.

To filter data

Steps to filter data are as follows:

1. Select a table.

2. Click on Sort & Filter option in Editing group on Home tab. It displays
the drop-down list.

The screenshot of selecting Sort & Filter is as shown:

3. Select Filter option. It displays a table with drop-down arrows in the header
of each column.

The screenshot of table after applying filter option is as shown:

 

4. If you click on drop-down arrows, it displays the list of data with check
box.
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The screenshot of table displaying drop-down arrows is as shown:

When you uncheck any check box of data, that data will not be displayed in
the table.

AutoSum in spreadsheet

Follow the given steps to apply AutoSum

1. Click the cell where you want to display the calculation.

 To sum with a range of numbers, select the range of cells you want.

 To sum with only some of the numbers in a range, select the cells or
range you want using the Ctrl key. Excel inserts the sum in the first
empty cell below the selected range.

 To sum both across and down a table of number, select the range of
cells with an additional column to the right and a row at the bottom.

2. Click the Formulas tab.

3. Click the AutoSum button.

Check Your Progress

3. State the steps to change the font size.

4. What are the steps to change the text alignment?

4.4 MS POWERPOINT

Ribbon view is a substitute that provides the facilities of accessing the commands
for applications. It is organized using a horizontal bar. It provides an easy way to
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access the commands, as all the commands are organized using tabs and groups.
With the help of Ribbon, performing various actions to the Office application is
easy.

The ribbon contains three components:

 Tabs: They appear across the top of the Ribbon and contain groups of
related commands. Home, Insert, Page Layout are example of ribbon tabs.

 Groups: They organize related commands; each group name appears below
the group on the Ribbon. For example group of commands related to fonts
or or group of commands related to alignment etc.

 Commands: Commands appear within each group as shown in the
sreenshot.

Views in Slides

PowerPoint views can be accessed from two locations.

 Views can be access quickly from the bottom bar just to the left of the
zoom settings
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 Views can also be access from the Presentation Views section in the View
ribbon

A short description of the different views and their features.

Normal View:

This is the default view in PowerPoint and this is primarily used to create and edit
slides. User can create/ delete/ edit/ rearrange slides, add/ remove/ modify content
and manipulate sections from this view.

Slide Sorter View:

This view is primarily used to sort slides and rearrange them. This view is also
ideal to add or remove sections as it presents the slides in a more compact manner
making it easier to rearrange them.
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Reading View:

This view is new to PowerPoint 2010 and it was created mainly to review the slide
show without losing access to rest of the Windows applications. Typically when
User run the slide show, the presentation takes up the entire screen so other
applications cannot be accessed from the taskbar. In the reading view the taskbar
is still available while viewing the slide show which is convenient. User cannot
make any modifications from this view.
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Slide Show:

This is the traditional slide show view available in all the earlier versions of
PowerPoint. This view is used to run the slide show during presentation.

Step (1): In the Design ribbon, under the Background group click on
theBackground Styles command.
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Step (2): Select one of the background styles that suits your requirements

Step (3): To edit the background for a specific slide, right click on the desired
background slide and select “Apply to Selected Slides”

Step (4): Selected slide(s) now have the new background.
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Creating Presentation and Slides

Opening a presentation in PowerPoint

Steps for opening a presentation are as follows:

1. Go to the File tab which is present on the left hand side of the ribbon.

2. Go to the Open option of the File tab.

The screenshot of an Open option is as shown:

3. As you click on the Open option, an Open dialog box appears. Choose
the appropriate drive and folder from where you want to open the file.

The screenshot of an Open dialog box is as shown:

4. Choose the file which you want to open by writing its name in the File
name text box.

5. Click on the Open option to open the file.

Saving a document

In PowerPoint 2010, by default, files are saved in .pptx format. In the previous
version, files are saved in .ppt format. There are different ways of saving the files
in your computer depending upon the requirements.
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Steps for saving the presentation in PowerPoint are as follows:

1. Go to the File tab which is present on the left hand side of the ribbon.

2. Go to the Save As option of the File tab on the left most side of the screen.

The screenshot of Save As option in File tab is as shown:

3. As you click on the Save As option, a Save As dialog box appears. From
the dialog box, you can choose the required drive or folder where you want
to save the file.

The screenshot of Save As dialog box is as shown:

4. In the Save As dialog box, go to the File Name text box to write the name
of the file.

5. Choose the format in which you want to save the File. By default file format
is .pptx.

6. Click on the Save option available on the bottom right side of the dialog
box to save the file.

Creating a new slide

Steps to create a new slide are as follows:

1. Click on the File menu.



Introduction to MS Office
and Adobe Photoshop

NOTES

Self-Instructional
144 Material

2. Select the New option of the File tab and click on it.

3. A new window of Available Templates and Themes appears.

4. Click on the Blank presentation and then click on the Create button on
the right hand side of the window.

The screenshot displaying the Blank presentation is as shown:

Changing layout of the slide and deleting a slide

You can change the layout of the slide and delete the slide by simply right click on
thumbnail of the slide. The illustration is shown below.
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Changing the order of the slides

You can change the order by simply right click the thumbnail of the slide that you
want to move, and then drag it to the new location. 

Applying Animation and Transition Effects

Applying Animation

Animation is one of the most common features of MS PowerPoint. It is used to
make an attractive presentation and for creating the interest in audience. MS
PowerPoint 2010 provides different varieties of animations that can be applied to
text, picture or other graphics in multiple ways.

The screenshot of Animations tab is as shown:

The first part of the Animations group provides the various options for
applying animations to a character, text, picture and graphics within each slide.

Steps to choose an animation for applying it to objects of a slide are as
follows:

1. To get all of the options from Animations group, click on the Down Row,
Up Row and Many arrows to the right of the Animations options pane.

2. Select the Animation option to apply on the text or other graphics.

The screenshot of Animation options is as shown:
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3. Click on Effect Options icon to apply an animation effect to the selected
object.

The screenshot of Effect Options icon of an Animations tab is as shown:

4. Click on the Add Animation icon present next to Effect Options. As you
click on Add Animation, a pictorial view of all of the animation effects to
animate text or graphics appears.

5. Choose the animation effect for adding it to the required object. The selected
animation effect will be highlighted in golden color.

The screenshot of Add Animation and selecting a specific animation effect
is as shown:

6. Timing group of Animations tab allows user to adjust the sequence and
timing of selected animations. User can also adjust settings if an animation
should be performed when the mouse is clicked or automatically.

The screenshot of Timing group is as shown:
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7.  Click on the Animation Pane, it displays all the animations applied to
each slide.

 The screenshot of Animation Pane is as shown:

8. After selecting all the animations as per the requirement, you can see the
preview by clicking on the Preview icon available below the File menu.

The screenshot of Preview option is as shown:

Transition Effects

Slide Transition is also an animation effect which is to define effects while proceeding
from one slide to next slide during the slide show. It also includes adding sound
effects. You can apply the different kinds of transition effects in slides of a
presentation.

Steps to apply the transition effect are as follows:

1. Click on the Transitions tab which is available on the Ribbon view.

The screenshot of Transitions tab is as shown:

2. Click on the ‘Up’ and ‘Down’ arrow of Transition to This Slide group to
choose a special effect that gets applied during the transition between the
previous slide and next slide.
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The screenshot displaying all the Transition Effects is as shown:

3. As you click on any of the transition effects, a preview of the theme plays in
front of you. To set the transition to slide, left click on the choice which you
want.

4. Click on the Apply To All option of the Transition tab to apply the same
transition effect on all slides.

5. Click on the list box of the Sound option of Transition tab.

6. Select and click on the sound which you want to play during the transition
between the current and the previous slide.

The screenshot displaying different types of Sound options is as shown:

7. After applying all the transitions you can also see the preview of a slide by
clicking on the Preview option.

Check Your Progress

5. What is the ribbon view?

6. When is the slide sorter view used?
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Microsoft Office Access 2010 or MS Access 2010 is a most popular database
management system tool for windows. It combines the object-oriented relational
database management system engine with graphical user interface and software-
development tools from Microsoft.

Microsoft Access 2010 has some design modifications over MS Access
2007. It is a relational database application meant for allowing users or programmers
to manage, sort and filter large amounts of data. It is a powerful tool for creating
and running database solutions and producing meaningful reports.

It is designed to help the organizations, such as a company, school, institutions
to collect, organize, manage and access useful data in such a way that it can be
easily retrieved and made available to users in a convenient way.

Also, it allows users to create custom databases in systematic structure that
store the information. This application provides a graphic interface for creating
custom forms, tables and data queries. It stores data in its own organized format
based on the Jet Database Engine and it is the application of MS Office which is
suitable for small as well as large scale business. The software can be downloaded
from the MS Office Website. Following are some terminologies related to MS
Access:

 Tables: Table allows the user to store a collection of data about a specific
subject, such as student record.

 Queries: Queries allow the user to view, change and analyse data in
different ways. This feature helps the user to fetch data from the created
tables.

 Forms: Forms help users to modify or update the existing data by adding
or deleting the new information.

 Reports: After storing the data in a database, user need to have a way
to view it; this is where reports come into the picture.

Features of MS Access 2010

The features of MS Access 2010 are as follows:
 For sharing a database on the Web, five templates are available in MS

Access 2010: Contacts, Assets, Projects, Events, and Charitable
Contributions. You can also modify any template, before or after you publish.

 An existing database can be converted to a Web. All desktop database
features are not supported on the Web, so you may have to adjust some
features of your application. The new Web Compatibility Checker can be
run to identify and fix any compatibility issues.

 Access 2010 offers a new macro builder that features IntelliSense and a
clean, straightforward interface. When you add an action, more options
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appear in the macro builder. In addition to traditional macros, you use the
new macro builder to create data macros which is a new feature.

 Data macros help support aggregates in Web databases and also provide a
way to implement ‘triggers’ in any MS Access 2010 database.

 The Expression Builder now features IntelliSense, so you can see options
as you type. It also displays help for the currently selected expression value
in the Expression Builder window.

 A field can be created that displays the results of a calculation and called
calculation field. The calculation must refer to other fields in the same table.
You can use the Expression Builder to create the calculation.

 MS Access 2010 includes a suite of professionally designed database
templates for tracking contacts, tasks, events, students and assets, among
other types of data. You can use them right away or enhance and refine
them to track information exactly the way that you want.

 Each template is a complete tracking application that contains predefined
tables, forms, reports, queries, macros and relationships. The templates
are designed to be immediately useful out-of-the-box so that you can get
up and running quickly.

 Functionality to an existing database can be easily added by using an
application part. This is also a new feature in MS Access 2010, an
application part is a template that comprises part of a database.

 In MS Access 2010, layouts have been enhanced to allow for more flexible
placement of controls on forms and reports. You can split or merge cells
horizontally or vertically, enabling you to easily rearrange fields, columns,
or row. You must use Layout view when designing Web databases, but
Design view still remains available for desktop database design work.

 The new user interface — introduced in MS Office Access 2007 and enhanced
in MS Access 2010 — was designed to make it easy for you to find commands
and features that before were often buried in complex menus and toolbars.

 The ribbon is a collection of tabs that contain groups of commands that are
organized by feature and functionality. The ribbon replaces the layers of
menus and toolbars found in earlier versions of MS Access.

 In MS Access 2010, Backstage view contains commands that you apply
to an entire database, such as compact and repair, or open a new database.
Commands are arranged on tabs on the left side of the screen, and each tab
contains a group of related commands or links.

 MS Access 2010 provides an intuitive environment for creating database
objects. Create tab is used to quickly create new forms, reports, tables,
queries, and other database objects.

 MS Access 2010 adds new conditional formatting features, enabling you
to achieve some of the same formatting styles as are available in MS Excel
2010. Conditional formatting is not available in Web databases.
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 In MS Access 2010, you can export data to a PDF (Portable Document
Format) or XPS (XML Paper Specification) file format for printing, posting
and e-mail distribution, provided that you first install the Publish as PDF or
XPS add-in. Exporting a form, report, or datasheet to a .pdf or .xps file lets
you capture information in an easy-to-distribute form that retains all your
formatting characteristics, but does not require others to install MS Access
on their computers to print or review your output.

Database Design in MS Access 2010

The term ‘database’ is used to describe a collection of related ‘data’ (information)
stored on computers. An electronic database should allow you to store, sort and
retrieve the data.

The Database Management System or DBMS is the software which acts
as an interface between the underlying database and the user to define, update,
retrieve and administer the database. Relational database is the collection of the
logically related data items which are organized in the form of tables.

Certain steps are used to create the database in MS Access 2010, which
are as follows:

1. Open Microsoft Access 2010 from the Start menu.

2. Now, click on the File tab on the menu bar and then, go to New option
available on left hand side of the window. Choose Blank database
and assign name to the Database on the right hand side of the window.

The screenshot displaying the creation of a Blank database is as shown
below:
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3. After choosing the Blank database option and writing the name in the
File_Name box, click on Create option to create the database.

Creating Table with Wizard

A ‘Table’ is a grid containing columns and rows in it. It contains cells, which can
contain any content inside them. At the moment you create the database,
automatically Table 1 is created.

For creating the new table, follow the steps as given below:

1. Click on the Create tab on the Ribbon view.

2. As you click on Create tab, Tables group containing the various options
offers you alternative methods to create a new table.

The screenshot containing the Tables group inside the Create tab is as
shown below:

3. Now, click on the Table option in the Tables group. As you click on it, a
blank datasheet will be created for you, with an ID field and an Add New
Field column.

4. As you enter data into the Add New Field column, another Add New Field
appears and the previous Add New Field column is re-labeled as Field1.

The screenshot displaying the Student record in table in Date sheet view
is as shown below:
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Creating Table in Design View

Steps for creating table in design view area as follows:

1. Click on the Create tab on the Ribbon and select the Table Design from
Tables group.

2. For create a table design view of the existing student list Table; right Click
on the Student- list and select the Design view.

The screenshot of displaying the Design view is as shown below:

3. As you click on the Design view option a table having the different fields
or attributes as Field Name, Data Type and Description appears on the
computer screen.

The screenshot displaying the Table created in Design View is as shown
below:
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Creating Table by Entering Data

The table can also be created by entering the data in the table. In this, the structure
of the table is not designed already. Rather the data is entered and the structure of
the table is designed based on the data that you enter in the column.

Once the cursor is moved to the next column, the column is saved. This
removes the need for defining the table structure as a separate task.

Steps for creating the table by entering data are as follows:

1. In the ribbon, click on the Create tab and then click on Table button.

This creates a new table as shown in the screenshot below:

2. Now, start entering the data in the field. Enter the data in the field and when
done, press the right arrow key on the keyboard. This sets the ID field to 1
and the type of data for the field would be set according to the data that
was entered. The screenshot displaying the type of data would be set to
Text for the Field1 is shown below:

3. Keep entering the data till the time you want more columns. Once all the
columns have been filled, click on the new row. Table structure would be
saved according to the data entered in the first row. The screenshot displaying
a table with three columns of type Text, Text and Number respectively, is
as shown below:
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4.6 ADOBE PHOTOSHOP

Photoshop is a product of Adobe and is used for professional image editing.
Photoshop is mainly used for digital image editing applications that cater to the
Internet, print and other media disciplines. This professional software package is
used by millions of multimedia experts (graphic artists and print designers), visual
communicators and novices alike. In the current situation, it is likely that almost
every picture (posters, book covers, magazine pictures and brochures) you have
seen has either been created or edited by Photoshop.

Old media, such as camera film and photographic prints, are still in use and
there will always be place for these. However, as the thirst for convenience and
quality increases, we will still be moving ahead in technology. The quality provided
by digital imaging has made it a standard today.

Image technology is one of the methods of producing pictures. The first
images were painted on stones. These were actually the stone walls of caves and
the pigment was extracted from natural materials. In due course of time, humans
invented new image technologies to express their experiences and ideas visually.
However, the technical evolution was slow in pre-industrial societies. For thousands
of years, the technique of image creation was primarily done by the skilled hands
of artisans and artists. Image technology accelerated during and after the industrial
revolution. Now, you can see new innovations on almost a daily basis.

Evolution of visual image was dependent on the different methods available
to the artist. Similarly, evolution of technology, new ideas and visual idioms reflect
the cultural ambiance of that period. In the twentieth century, new technologies
emerged with a great speed. Some changes in aesthetic values could be observed
over each decade due to cultural, political and technological influences. Thus,
each decade of the twentieth century can be associated with a distinct style, which
was a part of the development of culture.

One of Photoshop’s strongest features is that it can combine photographs,
text and graphics from multiple sources. Images are collected from a scanner,
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digital camera or a CD and superimposed, scaled, positioned, flipped, distorted
and rotated. The only limitation in Photoshop is your imagination.

Photoshop is like a virtual art studio. You can apply color to an image
using Photoshop’s Graphic User Interface (GUI). The only change being that
instead of pigment, colors and painting with light is used now. Photoshop provides
numerous tools, operations and filters that enable you to make a photographic
image that appears as if it had been painted in virtually any style and with any
paint medium. You can choose from 16,777,216 colors and a brush of any size
or shape. Photoshop also works as a color separator. It can configure and
generate separate duotones and process-color separations, tritones and
quadtones. In addition, it provides filters that can simulate Impressionist and
other painterly effects.

Photoshop is used to create and edit images for commercial printing
technique, including offset lithography, digital press and silk screen. It can also be
used by artists to create and transfer images for traditional copper or zinc intaglio
printing.

Check Your Progress

7. What is table?

8. Write one of the feature of Photoshop.

4.7 ANSWERS TO CHECK YOUR PROGRESS
QUESTIONS

1. You can minimize the ribbon in the following ways:

 By clicking on minimize ribbon button.

 By double clicking the tab on the ribbon.

 By right clicking the tab from the contextual menu and selecting minimize
ribbon button.

 By pressing Ctrl+F1 button.

2. Header and footer are the important parts of any document. They are used
for representing information about the document such as the page number,
heading of the document etc. Header is present on the top of the document
and footer is present at the bottom of the document.

3. Steps to change the font size are as follows:

 Select a cell in which you want to set specific font size.
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 Click on Font Size from the Font on Home tab. There are two options
for increasing and decreasing fonts.

 Select font size from drop down list. Otherwise, click on increasing font
or decreasing font.

4. Steps to change text alignment are as follows:

 Select the cell.

 Click on the Home tab.

 Click on vertical Alignment and horizontal Alignment commands in
Alignment group.

5. Ribbon view is a substitute that provides the facilities of accessing the
commands for applications. It is organized using a horizontal bar. It provides
an easy way to access the commands, as all the commands are organized
using tabs and groups.

6. Slide sorter view is primarily used to sort slides and rearrange them. This
view is also ideal to add or remove sections as it presents the slides in a
more compact manner making it easier to rearrange them.

7. A ‘Table’ is a grid containing columns and rows in it. It contains cells, which
can contain any content inside them.

8. One of Photoshop’s strongest features is that it can combine photographs,
text and graphics from multiple sources.

4.8 SUMMARY

  Info section gives important information related to file, by specifying its
properties. It enables you to protect documents, check for issues and manage
versions.

  In MS Word 2010, files are saved in the default format, which is .docx.
This is because .docx format is more secured and damages can be easily
recovered.

 There are two methods for saving a document in PDF or XPS format, both
are given below:

(i) One method of saving the file in Pdf or Xps format is with the help of
Save As button.

(ii) Another method of saving the file in Pdf or Xps format is with the help
of Save & Send section.

 The ‘Print Preview’ feature of MS Word helps you to view on the screen
how the printed version of the document would look like before printing a
hard copy. In latest versions of the MS Word (MS Word 2010 Onwards),
there is ‘NO’ Print Preview Tab or Option.
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 As an alternative, click on the File Tab then on the option Print from the menu
that appears on the left side. The Print pane will be displayed. In the Print
pane, click on the ‘Page Setup’ option to open Page setup dialog box. In the
Page setup dialog box define the Margins, Paper Size and Layout options for
setting the document text so that the text remains within the printable area.

 MS Word provides significant feature ‘Proofing’ for checking the text in the
document by using the option ‘Spelling & Grammar’. If you have made
mistakes in the document while typing the text then you can use the numerous
proofing features provides by MS Word to produce error-free and
professional documents.

 In Microsoft Excel 2010, various new features have been included which
help in creating an effective and attractive worksheet.

 Microsoft Excel is used for storing the data in the form of table. It is used by
several organizations to perform complex calculations, statistical analysis
and tracking income and expenses.

 Excel sheet contains data in cells. These cells can be converted into table
using Format as Table command. There are many built-in table styles
available in Excel 2010. When you apply table style on cells Design tab
appears.

 Ribbon view is a substitute that provides the facilities of accessing the
commands for applications. It is organized using a horizontal bar.

 You can change the layout of the slide and delete the slide by simply right
click on thumbnail of the slide.

 You can change the order by simply right click the thumbnail of the slide
that you want to move, and then drag it to the new location.

 Animation is one of the most common features of MS PowerPoint. It is
used to make an attractive presentation and for creating the interest in
audience.

 Microsoft Access 2010 has some design modifications over MS Access
2007. It is a relational database application meant for allowing users or
programmers to manage, sort and filter large amounts of data. It is a powerful
tool for creating and running database solutions and producing meaningful
reports.

 Photoshop is a product of Adobe and is used for professional image editing.
Photoshop is mainly used for digital image editing applications that cater to
the Internet, print and other media disciplines.
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 Ribbon: It is a set of tabs and commands to perform various sets of functions
and operations on documents.

 Cell: It is the interaction of row and column.

 Worksheet: It is the Excel sheet in workbook.

 Workbook: It is Excel document that contains Excel sheets.

 Table: It is a representation in the form of rows and columns for managing
and presenting the data.

4.10 SELF ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. Write the steps involved in the creation of the table.

2. Write the steps involved in adding the break in the document.

3. Write the steps to add column to the table.

4. What is use of Sort command?

5. How can one exit the slide show and return to the presentation?

6. Write the steps for creating presentation.

Long-Answer Questions

1. Define table. Explain the different actions that can be performed with table.

2. Define header and footer. Write the steps involved in adding header and
footer to the document and also explain how to remove the header and
footer from the document.

3. Define border and shading. Explain the steps to add the border and shade
to the word document and the possible actions that can be performed.

4. How will you align a statement in vertically middle and horizontally center?
Explain with example.

5. Prepare an Excel sheet to calculate the average of given numbers using the
average function? The numbers are: 12, 43, 65, 32, 76, 72.

6. Explain the various ways to create a table in MS Access 2010.
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5.0 INTRODUCTION

Nowadays, computer science and data communication fields are integrated into
one. Together they have made a revolution in the field of technology. Data
communication can be done only through networking. Networking refers to
combining a lot of systems with or without wires so that they can transfer the data
and can communicate with each other. An Internet is a large network, which is
extended all over the world. In this unit, you will learn about the growth of computer
network, web administration and media convergence.

5.1 OBJECTIVES

After going through this unit, you will be able to:

 Discuss the growth of computer network and WWW

 Understand web administration

 Explain media convergence
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5.2 GROWTH OF COMPUTER NETWORK AND
INTERNET

The idea for Internet came into existence in 1957, when Sputnik was launched by
Soviet Union. After this, the United States of America created a research agency
named Advanced Research Projects Agency (APRA) for research and for
developing advanced ideas and technology beyond the identified needs. For
performing the packet switching, APRA Network (ARPANET) contracted with
BBN (Originally Bolt, Baranek and Newman) Technology. BBN selected the
Honeywell mini-computer as the base on which they could build the switch. In
1969, four host computers were added to the existing wide area network. Now,
research is done for utilizing this network and for creating larger network.

In 1972, Ray Tomlinson created first e-mail program for transferring the
data on network. Network Control Protocol (NCP) was the main protocol that
was used for transferring the data. But this protocol could only be used for
transferring the data on the same network. NCP and Interface Message Processor
(IMP) lacked an error control mechanism. NCP had problem with the end-to-
end message delivery. At this time, the requirement of open system architecture
was felt, so Transmission Control Protocol/Internet Protocol (TCP/IP) came into
existence. Then NCP was used as a device driver and TCP/IP protocol was used
as a communication protocol. But there were certain issues, such as unique
addressing for each resource, that were available on the Internet, multiple packet
sending, gateways and router configuration, flow control and error control of data
and interfacing on various operating systems.

In 1988, Internet was commercialized. First mail service for this network
was MCI mail. Certain commercial Internet service providers (ISPs), such as
UUNET PSINET and CERNET entered the market. TCP/IP became the most
popular amongst all because of its ability to work with any pre-existing networks
which allowed the Internet to grow with a high speed.

5.3 GROWTH OF WWW

The World Wide Web (WWW) was developed by Tim Berners-Lee of the
European Particle Physics Lab in Switzerland in 1989. The Web was initially
conceptualized to help networked files to be communicated among its various
members located in different parts of the world. Gradually, it became popular and
the public also started using the World Wide Web. People started using the features
of Web like hypertext, graphics, video and sound. Since then, there has been no
looking back. The utility of the Web has significantly increased. With its ever
increasing capabilities, the Web today has become a signature element of people
in an exponentially short span of time.
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Nowadays, the Web is a distributed client and server technology, in which
a client with the help of the ‘browser’ is able to  access the Web pages and other
services from the server. The Web, today, consists the following:

 A personal desktop or any other device with processing capabilities like
mobile devices, GPRS devices, etc.

 Web browser software to access and interact with the Web

 An ISP (Internet Service Provider) connectivity

 Servers which have Web pages/information resources hosted on them

 Routers, switches, gateways, bridges, etc. to handle and direct the flow of
data

Figure 5.1  shows the process of accessing the Web page of a Website.
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Fig. 5.1  Overview of WWW

CLIENT (Web Browser)

The plethora of information resources like text, images, videos, links to other Web
pages, etc. on the World Wide Web can be traced, retrieved and presented with
the help of a Web browser. The most popular Web browsers available worldwide
are Internet Explorer and Netscape Navigator, along with many upcoming and
promising ones like Mozilla Firefox, Google Chrome, Apple Safari, Opera
Software, ASA Opera, etc.

A Web browser starts the process of retrieving the information resource
when the user (client) inputs a Uniform Resource Identifier (URI) or a Uniform
Resource Locator (URL)  in the browser address bar or clicks a hyperlink which
points to some other URL on the Web. The request is sent to the Web server
which hosts the desired Web content. The Web server then sends the desired
Web pages back to the client and the browser on the client machine interprets it
and displays it on the screen. The address bar of your browser contains the URL
of the Web page that you have opened after sending the request for the same.
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Web Server

Web servers are software programs running on computers or virtual machines
which serve and give access to Web pages (primarily using HTTP) requested by
the clients. The Web server stores the Web pages and sends them to the client in
HTML (HyperText Markup Language) when the client requests for them. When
the user (client) inputs an URI or an URL in the browser address bar or clicks a
hyperlink which points to some other URL on the Web, the server responds back
by sending the requested Web page or an appropriate message if it is unable to do
so. Also, a server performs multithreading and multiprocessing functions to suffice
multiple requests of clients at a time.

The popular Web servers are Apache’s HTTP server, Microsoft’s Internet
Information Services (IIS), Sun Java System Web server, etc. The World Wide
Web Consortium (W3C) regulates the developments of additional HTTP or HTML,
XML etc. through their standardization process all over the world.

When a client Web browser connects to the Internet, the client terminal is
assigned a unique IP (Internet Protocol) address by its ISP (Internet Service
Provider) which helps in its unique identification over the Internet. When the request
for a particular Web page reaches the destination Web server, the requested Web
page in HTML is sent back to the client through the network. The client, upon
receiving the HTML code, interprets it with the help of its Web browser and
displays the Web page on the client screen.

Various features of Web servers are as follows:

 Virtual hosting: A single IP address can be used to host multiple Websites.

 Variable and large file support: The size of HTML files may vary from
KB to GB and the server should be able to support them.

 Bandwidth congestion: Over-saturation and under-saturation of the
network should be avoided at any cost.

 Server side scripting: Dynamic Web pages require the Web server to
have scripting capabilities. .

Web Documents

The Web pages handled over the Web can be classified into the following categories:

1. Static Web pages: They are fixed documents that are maintained by the
server. The client only gets a read-only copy of these documents.

2. Dynamic Web pages: When a request for a dynamic Web page comes to
the server from the client, it runs an application program or a script that
creates the document dynamically at that time. Because a fresh document is
created for each request, the versions of the same Web page may vary with
different requests. CGI, JavaScript, etc. are used for dynamic Web pages.
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5.3.1 Web Administration

In today’s world of excessive internet penetration, websites have become more
popular than ever. Whether it is a small business or a multinational company, artist
or a service provider, everyone aspires to have their own dedicated website to
reach masses. Unlike past centuries, it has become very easy to create websites.
But with having websites, comes the responsibility of its administration. The
phenomenon of web administration can be defined as the process of maintaining a
website and ensuring its smooth running and loading. Efficiency of this process
leads to a seamless user experience. The main components of Web Administration
are:

1. Managing hosting & Web Servers: A completed website gets accessible
to viewers only if it is hosted properly. The installation and configuration of
web servers is an essential part of web administration, without which no
website can run smoothly. It is the responsibility of web administrator(s) to
keep the server side up and running with the latest patches. An efficient web
administration ensures a flawless loading and hosting of websites on web
servers. It also prevents technological glitches like slow loading or broken
pages while reaching viewers.

2. Maintaining Content: Whatever data or content you see on a website, it
gets there because of content management system. Web administrators run
content management systems for easy addition and management of content
on your website. Listing of contents, configuration of volume, categorization,
tagging and archiving permissions are the basic functions involved in managing
content. Keeping up-to-date software for your content management save
hours of hard work and productivity.

3. User Accounts Access: While running a website, a system administrator
keeps a check on the number of user accounts associated to a website.
Creating accounts and managing them is a task of great responsibility because
it directly impacts user experience. It is usually an automated process but
demands a prompt human intervention at the time of a glitch or crisis. A
smooth system administration ensures relevant access of content to the user
accounts associated to a website.

4. Uptight Web Security: The security of the content of a website is of utmost
importance. Checking and resolving for vulnerabilities saves a website from
unwanted hacking and phishing. Hackers around the world constantly attack
websites looking for the loopholes to hack them. An uptight security is one
of the most crucial aspects of maintaining a website. Keeping a website
safe is challenging and vital for all owners across the world irrespective of
the country, place or region one belongs to.
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5.3.2 Commerce and Publishing through New Media

The world of internet is witnessing a shift of approach when it comes to commerce.
Publishing content through new media is the trend of today. The reinvention of
commerce and publishing has paved way to exploring unconventional and new
media. The digital publication is unfolding new methods of generating versatile
revenue channels. The business models today are more flexible and are able to
accommodate innovative approaches to publish data. While the mobile and social
media publishing is on the rise and will possibly be on the peak for the decades to
come, internet is becoming the creative hub for publishers.

5.3.3 Media Convergence

The phenomenon of mixing of various mass communication mediums is known as
Media Convergence. Mediums as different as print, digital, TV, radio, magazines,
social media together converge to cater to the requirements of audience.

1. The blend is the trend: Gone are the days when one form of media used
to have a monopoly. Today the interactive technologies along with the
modern devices are leading to the newest form of media formats like vlogs
etc. The blend of technologies is helping to serve the content to its audience
in a more fresh way than ever.

2. Highly Personalized: The media convergence has largely helped the content
curators, hosts as well as the audience to reach more personalized content
from the huge pool of generic information. Now one can pick the content
they wish to consume by filtering it on the basis of inclination, preferences
and relevance.

3. All the more entertaining: Since the media convergence makes use of
the most heterogeneous combination of mediums, it is proven to be visually
more appealing. The aesthetics from various mediums contribute to make
the final product more interesting and attractive to masses.

Check Your Progress

1. What is network control protocol?

2. Define media convergence.

5.4 ANSWERS TO CHECK YOUR PROGRESS
QUESTIONS

1. Network Control Protocol (NCP) was the main protocol that was used for
transferring the data. But this protocol could only be used for transferring
the data on the same network.
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2. The phenomenon of mixing of various mass communication mediums is
known as Media Convergence.

5.5 SUMMARY

 Network Control Protocol (NCP) was the main protocol that was used for
transferring the data. But this protocol could only be used for transferring
the data on the same network. NCP and Interface Message Processor
(IMP) lacked an error control mechanism.

 The World Wide Web (WWW) was developed by Tim Berners-Lee of the
European Particle Physics Lab in Switzerland in 1989.

 Web servers are software programs running on computers or virtual machines
which serve and give access to Web pages (primarily using HTTP) requested
by the clients.

 The popular Web servers are Apache’s HTTP server, Microsoft’s Internet
Information Services (IIS), Sun Java System Web server, etc.

 The phenomenon of web administration can be defined as the process of
maintaining a website and ensuring its smooth running and loading.

 The phenomenon of mixing of various mass communication mediums is
known as Media Convergence. Mediums as different as print, digital, TV,
radio, magazines, social media together converge to cater to the requirements
of audience.

5.6 KEY WORDS

 Web Browser: It refers to a software application that is used for retrieving,
presenting and traversing information resources on the Internet.

 URL: It is defined as the global address of documents and other resources
on the World Wide Web.

 Web Servers: These are software programs running on computers or virtual
machines which serve and give access to Web pages (primarily using HTTP)
requested by the clients.

5.7 SELF ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. Write a note on client and web server.

2. Discuss the various features of web servers.
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Long-Answer Questions

1. Write a detailed note on growth of WWW.

2. What do you understand by web administration?

3. Explain the term media convergence.

5.8 FURTHER READINGS
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6.0 INTRODUCTION

In this unit, you will learn about the web pages and navigating a website. Using a
Web browser, one can view Web pages that may contain text, images, videos and
other multimedia and navigate between them via hyperlinks. A Web browser is a
software application for retrieving, presenting and traversing information resources
on the WWW. An information resource is identified by a uniform resource identifier.
A Web page is arranged in terms of document (style sheets, scripts and images) or
information resource that is suitable for the WWW. A Website, a collection of
related Web pages containing images, videos or other digital formats, is hosted on
at least one Web server accessible via a network through an Internet address
known as URL.

6.1 OBJECTIVES

After going through this unit, you will be able to:

 Describe the importance of Web page

 Discuss the important guidelines to create a home page

 Define the website

 Discuss the different types of website

 Describe the significance of URL

6.2 WEB PAGES AND WEBSITE

The WWW is a subset of the Internet and comprises of a huge collection of
documents stored in computers across the world. The Web encompasses special
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sites called Websites along the Internet, that support Web browsing. By clicking
on the links that appear on the Web page, one can navigate from one place to
another. Hence, Webpage can be defined as a single hypertext document written
in HyperText Markup Language (HTML) and described in HTML basics. A Web
page normally incorporates the basic information and links to navigate in the
Websites to which it belongs. Documents in the World Wide Web are classified
into three types, namely static, dynamic and active documents.

Static Webpage

These are fixed content documents which perpetually provide the same information
in response to all download requests from all Web users. Static documents are
stored in a Web server to be accessed by the Web client. The Web client, on
requesting for a Web page, gets a copy of the same. The contents of such files are
not subject to modification on part of the Web user as the Web user does not have
right to alter them. However, the Web pages can be modified in the server per say.
Thus, the static Web pages display the same information to all the Web users and
provide hypertext links to perform navigation through static documents. Their
biggest advantage is that they are cache friendly. This enables the Web pages to
display one copy of the same Web page to many people simultaneously.  However,
it becomes difficult to maintain Web pages in case of large sites as they demand
consistency and updation.

Dynamic Webpage

These Web pages provide interactive Web navigation and help modify the content
like text, images, form fields, etc., on a Web page, depending on different contexts
or conditions. The dynamic Web pages make use of two types of inter-activities,
which are as follows:

 Client side scripting - It is used to modify interface behaviours within a
specific Web page. This modification is based on the mouse or keyboard
actions and is conducted at specified time intervals. The dynamic behaviour
takes place within the presentation. The presentation technologies like
JavaScript or ActionScript for Dynamic HTML (DHTML) and Flash for
media types of the presentation are used. The client side scripting also
facilitates the use of remote scripting in which the DHTML page requests
for additional information from the server. The content is generated on the
Web client’s machine in which the Web browser retrieves a page from the
server and processes the code embedded in the Web page, so that the
contents of the retrieved page can be displayed to the Web user. Sometimes,
the Web browsers do not support the language and the commands of the
scripting language, in the client-side dynamic pages.

 Server Side Scripting - It is used to modify the requested Web page
source amongst pages to either adjust the sequence or reload the Web
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conditions like data in a posted HTML form, parameters in the URL, the
type of browser being used, the passage of time or a database or server
state. Server side scripting dynamic Web pages are designed with the help
of server-side languages like PHP, Perl, ASP, JSP, etc.

Both the techniques may be used simultaneously to develop the dynamic
Web pages. The advantages of dynamic Web pages are that these facilitate easy
update of the Web pages and faster Web page loading. In the dynamic Web
pages, the content and the design are located separately, thereby allowing frequent
modifications to the Web pages including the text and image updates.

Active Documents

The programs that run at the client side are known as the active documents.
Whenever a Web client requests for an active document, the Web server provides
a copy of the same in the form of byte code. The document is now ready to be run
at the Web client machine. As the active document is served in the binary form,
compression and decompression can be applied at the server and the client side
to reduce the bandwidth requirement and throughput.

6.2.1 Home Page

Home page is known as the first page of the Web page. It is replete with a myriad
of hyperlinks on its page. Creation of a home page connotes creating and launching
of the Website. This is a consequential  task which is accomplished by arranging the
Website hosting, designing and coding of the Website, monitoring the functioning of
the site and by scrutinizing the Website traffic. Creating the Website takes into
consideration, various factors which are to be implemented on the page. Launching
the Website is an important operation. This requires information pertaining to name,
phone, URL description as well as the domain details. It should be ensured that the
Website must be kept in the right direction. A comprehensive user’s guide that
conveys the relevant information of the Website, must be provided to the user. This
can be done after successfully launching the Website. The more accurate the details
are, the better the results would be. The task of launching the Website can be
carried out in the local listing of Google and Yahoo. This optimizes the search engine
facilities for your Website, which offers moderate list of options, searchable information
and the third party data providers, such as SuperPages, YellowPages, CitySearches,
etc. These search engines provide a great facility to recite the name of your Website.
Such search engines also offer a free Jumpstart program in which you can enter
you Website domain area, avail the ‘WAY’ (Who You Are) facility, get reviews and
list hours, etc. There are many factors that determine the success of a Website on
the Internet. The following factors should be taken into consideration while creating
and launching a Website:

 Message Board: It is a type of forum through which visitors of the Website
interact with the site to enhance its popularity.
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 Search Engine: This is a valuable retention tool which helps visitors  search
for relevant information, provided the site is enlisted with a  famous search
engine.

 Polls: This option on the Website enables the visitors to vote as per their
satisfaction. For instance, the users can assess the performance of the Web
services by giving their feedback with the help of the feedback option.

 Guestbooks: This Website facility helps the users contact the organization
for which the particular site is created. Through this facility, the Website
visitors can enter their name, e-mail, comments and suggestions. Once this
information reaches the organization, the respective executive of the
organization contacts the visitors.

 Data Entry Forms: Through this option, the Website visitors can place orders
and can also provide request information. Data entry forms also facilitate
storing of customer service data, which is later entered into a computerized
database or spreadsheet by the organization.

Fig. 6.1 Data Entry Form for Customer Record

Figure 6.1 depicts the data entry form for customer record that provides
various text fields, submit buttons, links to navigate to another page, combo boxes,
etc. If you click on the link Add another customer record? as specified in Figure 6.1,
it will provide another set of customer record fields to fill the detail of customer
information.
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Creation of a  home page requires eight steps which are as follows:

1. Select and Register a Web Page Domain Name

First select a suitable Website domain name to monitor the conflict issues of
the same. Once a domain name is allotted to an organization or an individual,
it can not be further allotted to anyone. The registration of domain name is
unique and is carried out by Internet Corporation for Assigned Names and
Numbers (ICANN), which is an accredited domain name registrar, such as
abc.com, xyz.com, etc. The free Website hosting service is also available
that can be availed without registering a domain name. The search engine
does not provide its services if any Website lacks its registered domain name.

2. Select and Configure a Website Hosting Service

The hosting cost of Website ranges from $100 to $250 every year. The cost
varies from one Website to another, depending on the Websites’ features,
such as e-commerce facilities, special processing requirements, high traffic
volume options, etc. At this stage, Web hosting is checked for control over
content, security and usage of the site.

3. Design, Code and Test the Website

A static Website comprises of a single Web page. It must have ‘index.html’
or ‘index.htm’. A bare-bone format of the Web page, which constitutes the
HTML code, is as follows:

   <HTML>

     <BODY> Hello Web! </BODY>

  </HTML>

There are various types of software tools, such as Adobe Photoshop, Microsoft
FrontPage, etc.

4. Deploy the Website to the Host

At this stage, the file transfer program is uploaded in order to download the
Website. It also updates the pages between system units and Website host
computer.

5. Security and Authentication

Before launching a Website on the Internet, it is essential to implement the
security and full-proof authentication of the site. The following security methods
are required for the same:
 Login pages should be encrypted.
 Data validation should be conducted in the server-side.
 Managing the Website with the help of encrypted connections.
 Website must be connected from secured network.
 Login credentials must not be shared.
 Maintaining a Password and key authentication.
 Use redundancy to protect the Website.
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After accomplishing the authentication only SSL is used with http://URL.
The login form POST is encrypted after every login process. The JavaScript
is used for validating the Web forms. The server side validation safeguards
from malicious security crackers but in a limited way. The Website must be
equipped with encrypted connections because non-encrypted connections make
the Website susceptible to login or password sniffing or even man-in-middle-
attacks. Screen below displays the setup of login screen.

A secured connection must be associated with Website and also secured
proxy server must be used, such as PuTTY secure proxy or OpenSSHproxy.
In order to maintain secure workstation, integrity auditing must be conducted.
The server failover and backups should also be deployed as they diminish the
possibility of server crashes. Data backup is also important in so far that it
safeguards from loosing the client’s data.

6. Online Payment Mode

Before launching any Website, it is essential to set up an online payment
mode, which is provided to the Website. A Website must be equipped with
facilities like payment through credit cards or  by a third-party, such as PayPal,
etc.

Other factors that should be considered while launching a Website are
following:
 A Website is launched with the help of File Protocol Program (FTP). It is

an economical option. The owner of Website must instruct the Web
designer and the system analysts to implement FTP before the launch of
the Website.

 The Web host firm place on the server must be provided on the site. For
example, site owner provides the disk to the Web host firm so that they
can set up fee for the site.

 It is incumbent upon the owner of the Website to remove the ‘teething’
problem before launching the Website. Incoherent or incomplete Website
can discourage the visitors. For example, if an organization provides e-
commerce services, it must ensure that up to date and relevant information
is available on its site.  The teething problem may lead to problem of set
up and layout of the Web screen.

A Websites is written in HTML and is a collection of linked Web pages on a
Web server which can be electronically accessed. Web server is a machine
in which a Website is located or hosted. It may be organization owned or
Internet Service Provider (ISP) owned.  The Web pages may be owned by a
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Introduction to Websiteuniversity, a private company or an individual and are accessible to all people.
Most of the Websites have their own homepages that facilitate navigation by
providing links to explore the details stored therein. The pages of a good
Website are organized using a common theme.

7. Launching the Website

Launch of the site is carried out after designing and completion of the site. It
is essential to finalize the layout and style of the site before launching. It is
significant to note that before the launch of the Website, its domain should be
registered.

8. Promote the Website

The information is sent on the Web through search engines and their related
directories. The promotion scheme must be published on the Website at regular
intervals. Therefore, this factor must be considered during creation of the
Website. The optimal way to promote the Website is to update the visitors on
the specific Website with the pertinent information.  For example, in case of
online air ticket booking systems, any promotional scheme such as shifting
the seat arrangement from economic to business class or changing the flight
schedules etc. must be updated online to intimate the travellers and the visitors
about the same.

It provides a point of entry to a Website with help. It also contains all relevant
links of a particular Website, so as to enable the user to explore the Website for

information available therein.

6.2.2 Website

A Website is a collection of related Web pages containing images, videos or other
digital files. It is hosted on at least one Web server, accessible via a network, such
as the Internet or a private local area network through an Internet address known
as a Uniform Resource Locator or URL. A Web page is a document written in
plain text and interspersed with formatting instructions of HyperText Markup
Language or HTML, eXtensible HyperText Markup Language or XHTML. A
Web page may incorporate elements from other Websites with suitable markup
anchors. The user’s application, often a Web browser, renders the page content
according to its HTML markup instructions onto display terminal. The pages of a
Website can usually be accessed from simple URL called the home page. Active
documents are sometimes referred to as client-site dynamic documents. Active
documents can be created in following ways:

 Java Applets, programs written in Java on the server, are compiled and
ready to run. The browser creates an instance of this applet and runs it.

 JavaScript is interpreted and run by the client at the same time. The script is
in the source code.
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Static and dynamic Websites are the types of Websites which are discussed below:

Static Web Sites

A static Website is one that has Web pages stored on the server in the format that
is sent to a client Web browser (see Figure 6.2). It is primarily coded in HTML.
This type of Website includes simple information about a company and its products
and services via text, photos, animations, audio and video and interactive menus
and navigation. This type of Website usually displays the same information to all
visitors.

Fig. 6.2 Layout of Static Web Sites

Dynamic Web Sites

A dynamic Website is one that changes or customizes itself frequently and
automatically based on certain criteria. Dynamic Websites can have two types of
dynamic activity: code and content. Dynamic code is invisible or behind the scenes
and dynamic content is visible or fully displayed. Figure 6.3 displays the layout of
dynamic Websites.

Fig. 6.3 Layout of Dynamic Web Sites

In Website, keywords are the words which are used to surf the corresponding
information regarding Web page content. Keywords are important because it allows
your customers to find your Web page when they search the Internet. Bounce
rates can be used in determining the effectiveness or performance of an entry page
of Website. An entry page with a low bounce rate means that the page effectively
causes visitors to view more pages. Google Analytics is a free service offered by
Google that generates detailed statistics about the visitors to a Website. Google
Sites is a free and easy way to create and share Web pages.
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The WWW was originally designed as a stateless entity. A client sends a request;
a server responds. In Figure 6.4, Registrar is the company of domain name. Web
address, such as ‘www.yourdomain.com’ hosting company represents the company
where files, data and information is kept for a specific Website (refer Figure).
Web designer represents the development team who create the Website (Web
pages, scripts, page layout and graphics) whereas Internet (connecting all the
Web servers across the Internet).

Fig. 6.4 Architecture of Web Site

Navigation Theory and Web Site

Navigation theory and practice for Web designing represents some prime and
specific factors. These factors are known as link, URL, bookmarks and HTML
tags. The site maps and Three Dimensional or 3-D visualizations come to the
hypertext navigation which provides complete information that can be availed by
the users if they click on address bar by selected phrases or keywords. In fact,
links are to be considered as the best possible way to practice the navigation
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theory. Basically, navigation can be defined by the HTML tags that let users to
jump from one page to another page. The site is divided into content areas in
which navigation theory provides to the users to access each of the content
frequently. The main benefit of this technique is incorporated into the navigation
into a paragraph text and hypertext links. The navigation practice is preferred to
the Website because of the following reasons:

 This mechanism provides users a rough idea of the scope of the desired
Website.

 This mechanism sometimes referred to fallback mechanism in high-traffic
across network so that if users try to access the searched information the
required information can come frequently.

 This mechanism reduces the garbage information if users collect and merge
the information.

 It provides always a Home menu that describes the whole information about
the created Website.

 This mechanism saves the time of users by providing the regular links.

Site tagged with navigational systems are logically hyperlinked so that users hover
the mouse on the image link or click on the text must be intuitive and clear for
them.

Page Layout of Proposed Web Site

The Website template provides a page layout for practicing the navigation theory.
Most of the page layout is required for the multimedia applications and navigation
link, for example, a header, a left column with the navigation, a right column with
the main content and footer as shown below.

The content and navigation are ensured suitable page footer in two ways, such as
using the styles in Cascading Style Sheets or CSS and tables. CSS is a style sheet
language used to describe the presentation semantics (the look and formatting) of
a document written in a markup language. The most common application is to
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applied to any kind of eXtensible Markup Language or XML document, including
plain XML, Scalable Vector Graphics or SVG and XML User Interface Language
or XUL. The CSS ensures a suitable page header and below that navigation is set
in the left side column as shown above. A primary navigation must be always clear,
structured and intuitive. It holds at least 4 to 15 links in which group of 4 to 5 links
are enclosed at a time along with headings so that navigation bar perform fast task
after scanning or clicking. The secondary navigation keeps the common place
links, such as Contact, About Us, Site Map, Home and copyright information.
Links between the pages of the Websites are considered as sure and certain way
to tie the multiple pages together. Some of the features, such as ‘Link Back to
Your Homepage’ is always considered as essential link because the home page is
considered as central hub which is used to connect almost all the navigational
links, ‘breadcrumb trail’ shows frequently the row of links which represents the
how the Website is structured whereas ‘Page jumps’ represents the link of sections
in a single page. In ‘Page jumps’ format, a long page is maintained so that user can
reach easily to required bookmark. A ‘site map’ is also prominent mechanism
which links to all the pages to the homepage links.

Navigating the Web

Navigating the Web means moving one Web page to other. Web page is designed
generally in that way in which whole information might come within a page. Generally
Web page is aligned on the left side. The purposes of navigating the Web are as
follows:

 It presents visitors along with most user friendly path so that they can get
quick information via requested page.

 It endures visitors know the location of site for example, frequent users.

 It allows visitors to move quickly on logically arranged pages.

 It gives visitors suitable context of the document which users get.

 It highlights the classification of organization that has to be promoted.

Features of navigation used in navigating the Web pages in proposed Website are
as follows:

 Central Navigation: This part contains main body of information. For
example, Google: ‘Search engine, Web and Protocol’, etc., is treated as
central navigation.

 Global Navigation: It contains hyperlinks which provide flexibility of accessing
almost every page linked on the site, such as Contact us, Home, etc.

 Feature Navigation: It provides attractive content on site for example,
promotion scheme feature or breaking news, etc.

 Content Navigation: It occurs on specific document. If one document
refers to other document, a link is made.
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 Drop-Down Navigation: It delivers drop-down menu and used as a space
saver.

 URL Navigation: This represents an address of requested page consisting
communication protocol. This address is followed by colon and two slashes.
An example of URL is ‘http://’. The full URL alerts you the URL structure.

 Text Links: These links are underlined by different color rather than text.
If the image or graphics is hyperlinked, the moving cursor around it showing
the address of site. The arrow cursor takes a shape of hand. URL is appeared
in the status bar at the lower left position in the browser.

Links

Links appeared on Web page that navigates the corresponding Web pages as a
reference. If user navigates the pages to search or get the information through links
that is also called in Web technology as hyperlink provides a very quick journey of
Web pages. Link is same as citation in literature. It is of two types known as text
link and image link. Text link provides a string-based link to users. If users click on
the anchored link or clickable text, they can easily get the required information
which reside on the specific link.

In the above link, the customer service URL is made as text link. It will provide the
information of Website which is specified as a Web address as shown in screen
below.

Types of Web Site

The types of Website are as follows:

 Commercial Web Site: Commercial Website especially in B2B or
Business-to- Business) but increasingly in B2C or Business-to-Consumer
when people want information about your business, your products or services
as they expect to get that information from your Website. The purpose of
this type of Website is to sell products or services. Commercial Websites
are used for promoting a business or service and are among the most
common type of Website on the Internet. The Internet address often ends
with ‘.com’. Commercial Websites operate as online businesses.

 Personal Web Site: The purpose of this type of Website is to provide
information about an individual or group. This type of Website contains
information or any content that the individual wishes to include.

 Organizational Web Site: The purpose of this type of Website is to support
an individual’s opinion or a group’s point of view. The organizational Website
is communicated with each other usually by chat or message boards. The
Internet address often ends with ‘.org’.



NOTES

Self-Instructional
Material 181

Introduction to Website Educational Web Site: The purpose of this type of Website is to provide
information about an educational establishment or to present information in
an educational manner. The Internet address ends in ‘.edu’.

 Entertainment Web Site: The purpose of this type of Website is to entertain
and provide amusement. The Internet address often ends with ‘.com’.

 News Web Site: The purpose of this type of Website is to provide
information about current events dedicated to dispensing news and
commentary. The Internet address often ends with ‘.com’.

 Hybrid Web Site: Many Websites are a mixture of types. For example, a
business Website may promote the businesses products, but may also host
informative documents, such as white papers or provide news for the visitors.
There are also numerous sub-categories to the ones listed above. For
example, there would be a hobby site where the Webmaster shares their
knowledge with other likeminded individuals and through forums or chat
rooms create a dialogue with them.

 Dynamic Web Sites: Dynamic Websites allow you to make your own
changes to one or more sections of your Website from an Internet
connection on any computer worldwide. Through a password protected
administrative area, you can easily add, edit or delete content, pictures and
links. Changes appear on the Website immediately.  Dynamic Websites
communicate with a database that pulls content into the page when a link is
clicked. This is the preferred application for e-commerce, membership sites,
event calendars, mailing lists and sites where frequent changes are needed.

 E-Commerce Websites: E-commerce has exploded across the business
world like few other technological developments in history. While a standard
store front serves pass-by traffic and a certain geographic area with overhead
costs and staffing requirements and only during business hours, an online
store is open 24×7 for 365 days a year and a potential customer base of
millions. It accepts credit card payments, have a catalogue of your products
available online, process orders automatically, increase the visibility of your
brand, track shipments and market your company to the far reaches of the
WWW that means to your business.
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 Real Estate Websites: These Websites help to sell the residential property
or several commercial office blocks.

 Non-Profit Websites: It is being offered on the Web server for all non-
profit organizations our Web design services at an incredible discount of
approximately 30 or 40 per cent the normal rate. It could be a charity
organization, a public service group or a small business.

 Blog: A Website that is used to log online readings or to post online diaries
may include discussion forums or chat rooms. The Internet address has a
variety of endings. A blog is a type of Website or part of a Website supposed
to be updated with new content from time to time. Blogs are usually
maintained by an individual with regular entries of commentary, descriptions
of events or other material, such as graphics or video.

Web Site Architecture

The layout and design framework of a Website and each of its pages describe
collectively to the Website architecture. The relationship between each page and
the whole Website as well as the relationship between each page and every other
page is the primary consideration when designing a Website from an architectural
standpoint. How both content and navigation are positioned on each of the pages
is also an extremely important consideration both for the end-users visiting the site
and for search engine optimization. Figure 6.5 displays the building blocks and
architecture of successful Website. The architecture is divided into five layers which
are Impact Layer, Surface layer, Persuasion Layer, Value Creation Layer and
Management Layer. In Impact layer, the key success indicators are trust and
credibility, branding and image, user experience, loyalty and retention and
conversion rates. Surface layer deals Home page, landing pages, navigation layout
and content information architecture. The features of successful Web page, such
as marketing and promotion personas, buying behavoiurs/motivations, conversion
funnels and persuasion strategies are designed in Persuasion layer. In Value Creation
layer, relationship building optimization strategies, pricing offer and positioning
competitive intelligence are designed whereas iterative management, tracking and
measuring unique value proposition, strategic purposing goals and objectives are
designed in Management layer. Site identify, branding, content layout and design,
eye catching presentation of Websites are designed  in two layers, such as Surface
layer and Persuasion layer .
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Fig. 6.5 Building Blocks and Architecture of Successful Website

The basic Web architecture is characterized by two-tiered services in which Web
client gets the information and Web server provides information to the client. The
Website architecture depends on key standards, such as HTML used for encoding
the content of document, Web browser is used to search the information, HTTP is
used for staging the transfer, Hypertext and Links is used the Motion of the Web,
pages on the Web (represents the layout of Web pages searched via various search
engines), URIs is used for naming the remote information objects to the global
namespace, CGI for three-tier architecture. The Common Gateway Interface or
CGI extends the architecture to three-tiers by adding a back-end server that provides
services to the Web server on behalf of the Web client, permitting dynamic
composition of Web pages.

URL

A Uniform Resource Locator or URL’s appearance, cookie preferences and default
home page are controlled by your browser settings. A URL is a protocol that is
used to identify a Website. According to Web Developer Notes, a URL includes
the protocol (HTTP), host name (WWW), domain name and domain type. A
Web page’s appearance, cookie preferences and your default home page are
controlled by the browser settings. You can tell your Web browser how you want
to display content on a Web page or change the current settings.

URL Domain

You can implement new kinds of domains that provide certain features and
interpretation of a URL. This is the most flexible interface available to extend the
Web server. A callback mechanism is provided to invoke and handle every request
in a domain or subtree of the URL hierarchy. The callback interprets the URL
using routines from the Httpd module. Figure 6.6 displays a simple domain that
always returns the same page to every request. The URL domain is registered
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with the Url_PrefixInstall command. The arguments to Url_PrefixInstall are
the URL prefix and a callback that is called to handle all URLs that match is also
prefixed, for example all URLs that have the prefix /simple are dispatched to the
SimpleDomain procedure.

Fig. 6.6 URL Domain

The dotted box in Figure 6.6 represents one application that embeds TclHttpd.
Documents, Templates and Application Direct URLs provide direct connections
from an HTTP request to your application. TclHttpd is used both as a general
purpose Web server and as a framework for building server applications. It is
built into several commercial applications, such as license servers and mail spam
filters. It works on UNIX, Windows and Macintosh. Using TclHttpd, you can
have your own Web server up and running quickly.

URL Redirection

URL redirection, also called URL forwarding, is used on the WWW for making a
Web page available under many URLs. Convert long and complex URLs into
short ones to make more human friendly and convenient to use. These shorter
links are easier to use in e-mail, chat sessions or giving to someone over the
phone. Redirection URLs can be used to hide affiliate codes in a link. Screen
below displays the ‘Default Web Site Properties’ tab which provides radio button
as ‘A redirection to a URL’ for redirecting URL.
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The URL redirection service is also popular as URL redirecting, URL forwarding,
domain redirection and domain forwarding. In all of the cases it refers to one and
the same Web technique for pointing a Web page to another URL of your choice.
Table 6.1 summarizes the basic URL redirection types.

Table 6.1 Basic URL Redirection Types

Basic URL Redirection Types Function 
Permanent Redirection: 301   This URL redirection is used when the URL for a certain Web site has 

been changed for a long term period. Its main purpose is to 
automatically redirect any references to the outdated URL of a certain 
page to its new Web address.  

Temporary Redirection: 302 You will need a 302 redirection in cases when a certain URL has been 
changed to a different address temporarily. The 302 redirect instructs 
anyone trying to access a certain URL that it is temporarily 
unavailable and automatically send them to a new valid address. With 
the 302 redirection set, the owner asks users to continue using the new 
address until modified at a later time. 

Redirection: 303 In contrast to the 301 and 302 redirects, the 303 redirect is not used 
for making a substitute reference for the originally requested URL. Its 
main purpose is to redirect a certain URL request to another URL 
which is not a substitute of the originally requested source but a 
separate Web page. This redirect is often used by e-commerce stores 
for redirecting visitors to a ‘Thank you’ page after filling in an order 
page. 

Gone Status Code: 410 This redirection status is used when a certain Web page has been 
removed on purpose and the users need to be informed that its URL is 
permanently unavailable and no substitute reference is necessary for 
it. Thus, all incoming request to this URL will receive a response that 
the requested page does not exist anymore. 

 
URL denotes Uniform Resource Locator. It is the address of a document on the
World Wide Web. Web browsers enable a person to enter either a known address in
the Web server or a specific document within that server. Addresses usually begin
with http://, ftp://, gopher://, WAIS://, file:// etc. It is not feasible to maintain WWW
without using the URLs. These are also used to represent hypermedia links and
links to network services within the HTML documents. Any file or service on the
Internet can be presented with the help of the URL. The first part of the URL that
comes before the two slashes specifies the method of access or protocol being
followed for communications between the browser and the Web server. The second
part after two slashes represents the address of the host machine, whose data or
services are being sought. The remaining parts signify the names of the files, the
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port to connect to or the text to search for in a database. All the parts of an address
for obtaining a file or service from a host machine in a URL are shown as a single
unbroken line with no spaces and the locations of the host machines or Websites
that run WWW servers are typically named with a WWW at the beginning of the
network address. The Web browsers enable the users to access Web services by
specifying a URL and connecting to that document or service. Once the user gets
connected with the Web server, the Web browsers select the hypertext in an HTML
document and send a request to open a URL. Thus, hyperlinks are used not only to
provide other texts and media in the same document but also to facilitate other
network services. Web browsers are not simply Web clients. They are full-featured
FTP, Gopher and telnet clients.

Check Your Progress

1. What are the different types of WWW documents?

2. What is home page?

3. What is URL redirection?

6.3 ANSWERS TO CHECK YOUR PROGRESS
QUESTIONS

1. Documents in the World Wide Web are classified into three types, namely
static, dynamic and active documents.

2. Home page is known as the first page of the Web page. It is replete with a
myriad of hyperlinks on its page.

3. URL redirection, also called URL forwarding, is used on the WWW for
making a Web page available under many URLs.

6.4 SUMMARY

 The WWW is a subset of the Internet and comprises of a huge collection of
documents stored in computers across the world. The Web encompasses
special sites called Websites along the Internet that support Web browsing.

 These are fixed content documents which perpetually provide the same
information in response to all download requests from all Web users. Static
documents are stored in a Web server to be accessed by the Web client.

 These Web pages provide interactive Web navigation and help modify the
content like text, images, form fields, etc., on a Web page, depending on
different contexts or conditions.
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Introduction to Website Home page is known as the first page of the Web page. It is replete with a
myriad of hyperlinks on its page. Creation of a home page connotes creating
and launching of the Website.

 A Website is a collection of related Web pages containing images, videos
or other digital files. It is hosted on at least one Web server, accessible via
a network, such as the Internet or a private local area network through an
Internet address known as a Uniform Resource Locator or URL.

 A static Website is one that has Web pages stored on the server in the
format that is sent to a client Web browser. It is primarily coded in HTML.

 A dynamic Website is one that changes or customizes itself frequently and
automatically based on certain criteria. Dynamic Websites can have two
types of dynamic activity: code and content.

 A Uniform Resource Locator or URL’s appearance, cookie preferences
and default home page are controlled by your browser settings. A URL is a
protocol that is used to identify a Website.

 The layout and design framework of a Website and each of its pages describe
collectively to the Website architecture. The relationship between each page
and the whole Website as well as the relationship between each page and
every other page is the primary consideration when designing a Website
from an architectural standpoint.

6.5 KEY WORDS

 Web Page:A Web document uniquely identified by Uniform Resource
Location (URL).

 Home Page: The first page of the Web page which given the information
about the type of Website.

 URL Navigation: An address of requested page consisting communication
protocol.

6.6 SELF ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. Write a note on the following:

(i) Static Webpage

(ii) Dynamic Webpage

(iii) Active documents

(iv) Home page
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2. Define website and its types.

3. Write a short note on URL.

Long-Answer Questions

1. What are the factors that should be taken into consideration while creating
and launching a Website?

2. Write the steps for creating a home page.

3. Explain the different types of website.

4. Explain the architecture of a website.
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7.0 INTRODUCTION

A website is a page or collection of pages on the internet. It contains specific
information that is either provided by some person or entity and it traces back to
a common URL. Websites are used for a variety of purposes, from describing a
business, to sharing a portfolio, to share business ideas to describing government
policies and schemes. There are various types of websites and each one of these
relate back to a different objective. In this unit you will learn about websites, their
typical uses and features.

7.1 OBJECTIVES

After going through this unit, you will be able to:

 Understand websites and their features

 Discuss the types of websites

 Explain the tools for new media

7.2 FEATURES OF A WEBSITE

The following are the key elements of an effective Website:

1. Appearance

2. Content

3. Functionality

4. Website Usability

5. Search Engine Optimization
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The most effective Website will reflect best practices across all of these
elements.

1. Appearance

A site must be visually appealing, polished and professional. Remember, it is
reflecting your company, your products and your services. Your Website may be
the first, and only, impression a potential customer receives of your company.

An attractive site is far more likely to generate a positive impression and
keep visitors on your site once they arrive. As businesses large and small continue
to populate the Web, your challenge is to attract and keep users’ attention. Ideas
like this are what PR professionals pay attention to keep their businesses successful.

Guidelines for increasing appearance of Website are as follows:

 Good Use of Color: An appropriate color scheme will contain two or
three primary colors that blend well and create a proper mood or tone for
your business. Do not overdo the color, as it can distract from the written
content.

 Text that is Easily Read: The most easily read combination is black text
on a white background, but many other color combinations are acceptable
if the contrast is within an appropriate range. Use fonts that are easy to read
and are found on most of today’s computer systems. Depending on your
audience. Keep font size for paragraph text between 10 and 12 pts. 

 Meaningful Graphics: Graphics are important, as they lend visual variety
and appeal to an otherwise boring page of text. However, do not over-use
them, and make sure that add meaning or context to your written content.
Do not overload any one page with more than three or four images.

 Quality Photography: A simple way to increase visual appeal is to use
high quality photography. High quality product images are especially important
for online retailers.

 Simplicity: Keep it simple and allow for adequate white space. Uncluttered
layouts allow viewers to focus on your message. Do not overload your site
with overly complex design, animation, or other effects just to impress your
viewers.

2. Content

Along with style, your site must have substance. Remember that your audience is
looking for information that will help them make a decision, so it should be informative
and relevant. Use this opportunity to increase visitor confidence in your company’s
knowledge and competence.

Guidelines regarding content for an effective Website are as follows:

 Short and Organized Copy: Clearly label topics and break your text up
into small paragraphs. Do not bore your visitors with visually overwhelming
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text. You have got less than 10 seconds to hook your visitors, so grab their
attention by being clear, concise and compelling.

 Update Your Content Regularly: No one likes to read the same thing
over and over again. Dead or static content will not bring visitors back to
your site!

 Speak to Your Visitors: Use the word you as much as possible. Minimize
the use of me and us.

 Consider a Pro: Unless you are an especially good writer, consider using
a professional to write or edit your text content. A good writing resource
is How to write for the Web. But What about the Glitz?

Flashy graphics and animation are tempting, and can have a very positive
impact on user experience. Just use them appropriately and keep some simple
guidelines in mind. Use multimedia to entertain and enlighten your prospects. An
animated banner, snappy video or interactive content will add to your site’s ‘interest
quotient’ and keep your visitors around longer. But — do not force your visitors
to endure something they are not interested in or do not have time for, and do not
let the ‘rich media’ overwhelm your other content.

3. Functionality

Every component of your site should work quickly and correctly. Broken or poorly
constructed components will only leave your visitors frustrated and disillusioned
with your company. Across the spectrum, everything should work as expected,
including hyperlinks, contact forms, site search, event registration, and so on.

Error-free copy: Remember the exposure your Website will get. Double-
check your facts and figures, as you do not know who may be quoting you
tomorrow. Nor do you want to be recognized or remembered for typos, incorrect
grammar and punctuation or misspellings. Spelling mistakes and bad grammar are
as unforgivable on a Website as they are in other company materials.

4. Website Usability

A critical, but often overlooked component of a successful Website is its degree
of usability. Your site must be easy to read, navigate and understand. Some key
usability elements include:

 Simplicity: The best way to keep visitors glued to your site is through
valuable content, good organization and attractive design. Keep your site
simple and well organized. 

 Fast Loading Pages: A page should load in 20 seconds or less via dial-
up; at more than that otherwise you will lose more than half of your potential
visitors.

 Minimal Scroll: This is particularly important on the first page. Create
links from the main page to read more about a particular topic. Even the
search engines will reward you for this behavior.
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 Consistent Layout: Site layout is extremely important for usability. Use a
consistent layout and repeat certain elements throughout the site.

 Prominent, Logical Navigation: Place your menu items at the top of your
site or above the fold on either side. Limit your menu items to ten or fewer.
Remember, your visitors are in a hurry and do not make them hunt for
information. 

 Descriptive Link Text: Usability testing shows that long link text makes it
much easier for visitors to find their way around a site. Long, descriptive
link text is favored by search engines, too. Back links are important to give
users a sense of direction and to keep them from feeling lost. Use a site
map, and breadcrumbs, if necessary.

 Cross-Platform/Browser Compatibility: Different browsers often have
different rules for displaying content. At a minimum, you should test your
site in the latest versions of the Internet Explorer (currently, versions 8 and
9), as well as Firefox and Safari.

 Screen Resolution: Screen resolution for the typical computer monitor
continues to increase. Today, the average Web surfer uses a resolution of
1024 × 768 pixels. However, you need to make sure that what looks good
at this setting will also work nicely for other resolutions.

5. Search Engine Optimized (SEO)

There are hundreds of rules and guidelines for effective search engine optimization.
For starters, follow these simple rules:

 Include plenty of written content in HTML format. Do not use Flash,
JavaScript or image-only objects for your navigational items.

 Use your important keywords frequently and appropriately in your copy.

 Minimize the use of tables and use Cascading Style Sheets (CSS) for layout
and positioning; keep your HTML code clutter-free.

 Leverage your links — make them descriptive and use your keywords in
the link text.

Check Your Progress

1. What is the most appropriate and easily read color combination of text?

2. How many colors will an appropriate color scheme contain?

7.3 TOOLS FOR NEW MEDIA

As we discussed above while learning about the difference between the new media
and the traditional media, the channels in new media are Website, blogs, social
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media, electronic mail, mobile phones, tablets, search engines and video-
conferencing. We shall discuss these one by one in the following section:

Website

According to the free online dictionary, a Website is a set of interconnected Web
pages, usually including a homepage, generally located on the same server and
prepared and maintained as a collection of information by a person, group, or
organization.

Similarly the online encyclopedia called Wikipedia defines a Website as a
set of related Web pages served from a single Web domain. A Website is hosted
on at least one Web server, accessible via a network, such as the Internet or a
private local area network through an Internet address known as a Uniform
Resource Locator (URL). All publicly accessible Website collectively constitute
the World Wide Web.

A Web page is a document, typically written in plain text interspersed with
formatting instructions of HyperText Markup Language (HTML) eXtensible
HyperText Markup Language (XHTML). A Web page may incorporate elements
from other Website with suitable markup anchors.

Web pages are accessed and transported with the HyperText Transfer
Protocol (HTTP), which may optionally employ encryption (HTTP secure,
HTTPS) to provide security and privacy for the user of the Web page content.
The user’s application, often a Web browser, renders the page content according
to its HTML markup instructions onto a display terminal.

The pages of a Website can usually be accessed from a simple Uniform
Resource Locator (URL) called the Web address. The URLs of the pages organize
them into a hierarchy, although hyperlinking between them conveys the reader’s
perceived site structure and guides the reader’s navigation of the site which generally
includes a Home page with most of the links to the site’s Web content, and a
supplementary about, contact and link page.

Websites are also known as portals. As another portal called whatis.com
puts it, a Website is a related collection of World Wide Web (WWW) files that
includes a beginning file called a Home page. A company or an individual tells you
how to get to their Website by giving you the address of their Home page. From
the Home page, you can get to all the other pages on their site. For example, the
Website for Reliance Industries has the Home page address of http://
www.ril.com. (The Home page address actually includes a specific file name
like index.html but, as in ril’s case, when a standard default name is set up, users
do not have to enter the file name.) Ril’s Home page address leads to thousands of
pages. But a Website can also be just a few pages.
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Overview of Website

The term ‘Website’ is used to refer to a collection of related Web pages that
comprise images, videos or other digital assets. A Web server is used to host a
Website. The site can be accessed via a network that includes the Internet or a
private local area network. This connection is established by the means of an
Internet address or a Uniform Resource Locator (URL).

We use the HyperText Markup Language (HTML) eXtensible HyperText
Markup Language (XHTML) to create a Web page. It is a document that is
written in plain text interspersed by formatting instructions of the language. There
are several elements from other Website which may be incorporated into a Web
page. This can be done by using suitable mark-up anchors. The access and
transport of Web pages are done with the help of HyperText Transfer Protocol
(HTTP). This may also employ encryption (HTTP Secure, HTTPS) in order to
offer security and privacy for the users of the Web page. Web browser or a user’s
application provides the contents of the page as per HTML mark-up instructions
onto a display terminal. The URL helps in accessing the pages of a Website or the
homepage. A hierarchy is formed by the URLs of the pages. By hyperlinking, the
reader’s perceived site structure and navigation of the site is enabled. In some
Website, it is mandatory that one subscribes to it in order to access some or all of
their content. Examples of subscription Website include:

 Business Sites

 Parts of News Website

 Academic Journal Website

 Gaming Website

 File-Sharing Website

 Message Boards

 Web-Based E-Mail

 Social Networking Website

 Website Providing Real-Time Stock Market Data

 Website Providing Various Other Services

History

CERN (European Organization for Nuclear Research) physicist, Tim Berners-Lee,
created the World Wide Web (WWW) in 1990. The term, World Wide Web
(WWW), is used to denote all publicly accessible Website. On 30 April 1993,
CERN declared that WWW would be free to be used by anyone. Prior to the
HTML and HTTP era, other protocols, such as File Transfer Protocol (FTP) and
the gopher protocol, were used. They were employed to retrieve individual files
from a server. A user could navigate and choose the files to be downloaded by the
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protocols and their simple directory structure. It was possible to present documents
as plain text files without formatting or encoding them in word processor formats.

Categories

In terms of functions, a Website may be classified as follows:

 A Personal Website

 A Commercial Website

 A Government Website

 A Non-Profit organization Website

In other words, a Website can be regarded as the work of an individual, a
business or other organization. We can also dedicate it to some particular topic or
purpose. A Website may also incorporate a hyperlink to any other Website.

Due to this association, the difference between individual sites may sometimes
be blurred from the user’s perspective. Generally, Website are written in or
dynamically converted to HTML. Users can access them by means of a software
interface or as a user agent. It is possible to view Web pages or access them from
a range of computer-based and Internet-enabled devices. These devices come in
various sizes and include desktop computers, laptops, Personal Digital Assistants
(PDAs) and cell phones.

A HTTP server refers to a Website that is hosted on a computer system and
is also known as a Web server. Additionally, these terms can also be used to refer
to the software that runs on these systems. The software retrieves and delivers the
Web pages as per requests from the Website users. According to Netcraft, an
Internet services company, Apache is the most commonly used Web server
software. Microsoft’s Internet Information Services (IIS) is also commonly used.

Static Website

In a static Website, the Web pages are stored on the server in the format in which
it is sent to a client Web browser. The pages are primarily coded in HTML.

Some examples of these Websites include simple forms or marketing
examples like classic Website, a five-page Website or a brochure Website. These
Website offer pre-defined and static information to users. The contents include
information about a company, products and services, and are conveyed by means
of text, photos, animations, audio/video and interactive menus and navigation.

In this type of Website, the same information is visible to all visitors. This is
similar to handing out a printed brochure to customers or clients. A static Website
provides consistent and standardized data for an extended period of time. The
Website’s owner may update the site periodically. The owner may manually edit
the text, photos and content and also alter the basic Website design skills and
software. Thus, the ultimate authority of presenting a Web page lies with its owner
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and visitors have no right of access to the Website’s profile. They have to accept
the page as it appears at a point of time.

Dynamic Website

In a Dynamic Website, the content and the appearance may change or customize
frequently and automatically. These are dependent on certain criteria. Dynamic
Website can have two types of dynamic activity: code and content. The dynamic
code is invisible or located behind the scenes and dynamic content is visible or
fully displayed.

(i) Dynamic Code: In a Web page with dynamic code, the code is created
dynamically by means of active programming language. The plain, static
HTML is not used here. In this Website, dynamic code refers to its
construction or the way it is made, and refers to the code that is used to
create a single Web page. We can create a dynamic Web page by joining
certain blocks of code, procedures or routines. This Web page will consist
of several bits of information from a database. We can put them together in
a pre-defined format so that it can be presented to the reader as a coherent
page. The page will also communicate with users in diverse ways. Some
means include reading cookies by recognizing users’ previous history, session
variables, server side variables, etc., or by employing direct interaction,
such as form elements, mouse rover effect, etc. There can be instances like
a site can display the current state of a dialogue between users, track a
changing situation or offer inputs in personalized ways to suit the requirements
of the individual user.

(ii) Dynamic Content: Users can view the Website with dynamic content in
plain view. Depending on certain criteria, the variable content is displayed
dynamically on the fly. It is done so by retrieving the content stored in a
database. This kind of a Website is highly vibrant and its messages, text,
images and other information are transforming the look and feel of the page
at any given moment. The content of the Web page depends on either pre-
defined rules or variable user input. For example, a news based Website
can use a pre-defined rule and display news articles for a particular date. In
this case, the most recent news articles on any given date are dynamically
presented. Similarly, a retail Website has a database of media products and
permits users to feed search request for a keyword, for example ‘Beatles’.
The content of the Web page will change the way it looked before, and
display a list of Beatles’ products like CDs, DVDs and books in order to
cater to the user’s demands. Purpose of dynamic Website The primary
objective of a dynamic Website is automation. It is possible to operate a
dynamic Website more effectively and efficiently. It is easier to maintain,
update and expand, and simpler to build a template and a database. This is
easier than building hundreds or thousands of individual, static HTML Web
pages.
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Software Systems

ANSI C servlets, Java Server Pages (JSP), the PHP, Perl, Python and Ruby
programming languages, ASP.NET, Active Server Pages (ASP), YUMA and
ColdFusion Markup Language (CFML) are some software systems available.
These can generate dynamic Web systems and dynamic sites. It is also possible
for sites to include content retrieved from databases or by using XML-based
technologies, such as RSS (Really Simple Syndication).

We can also generate static content either periodically to avoid the
performance loss of initiating the dynamic engine on a per-user or per-connection
basis. The same can be said in case regeneration takes place.

There are plug-ins that helps to expand the features and abilities of Web
browsers. They also display active content or create rich Internet applications.
Examples of such plug-ins are Microsoft Silverlight, Adobe Flash, Adobe
Shockwave or applets written in Java. User interactivity and real-time element
updated within Web pages are offered by dynamic HTML. These pages need not
be loaded or reloaded to effect any changes. They make use of the Document
Object Model (DOM) and JavaScript. These elements are supported by most
modern Web browsers. It is a common practice for Web developers and Website
owners to convert a Website into source of income. There are two broad divisions
for creating a Website business, as defined below:

(i) Content-Based Sites: One way to attain revenues is by selling advertising
space either through direct sales or through an advertising network.

(ii) Product or Service Based Sites: It is possible to derive revenue by offering
products or services for sale. This is common in the case of ecommerce
Website. Here, the products or services may be purchased at the Website
by means of providing the details of credit card or other payment information
as required in a payment form on the site. Sometimes, Website acts as
secondary sources of income for the existing brick and mortar businesses.
The products on offer are made available for purchase on the Web
exclusively. Website makes use of these practices to derive income. In case
of an auction Website, for example, the Website may charge the users of its
auction service to list an auction. They may also put up third-party
advertisements on the site and this serves as an additional source of income.

Types of Website

Websites are either static or interactive. Interactive sites are a part of the Web 2.0
community of sites. They allow interactivity between the site owner and site visitors.
On the other hand, static sites do not allow engagement with the users but serve or
capture the information.

Each type of Website specializes in a particular type of content or use. We
can classify them in several ways. A few such classifications are as follows:
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1. Affiliates: This is a site which aims to sell a third party’s product.
The seller receives a commission for facilitating the sale.

2. Affiliate Agencies: This is an enabled portal that provides not only
its custom CMS (Content Management System) but also syndicated
content from other content providers for an agreed fee. There are
usually three relationship tiers. For example, Commission Junction,
advertisers like eBay and consumers like Yahoo!

3. Archive Sites: These sites are used to preserve valuable electronic
content threatened with extinction. Two examples are: Internet Archive,
which since 1996 has preserved billions of old (and new) Web pages
and Google Groups, which in early 2005 was archiving over
845,000,000 messages posted to Usenet News/Discussion Groups.

4. Attack Sites: These sites are created specifically to attack the
computers of the visitors on their first visit to a Website by downloading
a file (usually a Trojan horse). These Website rely on unsuspecting
users with poor antivirus protection in their computers.

5. Blogs (Web Logs): These sites are generally used to post online
diaries, which may include discussion forums (e.g., Blogger, Xanga).
Many bloggers use blogs like an editorial section of a newspaper to
express their ideas on anything ranging from politics to religion to video
games to parenting, along with anything in between. Some bloggers
are professional bloggers and they are paid to blog about a certain
subject. They are usually found on news sites.

6. Brand Building Sites: These sites are developed with the purpose
of creating an experience of a brand online. These sites usually do not
sell anything but focus on building the brand. Brand building sites are
most common for low-value, high-volume Fast Moving Consumer
Goods (FMCG).

7. Celebrity Website: In these Websites, information revolves around
a celebrity. These sites can be official (endorsed by the celebrity) or
fan made (run by his/her fan/ fans, without implicit endorsement).

8. Click-To-Donate Sites: These Website allow the visitor to donate
to charity simply by clicking on a button or answering a question
correctly. An advertiser usually donates to the charity for each correct
answer generated. For example, the Hunger Site, Freerice, Ripple
(charitable organization), etc.

9. Community Sites: This is a site where persons with similar interests
communicate with each other, usually by chat or message boards. For
example, Myspace, Facebook, Orkut, etc.

10. Content Sites: The business of these sites is the creation and
distribution of original content. For example, Slate, About.com, etc.
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11. Corporate Website: These Website are used to provide background
information about a business, organization or service.

12. Dating Website: These sites allow users to find people who are
interested in long-term relationships, dating or making friends only.
Many of them are pay per services, such as eHarmony and
Match.com, but there are many free or partially free dating sites. Most
dating sites today have the functionality of social networking Website.

13. Electronic Commerce (E-Commerce) Sites: These sites offer
goods and services for online sale and enabling online transactions for
such sales.

14. Forum Website: These are sites where people discuss various topics.

15. Government Sites: These sites are made by the local, state,
department or national government of a country. Usually these sites
also operate Websites that are intended to inform tourists or support
tourism. For example, Richmond.com is the Geodomain for Richmond,
Virginia.

16. Gripe Sites: These sites are devoted to the criticism of a person,
place, corporation, government or institution.

17. Gaming Website/Gambling Website: These sites allow users to
play online games. Some enable people to gamble online.

18. Humour Site: These sites satirize, parody or otherwise exist solely
to amuse.

19. Information Sites: Most Website could fit in this type of Website.
To some extent, many of them are not necessarily for commercial
purposes. For example, RateMyProfessors.com, Free Internet
Lexicon and Encyclopedia. Most government, educational and non-
profit institutions have an informational site.

20. Media Sharing Sites: These sites enable users to upload and view
media such as pictures, music and videos. For example, Flickr,
YouTube, PureVolume and Google Videos.

21. Mirror Sites: These sites are the replication of another Website. These
types of Website are used as a response to spikes in user visitors.
Mirror sites are most commonly used to provide multiple sources of
the same information, and are of particular value as a way of providing
reliable access to large downloads.

22. Microblog Sites: These sites are a short and simple form of blogging.
Microblogs are limited to certain amounts of characters and work
similar to a status update on Facebook. For example, Twitter.

23. News Sites: These sites are similar to an information site, but are
dedicated to dispensing news, politics and commentary. For example,
CNN.com.
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24. Personal Website: These Websites are about an individual or a small
group (such as, a family) that contains information or any content that
the individual wishes to include. Many personal homepages are rare,
thanks to the modern era of social networking sites, such as Myspace,
but some are still used for home businesses. This Website is different
from a celebrity Website, which can be very expensive and run by a
publicist or agency.

25. Phishing Sites: These Website are created to fraudulently acquire
sensitive information, such as passwords and credit card details, by
masquerading as a trustworthy person or business (such as, Social
Security Administration, PayPal) in an electronic communication.

26. P2P/Torrents Website: These Website index torrent files. These
types of Website are different from a BitTorrent Client which is usually
standalone software. For example, Mininova, The Pirate Bay.

27. Political Sites: These are sites on which people may voice political
views, show political humour, campaigning for elections, or show
information about a certain political party or ideology.

28. Porn Sites: These sites show sexually explicit content for enjoyment
and relaxation. They can be similar to a personal Website, a Website
of a porn actor/actress or a media sharing Website where user can
upload from their own sexually explicit material to movies made by
adult studios.

29. Question and Answer (Q&A) Sites: Answer site is a site where
people can ask questions and get answers. For example, Yahoo!,
Answers, Stack Exchange Network (including Stack Overflow), etc.

30. Rating Sites: These are sites on which people can praise or disparage
what is featured.

31. Religious Sites: These sites are one in which people may advertise
a place of worship, or provide inspiration or seek to encourage the
faith of a follower of that religion.

32. Review Sites: On these sites, people can post reviews for products
or services.

33. School Sites: These are sites on which teachers, students or
administrators can post information about current events at or involving
their school. The US elementary high school Website generally use
K12 in the URL.

34. Scraper Sites: These are sites which largely duplicate, without
permission, the content of another site, without actually pretending to
be that site, in order to capture some of that site’s traffic (especially
from search engines) and profit from advertising revenue or in other
ways.
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35. Search Engine Sites: These Website index material on the Internet
or an Intranet (and lately on traditional media, such as books and
newspapers) and provide links to information as a response to a query.
For example, Google Search, Bing, Goodsearch, Ecosia, etc.

36. Shock Sites: These sites include images or other material that are
intended to be offensive to most viewers. For example, Goatse.cx,
rotten.com.

37. Social Bookmarking Sites: These are sites where users share other
content from the Internet, and rate and comment on the content.
StumbleUpon and Digg are examples.

38. Social Networking Site: These are sites where users could
communicate with one another and share media, such as pictures,
videos, music, blogs, etc., with other users. These may include games
and Web applications, for example, Facebook, Orkut, etc.

39. Warez: These sites are designed to host or link to materials such as
music, movies and software for the user to download.

40. Webmail: These sites provide a Webmail service. For example,
Hotmail, Gmail, etc.

41. Web Portal: These sites provide a starting point or a gateway to
other resources on the Internet or an Intranet. For example, msn.com,
msnbc.com, yahoo.com, etc.

42. Wiki Site: This is a site on which users collaboratively (and sometimes
destructively) can edit its content. For example, Wikipedia, WikiHow,
etc.

We can classify some Website in one or more of these categories. For
example, it is possible that a business Website may promote the products of the
business and also contain information on documents, such as white papers. Similarly,
there are sub-categories to the ones listed earlier. For example, a porn site is a
specific type of e-commerce site or business site as it sells memberships for access
to its site. It also possesses social networking capabilities. A movie star’s fan site
may be a dedication from the owner to a particular celebrity.

There are some architectural limits that are imposed on Website. These
refer to the computing power dedicated to the Website. Some large Website,
such as Facebook, Yahoo!, Microsoft and Google, employ many servers and also
permit the loading of balancing equipment, such as Cisco Content Services
Switches. These devices distribute visitor loads over multiple computers at
numerous locations. During early 2011, Facebook utilized nine data centres with
approximately 63,000 servers.

In February 2009, there were 215,675,903 Website with domain names
and content on them. This is stated by Netcraft, an Internet services company that
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has been tracking Web growth since 1995. On the contrary, the figure was just
18,000 Website in August 1995.

Informational Website

One of the most important informational sites is wikipedia.org, the online
encyclopedia. It is a unique site, which enables visitors to contribute and read
articles. If you have a small business, you may not need such a comprehensive
site. However, if you have information to share or sell, an informational Website
will be very helpful. For example, if you own a landscaping business, you can
create a Website, wherein you can list plants with their definitions and also write
about planting and caring instructions. This will not only be helpful to people, but
may also attract them to visit your nursery. You can also ‘hybrid’ this site with
e-commerce and also sell your plants online.

Transactional Website

A transactional Website enables customers to conduct transactions through the
Website of financial institutions by initiating banking transactions or buying products
and services, for example Amazon or eBay.

The main functions of transactional Website are as follows:

 Collection of details from the customer, e.g., card details and address.

 Collection of payment process are used by some people who use
PayPal instead of direct credit card payment. PayPal is a feature linked
up with eBay.

 A transactional Website acts as a mediator between the customer and
the company.

In these Websites, databases play a vital role in storing all the relevant
information of the customers, such as payment details, names, address and phone
numbers. The details might also include a purchase history record, showing what
the customer has already purchased and when, how much he has spent and help
the company to keep a track of whether payment has been made by the customer
or not. Moreover, the company can have a database to keep a track of all the
stock which they have. It can also help them to store and communicate information
for both internal purposes and to keep their customers informed.

Blogs

Wikipedia defines a blog as a discussion or informational site published on
the World Wide Web (WWW) and consisting of discrete entries (‘posts’) typically
displayed in reverse chronological order (the most recent post appears first). Until
2009 blogs were usually the work of a single individual, occasionally of a small
group, and often covered a single subject. More recently ‘Multi-Author Blogs’
(MABs) have developed, with posts written by large numbers of authors and
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professionally edited. MABs from newspapers, other media outlets,
universities, think tanks, interest groups and similar institutions account for an
increasing quantity of blog traffic. The rise of Twitter and other ‘microblogging’
systems helps integrate MABs and single-author blogs into societal new
streams. Blog can also be used as a verb, meaning to maintain or add content to a
blog.

A Blog, in fact, is an online diary, journal, or editorial expressing the owner’s
opinions, thoughts, experiences, and ideas. Blogs can be great tools for increasing
the traffic to your small business Website. You may go into your blog once a day,
or once a week and update it on what is happening within your business. Perhaps
you are introducing a new product or service. Then you would place a link in that
information to your small business Website, or a specific landing page within the
Website. This gives your Website a valuable, authoritative, relevant in-bound link—
something the search engines give great importance to. You would also use your
blog to post opinions about what is happening in your business realm that Web
visitors would find interesting and insightful, thus leading them to your Website. By
being seen as ‘an authority’ in your field by the virtue of writing compelling and
informative copy, other Website will link to you, thus garnering your site more of
those all important in-bound links. 

Some people allow readers to post comments on their blogs. Others use it
for one-way expression only. When you allow readers to post on your blog, you
must be prepared to monitor and possibly edit or delete what may be deemed
inappropriate by you. By inappropriate, it does not mean controversial. We know
that controversy can be very beneficial in attracting visitors. Inappropriate means
offensive language, off subject writings and rantings, etc. 

There has been discussion about whether it is better to have your blog as
part of your Website, or to have it hosted under a separate domain name. The
thinking being that with the latter, a separate domain will create more in-bound
links to your Website; as in linking from one Website to another. This is true to a
point. It appears though, at this time, Google is more impressed with the additional
content that would be provided to your site by your postings and the postings of
others. If your small business is large enough, you may be able to have the human
and financial resources to have two blogs—one on your Website, and another
operating under a different domain name. Be aware though, that each would have
to have its own, distinct content. Search engines frown on duplicate content. They
take it on themselves to choose which site they prefer and ignore the other(s). 

Blogs are not all that difficult to set up. There are free blogging sites, like
Google’s blogger.com. Then there is free blogging software you install
like Wordpress that you can install on your site or a separate site under a different
domain name. With a few hours of learning, one can get the hang of blogging. To
those that like to write and or pontificate, they can become addictive. 



Features of a
Typical Website

NOTES

Self-Instructional
204 Material

Social Media

The online encyclopedia describes social media as the means of interactions among
people in which they create, share and exchange information and ideas in virtual
communities and networks.

 Andreas Kaplan and Michael Heinlein define social media as “a group of
Internet-based applications that build on the ideological and technological
foundations of Web 2.0 and that allow the creation and exchange of user-generated
content. Beside, social media depends on mobile and Web-based technologies to
create highly interactive platforms through which individuals and communities share,
co-create, discuss and modify user-generated content. It introduces substantial
and pervasive changes to communication between organizations, communities,
and individuals.

Social media differentiates from traditional media in many aspects, such as
quality, reach, frequency, usability, immediacy, and permanence. There are many
effects that stem from Internet usage.

According to media reports, Indian organizations use social media much
more than the global average and their counterparts in emerging economies. A
study of social media marketing practices among various social media-savvy
organizations in India has thrown up some good insights.  The study answers key
questions that many marketers have in India, such as what is the business objective
for using social media, what are some of the best tactics, what is the average social
media budget, how do you measure social media and what is the future of social
media. For content contributors, the benefits of participating in social media have
gone beyond simply social sharing to building reputation and bringing in career
opportunities and monetary income.

There is an increasing trend towards using social media monitoring tools
that allow marketers to search, track and analyze conversation on the Web about
their brand or about topics of interest. This can be useful in PR management and
campaign tracking, allowing the user to measure return on investment, competitor-
auditing and general public engagement. Tools range from free, basic applications
to subscription-based, more in-depth tools.

Social media services focus on seven functional building blocks. These
building blocks help explain the engagement needs of the social media audience.
For instance, LinkedIn users are thought to care mostly about identity, reputation,
and relationships, whereas YouTube’s primary features are sharing, conversations,
groups and reputation. Many companies build their own social containers that
attempt to link the seven functional building blocks around their brands. These are
private communities that engage people around a narrower theme, as in around a
particular brand, vocation or hobby, rather than social media containers, such
as Google+, Facebook and Twitter.
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Every day, thousands of new accounts are created on social networking
sites. Some of them have a very short lifespan .Social networking sites are also
one type of online community that relies on user contributions. This raises the
point that how user motivation and participation can be inspired for continued use.
What makes an SNS successful in terms of both end-user loyalty and highly
motivated users is still unknown.

There are five reasons why people use social media. They are listed here:

1. It is omnipresent as its use is growing with each passing day.

2. It is time consuming as Internet users throughout the world spend
more time on social networking sites.

3. It is habit forming. Social media is hard to separate from the real life.
Out of 1000 people 56 per cent people check Facebook daily while
12 per cent check the site every two hours while 32 per cent people
check it during the meals.

4. It influences life offline. Compared to average Internet user, social
media sites users are more likely to spend money on clothing, shoes
and accessories.

5. It helps businesses. Businesses can take the advantage of social media
prevalence to connect to their consumers.

Electronic Mail (E-Mail)

The dictionary of Information Technology defines Electronic mail also known as
e-mail as “a way of sending messages between people using a computer or
computers on a network.” The message or document can be looked at on a
computer screen and printed out.

The online encyclopedia Wikipedia describes e-mail as “a method of
exchanging digital messages from an author to one or more recipients that operates
across the Internet or other computer networks.”

Yet another online encyclopedia called Webopedia terms e-mail as the
transmission of messages over communications networks. The messages can be
notes entered from the keyboard or electronic files stored on disk.
Most computer networks have an e-mail system. Some electronic mail systems
are confined to a single computer system or network, but others have gateways to
other computer systems, enabling users to send electronic mail anywhere in the
world. Companies that are fully computerized make extensive use of e-mail because
it is fast, flexible and reliable.

Some early e-mail systems required that the author and the recipient both
be online at the same time, in common with instant messaging. Today’s e-mail
systems are based on a store-and-forward model. E-mail servers accept, forward,
deliver and store messages. Neither the users nor their computers are required to
be online simultaneously; they need connect only briefly, typically to an e-mail
server, for as long as it takes to send or receive messages.
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An Internet e-mail message consists of three components, the message
envelope, the message header and the message body. The message header contains
control information, including, minimally, an originator’s e-mail address and one
or more recipient addresses. Usually descriptive information is also added, such
as a subject header field and a message submission date/time stamp.

Mobile Phone

A mobile phone (also known as a cellular phone, cell phone and a handphone) is
a device that can make and receive telephone calls over a radio link while moving
around a wide geographic area. It does so by connecting to a cellular network
provided by a mobile phone operator, allowing access to the public telephone
network.

Mobile telephone systems are basically meant to provide telephony for the
individuals on the move. The telephone helps to keep the individual connected
while he/she is away from home or office. The basic point here is the element of
universal coverage. The mobile telephone has to be reachable wherever the
subscriber is, e.g., in the car, on the street or in a shopping mall. Even a modest
voice quality is acceptable as the user might be speaking from a place with very
high ambient noise. Communication is not very significant and wherever needed,
low-bit rate data communication is acceptable.

In addition to telephony, modern mobile phones also support a wide variety
of other services, such as text messaging, Multimedia Messaging Service (MMS),
e-mail, Internet access, short-range wireless communications (infrared, Bluetooth),
business applications, gaming and photography. Mobile phones that offer these
and more general computing capabilities are referred to as smartphones.

Tablet PCs

Webopedia defines Tablets PCs as a type of notebook computer that has an Liquid
Crystal Display (LCD) screen on which the user can write using a special-purpose
pen or stylus. The handwriting is digitized and can be converted to standard text
through handwriting recognition, or it can remain as handwritten text. The stylus
also can be used to type on a pen-based key layout where the lettered keys are
arranged differently than a QWERTY keyboard. Tablet PCs also typically have
a keyboard and/or a mouse for input.

Wikipedia throws some more light on tablet PC which is an important vehicle
of new media. It says “tablet computer, or simply tablet, is a one-piece mobile
computer. Devices typically have a touchscreen, with finger or stylus gestures
replacing the conventional computer mouse. It is often supplemented by physical
buttons or input from sensors such as accelerometers. An on-screen, hideable
virtual keyboard is usually used for typing. Tablets differentiate themselves by being
larger than smart phones or personal digital assistants. They are usually 7 inches
(18 cm) or larger, measured diagonally.
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Though generally self-contained, a tablet computer may be connected to a
physical keyboard or other input device. A number of hybrids that have detachable
keyboards have been sold since the mid-1990s. Convertible touchscreen notebook
computers have an integrated keyboard that can be hidden by swivel or slide
joint. Booklet tablets have dual-touchscreens and can be used as a notebook by
displaying a virtual keyboard on one of the displays.

Check Your Progress

3. What does the online encyclopedia Wikipedia describes e-mail as?

4. What is a mobile phone?

5. What does Webopedia define a Tablet PC as?

7.4 ANSWERS TO CHECK YOUR PROGRESS
QUESTIONS

1. The most easily read combination is black text on a white background.

2. An appropriate color scheme will contain two or three primary colors that
blend well.

3. The online encyclopedia Wikipedia describes e-mail as “a method of
exchanging digital messages from an author to one or more recipients that
operates across the Internet or other computer networks.”

4. A mobile phone is a device that can make and receive telephone calls over
a radio link while moving around a wide geographic area.

5. Webopedia defines Tablets PCs as a type of notebook computer that has
an Liquid Crystal Display (LCD) screen on which the user can write using
a special-purpose pen or stylus.

7.5 SUMMARY

 A site must be visually appealing, polished and professional. Remember, it
is reflecting your company, your products and your services.

 An attractive site is far more likely to generate a positive impression and
keep visitors on your site once they arrive.

 As businesses large and small continue to populate the Web, your challenge
is to attract and keep users’ attention.

 An appropriate color scheme will contain two or three primary colors that
blend well and create a proper mood or tone for your business.
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 The most easily read combination is black text on a white background, but
many other color combinations are acceptable if the contrast is within an
appropriate range.

 Graphics are important, as they lend visual variety and appeal to an otherwise
boring page of text.

 A simple way to increase visual appeal is to use high quality photography.

 Along with style, your site must have substance. Remember that your
audience is looking for information that will help them make a decision, so it
should be informative and relevant.

 Clearly label topics and break your text up into small paragraphs.

 Flashy graphics and animation are tempting, and can have a very positive
impact on user experience.

 Every component of your site should work quickly and correctly. Broken
or poorly constructed components will only leave your visitors frustrated
and disillusioned with your company.

 A critical, but often overlooked component of a successful Website is its
degree of usability.

 The best way to keep visitors glued to your site is through valuable content,
good organization and attractive design. Keep your site simple and well
organized.

 Site layout is extremely important for usability. Use a consistent layout and
repeat certain elements throughout the site.

 Place your menu items at the top of your site or above the fold on either
side.

 Usability testing shows that long link text makes it much easier for visitors to
find their way around a site.

 Different browsers often have different rules for displaying content.

 As we discussed above while learning about the difference between the
new media and the traditional media, the channels in new media are Website,
blogs, social media, electronic mail, mobile phones, tablets, search engines
and video- conferencing.

 According to the free online dictionary, a Website is a set of interconnected
Web pages, usually including a homepage, generally located on the same
server and prepared and maintained as a collection of information by a
person, group, or organization.

 Similarly the online encyclopedia called Wikipedia defines a Website as a
set of related Web pages served from a single Web domain.

 A Web page is a document, typically written in plain text interspersed with
formatting instructions of Hyper Text Markup Language (HTML) eXtensible
Hyper Text Markup Language (XHTML).
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 The pages of a Website can usually be accessed from a simple Uniform
Resource Locator (URL) called the Web address.

 Websites are also known as portals.

 The term ‘Website’ is used to refer to a collection of related Web pages
that comprise images, videos or other digital assets.

 We use the Hyper Text Markup Language (HTML) eXtensible Hyper Text
Markup Language (XHTML) to create a Web page.

 The URL helps in accessing the pages of a Website or the homepage.

 In a Dynamic Website, the content and the appearance may change or
customize frequently and automatically.

 Users can view the Website with dynamic content in plain view.

 Websites are either static or interactive. Interactive sites are a part of the
Web 2.0 community of sites.

 One of the most important informational sites is wikipedia.org, the online
encyclopedia.

 A transactional Website enables customers to conduct transactions through
the Website of financial institutions by initiating banking transactions or buying
products and services, for example Amazon or eBay.

 In these Websites, databases play a vital role in storing all the relevant
information of the customers, such as payment details, names, address and
phone numbers.

 A Blog, in fact, is an online diary, journal, or editorial expressing the owner’s
opinions, thoughts, experiences, and ideas.

 The online encyclopedia Wikipedia describes e-mail as “a method of
exchanging digital messages from an author to one or more recipients that
operates across the Internet or other computer networks.”

 A mobile phone (also known as a cellular phone, cell phone and a
handphone) is a device that can make and receive telephone calls over a
radio link while moving around a wide geographic area.

 Webopedia defines Tablets PCs as a type of notebook computer that has
an Liquid Crystal Display (LCD) screen on which the user can write using
a special-purpose pen or stylus.

7.6 KEY WORDS

 Affiliates: This is a site which aims to sell a third party’s product. The seller
receives a commission for facilitating the sale.

 Archive Sites: These sites are used to preserve valuable electronic content
threatened with extinction.
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 Attack Sites: These sites are created specifically to attack the computers
of the visitors on their first visit to a Website by downloading a file (usually
a Trojan horse).

 Blogs (Web Logs): These sites are generally used to post online diaries,
which may include discussion forums (e.g., Blogger, Xanga).

 Celebrity Website: In these Websites, information revolves around a celebrity.

7.7 SELF ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. Discuss the features of a website.

2. What is SEO? And how is it related to the cross functioning of a website?

3. List the tools for new media.

4. Give a brief overview of a website.

5. How are static websites different from dynamic websites?

Long-Answer Questions

1. Write a detailed note on the various types of websites and their specific
purpose.

2. “Users can view the Website with dynamic content in plain view. Depending
on certain criteria, the variable content is displayed dynamically on the fly.”
Discuss.

3. “Each type of Website specializes in a particular type of content or use. We
can classify them in several ways.” Give a classification of websites.

4. Differentiate between an informational website and a transactional website.
Use examples from the text.

5. Write in detail about the tools for new media, and their uses.
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8.0 INTRODUCTION

Hardware and software together constitute to the formation of a computer system.
Computer hardware refers to any physical device used in or with your system,
whereas software is a collection of codes installed onto your computer’s hard drive.
Examples of hardware devices in the computer include printer, monitor, input devices
like keyboard and mouse. Hardware also includes internal components like
motherboard, RAM, CPU and secondary storage devices like CD, DVD, and
hard disk. Your computer’s operating system (OS) manages all of the software and
hardware on the computer. Most of the time, there are several different computer
programs running at the same time, and they all need to access
your computer’s central processing unit (CPU), memory, and storage.

In this unit you will learn about network hardware and software in detail.

8.1 OBJECTIVES

After going through this unit, you will be able to:

 Understand network hardware and software

 Discuss about network operating system

 Explain internet protocol suite

8.2 NETWORK HARDWARE AND SOFTWARE

In general, a computer network is composed of one or more servers, workstations,
network interface cards, active and passive hub, routers, bridges, gateways,
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modem, software components like network operating systems and other application
software. The following components are widely used for the construction of
networks.

Server

It is the most powerful computer of the network. In a local area network, usually
a powerful microcomputer or a super microcomputer with the power of a
minicomputer is used as a server. There are two types of servers normally employed
in a local area network. They are dedicated servers and non-dedicated servers.

As a dedicated server, the server computer performs functions and services
of the whole network. It helps to efficiently run user applications and increases the
overall system cost. Users cannot run their applications directly on a dedicated
server. It provides e-mail service, sharing of multiple hard disks and  other resources
and faster response time. For larger networks with heavy load, dedicated servers
are usually employed.

In a non-dedicated server, apart from the role of a network controller, a
server also acts as an individual workstation. The server is equipped with large
memory. Network operations demand only a portion of server memory. The
remaining portion of the memory may be used for the user applications. Under
light load conditions, it is advisable to use a non-dedicated server. Some servers
can operate on both modes, according to the requirement of the user.

File Server

The primary goal of a computer network is to share data among several users.
They also make their attached disk drives, printers, modems and unique
communication links available to the various client stations. Providing one computer
with one or more hard disks facilitates this.  All client stations share these hard
disks.  Clients can make their requests to access any of the shared facility to the
server. The file server is a powerful computer which runs special software. It
provides the files and other shared resources to different users in the network. It
provides facilities like user authentication, security to various user programs and
data. It can be accessed through network operating system (NOS). Typical
configurations of a server are a Pentium 4 machine with 128 MB or higher capacity
RAM, 40-GB or higher capacity hard disk, to serve upto ten nodes or workstations.

All activities of a file server can be monitored and controlled from the monitor
called console. The network administrators are given special privileges. They are
given supervisory passwords. They perform the network administration operation
for the entire network. In case any user of the network needs to get a new network
service, he or she has to contact the network administrator and make a request
for the specific service needed. The file server has a large memory, which is used
for caching directories, and files and hashing directories. Novell Netware and
Windows NT are the two network operating systems that run on a server machine.
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Another important component of a network is the workstation or a client.  A
workstation is an individual computer with capabilities to communicate with other
machines. It must be equipped with the hardware and software necessary to connect
to a LAN. Usually a network interface card (NIC) or an Ethernet card or an
Arcnet card is used for this purpose. Part of the network operating system is also
available on the workstation. A workstation can communicate with other
workstations or to the server. The hardware requirement for a workstation depends
on the application and the size of the network. In a typical LAN of a university
computer centre, a Pentium III system with 64-MB RAM and 4–8-GB hard disk
capacity, with a necessary network interface card, can be used for a typical
workstation. In general, the memory and hard disk capacity of a workstation is
much less than that of a server.

Network Interface Unit

Every computer on the network needs one add-on card called network interface
card (NIC) or Ethernet adapter or network interface adapter. The role of NIC is
to move the serial signals on the network cables or media into parallel data stream
inside the PC. In some cases, two or more such NICs are used in the server to
split the load. These interface units also have the important jobs of controlling
access to the media. This includes activities known as carrier sense (listen before
transmit), sequential station number and token passing, which are discussed in the
later chapters. The above activities are known as media access control.

Transmission Media

The data signal travels through this medium. There are two general categories.
They are bounded (guided) and unbounded (unguided) medium. Twisted pair,
coaxial cables and fibre optic cables are all bounded media. The data signals
travel within the boundaries of the transmission media. On the other hand, microwave
and satellite transmissions, both travel through the air, which has no boundaries,
hence called unbounded transmission.

Hub

The network hub is a centralized distribution point for all data transmission in a
network. Hub may also be referred to as a concentrator. Data packets from an
NIC arrives at the hub. The hub receives and rebroadcasts them to other computers
connected to it. In general, the hub network is a passive device. It does not know
the destination of a received data packet. Hence, it is required to send copies to
all the hub connections. Hubs can be classified into the following three categories:

 Stackable and non-stackable hubs

 Active and passive hubs

 Intelligent and non-intelligent hubs.
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Stackable hubs are hubs that can be stacked or interconnected to make a
single hub appearance. They are useful for vendors to make hubs of size suitable
to customer requirement. Non-stackable hubs cannot be interconnected. They
are always provided only a fixed number of connections.

The hubs that connect to the network backbone are known as active hubs.
The hubs, which connect only to active hubs, are known as passive hubs.

Intelligent hubs contain a special firmware that can be accessed by remote
workstations. The firmware is known as simple network management protocol
(SNMP). Network performance and network status data are read from SNMP.

Repeater

A repeater is a communication device that connects between two segments of the
network cable. It retimes, regenerates, strengthens the digital data, and sends
them on their way again. Repeaters are often used to extend the cable length to
enlarge LANs. A wide area network contain many repeaters. Ethernet also
frequently uses repeaters to extend the length of the bus.

Bridge

A bridge interconnects two networks using same technology (such as Ethernet or
Arcnet). Bridge is more sophisticated than a repeater. A modern bridge reads the
destination address of the received packet and determines whether the address is
on the same segment of the network cables of the originating station. If the
destination is on the other side of the bridge, the bridge transmits the packet into
the traffic on that cable segment. Local bridges are used to connect two segments
of the same LAN. Remote bridges are used to link local LAN cables to thin long-
distance cables to link two physically separated networks. Network administrators
often use bridges to split the big networks into a number of small networks. Bridges
are easy to install. They provide an easy way to perform network management
functions.

Router

A router transfers data between networks. It is also possible for a router to transfer
data between different compatible network technologies such as Ethernet and
IBM token ring. Since Internet consists of thousands of different network
technologies, routers are an integral part of the Internet. A router has the address
on the network. A bridge does not have an address. Hence, a router can act as an
intermediate destination. In other words, a computer can send a data packet to
the router of another network. The router will transfer the packet to the other
network. On the other hand, the bridge must examine all the packets to determine
which packets to transmit between networks. As such, computers never send
packets directly to a bridge. A router examines a packet only if it contains the
router’s address.
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brouter receives the packet and examines whether it supports the protocol used
by the packet. If not, it simply drops the packet. The packet is bridged using the
physical address information.

Gateway

Two dissimilar networks can be connected by means of a gateway. For example,
a mainframe can be connected and accessible to a PC network by means of a
gateway. Unlike routers, a gateway converts the format of the data sent between
two networks. A router adds only addressing information to the data packet.
Routers never change the content of the message. But a gateway has to identify
the protocols used in the networks, and recognizes the data format and converts
the message format into a suitable format to be accepted by the other network.
Wide area networks often use gateways because there is a large number of dissimilar
networks present in a WAN. Gateways provide good connectivity to different
kinds of networks on the Internet.

Modem

Another significant network component is modem. The term modem is the
shortened version of ‘modulator–demodulator’. Modem provides a two-way
communication facility between a computer network and a telephone network.
As a wide area network uses the existing telephone network to connect to a
distant network, it always uses a modem to dial-up the telephone network. Modem
converts the digital data from the computer into useful analogue signals that can be
transmitted through a telephone network. Similarly, signals from the telephone
channels are converted back into digital data suitable for a computer.

Network Software

In any computer system, there are different hardware parts and to establish
communication between these hardware parts, software is needed. Without
software, hardware is dead. When a computer is attached to another computer,
there must be some way to exchange data between the two. This job is done by
software. The design of software is according to the working of the hardware
parts. Previous section was devoted to network hardware. Hardware components
need software to communicate with each other within themselves and also to
other computer connected through the network. Such software is called network
software.

Network software is highly structured. When a communication is to take
place between two parties, some kind of agreement is needed. Similarly, when
communication is required between two computers, connected to a network, an
agreement is needed. Such agreements are known as protocols. Network software
is a set of various protocols and protocol suites. Organizing networks as a series
of layers reduces design complexities. The structure of networks differs. Number
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of layers, names and functions of each layer differ from one network to another.
But in all networks, function of each layer is to offer certain services to higher
layers and shielding it from details of implementation. If a user of computer A
wants to communicate with a user of computer B, he gives instructions at the
highest layer of the protocol which passes downwards through lower layers until it
reaches the lowest layer, which is the physical layer or the physical medium. Actual
communication takes place through the physical medium. Data transfer does not
take place directly between corresponding layers of two machines. It has to come
down to the physical level and then communicated to the physical level of another
machine and then to layers above that machine until it reaches the top layer of the
network protocol suite on that machine and communication takes place.

There is an interface between each pair of adjacent layers. Primitive
operations and services are defined in these interfaces. These services are given
by the lower layer to its immediate upper layer. Network architecture comprises
a set of layers and protocols. Each layer in this architecture needs a mechanism to
identify senders and receivers. Designers of network architecture decide on issues
like number of layers, names of each layer and its function.

A local area network (LAN) needs software as a protocol that establishes
communication between hardware parts of these machines through network
interface card that regulates network characteristics such as topologies, method
of access, cabling and data transfer speed. Thus, the protocol links hardware
parts of one machine to another for data communication. In a network, lowest
layers of protocol hierarchy are closest to the physical machine. These protocols
are implemented in hardware by recording in a ROM chip and are called firmware.
But these, essentially, contain a complex protocol algorithm that may be hardwired
as embedded software.

The most commonly used protocols for LANs are as follows (Table 8.1):

 Ethernet: This protocol is most popular and it uses a method access
known as CSMA/CD,  which stands for carrier sense multiple access
with collision detection. In such a method, a computer first checks for
the clearance of the network and if it is clear it starts transmission. In
case it finds the line busy, it waits and tries again when it finds a clear
line. Collision occurs when two nodes transmit simultaneously. On
occurrence of a collision, each computer stops sending and after waiting
for some time, retransmits. Although collision is normal in Ethernet,
the delay is very small and overall effect on performance is negligible.
This protocol is designed to work on different topologies such as linear
bus, star or tree. Physical media that it can handle are: twisted pair,
coaxial, fibre optic cables or wireless access points. Speed ranges
from 10–1000 Mbps. This protocol is standardized as IEEE 802.3.
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access involves token passing. Signal travels within the network in a
logical ring, from one computer to another. A token in electronic form
circulates in the ring. If a machine has the token, it can transmit, but if
it has nothing to transmit, it hands over this token to the next computer.
If it has something for transmission, data is attached to the token by
this computer and it moves around the ring to deliver it to the intended
recipient. This protocol works on ring, star-wired, either with a twisted
pair or fibre optic cable. Speed of transmission ranges from 4 to 16
Mbps. IEEE 802.5 is the name of the standard for this system, by
Institute of Electrical and Electronics Engineers (IEEE).

 FDDI (fibre distributed data interface): This protocol can
interconnect two or more LANs located at a distance of 100–200
km. Token passing is the method of access. FDDI has a dual ring
physical topology containing two token rings. This works as a
safeguard. If primary ring fails for any reason, another acts as a backup.
During normal transmission primary ring is active. In case there is a
break, for any reason, information transmission is not disrupted as it
automatically starts using portions of the second ring. It operates at
100 Mbps and uses a  fibre optic cable as a medium. This protocol is
derived from IEEE 802.4

 ATM (asynchronous transfer mode):  This protocol transmits data
in fixed-sized small packets, in contrast to others that transfer variable
length packets. It is a packet switching protocol. Such transmission
using fixed-sized cells is known as cell relay. It uses 53 bytes per cell.
Its speed is 155 Mbps and higher. ATM supports audio, video and
imaging. It works on star topology. Physical media used are both
twisted pair and fibre optic cable. Like FDDI, ATM also interconnects
two or more LANs. Internet service providers use this protocol for
providing services to their customers for access to the Internet at high
speeds. Ongoing development in this field will make this technology
more cost-effective and will provide an alternative for construction of
faster LANs.

Table 8.1 Summary of LAN Protocols

Protocol 
Name 

Cable (Physical Media) 
It Uses 

Speed Topology on Which It 
Works 

Ethernet Twisted pair, coaxial, 
Fibre 

10 Mbps Linear bus, star, tree 

Fast Ethernet Twisted pair, Fibre 100 Mbps Star 
Token Ring Twisted pair 4–16 Mbps Star-wired ring 

FDDI Fibre 100 Mbps Dual ring 
ATM Twisted pair, fibre 155–2488 

Mbps 
Linear bus, star, tree 
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Network Operating System

Operating systems for single users are, well-known—DOS and Windows. These
operating systems control one computer. But network operating systems (NOS)
control many computers interconnected through a network. NOS coordinate
various activities according to a set of protocols for smooth running of a network.
Network operating systems are of two main types:

 Peer-to-Peer (PP)

 Client/Server (CS)

Peer-to-Peer NOS (PP NOS)

In PP type network operating systems, there is no centralized server to serve
other users.  Users can share resources and files on their computers as well other
computers on the network. In this type of network, all computers are considered
equal for sharing network resources. Small and medium LANs use this type of
network operating systems. Examples of PP-type NOS are ‘AppleShare’ and
‘Windows for Workgroups’.

Client–Server NOS (CS NOS)

In this type of network operating systems, there are a set of dedicated servers
having functions and applications for users. Figure 8.1 shows that file servers are
the heart of the system. They provide secured access to resources for clients or
individual workstations.  The network operating system integrates all the
components of the network. Multiple users can share the same resources,
simultaneously sitting at remote physical location. Examples of CS NOS are Novell
Netware and Windows 2000 Server.

Resources are Controlled by the File Server
in a Client/Server Network

Fig. 8.1 Client/Server Network

In any network, the application layer is at the highest level and the physical
layer is at the lowest. Data is transferred on the physical layer as a series of bits
(0 and 1).
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Hardware and SoftwareNovell Netware is based on the client–server model. It uses a protocol
stack having five layers. Figure 8.2 shows these layers and the protocol used at
these layers.

SAP File Server
...... Application Layer

Transport Layer

Network Layer

Datalink Layer

Physical Layer

NCP SPX

IPX

Ethernet Token Ring ARCnet

ARCnetToken RingEthernet

Fig. 8.2 Novell Netware

IPX at the network layer means internetwork packet exchange; it is a protocol
used by the Novell NetWare. It is used for connectionless communication and is a
datagram protocol.

SPX stands for sequenced packet exchange, which is a protocol, working
at the transport layer. The fourth layer of the OSI model corresponds to this layer.
The SPX layer is above the IPX layer, which is a network layer and corresponds
to the third layer of the OSI model and this gives connection-oriented services.
SPX is used primarily by client/server applications.

Internet Protocol Suite (TCP/IP)

This protocol suite is commonly known as TCP/IP (TCP stands for transmission
control protocol and IP stands for internet protocol). It is the set of protocols used
for communication on the Internet and other similar networks. The name has been
given from two of the most important protocols TCP and IP.

This comprises a set of layers. Each layer has to solve a set of problems
involving data transmission to provide a service to the layer above it utilizing services
from the layer below it. Logically, the highest layer is closest to the user. This layer
deals with data of abstract nature. Upper layers rely on protocols of layers below
it. These data are translated into forms for transmission.

RFC 1122 defines four layers for the TCP/IP model. The lowest layer is the
link layer, above this is internet layer the transport layer is above internet layer and
the application layer is at the top and closest to the user. This is shown in the
following Figure 8.3.
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Fig. 8.3 Stack Connection

The lowest layer establishes communication with physical media that contains
hardware. When information is transferred between two host computers, it passes
from the application layer of one computer down to the link layer and then to the
machine and the information is transferred to the next machine and again it travels
to upper layers till it reaches the application layer of the second computer where
the user gets the desired data sent by the first computer as shown in Figure 8.4.

Fig. 8.4 Network Connection

When data travels from upper layers downwards, each upper layer attaches
a header; see Figure 8.5. After transmission of data in bit form to another machine
it travels upwards, stripping off the header till data reaches the application layer.

Data

UPP
Data

UPP
Header

Frame
Footer

IP
Header

Frame DataFrame
Header

IP Data

Application

Transport

Internet

Link

Encapsulation of Application Data Descending through the
Protocol Stack

Fig. 8.5 Header Attachment by Each Layer
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Hardware and SoftwareTable 8.2 gives examples of the protocols present at layers of the protocol
suite.

Table 8.2 Protocol Suite

Application DNS, TFTP, TLS/SSL, FTP, Gopher, HTTP, IMAP, IRC,
NNTP, POP3, SIP, SMTP,SMPP, SNMP, SSH, Telnet,
Echo, RTP, PNRP, rlogin, ENRP

Routing protocols, BGP and RIP, running over TCP/UDP,
is also considered part of the internet layer.

Transport TCP, UDP, DCCP, SCTP, IL, RUDP, RSVP

Internet IP (IPv4, IPv6), ICMP, IGMP, and ICMPv6

Initially, OSPF for IPv4 was taken to be an IP layer protocol
as it runs per IP-subnet but has been placed on the Link
since RFC 2740.

Link ARP, RARP, OSPF (IPv4/IPv6), IS-IS, NDP

Basic ability of transferring bits between computers is provided by hardware
in the networks. But for using the networks, a set of rules (protocols) are needed
which all the members of the network agree on.

Thus, the communication protocol is standardized, which specifies the way
computers interact and exchange messages. A protocol sets the format in which
messages are transmitted and errors are handled.

These are designed as a set of protocols in which every protocol has specific
responsibility instead of designing one protocol for all forms of communication.
This is done for reducing complexities and simplifying the design.  Protocol Suite
is the name given to the set of protocols.

Important Protocols

There are many protocols at each layer. Some of the popular and more important
are given in Table 8.3. 

Table 8.3 Important Protocols

PPP    Point-to-Point Protocol.This creates connection in both types of systems,
synchronous as well as asynchronous. It provides a security mechanism in
host-to-network or router-to-router connection. This provides connections over
regular telephone lines, using modems on both the ends. This protocol finds
use in connecting PCs to the Internet.

SLIP    Serial Line Internet Protocol.This is a predecessor of PPP that works over a
serial connection. CSLIP (compressed serial line internet protocol) is an advanced
version of SLIP. This version acts to reduce the overhead by sending information
about header information and thus increases the throughput.
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FTP    File Transfer Protocol. This transfers binary files and text. It transfers files
following a very strict mechanism related to the ownership of files and
restrictions on access. At present, this is the protocol most commonly used for
the Internet.

Telnet    It is defined in RFC854 and is the protocol for terminal emulation. It is used on
TCP. Using this, local hosts can log on to remote hosts for using their resources.

SMTP Simple Mail Transfer Protocol is used for sending e-mails from a local host to a
server using TCP. This protocol permits exchange of mails over the network.
The protocol contains a data structure that delivers information to the sender,
the mail’s body and the recipient(s).

HTTP Hyper Text Transport Protocol. This protocol transfers pages containing
hypertext on the World Wide Web.

SNMP Simple Network Management Protocol.This defines messages in relation to
network management. This protocol uses routers and can be configured by a
host using  LAN.

UDP User Datagram Protocol.This protocol transfers datagram to a remote computer.
UDP is not reliable and there is no guarantee on delivery of packets.

TCP Transmission Control Protocol. This enables a computer to send data to a
computer located far away. It is reliable and there is guarantee that packets will
reach the destination in the same order in which these are sent.

IP Internet Protocol. This is common to all the other protocols. It identifies and
reaches the targeted computer connected to the network. A computer is identified
by its IP address, which is unique for every computer. 

ARP Address Resolution Protocol. This maps an IP address into an address
recognized by the hardware. This protocol makes broadcast of a request message
containing an IP address. The target computer gives a response using both the
hardware address and original IP address.  

NNTP Network News Transport Protocol. This protocol carries postings on USENET
between news clients and servers.

 

  Apart from these there are other protocols too. One very important protocol
is internet control message protocol (ICMP). It is considered a core protocol.
Operating systems of networked computers use this protocol for handling error
messages.

To perform its task, it relies on IP, but differs from TCP and UDP. It does
not send or receive data between end systems. Direct use of this is not made by
user network applications with exceptions of tools such as ping and traceroute.

The OSI Seven-Layer Model

As already mentioned in earlier part of this section, a layered model is most common.
This helps us to have better understanding of a protocol suite.
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Hardware and SoftwareInternational organization for standardization has defined seven layers which
were introduced by the more than 20 years ago. This is a theoretical model which
assigns specific tasks for each layer. Practical models may not be exactly same as
this, but they serve as a valuable guideline as given in Table 8.4.

Table 8.4 OSI Seven Layer Model

Layers Defined Responsibilities Assigned

1. Physical Basic hardware components for networks. 

2. Data link Frame format, transmitting frames over the net, i.e., bit/
byte stuffing, checksum

3. Network Address assignment, packet’s forwarding methods

4. Transport Transfer correctness

5. Session Establishment of a communication session, Security,
Authentication, i.e., passwords

6. Presentation Computers represent data in different ways (char, integer);
thus, the protocol needs to translate the data to and from
the local node.

7. Application Specifications for applications using the network, request
sending, specifying filename over the net, responding to a
request etc.

Figure 8.6 shows a comparison of the OSI model with TCP/IP (Internet
protocol suite). In TCP/IP there is no mention of the physical layer. Session,
presentation and application layers are merged in one layer as the application
layer. IP is a the protocol at the network layer and TCP and UDP are protocols at
the transport layer. ARP (address resolution protocol) and RARP (reverse ARP)
are two important protocols at the data link layer for communication of physical
devices to upper layers.

   

Internet Protocol Suite OSI—Seven Layers Mode

Not Specified

Fig. 8.6 Comparison of the OSI Model with Internet Protocol Suite
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Check Your Progress

1. What is the primary goal of a computer network?

2. What is a network hub?

8.3 GLOSSARY OF TERMS ASSOCIATED WITH
WEBSITES

When it comes to a thorough understanding of websites, knowing the terminologies
associated with it is a must. With the internet becoming almost an integral part of
everyone’s life, knowing the terms associated with websites not only prevents
confusion of understanding it but also promotes better access and use of it.
Therefore, here is the glossary of most used and common terms associated with
websites.

 Anchor Text: Anchor text is the clickable and visible text present in a
hyperlink. Often seen as underlined or in color blue, this string of text can
be a paragraph or a simple one character. A common example of anchor
text during the early internet days was ‘Click here’ in the websites.

 Address Bar: The text box showing the address of a web page in a web
browser is known as the address bar. Also used as a quick search box,
address bar shows the address of a web page one is presently accessing.

 Backlink: Backlink refers to a link in a website which takes the user back
to a certain page of the website or a particular website. A backlink is
considered to be one of the important ranking factors of SEO.

 Blog: Short form of ‘Web Log’, a blog refers to a section of a website or
a website that is updated with fresh content on a regular basis. Also meaning
‘to write’, a blog can be used as a crucial part of content marketing, SEO
and also as a platform to share one’s personal thoughts.

 Browser: The software one uses to view the web pages is known as the
browser. Google Chrome, Internet Explorer, Mozilla Firefox, Opera, Safari
are some of the widely used examples of browsers.

 Banner: Incorporating the name of the brand or company or logo of a
website, the banner is a horizontal top part of a website template that is
used to draw attention to certain offers or information. Banners are
considered to be a great form of website advertising.

 CMS: CMS or Content Management System lets one make changes to
his or her websites as needed. Be it publishing a post or simply un-publishing
it, CMS is there to help one out. In order to edit the website content through
CMS one doesn’t require to have knowledge of HTML as with the help of
a few clicks all the editing can be done with CMS.
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Hardware and Software Cookie: A cookie is kind of web server message that helps in preparing
customized content for the users visiting a website depending on whether
he or she is visiting the website for the first time or have visited before. The
web server sends cookie or message to the web browser helping in identifying
the users.

 Content: All the texts, images or any other types of files that a website is
consisted of are known as contents.

 Error 404: When a user is shown a ‘404 Error’ message while trying to
access a webpage, it means that the webpage he or she is searching for is
not found. Usually, this happens when the link of a webpage is still on the
internet but the page is taken down or the link is wrong and the web page
doesn’t exist.

 E-commerce website: Websites that deals with selling of merchandises
are known as E-commerce websites. These websites use an intricate program
which lets the users select products, put them in ‘shopping cart’, and process
the payment for them. E-commerce stands for Electronic Commerce which
clearly states why certain websites are known as E-commerce sites.

 Favicon: The term ‘Favicon’ refers to the little image in the browser window,
next to the meta-title (if one is using tabs) or next to the URL.

 File Format: Every file requires to be in the correct format in order to get
uploaded on the internet and accessed by users. For example, if one is
uploading an image file in a website the ideal file format is Jpeg for photos.

 Forum Page: Usually, a forum page refers to an online discussion website
page. To be more specific, a web page where contents can be posted by
users on various related topics is called a forum page.

 HTML: The term HTML stands for Hypertext Markup Language. It is a
cross-platform language in which a webpage is written. This language is
also used for formatting and creating a webpage. With the advancement of
technology, now template-based webpage creating systems being available,
learning to use the HTML is no longer a must for creating a website.

 Hyperlink: Commonly referred to as a link, a hyperlink serves as an
electronic connection between web pages of the same website or between
web pages of different websites.

 Key Phrases/Keywords: Keywords or key phrases are words that a
potential user is likely to type in the search boxes. Identifying with the content
of a website, keywords help the search engine in finding a business quickly
as per the search of a user.

 Links: Links refer to active images or texts by clicking on which a user
moves to a different website or a different web page of the same or different
website.
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 Meta tags: Meta tags, commonly associated with web pages, shows
information about the webpage one is using. Located on the top browser
bar, meta title or meta tags helps in search engine rankings of a website.

 SEO: SEO or Search Engine Optimization is all about improving the ranking
of a website on the search engines like Google. Referring to the off and on-
site actions that help in achieving a higher and more targeted ranking on a
search engine, SEO is crucial for making a website found in top search
results of search engines.

 Traffic: The term traffic associated with websites refers to the amount or
number of visitors to a website. The more the traffic is the more effective
becomes the website in attracting the attention of the audience.

 URL: URL stands for Uniform Resource Locator and is simply known as
the address of a webpage. Every document on the internet has a certain
address and it is the URL that refers to them.

Check Your Progress

3. What does a Content Management System do?

4. What does backlink refer to?

8.4 ANSWERS TO CHECK YOUR PROGRESS
QUESTIONS

1. The primary goal of a computer network is to share data among several
users.

2. The network hub is a centralized distribution point for all data transmission
in a network.

3. CMS or Content Management System lets one make changes to his or her
websites as needed.

4. Backlink refers to a link in a website which takes the user back to a certain
page of the website or a particular website.

8.5 SUMMARY

 In general, a computer network is composed of one or more servers,
workstations, network interface cards, active and passive hub, routers,
bridges, gateways, modem, software components like network operating
systems and other application software.

 In a local area network, usually a powerful microcomputer or a super
microcomputer with the power of a minicomputer is used as a server.
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Hardware and Software As a dedicated server, the server computer performs functions and services
of the whole network.

 In a non-dedicated server, apart from the role of a network controller, a
server also acts as an individual workstation.

 The primary goal of a computer network is to share data among several
users.

 All activities of a file server can be monitored and controlled from the monitor
called console.

 Another important component of a network is the workstation or a client. A
workstation is an individual computer with capabilities to communicate with
other machines.

 Every computer on the network needs one add-on card called network
interface card (NIC) or Ethernet adapter or network interface adapter.

 The data signal travels through this medium. There are two general categories.
They are bounded (guided) and unbounded (unguided) medium.

 The network hub is a centralized distribution point for all data transmission
in a network.

 Stackable hubs are hubs that can be stacked or interconnected to make a
single hub appearance.

 The hubs that connect to the network backbone are known as active hubs.

 A repeater is a communication device that connects between two segments
of the network cable.

 A bridge interconnects two networks using same technology (such as Ethernet
or Arcnet).

 A router transfers data between networks. It is also possible for a router to
transfer data between different compatible network technologies such as
Ethernet and IBM token ring.

 A router can also act as a bridge. Such a router is known as a brouter. The
brouter receives the packet and examines whether it supports the protocol
used by the packet.

 Two dissimilar networks can be connected by means of a gateway.

 In any computer system, there are different hardware parts and to establish
communication between these hardware parts, software is needed.

 Network software is highly structured. When a communication is to take
place between two parties, some kind of agreement is needed.

 There is an interface between each pair of adjacent layers. Primitive
operations and services are defined in these interfaces.

 Operating systems for single users are, well-known—DOS and Windows.
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 In PP type network operating systems, there is no centralized server to
serve other users.

 SPX stands for sequenced packet exchange, which is a protocol, working
at the transport layer. The fourth layer of the OSI model corresponds to
this layer.

 RFC 1122 defines four layers for the TCP/IP model. The lowest layer is
the link layer, above this is internet layer the transport layer is above internet
layer and the application layer is at the top and closest to the user.

 The lowest layerestablishes communication with physical media that contains
hardware.

 Basic ability of transferring bits between computers is provided by hardware
in the networks.

 To perform its task, it relies on IP, but differs from TCP and UDP. It does
not send or receive data between end systems.

 International organization for standardization has defined seven layers which
were introduced by the more than 20 years ago.

 When it comes to a thorough understanding of websites, knowing the
terminologies associated with it is a must.

 Anchor text is the clickable and visible text present in a hyperlink. Often
seen as underlined or in color blue, this string of text can be a paragraph or
a simple one character.

 The text box showing the address of a web page in a web browser is
known as the address bar.

 Backlink refers to a link in a website which takes the user back to a certain
page of the website or a particular website.

 Incorporating the name of the brand or company or logo of a website, the
banner is a horizontal top part of a website template that is used to draw
attention to certain offers or information. Banners are considered to be a
great form of website advertising.

 CMS or Content Management System lets one make changes to his or her
websites as needed.

 A cookie is kind of web server message that helps in preparing customized
content for the users visiting a website depending on whether he or she is
visiting the website for the first time or have visited before.

8.6 KEY WORDS

 Favicon: It refers to the little image in the browser window, next to the
meta-title (if one is using tabs) or next to the URL.
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Hardware and Software Blog: It is the short form of ‘Web Log’, a blog refers to a section of a
website or a website that is updated with fresh content on a regular basis.
Also meaning ‘to write’, a blog can be used as a crucial part of content
marketing, SEO and also as a platform to share one’s personal thoughts.

 Anchor Text: It is the clickable and visible text present in a hyperlink.
Often seen as underlined or in color blue, this string of text can be a
paragraph or a simple one character. A common example of anchor text
during the early internet days was ‘Click here’ in the websites.

8.7 SELF ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. Define the terms:

(i) Anchor text; (ii) Address bar; (iii) Cookie

2. Write a short note on network hardware and software.

3. Write a note on the OSI seven-layer model.

4. Define network software. Also write about the network operating system.

Long-Answer Questions

1.  “As a dedicated server, the server computer performs functions and services
of the whole network.” Explain.

2. Write a detailed note on file server. Also explain its goal and functionality.

3. What do you mean by a network interface unit? Explain.

4. Write a detailed note on network operating systems. Also give its
classification.

5. What is an internet protocol suite? Discuss.
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BLOCK - III
ONLINE COMMUNICATION

UNIT 9 E-MAIL AND INTERNET
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9.0 INTRODUCTION

Internet and e-mail are today synonymous to each other. Communication between
people has now leveled up from the age old practices of letters and calls. People
today use emails as a medium of formal communication. The functionality and
working of an e-mail is primarily dependent on internet.

In this unit you will learn about e-mail and internet in detail.

9.1 OBJECTIVES

After going through this unit, you will be able to:

 Understand about network protocols

 Discuss E-mail and search engines

 Explain the functionality of plug-ins and ports

9.2 NETWORK PROTOCOLS

As discussed, EDI is based on the Internet connection and transfer of data hence
we need some standard protocol, program and servers that facilitate a smooth
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E-mail and Internettransaction and communication between two trading partners. In this section we
will study about some common services that are used in EDI transactions.

SMTP

The complete transaction involved in EDI involves transfer of information in the
form of mail. The SMTP (Simple Mail Transfer Protocol) is the standard TCP/IP
protocol that supportselectronic mail on the Internet. It provides a common
specification for the exchange of e-mail message between systems and networks.
It uses the TCP well-known port 25. It defines how message transferred and also
format the message that is provide an envelope to the message. RFC821, dated
August 1982, defines SMTP as:

‘The idea of using a reliable, order-preserving transport protocol to
transfer mail electronically is just a simple implementation of data transfer’.

When client wants to send or receive a message it connects through a mail
server which run on a host computer.  The mail client and mail server communicate
with one another by using POP or ‘Post Office Protocol’ i.e., the POP server will
hold the message until the recipient retrieves the e-mail. The mail server determines
the route through which message is sent through the Internet and when it arrives
the server sends a message to POP server. The complete message transfer is
managed by a program called TRANSPORT AGENT which ensures that massage
is properly transported as per SMTP protocol. The SMTP client-server has two
components:

 UA (User Agent) - It prepares the message, creates the envelope and
puts the message in the envelope. The mail client and mail server together
provide the functionality of the user Agent

 MTA (Mail Transfer Agent) - It transfers the mail across the Internet.

Fig. 9.1 SMTP (Simple Mail Transfer Protocol)



E-mail and Internet

NOTES

Self-Instructional
232 Material

Let us see various stages involved in Mail transfer:

 Establishment of Connection: The connection between the client and
TCP is established using the well-known port 25.

 Transfer of Message: The client can send only one message at a time but
the message can have more than one recipient.

 Termination of Connection: Once the message is sent the client terminates
the connection.

Thus, if we want to send a message then we should first compose the message
and client, i.e, host computer will contact to mail server and send the message
through an Internet service provider. Now the server calls the transport agent to
deliver the message to the appropriate computer connected to the Internet.

SMTP and DNS

The most important component of the TCP/IP electronic mail system is the Simple
Mail Transfer Protocol (SMTP). Derived from Mail Transfer Protocol (MTP),
SMTP is the mechanism used for the delivery of mail between TCP/IP systems
and users. The only part of the e-mail system for which SMTP is not used is the
final retrieval step by an e-mail recipient.

In the early days of SMTP, mail was delivered using the relatively inefficient
process of relaying from server to server across the internetwork. Today, when an
SMTP server has mail to deliver to a user, it determines the server that handles the
user’s mail using the Domain Name System (DNS) and sends the mail to that
server directly.

SMTP servers both send and receive e-mail; the device sending mail acts
as a client for that transaction; the one receiving it acts as a server
(refer Figure 9.2). To avoid confusion, it is easier to refer to the device sending e-
mail as the SMTP sender and the one receiving as the SMTP receiver; these
were the terms used when SMTP was originally created.

Fig. 9.2 Simple Mail Transfer Protocol (SMTP)
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E-mail and InternetSMTP Connection and Session Establishment and Termination

The delivery of electronic mail using the Simple Mail Transfer Protocol involves
the regular exchange of e-mail messages between SMTP servers. SMTP servers
are responsible for sending e-mail that users submit for delivery. They also receive
e-mail either intended for local recipients, or in some cases for forwarding or
relaying to other servers.

An SMTP session consists of three basic phases (refer Figure 9.3):

1. First, the session is established through the creation of a TCP connection
and the exchange of identity information between the SMTP sender and
receiver using the HELO command.

2. Once the session is established, mail transactions can be performed.

3. Finally, when the SMTP sender is done with the session, it terminates it
using the QUIT command.

If SMTP extensions are supported, the SMTP sender uses the EHLO (Extended
HELO) command instead of HELO, and the SMTP receiver replies with a list of
extensions it will allow the SMTP sender to use.

SMTP Mail Transaction Process

The delivery of e-mail message begins with the establishment of an SMTP session
between the devices sending and receiving the message. The SMTP sender initiates
a TCP connection to the SMTP receiver, and then sends a HELO or EHLO
command, to which the receiver responds. Assuming there are no problems, the
session is then established and ready for actual e-mail message transactions. Figure
9.3 illustrates a SMTP session.

 

Fig. 9.3 SMTP Session
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SMTP Mail Transaction Overview

The SMTP mail transaction process consists of three steps:

1. Transaction Initiation and Sender Identification: The SMTP sender
tells the SMTP receiver that it wants to start sending a message and gives
the receiver the e-mail address of the message’s originator.

2. Recipient Identification: The sender tells the receiver the e-mail
address(es) of the intended recipients of the message.

3. Mail Transfer: The sender transfers the e-mail message to the receiver.
This is a complete e-mail message meeting the RFC 822 specification (which
may be in MIME format as well) (refer Figure 9.4).

abc@xyz.com

efg@xyz.com

efg

abc

efg

abc

Fig. 9.4 SMTP Mail Transaction

SMTP Security Issues

The base protocol does not include any security mechanism as the Internet security
was not an issue in the times when SMTP was designed. But with the change in
current scenario, e-mail is so often abused today, most modern SMTP servers
incorporate one or more security features to avoid any problem.
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The SMTP sender performs operations using a set of SMTP commands. Each
command is identified using a four-letter code. Since SMTP only supports a limited
number of functions, it has a small command set (see Figure 9.5).

Fig. 9.5 SMTP Commands and Responses

 Command Format

Figure 9.6 shows the command format.

Fig. 9.6 Command Format

 Commands

Figure 9.7 shows the various commands in SMTP.

Keyword Argument(s) 
HELO Sender’s host name. 
MAIL FROM Sender’s of the message. 
RCPT TO Intended recipient of the message. 
DATA Body of the mail. 
QUIT Terminates the session. 
RSET Nullifies the entire message transaction and resets the buffer. 
VRFY Name of recipient to be verified. 
NOOP Ask a receiver to send a valid reply. 
TURN Allows the client and server to switch the role. 
EXPN Mailing list to be expanded. 
HELP Ask the receiver to send helpful information to the sender. 
SEND Deliver e-mail to one or more workstations. 
SMOL FROM Deliver e-mail to one or more workstations or recipients if 

the user is not active. 
SMAL FROM Deliver e-mail to one or more workstations and recipients if 

the user is not active. 
 Fig. 9.7 Commands

SMTP Responses

Each time the SMTP sender issues a command, it receives a reply from the SMTP
receiver (refer Figure 9.8). These replies are similar to FTP replies, and uses both
a three-digit reply code and a descriptive text line. A special enhanced status
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codes SMTP extension is also defined; when enabled, this causes the SMTP
receiver to return more detailed result information after processing a command.

Fig. 9.8 SMTP Responses

NetBIOS

NetBIOS Stands for Network Basic Input/Output System. This program was
created by IBM for early PC in order to allow applications on different computers
to communicate within a Local Area Network (LAN). Later Microsoft adopted it
and it became a de facto industry standard. Initially NetBIOS is used in Ethernet
and Token ring network, howeverthe later user interface was included in it and it
was extended as NetBIOS Extended User Interface (NetBEUI) adaptable with
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E-mail and InternetMicrosoft Windows operating systems. As it does not support a routing mechanism.
Thus, user of NetBIOS needs a transport mechanism like TCP so that applications
communicating on a Wide Area Network (WAN) are able to communicate along
with NetBIOS. It hides the details of network from application under execution. It
also includes an error recovery mechanism that is applicable in session mode.
Using a network control block it provides a message location and the name of a
destination. In the OSI model NetBIOS provide the session and transport services.

NetBIOS provides two communication modes namely session or datagram.

 Session mode is connection oriented where two computers establish a
connection if they want to transfer some data. This technique is useful for transferring
large messages as it supports error detection and recovery.

Datagram mode is ‘connectionless’ where each message is sent
independently. This mechanism is suitable for smaller messages here application is
responsible for error detection and recovery. Datagram mode is typically used for
broadcasting a message to every computer on the LAN.

Gopher

The Gopher protocol is an application layer protocol based on TCP/IP which
was invented by a team led by Mark P. McCahill at the University of Minnesota in
1991 with an objective of searching, retrieving and distributing documents over
the Internet. In was designed with a user friendly approach hence it is oriented
towards a menu-document design, and was considered as an alternate to WWW
in its early stage, however later HTTP became a dominant protocol. It allows the
client to use many resources available on the Internet in a simple, consistent manner.

The text menu interface was easy to use and was designed keeping
in mind the text oriented computer systems used in those days. Because it provide
a convenient way to move from one menu to another it appear like all gopher
servers act as one interconnected large system also refered as ‘GOPHERSPACE’.
Recently Gopher has modified and has introduced graphical interface that support
multimedia.

The Gopher is based on the client-server oriented approach and supported
by TCP. It uses TCP protocol for communication and data exchange. It uses
software based on a simple protocol for searching and retrieving files from Gopher
servers on the Internet. The biggest advantage of Gopher is its easy-to-use interface
also provides facility to create customized menu. Further it allows administrators
to create links to other computers or services, to annotate files and directories,
hence used as a tool within the organization for finding any information more quickly
and efficiently. The Gopher server uses tag files for generating menus, links and
annotations thus by using menu any client of the Gopher can download the required
files, switch to a directory, or link to other Gopher servers. It presents information
in a hierarchical structure and the client presents the user with the directory list and
client can choose a subdirectory from the displayed list to find the particular file.
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As said it is based on the TCP protocol which is a connection oriented
protocol thus a connection is established between client and server before data
transmission but it does not maintain the connection between the requests like
FTP, it is also known as stateless connection. The client initiates the connection by
sending a selector to the server. This selector includes a line of text that consists of
a series of character or a null string. The server responds with a block of text
terminated with a period on the line itself, once an acknowledgement is received
from client and server close the connection.

The Gopher protocol supports client–server software that searches files on
the Internet. A Gopher client is required for validating and testing of Gopher
publishing service. For example, WS Gopher 1.2 is available on the Internet as
shareware. The server based text files are hierarchically organized and viewed by
end-users. These end-users access the server by using Gopher applications of
remote computers. Gopher browsers initially display the text-based files. Most of
the files along with database are available on Gopher that converts HTTP compatible
formats and makes them available on the Internet.

In the preceding screen, the Internet Service Manager displays the services
that are installed on the server to which the Internet service manager is attached.

Veronica

Veronica is a search engine. It helps to search any item on the Internet. It is a
gopher based resource that helps to search a gopherspace for menu item that
contain specialized words. It is a very useful tool and without it the gopherspace
will become hard to navigate. The main reason behind it was a lot of people setup
gopher servers and creates menus full of interesting stuff. This created a problem
as identifying the menu that will fulfill the user need and was a tough job. The
veronica has a big database of available services. Veronica tracks all the gopher
menus that can be accessed directly or through Mother Gopher in Minnesota.
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E-mail and InternetThus there is a special which program that on a regular basis contacts all Gopher
servers and asks for a copy of all menus. These menus were stored in a database.
It was developed in 1992 by Steven Foster and Freid Barrie in System computing
Department of Univeristy of Nevada at Reno.

To use the Verinoca, user has to find the resource on the menu somewhere
and select the item. It will check the database and find all items that contain the
given search pattern and send to the user in the form of the menu. There are two
different ways of Veronica searching:

(a) Menu Search: It searches through the names of existing gopher menus
and returns a menu of menus of word which include the word which is
being searched.

(b) Item Search: It searches through every gopher menu item and create a
menu of the entire item that matches the words being selected?

Archie

There are ten thousands of anonymous FTP servers available on the Internet and
there is no central directory which can help the user to find a particular file. Archie
fills this gap and provide a service that helps to find files available on anonymous
FTP servers. It just goes around the world, checking database after database
looking to find a file that a user is looking for. The word Archie is chosen because
it sounds like the word archive. Archie is a program that allows searching a file if
the client knows the file name or part of of a file name from the entire Internet
FTP server. The Archie was developed as a project by Alan Emtage and Bill
Heelan with help of Peter Deutsch at Mcgill University School of Computer Science
in Montreal, Canada.

Let us see how Archie works:

(a) At regular interval a special program run by Archie server that connect to
all possible anonymous FTP server (host).

(b) Download complete directory listing of all public file.

(c) These lists are stored in “Internet Archieves Database”.

Thus there are a large number of Archie server that visits each anonymous
FTP site, and reads all the file and directory names, and also index them as one
large index. The Archie server checks the user query against this index. There are
three ways through which a user can use Archie server.

(a) User can contact an Archie client which in turn contact Archie server on
behalf of user, provide information, what user is looking for, to Archie server.
The server performs the search and displays the result to the user.

(b) User can use Archie through Telnet. Thus user needs to log in with userid of
Archie through Telnet. The Telnet provides the facility to connect a remote
computer log in, and work directly, i.e., once connected user interact with
Archie server and tell what it want to search and enter the Archie search
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commands. Once commands are received the Archie server will process
the request and display the result. The Archie also provide a facility of “whatis”
that provide a description of thousands of different programs, data files and
document in case use is not clear about the file it is looking for. It also
provides a form interface called ArchiePlex which is easier to use.

(c) If one does not want to get a direct connection to Archie server it can also
mail the request and Archie server will process the request and mail the
result to the client.

Although Archie is also considered as the Internet’s first search engine, but
it lost its importance with the growth of the World Wide Web.

If some programs are installed in a system unit and you want to know the
availability of the program on the Internet, you can get to know the machine along
with such programs via Archie. Basically, Archie is a program that searches files
anywhere on the Internet by filename. This facility is maintained by a database
with the Internet sites accessible via anonymous FTP. Table 9.1 shows the various
types of Archie servers.

Table 9.1 Various Types of Archie Servers

Name IP Address 
archie.rutgers.edu 128.6.18.15 
archie.cs.mcgill.ca 132.206.51.250 
archie.funet.fi 128.214.6.102 
archie.rediris.es 130.206.1.2 
archie.sura.net 192.239.16.13 
archie.doc.ic.ac.uk 146.169.16.11 

The Archie server can be accessed via Telnet, for example, ‘Telnet
archie.rutgers.edu’. For getting Archie server login to ‘Archie’. It requires no
password. You can look for files by its full name. For this, either ‘set type exact’
syntax is used or you can use ‘set type sub’ syntax. The ‘set type sub’ syntax is
used if the required name of the file is known. The ‘find file-name’ syntax is also
used to find the required file name.

WAIS (Wide Area Information Servers)

WAIS (Wide Area Information Servers) also pronounced as ‘ways’is a program
that enable auser to search for content of file by inputting any string of the text that
belong to that file. It is basically an English language query search engine that acts
as a front end to large database that contain text based document. It proved very
useful for the Internet system in which some specialized subject databases are
created at multiple server, in such a system it becomes necessary to provide a list
of distributed databases that contain this information. WAIS keeptrack of all such
multiple servers at one location by creating a directory of servers at one location
and made them available for searching by the client.
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E-mail and InternetThe three components of WAIS are:

(a) Client:One who places the request.

(b) Server:On request of the client the server returns a list of documents that
contain the words or phrases that client want to search. It uses heuristic
approach to rank the documents.

(c) An indexer: It takes all lists of files present in servers and the one publisher
want to index. It then generates an index file that includes the a directory of:

(i) All words appearing in the database.

(ii) Name of the file or document in which these words appear.

(iii) Headline or a short summary of the documents that include the searched
word to give a view to the user.

It uses its own Internet protocol which is an extension of the Z39.50 standard
(Information Retrieval Service Definition and Protocol Specification for Library
Applications) of the National Information Standards Organization. Both commercial
and freeware servers of WAIS are available with many features like incremental
indexing which provide reindexing once there is some information is amended in
the database. The publishers provide flexibility of creating an index file that can
serve through WWW or Gopher. Thus the key advantages of WAIS are as follows:

(a) It allows user to select information from large database which may be
distributed over many server, i.e., distributed database.

(b) This distributed database can be heterogeneous thus user need not know
the details of a variety of systems used and their background.

(c) It provides a description of each text that meets the string which is being
searched.

(d) The user can download the full text.

(e) It provides the ways to download and organize the retrieved data.

PING

PING is a diagnostic approach to identify that a given IP address exist or not it,
i.e., it is used to find if a particular IP address exist or not and also whether it is
available for accepting requests and communicate back. The verbal meaning of
PING is “to get the attention of” or “to check for the presence of”. PING stand
for “Packet Internet or Inter-Network Groper”. It is very similar to dial a phone
or a mobile number to find whether the other partner is online or not and once the
correspondent receive the call response back to mark its presence. It is used for
trouble shooting like to testconnectivity, i.e., to find whether their IP address we
want to reach is connected or not and also to test the response time i.e., the time
taken to get back the reply (speed of the network connectivity). It also help to find
the dot address for a given domain name.
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9.3 E-MAIL

Electronic mail or e-mail is one of the most popular network services. The use of
e-mail is considered the foremost reason behind the popularity of the Internet. The
proliferation of cyber cafés can be attributed to e-mail or World Wide Web.
E-mail provides an efficient and fast means of communication with relatives, friends
or colleagues throughout the world. With the help of e-mail, one cannot only
communicate with myriad people at a time but can also receive and send files and
other information within a fraction of seconds. The biggest advantage of e-mail is
that the intended receiver of the message does not require to be present at their
desktop at the time of receiving of the message.

Definition

The term e-mail connotes the basic communication facility provided by the Internet
to its users to send and receive messages in any part of the world. It is considered
one of the most popular applications of the Internet and is accounted for 90% of
the Internet traffic. E-mail facilitates sending of messages in the form of a text,
audio and video or even a combination of these types. When a message is sent
from the source user, it reaches the recipient’s mail box. The e-mail message received
by the recipient can be opened, discarded, edited, saved, responded back to or
can even be forwarded to some other recipient. E-mail messages are delivered
instantly after the transmission. An e-mail can be sent by connecting to the network
from any location. An Internet connection usually requires a telephone line, a modem
and a computer. Wireless connections have also become popular means of getting
connected to the Internet. This job is accomplished by the Simple Mail Transfer
Protocol (SMTP) running over TCP/IP.

Uses of E-Mail

E-mail provides several features that are useful in day-to-day life. It is an efficient
and cost-effective way of communication across the world. With the help of
e-mail, one can send common letters or circulars to several recipients. The e-mail
messages are delivered instantly, even if they are sent to remote locations worldwide.
Thus, it saves time as well as money. Whereas the postal messages are time
consuming. E-mail provides an address book facility which keeps a record of the
e-mail addresses. This saves the user from the predicament of remembering the
addresses of the recipients. In addition, a lot of time, energy and money is saved
as the user creates a mailing list with a group name, so that a letter or a circular can
be transmitted by just typing the name of the particular group. Another advantage
of using e-mail is that provided the e-mail address typed in is correct, it enables
the sender to know immediately whether the message has been delivered to the
recipient,. In case the message is not delivered, the sender will receive a return e-
mail message to inform him about the failure of the particular message. E-mail
goes beyond all time zones and barriers.
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E-mail and InternetE-mail also provides the user with a facility of attachment which allows the
user to attach any file created in any application, such as Word processors,
spreadsheet or PowerPoint presentations. For example, if the total amount of
outstanding against a client is computed in a spreadsheet, the client may be informed
through a letter in e-mail along with an attachment showing his outstanding amount
in the spreadsheet. The primary advantages of e-mail can be summarized in the
following:

 It conducts paperless communication of messages quickly.

 It ensures simultaneous transmission of messages to several users. The
messages may comprise of pictures, video, film clips, text, animation or
even a combination of them. Voice and audio messages can also be
transmitted this way.

 The e-mail messages can also be printed, prioritized, forwarded and
stored.

 Public bulletin boards can be created in which every member of the
organization can post and view messages. This can also be accomplished
in the case of shared text messages and application files used widely
across computer platforms.

 It allows delivery and receiving of faxes and meetings can also be
scheduled through e-mail.

E-Mail and Importance of @ Symbol

The magic of ‘icon’ can be symbolized with the help of ‘@’ icon. Basically, this
icon is the special character on the computer keyboard and a prime component of
e-mail address. It was iconized in the ‘Museum of Modern Art’ in ‘New York’.
This ‘@’ symbol is deemed to be significance that it was known as for its design
collections and architecture. This icon was originated by the American Underwood
in year 1885. This icon has been composed of 25 architecture and design specialists
after winning the approval of acquisition committee of icon’s specialists. The Bolt,
Beranek and Newman (BBN Technologies) developed a communication network
for messaging the service. This company provides research and development
services and packet switching including the ARPANET and the Internet. In the
year 1971, an American programmer, Raymond Tomlinson, added this icon to the
first e-mail message that was to be sent from one system to other system unit. In
the network era, this icon becomes a supernova of visual and digital age and that
is why, it has been elevated to the design collection.

In e-mail, the ‘@’ symbol was used to separate a person’s online user
name from his mail server address, for example, user@abc.com. Its widespread
use on the Internet made it necessary to put this symbol on keyboards. The
significance of the ‘@’ symbol is that it separates the user id from the domain
name. E-mail services provide a best communication between users and the Internet
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applications. It is frequently used to inform the exceptional events and system
failures. The attachments are helpful in sending the log files which are used to
dump the information from failed process to the developer. The outgoing Simple
Mail Transfer Protocol or SMTP mail server address comes in the form of
smtp.yourSMTP.com or it can be taken as mail.yourISP.com towards Web
address of the Internet Service Provider or ISP. ISP is a company that accesses
the Internet services. This service provider provides a software package in which
you get registration with the providing services. Once you registered with username,
password and dialing phone number, you can access ISP by paying the monthly
fee. This software package is equipped with modem that is connected with the
Internet services.

Certain equipments which are required to access the Internet are as follows.
Amongst these, some of them are mandatory and some are optional.

 Computer: A computer which is used to browse the Internet may either
be a personal computer with Pentium processor or a Macintosh. It should
have enough power and memory concomitant with multimedia features.
Though 128 MB RAM is sufficient to have access to Internet but 512
MB RAM or more is recommended. Now-a-days, devices like smart
phones, mobile phones, Pocket PCs, etc., are also used to browse the
Internet.

 Modem: It stands for Modulator/Demodulator. This may either be
internally built in or externally connected. The modem is a device that
converts data in binary code used by the computer, to an analog signal
that can be transmitted over the telephone network and vice versa.

 Internet Account with a Service Provider: An account with a service
provider is essential to create a link between the user’s computer and
the Internet. A service provider, which is popularly referred to as ISP
(Internet Service Provider), signifies phone or cable companies that
provide last mile connectivity. It may also refer to a cable line from the
subscriber’s home to his office and also to an exchange for long distance
connectivity based on monthly or annual charges.

 Widely used Current Standard Broadband Technologies: These
technologies  are DSLs, that is, Digital Subscriber Line (DSL) and cable
modems. However, recent technologies like VDSL and optical fiber
connections are also gradually becoming popular in providing Internet
access in a much more cost-effective way than copper wire technology.
Wi-Fi networks are also used to provide the Internet connections.
However, these are not served in the areas by cable or ADSL. The
WiMAX has been gaining popularity with regard to mobile and stationary
broadband access.

 Internet Browser Software: It is the software tool which enables a
user to browse the Internet with the help of Web addresses or URLs. A
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E-mail and Internetfew of the widely used browsers are Internet Explorer (IE) version 7 or
8, Netscape, Mozilla Firefox, Chrome, AOL, Opera, etc.

 Anti-Virus Software: These are used to protect the user from the
onslaught of the nasty programs that obtain access to the user’s terminal
when he/she is surfing the network or downloading contents from there.
Some examples of anti-virus software are Symantec, Norton, McAfee,
etc.

 E-Mail Software: The e-mail software may be chosen from the Outlook
or Outlook Express. Google, Yahoo and Hotmail offer free Web-mail
for the same.

 Plug-In Software: It is considered an add-on to the user terminal. It
enables the user to avail services like music, video, multimedia, etc., on
the Internet. The most popular plug-in-softwares include Real Audio
music player, Macromedia Flash Player, Windows Media Player, Apple
Quick Time, Java Virtual Machine, etc.

 Stereo Speakers, Microphone and Webcam: These equipments
enable the user to play sounds, videos, to conduct Internet telephoning
and to send images to other users connected to the Internet.

Opening an E-Mail Account

Opening an e-mail account is not an issue. Now-a-days, all subscribers get facility
to open an e-mail account free of cost. A number of Web services like Google,
Hotmail, Yahoo, etc., are readily available to register a user to open an e-mail
account and access it from anywhere in the world.  However, to avail this facility,
the user should have access to a computer and an Internet connection. In addition
to these Web services, organizations or ISPs also provide Web interfaces to enable
the users to open their e-mail accounts, though by charging them. In this case, the
organization or ISP possesses the personal record of the users and based on their
personal records and their relationship with them, they open their e-mail accounts
and equip them with an e-mail address. The e-mail addresses comprise of e-mail
ids meant for individual users, which could be their first name or a combination of
their name and surname or their date of birth, etc., along with the URL of the
organization. For example, in sanjay0203@teraclean.com, sanjay 0203 signifies
e-mail id consisting of the name and birth date and month, whereas teraclean.com
indicates the URL of the organization.

In case of universally available Web services like Google, Hotmail or Yahoo,
the user needs to open the Website of the respective Web service by typing its
corresponding URL in the Web browser. For example, if the user wants to open
an account in the Google Web service, then he needs to key the Web address of
Google, that is, www.google.com. Once the Website of Google opens, the user
needs to click on the Gmail service of the Google. The Gmail interface provides
the facility for opening of a new account, for which it provides a registration form



E-mail and Internet

NOTES

Self-Instructional
246 Material

to be filled up by the user. In accordance with the procedure, the user mentions his
personal information, e-mail id and password in the form. Thereafter, he gets
registered and obtains an e-mail address. This process of creating an e-mail account
is described as follows:

Type the URL “http://www.google.com” in the address bar of a Web browser,
such as an Internet Explorer, to visit the Google homepage as shown in screen
below.

The page shows a hyper link namely Gmail. Once you click on the Gmail
link, it navigates you to another Web page as shown in given screen. If you have
an existing account with Gmail, you can type in your e-mail id and your password
to log on to your account. If you are accessing the Gmail for the first time, then you
need to create an account for yourself. The procedure for the same is as follows:
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E-mail and InternetClick on the “Sign up” icon as illustrated in screen. This will lead you to
another Web page that contains the registration form as shown in screenshot below.
Now you are required to fill the form that asks for your personal details along with
your user ID and password to open a new e-mail account for you.

Once you are through with the registration process, after accepting the terms
and conditions, you become a member and thereafter you are  able to use your e-
mail account to send and receive e-mails. Now all you need is to remember your
user ID and your password for future use of your e-mail account. In other words,
it means that whenever you need to log on to your newly created account, you
need to simply type  your user ID and your password.

Reading and Writing E-Mail

E-mail is extensively used by people across the world. The procedure of reading
and writing an e-mail is not a very sophisticated one. The steps involved are as
follows:

Reading an E-Mail Message

The e-mail account can be accessed at anytime and from anywhere by logging on
to the particular e-mail account, as mentioned earlier. To read or write an e-mail,
you need to perform the following steps:

1. Type the URL “http://www.google.com” in the address bar of a Web
browser.
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2. Enter your user ID and the password as shown in screenshot below.

Once you have signed in successfully, you can access your e-mail account
as shown in screenshot below.

Clicking on the Inbox icon lets you open your Inbox. The Inbox folder
contains all your previous e-mail messages and also enables you to read the new
ones. You also have an option of deleting the previous messages or transferring
them to some other folders also. An e-mail message in the Inbox can be read by
clicking on the e-mail subject or any other clickable item therein. This displays the
contents of the message to be read and allows you to take appropriate action
accordingly. Some e-mail messages are delivered along with attachments.
Attachments may comprise of textual messages, graphics, pictures, videos, sounds
or a combination of these types.
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E-mail and InternetThe e-mail message depicts an attachment button within the message itself,
which on being clicked enables you to either open the attachment in relevant
applications or save it on your computer to be opened separately.

Writing an E-Mail Message

As mentioned earlier, e-mail account can be accessed by logging on to e-mail
account. To write an e-mail, you need to perform the following steps:

The Compose option on the left hand side of the screen enables you to
write an e-mail message. Attachments can also be appended along with the e-mail
messages wherever they are required. The following steps are to be followed for
writing and sending an e-mail message:

1. To: It is a field in which the valid e-mail address of the recipient like
User ID@domain.com is typed in, so that the message can be delivered
correctly. In case of multiple recipients, e-mail address of each recipient
is typed in the same box separated by comas.

2. Cc: It signifies the e-mail address/(s) of the recipient/(s) to whom a
carbon copy of the message is to be transmitted. The recipient/(s)
specified in To field also receives the e-mail address/(s) of the recipients
in their messages indicating that e-mail address/(s) in the Cc field also
receive/(s) the same message.

3. Bcc: It denotes the e-mail address/(s) of the recipient/(s) to whom a
copy of the message is transmitted. However, in this case, the recipient/
(s) in both To and Cc field remain oblivious of the other  e-mail addresses,
to which the message is sent.  Bcc stands for blind carbon copy.

4. Subject: This box enables the sender to write the subject of the message,
so that recipient/(s) on receiving the message, could have a clear idea of
what the e-mail message is about.

5. Message box: It is the field in which you type your message which is
to be transmitted.

An attachment can also be appended to the e-mail message before sending
it. There exists an Attachment button within the compose mail box. On clicking on
the Attachment button, you are asked to provide the location of the desired file to
be attached. You then click on the Browse button which enables you to select the
desired file from your computer. Finally, clicking on the Attach or OK button
attaches the document along with your e-mail message.

Your message with or without attachment is now ready to be transmitted.
Now you need to follow the following steps:

1. If you want to postpone transmitting of your message, you have another
option called Draft in which you can save your message to be transmitted
later. The message saved in the Draft can also be modified before
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transmission. The Draft webpage provides you a Send button. On
clicking on it, your message is transmitted and a copy of the message is
saved in your Sent mailbox, provided the send and save option has
been set.

2. If you do not want to postpone the transmission of your message, then
just click on the Send button. On clicking on it, your message will be
transmitted and a copy of the message will be saved in your Sent mailbox.

9.4 SEARCH ENGINES

A search engine is a software system that enables users to search for information
on the Web using keywords. It is designed to help the Internet users locate the
Internet resources, such as Web pages, documents, programs and images using a
keyword search mechanism. Search engines typically use databases that contain
references to a host of resources. The users interact with a search engine using an
interface. There are many search engines available with different appearances and
search mechanisms. Some commonly used search engines are: Google, Yahoo,
MSN, Altavista, AOL, Ask Jeeves, Lycos, Excite and HotBot.

Google (http://www.google.com) Yahoo (http://www.yahoo.com)

 

9.5 BROWSERS

A browser is a software which your computer uses to view WWW documents
and access the Internet. The browser program residing in your computer provides
you with the facilities like text formatting, hypertext links, images, sounds, motion
and other features. Internet Explorer and Netscape are considered the most widely
used browsers. Browsers have sub programs called plug-ins to handle the
documents found on the Web. It may also have other plug-ins stored elsewhere in
the computer.

Web browsers are used to interpret special hypertext pages consisting of
the HyperText Mark up Language (HTML) and JavaScript so that they can be
displayed in the given format. Some of the widely used Web browsers are Internet
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E-mail and InternetExplorer, Netscape Navigator, Mozilla Firefox, Google Chrome, Lynx, Opera,
Apple’s Safari, etc.

Components of a Web Browser (Browser Architecture)

A Web browser comprises of three parts. These  are controllers, client programs
and interpreters.

 Controller: The controller obtains input from the keyboard or the mouse
to access Web pages with the help of a client program. After accessing the
Web pages, the controller uses one of the interpreters to display the Web
pages on the host screen.

 Client Programs: These are used to establish TCP sessions with the Web
server or the proxy server. To accomplish this task, the client programs
make use of HTTP, FTP, Gopher or Telnet.

 Interpreters: These are used to display the Web pages on the Web user’s
screen. The interpreters which are used to translate Web pages on the
client’s screen are HTML, CGI and JAVA. Such interpreters  depend on
the type of document. The HTML, which is a markup language and which
allows the browser to change the format of the Web pages, is used for
scripting Web pages. The HTML also helps store instructions along with
the text, so that any browser can read the instructions and format the text
according to the respective host machine.

Functions and Working Principle of Web Browsers

A Web browser is considered to be a client software program using HTTP. It is
supported by a TCP/IP client accessing the Web documents on Web servers. The
browser program basically retrieves hypertext pages that provide advanced features
of the Web, such as virtual memory, memory caching, etc.  Browsers support the
transfer of the hypertext document, for example, playing sound files, transferring
images and implementing the interactive programs, etc. Figure 9.9 illustrates the
structure of a Web browser:

Fig. 9.9  Architecture of a Web Browser

Each browser consists of three parts, a controller, client protocol and
interpreters. The controller receives input from input devices, such as keyboard,
mouse, etc. It uses client programs to access the Web pages. After the document
has been accessed, the controller uses one of the interpreters to display the document
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on screen. The following figure lists the popular Web browsers that are used by
users’ all over world.

Fig. 9.10 Popular Web Browsers

Check Your Progress

1. What is the Gopher based on and what is it supported by?

2. How does the SMTP sender perform operations?

3. What is WAIS?

4. What is a Web browser?

9.6 PLUG-INS AND PORTS

All peripherals need a way to connect to the computer. Let us discuss about
different type of ports and plug-in.

First is most common of all and that is USB. It is abbreviated for Universal
Serial Bus and it is type of port found not only in computer peripheral but also on
gaming consoles, TV, DVD, Blu-ray player and car audio system. In general USB
is nearly everywhere. The rectangular slot found usually found at the back of the
device or computer regardless of the colour is the USB port. It’s worth mentioning
that USB port present on the device you want to connect might look different
sometimes. There are actually different type of USB connectors and ports available.
Old USB slots are non-functional when connected upside down. But recent version
of USB known as “C type USB” has proven itself a welcome change as it does
not matter which way you plug in the USB.

Another significant port located at the back of the computer is Ethernet
port. It allows one to plug in through Ethernet cable which can connect its computer
to some desired network or Internet.
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over the years. The 15 pin VGA port was the standard and can sometimes be
found in the old computer systems and projectors. This type of connectors are
restricted in terms of screen resolution and the quality that it can support.

Another important kind of port is DVI port which comes in few different
variations, some of which suffer the same limitations as that of VGA cable and
port. For this very reason, DVI port is becoming less common.

 By far the most common port and plug duo used for connecting the display
and computer monitor or widescreen TV is HDMI port. HDMI is fully digital and
supports high screen resolution and can also carry audio. It is commonly found
now in just any newly manufactured TV or monitor. HDMI plugs and ports come
in few different sizes too accommodate different devices.

Another port is the Display port. Though it is not common as that as HDMI
but soon it will take its place, because it is actually better in couple of ways
supporting even higher resolutions and frame rates. Display port comes in two
sizes and for Mac, smaller of the two is common known as the mini display port.

Turning to audio, we have got our standard 3.5mm headphone jack and
3.5mm audio input jack. It is worth noting that many audio devices are equipped
with USB ports, hence formerly mentioned pair aren’t always necessary.

Some computers also come with integrated SD card reader which can make
it easier to copy files from digital camera to your computer.

9.7 NEWS GROUPS

Nowadays Newsgroups and Forums are widely used application on the Internet
for reading and communication purposes.

Newsgroups

Newsgroups are discussion groups on the Internet. They require the user to have
a news reader to read the messages. They can be made for certain interests.
Users must also subscribe to a Newsgroups and the messages can be read by any
subscriber. The messages within a Newsgroups are stored on a news server which
is then shared to every subscriber’s server.

Advantage

It is free to subscribe and post.

Disadvantages

  It is not user-friendly.

 The risk of viruses is always there.
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Forums are online discussion sites similar to Newsgroups. Messages are
known as threads and are temporarily archived. To post on a Forum, you will
need to register and agree to a set of rules. Forums are controlled by a forum
administrator and moderated by Forum Moderators.

Advantages

 You can bond with other Forum members.

 It is user-friendly.

Disadvantage

 Some Forums do not allow advertising.

Difference between Forums and Newsgroups

Forums are different from Newsgroups because the users not require a news
reader to use the Forum.

Forums and Newsgroups can help their target market to promote their
Websites.

9.8 IRC (INTERNET RELAY CHAT)

IRC is abbreviated for Internet Relay Chat which is basically a system for chatting
or text messaging over the internet. In other words, it suggests the protocol used
for chatting. It defines a set of rules and conventions. However, in this system, the
chat is not limited to be carried out between only two people, here one has the
option of group communication with as many people as one desires to have in
segregated rooms and channels commonly known. In addition, one has the ability
to do the person to person communication privately. It was developed by Jarkko
Oikarinen in August 1988 at the University of Oulu in Finland. The software
required for chatting over the internet is known as Chat Program, with examples
like Facebook messenger, Google chat, WhatsApp. It is based upon Client/Server
model or IRC Client – IRC Server.

The properties of IRC can be studied by thinking of it like a type of a social
network and using literature, it can be said that the social networks show the
property of small world and a power-law degree distribution. Many studies have
proven that the IRC networks exhibit the properties of social networks which are
very complex. The Properties of net Relay Chat (IRC) networks can be analyzed
on the basis of complex network characteristics.

The two totally different IRC communities which are studied are:-

1. Freenode

2. unfirc.
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E-mail and Internet1. Freenode: The IRC channels which are in freenode are largely used for
chatting. The degree distribution in the case of freenode IRC user distribution
and channel network have been found to be following a power-law
distribution. The Freenode IRC communities are not considered to be scale-
free.

2. Unfirc: The IRC channels in Unfirc are largely utilised for the purpose of
file sharing and warez. The Unfirc’s IRC channel network does follow the
power-law degree but the IRC user network in this case has not been
found to show power-degree distribution due to the very nature of this type
of IRC community. These channels are maintained by IRC bots or file
servers. Because of this, the number of users is high and number of users is
comparatively high.

Other type of popular IRC communities are also being studied and that is
still a work in progress.

Most oftenly, different types of channels are used for different topics of
conversations hence it is convenient to use one channel for one topic. Due to this
reason, IRC networks contain various rooms, or channels. A channel can be defined
as a specific chat group which comes within an IRC and here people can talk to
each other in texts. The channels will always begin with a hashtag (#) which is
representative of the chat topic, such as “#indiansonfacebook” “#itookapictureof”
“#sports” “#culture” etc. If these channels are not password protected, one can
very simply become part of them. The channels which are not password protected
are called public while the password protected ones are called private. It is
mandatory for everyone to have a username to join an IRC conversation. The
username which is also called a handle can be anything that one wants with some
rules such as, it may include letters and numbers but not spaces.

The first step toward that, however, is to find a channel to join and using the
client provided list of the channels on the server, one can easily get started. IRC is
a great tool for the purpose of troubleshooting and problem solving and this gets
even better because most of the support groups of computer software to anything
today are available on IRC and they always respond to any query very promptly.

 There are some precautions too to be taken while using IRC, that one
should never share any personal detail such as debit card number, credit card
number, passwords, and there should be some guidance to minors on these safety
issues while using IRC. There might be people on IRC trying to dupe others by
gaining confidence, so care should be taken regarding this also. Some people are
also trying to harm and disturb others by sending repeated messages and offensive
remarks and spam. There are bots and humans on IRC which are looking for such
malicious activity and those involved are kicked out and legal action can also be
taken against those involved.
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The IRC communication protocol is of the oldest instant electronic
communication protocols. It is a very mature and a properly and meticulously
defined protocol and it has been explained in RFC 1459.

An IRC protocol stack is implement in java in order to gather data from the
IRC servers. In addition to the above, an IRC bot using this protocol stack is also
implemented. This bot will connect to IRC server and will gather the list of IRC
channels therein server. After that, the bot will join each of the channels, gets the
list of all the users in those channel and abandon the channel. Afterwards, the
information gathered is compiled as a bipartite graph representing channels and
also the users on those channels. The process above is repeated for server on
different occasions in order to get a more accurate data which is more
representative.Two totally different networks are derived from the IRC community
data; IRC user and channel networks.

In the IRC user network, IRC users are represented as nodes and two
nodes are connected using an edge if both of the users are in the same IRC channel.

In the case of IRC channel network, the channels are nodes and the two
corresponding channels having common users are connected with an edge.

The analysis of IRC networks are done on the basis of their complex network
properties such as the small-world and scale free properties.

Check Your Progress

5. What are newsgroups?

6. What is IRC and what does it stand for?

7. What is the most common port and plug duo used for connecting the display
and computer monitor?

9.9 ANSWERS TO CHECK YOUR PROGRESS
QUESTIONS

1. The Gopher is based on the client-server oriented approach and is supported
by TCP.

2. The SMTP sender performs operations using a set of SMTP commands.

3. WAIS (Wide Area Information Servers) is a program that enable s a user to
search for content of file by inputting any string of the text that belong to that
file.

4. A Web browser is considered to be a client software program using HTTP.

5. Newsgroups are discussion groups on the Internet.
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E-mail and Internet6. IRC is abbreviated for Internet Relay Chat and is a system for chatting or
text messaging over the internet.

7. The most common port and plug duo used for connecting the display and
computer monitor or widescreen TV is HDMI port.

9.10 SUMMARY

 EDI is based on the Internet connection and transfer of data hence we need
some standard protocol, program and servers that facilitate a smooth
transaction and communication between two trading partners.

 The complete transaction involved in EDI involves transfer of information in
the form of mail.

 The idea of using a reliable, order-preserving transport protocol to transfer
mail electronically is just a simple implementation of data transfer.

 When client wants to send or receive a message it connects through a mail
server which run on a host computer.

 The complete message transfer is managed by a program called
TRANSPORTAGENT which ensures that massage is properly transported
as per SMTP protocol.

 The most important component of the TCP/IP electronic mail system is the
Simple Mail Transfer Protocol (SMTP).

 The only part of the e-mail system for which SMTP is not used is the final
retrieval step by an e-mail recipient.

 In the early days of SMTP, mail was delivered using the relatively inefficient
process of relaying from server to server across the internetwork.

 SMTP servers both send and receive e-mail; the device sending mail acts
as a client for that transaction.

 The delivery of electronic mail using the Simple Mail Transfer Protocol
involves the regular exchange of e-mail messages between SMTP servers.

 If SMTP extensions are supported, the SMTP sender uses the EHLO
(Extended HELO) command instead of HELO, and the SMTP receiver
replies with a list of extensions it will allow the SMTP sender to use.

 The delivery of e-mail message begins with the establishment of an SMTP
session between the devices sending and receiving the message.

 The base protocol does not include any security mechanism as the Internet
security was not an issue in the times when SMTP was designed.

 The SMTP sender performs operations using a set of SMTP commands.
Each command is identified using a four-letter code.
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 NetBIOS Stands for Network Basic Input/Output System. This program
was created by IBM for early PC in order to allow applications on different
computers to communicate within a Local Area Network (LAN).

 Thus, user of NetBIOS needs a transport mechanism like TCP so that
applications communicating on a Wide Area Network (WAN) are able to
communicate along with NetBIOS.

 The sender transfers the e-mail message to the receiver. This is a complete
e-mail message meeting the RFC 822 specification.

 Datagram mode is ‘connectionless’ where each message is sent
independently. This mechanism is suitable for smaller messages here
application is responsible for error detection and recovery.

 The Gopher protocol is an application layer protocol based on TCP/IP
which was invented by a team led by Mark P. McCahill at the University of
Minnesota in 1991 with an objective of searching, retrieving and distributing
documents over the Internet.

 The Gopher is based on the client-server oriented approach and supported
by TCP.

 As said it is based on the TCP protocol which is a connection oriented
protocol thus a connection is established between client and server before
data transmission but it does not maintain the connection between the requests
like FTP, it is also known as stateless connection

 The Gopher protocol supports client–server software that searches files on
the Internet.

 Veronica is a search engine. It helps to search any item on the Internet. It is
a gopher based resource that helps to search a gopherspace for menu item
that contain specialized words.

 There are ten thousands of anonymous FTP servers available on the Internet
and there is no central directory which can help the user to find a particular
file.

 If some programs are installed in a system unit and you want to know the
availability of the program on the Internet, you can get to know the machine
along with such programs via Archie.

 WAIS (Wide Area Information Servers) also pronounced as ‘ways’ is a
program that enable s a user to search for content of file by inputting any
string of the text that belong to that file.

 It uses its own Internet protocol which is an extension of the Z39.50 standard
(Information Retrieval Service Definition and Protocol Specification for
Library Applications) of the National Information Standards Organization.
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E-mail and Internet PING is a diagnostic approach to identify that a given IP address exist or
not it, i.e., it is used to find if a particular IP address exist or not and also
whether it is available for accepting requests and communicate back.

 Electronic mail or e-mail is one of the most popular network services.

 E-mail provides an efficient and fast means of communication with relatives,
friends or colleagues throughout the world.

 The biggest advantage of e-mail is that the intended receiver of the message
does not require to be present at their desktop at the time of receiving of the
message.

 The term e-mail connotes the basic communication facility provided by the
Internet to its users to send and receive messages in any part of the world.

 E-mail facilitates sending of messages in the form of a text, audio and video
or even a combination of these types.

 An e-mail can be sent by connecting to the network from anylocation.

 E-mail provides several features that are useful in day-to-day life. It is an
efficient and cost-effective way of communication across the world.

 The magic of ‘icon’ can be symbolized with the help of ‘@’ icon. Basically,
this icon is the special character on the computer keyboard and a prime
component of e-mail address.

 Opening an e-mail account is not an issue. Now-a-days, all subscribers get
facility to open an e-mail account free of cost.

 Once you are through with the registration process, after accepting the
terms and conditions, you become a member and thereafter you are able to
use your e- mail account to send and receive e-mails.

 The Compose option on the left hand side of the screen enables you to
write an e-mail message.

 An attachment can also be appended to the e-mail message before sending
it.

 If you want to postpone transmitting of your message, you have another
option called Draft in which you can save your message to be transmitted
later.

 A search engine is a software system that enables users to search for
information on the Web using keywords.

 The users interact with a search engine using an interface.

 A browser is software which your computer uses to view WWW documents
and access the Internet.

 Web browsers are used to interpret special hypertext pages consisting of
the HyperText Mark up Language (HTML) and JavaScript so that they
can be displayed in the given format.
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 A Web browser is considered to be a client software program using HTTP.
It is supported by a TCP/IP client accessing the Web documents on Web
servers.

 Forums are online discussion sites similar to Newsgroups. Messages are
known as threads and are temporarily archived.

9.11 KEY WORDS

 Newsgroups: These are discussion groups on the Internet. They require
the user to have a news reader to read the messages.

 Forums: These are online discussion sites similar to Newsgroups. Messages
are known as threads and are temporarily archived. To post on a Forum,
you will need to register and agree to a set of rules. Forums are controlled
by a forum administrator and moderated by Forum Moderators.

9.12 SELF ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. Write a short note on network protocols.

2. What is an e-mail? Describe its functionality.

3. What is a search engine? How is it relevant in modern day use?

4. Differentiate between plug-ins and ports.

5. Write a short note on internet relay chat.

Long-Answer Questions

1. What is SMTP? What are its components? Illustrate your answer with a
diagrammatic representation.

2. “NetBIOS provides two communication modes namely session or
datagram.” Explain these in detail.

3. Write a detailed note on Veronica.

4. “PING is a diagnostic approach to identify that a given IP address exist or
not.” Discuss the functionality of PING in detail.

5. Write a note on newsgroups. What are these used for?

6. “The browser program residing in your computer provides you with the
facilities like text formatting, hypertext links, images, sounds, motion and
other features.” Explain the functionality of a browser in detail.
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UNIT 10 TELE AND VIDEO
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10.0 INTRODUCTION

A teleconference is a telephone meeting between two or more participants. It is a
medium involving technology usual to simple two-way phone connection.
Conference calls connect people through a conference bridge, which is essentially
a server that acts like a telephone and can answer multiple calls simultaneously.
Videoconferencing on the other hand means to conduct a conference between
two or more participants at different sites by using computer networks. The process
involves transmitting audio and video data. In this unit, you will learn about tele
and video conference in detail.

10.1 OBJECTIVES

After going through this unit, you will be able to:

 Understand teleconferencing and its implications

 Discuss reference on the internet

10.2 TELECONFERENCING

Teleconferencing is a technology that allows communication among several people
at distant locations but connected via the telecommunications system, usually over
a telephone line. It is similar to a telephone call but the consersation is extended to
several people instead of only two. Thus, it can reduce the travelling cost, increase
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idea sharing with each other, and result in improved quality and increased
productivity.

A business organization uses teleconferencing to connect to its remote clients
and employees. Teleconferencing enables organizations to arrange meetings,
demonstrate their product, present project updates, and even provide live training
classes to various employees at remote locations. In addition, it can also be used
to report monthly progress.

The simplest form of teleconferencing is to use the three-way calling service
provided by the telephone companies. This service enables you to establish your
own teleconference between yourself and the other two persons. Some of the
teleconferencing service providers provide this service for more than three persons.
Since it is low cost, most companies use teleconferencing service provided by the
telephone companies rather than setting up their own teleconferencing systems.

The traditional mode of teleconferencing enables only voice sharing among
the participants, but modern teleconferencing technologies, namely data
conferencing and videoconferencing, help in sharing information from both the
ends simultaneously. While data conferencing allows sharing electronic documents
with each other, videoconferencing enables the participants to see each other, in
addition to information sharing.

Data Conferencing

Data conferencing is a type of teleconferencing that allows sharing of computer
data such as graphics, drawings, documents, screen, applications, etc., interactively
among multiple users at remote locations. All the participants can view the data,
comment on it, or manipulate it. In data conferencing, devices like keyboard,
screen, mouse, etc., can be shared among the participants or one participant’s
computer can control other participants’ computers.

Data conferencing is performed with the help of whiteboards, application
sharing, and application viewing.

 Whiteboard: It is an online workspace visible to everyone participating
in data conferencing. All the participants can simultaneously write and
draw on the whiteboard and the changes made are viewed by everyone.
Whiteboard employs different tools to support drawing and writing.

 Application sharing: It is like remote control software that allows the
participants at the remote machines to interactively work on an application
installed on only one participant’s machine.

 Application viewing: It is similar to application sharing except that only
one participant is allowed to make changes in the shared document
while others can only view the document and provide suggestions.
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Videoconferencing

Videoconferencing enables conversation among people geographically apart from
one another with a facility to see each other while they converse. The newsreader
on the TV, for example, talking to a reporter(s) at a faraway place(s) and reporting
directly to the audience, uses the videoconferencing facility. Videoconferencing is
an extremely useful means of communication because it saves the time and expense
of travel and can often accomplish many of the things that a physical meeting can.
The five basic components that are required to conduct a videoconferencing are
as follows:

 Camera: To capture the images to be sent across the network

 Monitor or television: To display the images of the people participating in
the video-conference

 Microphone: To record the sound at the sender’s end

 Speakers: To play the recorded sound at the receiver’s end

 Coder/decoder (codec): To compress and decompress video and audio
data, allowing transmission across the network

In addition to these components, the videoconferencing software should also be
installed on the system. Cu-SeeMee and Microsoft NetMeeting are some of the
popular software used for videoconferencing. Here, we will discuss videoconferencing
using Microsoft NetMeeting.

The steps for installing Microsoft NetMeeting are as follows:

1. Click Start and then click Run from the submenu that appears. The Run
dialog box appears.

Fig. 10.1 The Run Dialog Box

2. Type conf.exe in the Open text box and press the Enter key. The Microsoft
NetMeeting wizard appears.
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Fig. 10.2 The Microsoft NetMeeting Wizard

3. Follow the steps of the Microsoft NetMeeting wizard as instructed to install
it.

After installing NetMeeting, you can conduct a videoconference with the other
person who also has all the basic components attached with his or her system. The
steps for conducting videoconferencing using Microsoft NetMeeting are as follows:

1. Start the NetMeeting software. The NetMeeting window appears.

Fig. 10.3 The NetMeeting Window
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2. Click the Call menu and then click New Call. The Place A Call dialog box
appears.

Fig. 10.4 A Place A Call Dialog Box

3. Enter the name of the computer with which you want to have a
videoconference in the To list box and click the Call button. The NetMeeting
message box appears on your screen and the NetMeeting-Incoming Call
message box appears on the screen of the person on the other side.

(a) NetMeeting Message Box (b) NetMeeting-Incoming Call Message

Fig. 10.5 Getting Connected for Videoconferencing

After getting connected, you can begin the videoconferencing over a local network
or the Internet by using the digital camera, microphone and speakers.

Check Your Progress

1. What is teleconferencing?

2. What is data conferencing?

10.3 ACCESSING REFERENCES ON THE
INTERNET

By accessing reference on the internet it is meant that certain information is used
as a reference for a project which is published online. Usually, references on the
internet are accessed in the educational field, for example, doing a paper or writing
essays or any other projects. Since the birth of the World Wide Web, more and
more people are accessing various references found on the internet for doing
various projects and writings. However, one must remember that using the internet
for references and using them in one’s work are not always recommended.
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Publishing anything on the internet is very easy as well as extremely cheap.
As a result, hence, along with reliable and information and academic sources,
wrong and twisted information available as well. When it comes to accessing
random references from the internet, people often are strongly discouraged as
those references often lack credibility. Compared to print publishing, publishing
information on the internet is economical and can be done easily without having to
worry about any information verification or credibility check. The credibility of the
writers who publish information on the internet is also vague and not always worthy,
since twisting facts or publishing information filled with mistakes are easily doable
on the world of web.

 However, neither all the references available on the internet are dubious,
nor accessing them is always a wrong decision. As a user practicing safety measures
regarding the credibility of the online published information while accessing
references on the internet can save one a lot of toiling to come up with informational
writing. Just like the cons of accessing references o the internet, it has its own pros
as well. For example, accessing references on the internet simply saves one from
typing the whole thing as he or she can simply copy paste portions of information
required for their projects.

There are certain ways of referring content from the websites in a project,
by following which one can ensure maximum credibility to their content that they
accessed online. Such as, when accessing reference on the internet, make it a
point to know or mention the name of the author or creator of the accessed reference,
which is generally an organization. Then mention the year or date the web page
has been created or last updated, the name of the organization behind the website
and its content, and also the date when one viewed and accessed reference from
the website. In the end, mentioning the URL of the website from where one has
accessed reference completes the referencing process. While accessing reference
on the internet, remember not to twist or tamper with the published content as it
may lead to copyright-related dismay.

Check Your Progress

3. What does audio teleconferencing refer to?

4. What is meant by accessing reference on the internet?

10.4 ANSWERS TO CHECK YOUR PROGRESS
QUESTIONS

1. Teleconferencing is a technology that allows communication among several
people at distant locations but connected via the telecommunications system,
usually over a telephone line.
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2. Data conferencing is a type of teleconferencing that allows sharing of
computer data such as graphics, drawings, documents, screen, applications,
etc., interactively among multiple users at remote locations.

3. Audio teleconferencing simply refers to the form of teleconferencing where
only voice of different users from different remote locations is connected
through telephone lines.

4. By accessing reference on the internet it is meant that certain information is
used as a reference for a project which is published online.

10.5 SUMMARY

 Teleconferencing is a technology that allows communication among several
people at distant locations but connected via the telecommunications system,
usually over a telephone line.

 A business organization uses teleconferencing to connect to its remote clients
and employees. Teleconferencing enables organizations to arrange meetings,
demonstrate their product, present project updates, and even provide live
training classes to various employees at remote locations.

 The simplest form of teleconferencing is to use the three-way calling service
provided by the telephone companies.

 The traditional mode of teleconferencing enables only voice sharing among
the participants, but modern teleconferencing technologies, namely data
conferencing and videoconferencing, help in sharing information from both
the ends simultaneously.

 Data conferencing is a type of teleconferencing that allows sharing of
computer data such as graphics, drawings, documents, screen, applications,
etc., interactively among multiple users at remote locations.

 Videoconferencing enables conversation among people geographically apart
from one another with a facility to see each other while they converse.

 Videoconferencing is an extremelyuseful means of communication because
it saves the time and expense of travel and can often accomplish many of
the things that a physical meeting can.

 In addition to these components, the videoconferencing software should
also be installed on the system.

 After installing NetMeeting, you can conduct a videoconference with the
other person who also has all the basic components attached with his or her
system.

 The term teleconferencing stands for performing a meeting through the
medium of telecommunications.
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Tele and Video
Conferencing

 The very purpose of teleconferencing is to achieve multi-user communication,
no matter how far the users are from each other.

 Audio teleconferencing simply refers to the form of teleconferencing where
only voice of different users from different remote locations is connected
through telephone lines.

 Also known as computer teleconferencing, web teleconferencing is a mode
of teleconferencing where telephone lines are used in order to connect two
or more computers and modems.

 Also referred to as electronic whiteboarding, audio-graphic teleconferencing
transmits visual information along with making voice communications.

 Just like teleconferencing, video conferencing is also a communication
technology that lets users from different locations hold face-to-face
conferences and meetings.

 Videoconferencing involves the combination of both video and audio in
order to accomplish a real-time face-to-face video conference. In order to
perform a videoconferencing, a monitor and a camera need to be there at
each end of the platform of communication.

 In order to better understand what videoconferencing is, one must remember
its differences from that of teleconferencing.

 Videoconferencing can be divided into two main types, personal and group
video conferencing.

 By accessing reference on the internet it is meant that certain information is
used as a reference for a project which is published online.

 Publishing anything on the internet is very easy as well as extremely cheap.
As a result, hence, along with reliable and information and academic sources,
wrong and twisted information available as well.

 There are certain ways of referring content from the websites in a project,
by following which one can ensure maximum credibility to their content that
they accessed online.

10.6 KEY WORDS

 Audio Teleconferencing: It simply refers to the form of teleconferencing
where only voice of different users from different remote locations is
connected through telephone lines.

 Web Teleconferencing: It is a mode of teleconferencing where telephone
lines are used in order to connect two or more computers and modems.

 Audio-Graphics Teleconferencing: It is also referred to as electronic
white boarding, audio-graphic teleconferencing transmits visual information
along with making voice communications.
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10.7 SELF ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. What is teleconferencing? Give a brief description.

2. Explain the terms:

(i) Whiteboard

(ii) Application sharing

(iii) Application viewing

3. Write a note on the simplest form of teleconferencing.

4. Discuss data conferencing and its use.

Long-Answer Questions

1. What are the types of teleconferencing? Discuss in detail.

2. What does videoconferencing involve? List its types.

3. Write a detailed note about accessing references on the internet.

4. “Videoconferencing enables conversation among people geographically
apart from one another with a facility to see each other while they converse.”
Explain.

5. “While data conferencing allows sharing electronic documents with each
other, videoconferencing enables the participants to see each other, in
addition to information sharing.” Discuss.

10.8 FURTHER READINGS

Rajaraman, V. 2004. Fundamentals of Computers, 4th edition. New Delhi:
Prentice Hall India Pvt. Limited.

Sanders, Donald H. 1983.Computers Today, 1st edition. New York: McGraw-
Hill.

Laudon, Jane P. and Kenneth C. Laudon. Management Information System:
Managing the Digital Firm. New Jersey: Prentice Hall, 2007.

Senn, James A. Analysis and Design of Information System. New York:
McGraw-Hill, 1984.



NOTES

Self-Instructional
Material 271

Conventions of Writing
BLOCK - IV

MEDIA AND USAGES

UNIT 11 CONVENTIONS OF
WRITING

Structure
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11.4 Answers to Check Your Progress Questions
11.5 Summary
11.6 Key Words
11.7 Self Assessment Questions and Exercises
11.8 Further Readings

11.0 INTRODUCTION

New media has always been connected to technologies such as CD-ROM,
streaming media, Web applications, HTML, and DVD video and editing. The fact
that these technologies are itself constantly changing explains the aptness of the
suffix ‘new’ associated to it. It is believed that only those writings matter that are
able to generate at some reaction from the readers. In this unit you will learn about
writing conventions.

11.1 OBJECTIVES

After going through this unit, you will be able to:

 Understand the conventions of writing for new media

 Discuss the linkage of writing to original sources

11.2 CONVENTIONS OF WRITING FOR NEW
MEDIA

When it comes to writing for new media the same terms may come out to be
confusing which leaves a writer more concerned about how to write than focusing
on what to write. The hunger to write can only be satisfied by practicing the skill of
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writing on a regular basis, but the correct usages comes only when this writing skill
is applied cautiously, framed in a proper format, styled to suit the dimensions of
the media one is writing for and the validity of what the writer is writing to that
what his audience is interested to read about.

New media is a bigger and wider platform than the mediums of conventional
media and broadcasting system. It is fast in delivering news and information. But is
also more rapid to influence its end users who call themselves the audience or
sometimes the listeners only but are actually playing much bigger roles as of the
jury to accept or reject the writings served to them at the first place. For it is said
that only those media writings matter that are able to generate at least some reaction
among its readers.

Some call this reaction to be one of chaos. Because it is believed that chaos
can be positive also, just like the act of indulging in perfection-- which often leaves
the person unsatisfied but at the same time makes path for him towards a better
version of life. Such is the chaos of a writing that matters to its readers; they
somewhere feel connected to it and in a response either wishes to change the
negatives they noticed and realized which need to be worked upon or try to
reciprocate the good things they could relate to.

Styles in writing for new media

We have a general tendency to associate people with their styles be it their dressing
style, accessories--costume styling, way of communication, walking styles, gesture
anything; similar to this is the writing style that makes a writer distinct from others.
Because style is what captures ones uniqueness and therefore for a writer the
struggle to retain this uniqueness becomes obvious as it is the sole thing she/he can
call her/his without any inhibitions of what the medium she/he writes for.

Writing styles can be broadly listed as follows:

 Narrative

This is the most common form in storytelling and writing a novel. In the narrative
style of writing the writer narrates the incidents of the tale in a break-free manner
and wishes to take the reader/listener along with him on a journey in which the
story is set. When it comes to new media writing style this same narrative style
takes a slight transformation.

The availability of new media anytime anywhere is an interesting feature
which exposes its readers to be able to access the reading material on their smart
devices from any remote location even while travelling, attending any other event
or performing an everyday task simultaneously. This on one hand serves as an
advantage to today’s generation, on the other hand proves to restrict the writer to
not over exaggerate even the things of joy that otherwise are favorite among readers
of the story as well.
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Conventions of Writing Descriptive

In general the descriptive writing style is used to make a text interesting and indulging
enough.

For example a writer may describe the status of a man

“He was a lean and thin bony structure only, barefooted and wearing just
a pair of worn-out clothes.”

Instead of simply stating

“He was a malnourished, poor man.”

Using this similar style while writing for the new media may bring unwanted
results, unsuccessful to capture the eye of a good number of readers. Researches
based on eye-stalking methods reveal that online readers tend to pay less attention
to the details and are more in hurry to get to the conclusion. They often skip the
left and right side details and are less prone to the fears of missing out on information,
if any.

The writing style a writer is always advised to take up is about two things in
general, one is obviously the choice of what his/her reader feels comfortable with.
Second is the one that goes appropriate with the need of the content that the
writer wants to deliver to its readers through his/her writings. At times it is advised
to the writers to keep their write-up small and within the defined word limits but
like the way a story is not meant to be accommodated in the boundaries of a
poem, to go with the idea of skipping the description that a text demands is also
not a good choice.

For instance when asked to write a description of a product that is up for
sale or while recommending a product to his/her reader (be it the costumer in this
case) all that the writer needs to give is a detailed description of the features of the
given product along with a note of recommendation if required. But what must be
taken care of in this descriptive style is the structure of the description and the
choice of words used that make the described part relevant to the need of the
costumer without any feel of boredom that sometimes even leaves the important
points to be felt as if unwanted in the text.

 Short and handy

This is the key style of successful new media writings. Nowadays people largely
rely on new media sources for the bytes of news and information; the reason
behind it being quick and easy accessibility, exposure to a wide variety of opinions
and views on the same topics, quick response rates and the option available to
almost each individual to easily express their views which is why social media sites
are becoming more popular day by day.

This creates demand for more writings and at the same time expecting these
writings to be short and handy that could be easily engulfed and quickly digested.
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Globalization has reduced the borders and is enabling readers to fast share what
they learned just now across a wide audience.

Why writing style conventions talk of keeping the write-ups short and handy
while writing for new media users can be summed up as follows:

 When data is formatted in short bullet points it easily captures attention.

 Short notes eases the search of selfish readers who are quick in scanning
what they want to read and what not and proceed accordingly.

 Short writings are of more use as they can be more easily used in
references and quick explanations.

 Short notes are easy to understand and create less confusion.

Presentations

We all are aware of the well-known fact stating:

“We eat with our eyes first, then only comes the role of tongue.”

Similar to this the writings served on any new media platform are the food
for the reader and writer is the master chef responsible to present the writings he/
she cooked in a manner that is appealing to the senses of his foodie consumer.

The concept of focusing on the presentation style of a write-up becomes
even more important when the fingers are fast enough to scroll down the pages
that do not appeal to the eyes in the first glance, no matter what content it is
comprised of. The same texts being served in different styles according to its
receivers on different sites is something becoming more usual and acceptable day
by day this is because in the market of new media writings not only the idea but the
presentation also matters!

 Reading from screens of PCs, tablets, e-readers like kindle or smart
phones tends to slow down the reading speed. So the writings must
follow a reading-friendly format.

 While writing for new media a writer must follow the inverted pyramid
rule that focuses first on the conclusion > explanation > descriptive details.
This allows the user an easy access to what he actually wants to read
about.

 Whatever be the opted writing style of the writer it is always necessary
to work on the structure. Formatting the information in separate
paragraphs, breaking the long descriptions in short sentences, using active
verb forms and writing in present tense which makes the article less
complicated as compared to passive voice articles.

 Titles are deciding factor for the user either to click and read the full
write-up or scroll down the newsfeed. Unlike in print media, here headings
must be kept simple and direct in relation to the theme of the write-up
this is because rarely an online reader spares time to ponder on the
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Conventions of Writingrelevance of the title and that too when a wide range of reading material
is available on a single click.

 Even when an online reader is already reading a write-up influenced by
the heading or title of it, to keep him continue with the reading there
must be appropriate subheadings included in the text.

 Each subheading should include an explanation in minimum words along
with the key points given in bullet or list format.

 Using lists and numberings presents the same write-up in a better structure
that is easy to grasp even to any first time user of that page.

Newsfeeds

According to the definitions of oxford dictionary newsfeed is a service by which
news is provided on a regular or continuous basis for onward distribution or
broadcasting.

New media mostly relies on social media platforms like facebook, whatsapp,
instagram, snapchat, twitter, etc other than blogs and web pages. Thus making a
big mainstream social media market that is occupied not only by individuals but
also by a large number of big and small institutions, firms and companies that use
social media as a marketing tool to grow and pull up their reach. Therefore now
new media is not just limited to sharing of individual experiences. It is fast filling the
spaces to create more awareness among its users, broadcasting real time news
from east-west, north-south all directions of the world to every other corner.

From discussing news to newsfeeds we have already covered a long way
from the date of September 2006 when facebook for the very first time introduced
a new feature called ‘newsfeed’ in its home page content list enabling facebook
users to see a constantly updated list of their friend’s facebook activities. Initially
here might have been mixed responses to the concept of newsfeed but nowadays
its actually like a compulsory morning breakfast thing for many social media users
and not just the facebook users.

In the later world the cool options available on instagram, snapchat, clips
by apples and medium’s series have made stories to be the new newsfeed that
slowly eliminating the good old days of posts and pictures in the newsfeed. With
this lot of exposure to news and everyday newsfeed the new media users are
more aware and good in making decisions of what to have and what to reject.
Thus making the job of developing good content for the newsfeed a bit tougher
than ever.

Content developers and writers on new media need to come up with stories
that their audience feels connected with. Monotonously narrating incidents after
incidents or boasting about the merits or demerits of one thing cannot influence the
readers who are becoming smart enough with every next click.
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Unlike on social media platforms, the more basic deciding factor for the
maximum reach of a newsfeed on any other new media platform in the SEO.
When applied to writing, the search engine optimization (SEO) refers to a process
in which the search engine scans the articles available on the internet in accordance
to the occurrence of the typed keywords in the search-bar by the user and ranks
the articles that match the searched list on the higher ranking in the search results
display. Therefore a writer uses some specific keywords in a particular order in
his/her write-up on the page in the hopes that his/her article ranks higher in the
search result displays thus would help to gain greater number of readers on his/her
page.

Hyperlinks

Hyperlinks are simply the reference links. As per definitions of encyclopedia a
hyperlink is a reference to data that the reader can directly follow either by clicking
or tapping on it.

We all are well aware of the complications we face while using conventional
sources of reading materials. How we either used to carry a set of dictionary with
us always of underline the difficult words for later learning and consultation.
Sometimes there could be excerpts narrated from a past incident that we might
have skipped or altogether forgotten about, in such cases we either end up in a
library trying to find out what all had actually happened or we try to consult some
expert who can introduce us some insight on that particular topic.

New media features have completely changed this scenario, now everything’s
just a click away. Hyperlinks include hypertexts that become easy access to look
up to the required references. Writers are extensively writing hyperlinked texts
that reduce the stress of reader to search out here and there for the better
understanding of the text they are actually reading.

This is also helping easy flow of words from one language to another neither
being a thing of hindrance nor requiring any interpreters or translators in between.
This is one of the ways how new media is adding to rapid worldwide globalization.

The major thing of concern to the writers of new media is the choice of
when to hyperlink their texts and when not to. Many a times writers fear the
impact of overuse of hyperlinks that may result into loss of actual information the
writer wants o convey to his/her readers. Sometimes chances of misinterpretations
of facts that are hyperlinked as the references lead to feeling of distrust among the
readers. There have been cases where at times the reader lost track of the original
content and start confusing the ideas and beliefs of the writer with that of the views
expressed in the hypertext.

As every technology has its own merits and demerits, so is the case with the
technological feature of new media called hyperlink. But if used sensibly can prove
to be the cherry on the cake.
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Virtual Reality Modeling Language, sometimes also called as the Virtual Reality
Markup Language is a standard file format designed particularly keeping the internet
or World Wide Web in mind for representing 3-dimensional interactive vector
graphics. It is a universal interchange format for 3D multimedia and graphics.

Words are mightier than the sword but still even words have their limitations,
just like anything else has. What’s different in this idea is the concept that the
digital world believes in nothing like a limitation. The tech-students are everyday
working to overcome these factors that limit the wings of imagination to be realized
on the grounds of reality.

VRMLs help in creating an online environment for the users that provides
them with an environment that is close to reality within the comforts of actually
being away from the real ground zero base. These VRML files are text formats
constituted of specifications to determine the edges and vertices of the required
figures. These are commonly termed as worlds and therefore are specified by .wrl
extension like .doc for documents and .jpg or jpeg for images etc. A number of
3D modeling programs available for multimedia interface can also save the objects
and scenes in VRML format. Due to their purposeful extensive use of being
transferred over internet these otherwise basically plain text files are also mostly
saved in compressed form to favor their transference.

Even the use of multimedia interface is not just limited to basic 3D objects
but is fast becoming more advanced. With these advancements the world of Virtual
Reality Modeling Language is being replaced largely by a new standard referred
to as X3D which ultimately emerged out of VRML only.

Check Your Progress

1. What is the descriptive writing style used for?

2. How do short notes help a reader?

11.3 LINKAGE TO ORIGINAL SOURCES OF NEWS
AND BACKGROUND

The rule number one is to treat others in the manner similar you yourself want to
be treated as; in simpler words to be respected by others you have to respect
others.

Any idea can never be completely an original creation of an individual. Our
ideas are generally a mixed influence of a lot of other ideas and experiences that
we somewhere at sometime had. A writer, being an individual is no different to this
theory; instead he/she is just more aware of his/her surroundings and knows how
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to compile a variety of ideas at one place in a manner that solves the purpose of
the subject he/she is dealing with.

While writing for new media the basic ethics of writing system remains the
same as otherwise. The truth is, almost all writings are inspired either from some
background stories or an idea travelling long way from a distant land. The thing
that keeps on evolving with the changing media with the ever changing times is the
gesture how a writer on a particular media platform pay regards or give credits to
his/her acquired sources of information.

New media is providing its writers with more genuine and easy ways of
linking the information in his/her writings to their original source of news which in
other mediums is often a complex task due to which most of the writers tend to
skip it.

The act of stealing online information and using it to write new articles is still
tried and performed by a number of mischievous people. They do not understand
or maybe don’t really want to understand the hard work that goes into writing an
original piece of write-up that is full of actual news and information relevant to the
topic. For process of gathering real time news in itself is a full time profession that
comes under journalism. Constructing every single sentence from the data received
in the form of untidy, unstructured excerpts of news and information is a valuable
art and the writer must be respected for that.

On the new media system there are a number of ways of doing it. Some of
them can be listed as under:

 Sharing news and articles directly in their original format is the biggest
boon that almost all social media sites provide.

 These tools are the available options of direct sharing of a post or
newsfeed on facebook, whatsapp and instagram. This way they
automatically include the name and reserved credit of the write-up in the
name of its writer.

 Blog writing and pagers support the hyperlinks that are easy way to give
all essential references and credits to the original source of information.

 The writer may hyperlink the name of the multiple sources he/ she used
as background information to develop his/her own work.

 The tagging option on almost all social media like instagram, facebook
and snapchat are not technically but on literal grounds work similar to
the way hyperlinks are used.

 Twitter being one of the most popular social media for letting people
express their views freely is also equipped with the option of tagging
people by adding @username of the person they want to re-tweet in
their own new tweets.



NOTES

Self-Instructional
Material 279

Conventions of Writing There may be chances when a writer wants to quote an entire statement
or a complete example by another writer. The best way is to put that full
excerpt in double quotes and name the writer in its end.

 If the writing consists of a multiple number of references to any single
other writing, generally which could be a research paper or some
experimental data. The writer may provide some space to the source
papers and documents by adding a few notes on that particular work
done by the writer of those research papers or his short bio.

Linking the writings on new media to their original source of information
and adding an insight to the background data is not merely a good etiquette expected
from a genuine writer. This linking of the original sources of news and information
along with background details is actually helpful to the writer to gain trust of his
readers as well as his/her fellow writers. The simple act of giving credits to the
deserving ones can earn them credibility. And none can discard the fact that no
matter what a writer is served with, in the end all that matters to him/her is the
hunger of being praised and trusted for his writing works.

Check Your Progress

3. How is the linking of the original sources of news and information along
with background details helpful to the writer?

4. What are the basic ethics of writing while writing for new media?

11.4 ANSWERS TO CHECK YOUR PROGRESS
QUESTIONS

1. The descriptive writing style is used to make a text interesting and indulging
enough.

2. Short notes eases the search of selfish readers who are quick in scanning
what they want to read and what not.

3. The linking of the original sources of news and information along with
background details is actually helpful to the writer to gain trust of his readers
as well as his/her fellow writers.

4. While writing for new media the basic ethics of writing system remains the
same as otherwise.

11.5 SUMMARY

 New media has always been connected to technologies such as CD-ROM,
streaming media, Web applications, HTML, and DVD video and editing.
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 New media is a bigger and wider platform than the mediums of conventional
media and broadcasting system.

 When it comes to writing for new media the same terms may come out to
be confusing which leaves a writer more concerned about how to write
than focusing on what to write.

 We have a general tendency to associate people with their styles be it their
dressing style, accessories--costume styling, way of communication, walking
styles, gesture anything; similar to this is the writing style that makes a writer
distinct from others.

 In the narrative style of writing the writer narrates the incidents of the tale in
a break-free manner and wishes to take the reader/listener along with him
on a journey in which the story is set.

 The availability of new media anytime anywhere is an interesting feature
which exposes its readers to be able to access the reading material on their
smart devices from any remote location even while travelling, attending any
other event or performing an everyday task simultaneously.

 In general the descriptive writing style is used to make a text interesting and
indulging enough.

 Using this similar style while writing for the new media may bring unwanted
results, unsuccessful to capture the eye of a good number of readers.

 Researches based on eye-stalking methods reveal that online readers tend
to pay less attention to the details and are more in hurry to get to the
conclusion.

 The writing style a writer is always advised to take up is about two things in
general, one is obviously the choice of what his/her reader feels comfortable
with.

 For instance when asked to write a description of a product that is up for
sale or while recommending a product to his/her reader (be it the costumer
in this case) all that the writer needs to give is a detailed description of the
features of the given product along with a note of recommendation if required.

 This is the key style of successful new media writings. Nowadays people
largely rely on new media sources for the bytes of news and information;
the reason behind it being quick and easy accessibility, exposure to a wide
variety of opinions and views on the same topics, quick response rates and
the option available to almost each individual to easily express their views
which is why social media sites are becoming more popular day by day.

 Similar to this the writings served on any new media platform are the food
for the reader and writer is the master chef responsible to present the writings
he/she cooked in a manner that is appealing to the senses of his foodie
consumer.
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Conventions of Writing The concept of focusing on the presentation style of a write-up becomes
even more important when the fingers are fast enough to scroll down the
pages that do not appeal to the eyes in the first glance, no matter what
content it is comprised of.

 Reading from screens of PCs, tablets, e-readers like kindle or smart phones
tends to slow down the reading speed.

 While writing for new media a writer must follow the inverted pyramid rule
that focuses first on the conclusion > explanation > descriptive details.

 Whatever be the opted writing style of the writer it is always necessary to
work on the structure.

 Titles are deciding factor for the user either to click and read the full write-
up or scroll down the newsfeed.

 Even when an online reader is already reading a write-up influenced by the
heading or title of it, to keep him continue with the reading there must be
appropriate subheadings included in the text.

 Using lists and numberings presents the same write-up in a better structure
that is easy to grasp even to any first time user of that page.

11.6 KEY WORDS

 Newsfeed: It is a service by which news is provided on a regular or
continuous basis for onward distribution or broadcasting.

 Hyperlink: It is a reference to data that the reader can directly follow
either by clicking or tapping on it.

 Virtual Reality Modeling Language: It is also called Virtual Reality
Markup Language and is a standard file format designed particularly keeping
the internet or World Wide Web in mind for representing 3-D interactive
vector graphics.

11.7 SELF ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. Write a short note on the conventions of writing for new media.

2. What do you mean by short and handy?

3. What do you mean by newsfeed?

4. Write a short note on hyperlinks and their uses.
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Long-Answer Questions

1. “New media is a bigger and wider platform than the mediums of conventional
media and broadcasting system. It is fast in delivering news and information.”
Explain.

2. Write in detail about narrative and descriptive writing.

3. “The concept of focusing on the presentation style of a write-up becomes
even more important when the fingers are fast enough to scroll down the
pages that do not appeal to the eyes in the first glance, no matter what
content it is comprised of.” Explain.

4. “VRMLs help in creating an online environment for the users that provides
them with an environment that is close to reality within the comforts of actually
being away from the real ground zero base.” Discuss.

5. How do you link writing back to its original source of news and background?
Discuss.
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12.8 Further Readings

12.0 INTRODUCTION

Media relations are a vital part of public relations. Public relations or PR is about
raising your company’s authority, building relationships with key people and
managing your reputation. Sometimes, PR is being confused with marketing and
the importance of public relations is overlooked. But PR is important to increase
sales and gain customers. Public relations is the practice of managing the flow of
information between an individual or organization and the public. In this unit, you
will learn about the importance of public relations and advertisement.

12.1 OBJECTIVES

After going through this unit, you will be able to:

 Understand public relations

 Discuss advertisement through new media

12.2 PUBLIC RELATION AND ADVERTISEMENT
THROUGH NEW MEDIA

With changing time, journalism and mass communication have been changing rapidly.
Previously this sector was letting people know what is happening around them,
but now has become a medium of introducing them to lots of other things. The
entire sector of journalism and mass communication has spread its wings towards
several directions. Thus, public relation and advertisement have also become an
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essential part of this entire segment. In the leading colleges and universities, where
journalism and mass communication is included within the course structure, PR
and advertisement have made crucial part in the syllabus.

This is the age of new media. With the help of internet, people get every
information as quick as possible. They don’t need to wait for newspapers, or even
for televisions. The young generation is internet-kids, you can call. Instead of
watching movies on television or getting updated news in newspaper or journals,
they depend more on websites and web channels. So, it is always better to use
that media to reach them whether you need to do PR for the company or do an
advertisement for the same. This chapter will give some ideas about PR and
advertisement through new media.

What is Public Relation?

In simple words, public relation is a type of strategic communication which is built
by individuals, organizations or companies with the public for the benefits of the
organization. Companies or individuals appoint a public relation officer or agency
to craft their plans and use different types of media to promote those plans which,
in turn, promote their companies and build strong image among the public.

Objectives of Public Relation

The main objective of the public relation officers is to work with the media personnel
to use them for building the brand of the company or individual they work for. In
order to market the products, the PR people use the means of communication in a
various way. The chief objectives of PR are-

1. Building Brand Awareness: When a company is launching a new brand
or modifying the existing one. They use public relation to make people aware
of the new product or the new add-ons to the existing product. Special
events are arranged for that by the PR people.

2. Creating Interests: During promotion of any product or brand, the PR
officers try every means to create interest among the people so that they
can get attracted to it. For example, if your favourite shop is giving discounts
on Christmas, it is the duty of PR officers to focus on the percentage of
discount on types of materials. They can use different media to give the
advertisement of the same.

3. Giving Information: Public relation is another way to make people know
more about the particular product or brand. It is the responsibility of PR
officers to make them know more about the product or services through
articles, press conferences, websites, newsletters, etc.

4. Boosting up the Demand: Finally, through all these activities, PR stimulates
the demand of a particular product or service among the target consumers.
Through shows or advertisements on the internet and television or articles
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in the newspaper, the sales of the product get increased and that is the final
objective of PR.

Public Relation through New Media

To promote a particular product or service, PR officers require a medium. So far,
radio, television, and newspapers were the only media. But, nowadays, with the
advent of internet, social media is one of the greatest and strongest media that can
make every PR ventures successful. But, what is ‘New Media’?

Check Your Progress

1. What is public relation?

2. What is the main objective of the public relation officer?

12.3 NEW MEDIA THE NEW HORIZON OF
MODERN ERA

As digital technologies have seen tremendous progress in latest years, today,
everything has got dependant on it to some great extent; and therefore, new media
is coming up faster into the scene. ‘New Media’ is referred to social media, video
games, blogs, and online news outlets. These are the present-day communication
channels which have far-reaching impact on society, especially in the field of business
and politics.

New media has become an indispensable source of PR and ad today as it
is an interactive platform where the public, whom you are targeted for promoting
your product or service, can actively take part in the PR process and can share
their opinions and views. That helps the companies or the individuals to incorporate
those opinions into their activity and come up with the end result that will have a
strong impact on the target consumers.

Impact of New Media on Public Relation

New media has to boost up public relation to some great extent and it certainly
has some positive impacts on the issue-

 Now, interacting with people is really simple which is important in PR.

 Each company or individuals can get proper feedback which is essential for
a particular product or service.

 With the advent of new media, establishing direct contact is easier now.

 Today, you can reach widely to your target consumers, even in the remote
areas.

 The media relation have become stronger
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 Creating engaging and exclusive content is also possible now.

 One can easily access the workload and edit well.

This is a discussion in nutshell. To know more about how social media has
changed public relations, you need to concentrate on the following discussions:

1. Social Media Has Made Customers More Focussed

As brands have their stronghold on social media, customers can readily get to
know detail about their products or any services and also provide their opinions
faster. If they share negative comments or feedback about anything, the companies
can quickly resolve those to avoid any PR crisis. Besides that, companies can also
interact with people about their products and use the valuable feedbacks.

2. PR Is Now Affordable for Small Businesses Too

So far, it has been believed that PR is for reputed business houses who can spend
on the brand endorsement. Today, any small businesses can appoint PR personnel
who can endorse your business and help you to make it bigger. Hire students of
journalism or public relations who can do it within affordable rate and also become
more experienced.

Advertisements- How New Media Has Its Impact on It

Advertisements are one of the best ways to promote your product or service. But,
for that, the companies or individuals need certain media. So far, television,
newspapers, magazines, radio, etc. were the best media, but, today, with the advent
of internet, social media has become the potent source of advertisements. Before
knowing the impact of new media on an advertisement, you should have a clear
idea about advertisements and its objectives.

What Is Advertisements?

An advertisement is a tool for promoting a particular product or service to build
and increase a large scale of target consumers. Usually, the advertisers buy space
or slot in respective to print media and electronic media. Usually, ads are used to
create brand image along with providing the customers enough information about
the product on the issue, including the prices, usage of the product, etc.

Objectives of Advertisements

Advertising is one of the key tools of marketing. Today, the entire marketing strategy
of anything depends so much on advertising that the fine line between the two has
almost vanished. Presently, digital advertising is replacing another genre of
advertising and getting popular as it is a two-way communication where the target
consumer can actively take part in the process and share their views regarding
this. Here are certain objectives of advertising-
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1. Introducing New Products

This is one of the key objectives of advertising. Whether you want to launch a new
product or it is something to re-launch, there is no better option than advertisements.

2. Creating Awareness

With advertising, you can create awareness about some issues or anything. To
reach more and more customers, advertisements are the best way.

3. Introducing a Brand

For brand building, advertising can help the most. Today, young generation can go
for startups and through ads; they can build their brand and reach to their customers.

4. Building a Brand

When a company or individual creates quality products or offers quality services,
it will definitely want to build a brand so that people know them by name. With
continuous advertisements, it is really possible to become a prominent name in the
industry that is known as brand.

Impact of New Media on Advertisements

Today, people, specifically the young generation is more prone towards spending
time in the web world. They surf internet, watch web series, play mobile games
and all. Therefore, the advertisers aim towards the social media to give their ads.
Here are the vivid impacts of social media on advertisements-

1. Small Businesses Can Grow up

Today, small business people can think of reaching more towards the target
customers. They can give advertisements on social media and soon get noticed.
As social media is a two-way communicative media, people can share their ideas
and feedback on ads that will help the advertisers in the future.

2. Social Media Compliments Advertising

Advertising and social media are strongly inter-connected to each other today.
According to research, it has been proved that the impact of social media on
advertising has increased a lot once the traditional way of advertising has been
amalgamated with the digital advertising of the present day. Due to huge campaigns
in several websites and web channels, the sales have been increased around 300
times than usual.

3. Powerful Content

Ads are always relevant to social life. Today, through social media, the contents of
ads have become stronger than ever before. No matter whatever the product is, it
has to be presented in an exclusive way.
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So far, you got some idea about the impact of new media on public relation
and advertisement. Through this discussion, it is quite evident that to get more
consumers for your product and to promote it further, you will need the help of
new media now so that you can reach to present generation much easier.

Check Your Progress

3. What are advertisements?

4. How has new media become an indispensable source of PR today?

12.4 ANSWERS TO CHECK YOUR PROGRESS
QUESTIONS

1. Public relation is a type of strategic communication which is built by
individuals, organizations or companies with the public for the benefits of
the organization.

2. The main objective of the public relation officers is to work with the media
personnel to use them for building the brand of the company or individual
they work for.

3. Advertisements are one of the best ways to promote your product or service.

4. New media has become an indispensable source of PR and ad today as it
is an interactive platform where the public, whom you are targeted for
promoting your product or service, can actively take part in the PR process
and can share their opinions and views.

12.5 SUMMARY

 With changing time, journalism and mass communication have been changing
rapidly too.

 This is the age of new media. With the help of internet, people get every
information as quick as possible.

 They don’t need to wait for newspapers, or even for televisions. The young
generation is internet-kids, you can call.

 Instead of watching movies on television or getting updated news in
newspaper or journals, they depend more on websites and web channels.

 In simple words, public relation is a type of strategic communication which
is built by individuals, organizations or companies with the public for the
benefits of the organization.
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 Companies or individuals appoint a public relation officer or agency to craft
their plans and use different types of media to promote those plans which,
in turn, promote their companies and build strong image among the public.

 The main objective of the public relation officers is to work with the media
personnel to use them for building the brand of the company or individual
they work for. In order to market the products, the PR people use the
means of communication in a various way.

 When a company is launching a new brand or modifying the existing one.

 During promotion of any product or brand, the PR officers try every means
to create interest among the people so that they can get attracted to it.

 Public relation is another way to make people know more about the particular
product or brand.

 To promote a particular product or service, PR officers require a medium.
So far, radio, television, and newspapers were the only media.

 As digital technologies have seen tremendous progress in latest years, today,
everything has got dependant on it to some great extent; and therefore, new
media is coming up faster into the scene.

 New media has become an indispensable source of PR and ad today as it
is an interactive platform where the public, whom you are targeted for
promoting your product or service, can actively take part in the PR process
and can share their opinions and views.

 As brands have their stronghold on social media, customers can readily get
to know detail about their products or any services and also provide their
opinions faster.

 Advertisements are one of the best ways to promote your product or service.
But, for that, the companies or individuals need certain media.

 An advertisement is a tool for promoting a particular product or service to
build and increase a large scale of target consumers.

 Advertising is one of the key tools of marketing. Today, the entire marketing
strategy of anything depends so much on advertising that the fine line between
the two has almost vanished.

 When a company or individual creates quality products or offers quality
services, it will definitely want to build a brand so that people know them
by name. With continuous advertisements, it is really possible to become a
prominent name in the industry that is known as brand.

 Ads are always relevant to social life. Today, through social media, the
contents of ads have become stronger than ever before. No matter whatever
the product is, it has to be presented in an exclusive way.
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12.6 KEY WORDS

 Advertisement: It is a tool for promoting a particular product or service to
build and increase a large scale of target consumers.

 Public Relation: It is the practice of managing the spread of information
between an individual or an organization and the public.

12.7 SELF ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. What are the objectives of public relation?

2. How is building brand awareness and creating interest different?

3. How can you boost up the demand?

4. How is PR affordable and beneficial for small businesses?

5. What is the impact of new media on advertisement?

Long-Answer Questions

1. “With changing time, journalism and mass communication have been changing
rapidly.” Discuss in detail.

2. Write in detail about public relations and its importance.

3. Write a note on new media- the new horizon of modern era.

4. What are the impacts of new media on public relation?

5. “Advertising and social media are strongly inter-connected to each other.”
Discuss.
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13.0 INTRODUCTION

Multimedia combines different forms of media for text, images, sound, graphics,
animation and video into a single presentation to create a more enriched and
entertaining message. The Machines and Systems used for the creation and
transmission of these type of messages are covered under multimedia technologies.
We are surrounded by multimedia and we experience multimedia in our daily life
all the time these days be it in the form of movies, playing video games, exploring
websites on the Internet or watching television and You Tube.

13.1 OBJECTIVES

After going through this unit, you will be able to:

 Discuss the various ways of formation of digital image by computer

 Understand the significance of streaming audio and video

 Discuss the ethical issues and regulation mechanism

13.2 WORKING WITH IMAGES AND GRAPHICS

The role that image plays in multimedia is very important. A still picture, painting or
photograph taken through a digital medium such as digital camera or a scanner is
called an image. The image is made up of many pixels. The smallest unit of a digital
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image or graphic that can be shown on a digital screen or displaying device is
called a pixel. There are more than one kind of formats of images such as Captured
Image Format and the format when images are to be stored. The captured image
Format is defined on the basis of two main factors that is spatial resolution specified
as pixels x pixels (e.g. 640x480) and the colour encoding specified as bits per
pixel. The both factors mentioned above depend on hardware and software for
input/output of images. When we are storing an image, we store a two-dimensional
array of values, in which each of the value represents the data associated with
every pixel in the image.

Formation of a digital image by computer

Images can be generated by the computer in two ways:

1.  Bitmap or Raster Images

2. Vector Images

1. Bitmap or Raster Images

Bitmap or raster images are made up of a series of very small dots which are
called pixels. Each pixel is actually a very small square which is given a colour, and
then a collection of these pixels arranged in a pattern form the images. When one
zooms in on these images they can see every individual pixel that made up that
image. Bitmap graphics is edited by erasing and/or changing the colour of every
individual pixels using programs such as Adobe Photoshop.

2. Vector Images

Vector images, unlike Bitmap images, are not based on pixel patterns, they instead
use mathematical formulas to draw lines and curves which are then combined to
form an image using the geometric objects such as circles and polygons. Vector
images can be edited by manipulating the lines and curves that were involved in the
formation of the image using programs such as Adobe Illustrator.

Which one is better?

We use vector images in place of Bitmap images as the former ones tend to be
smaller than latter ones. And this happens due to the fact that bitmap image has to
store colour information for each individual pixel that forms the image but on the
other hand, a vector image just has to store the mathematical formulas that form
the image, thus taking up less space.

These images are also more scalable than Raster images. When a bitmap
image is scaled up, individual pixels that make up the image can be seen. This
property is most noticeable on the edges of the image. Some ways of making
these edges less noticeable are there but they often result in making the image
blurry as well. On the other hand, when a vector image is scaled up, the images
are redrawn using the mathematical formulas, so the resulting images are as smooth
as the original ones.
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Some Popular Image Formats

 BMP is also known as bitmap image file or device independent bitmap file
format or   bitmap only.

 GIF or Graphics Interchange Format, is a bitmap image format animation
widely used on the internet.

 JPEG, short form for Joint Photographic Experts Group, by which it is
developed, is a commonly used method for the compression of digital images,
particularly those images which are produced by digital photography.

 PNG (Portable Network Graphics) is a raster type graphics file format
which supports data compression without any sort of loss.

Editing of the Images

There is also a need to edit these images which can be done with the help of few
of the software like general drawing programs, Corel Photo Paint, Macromedia
Fireworks, Art Rage: free (NZ) paint program simulating, JASC Paint Shop Pro,
LibreOffice /Open Office, Draw, My paint, and GIMP. Description of some of
the image and graphic editing tools is given below: -

Adobe Photoshop

 It allows the layering of images, graphics and text.

 It Includes lots of graphics drawing and painting tools.

 It also includes sophisticate lighting filters.

 It can be said that it is a very good image and graphics processing and
manipulation tool.

Among a wide variety of Image Processing softwares now available in the market,
a few of them have become industry standards like Adobe Photoshop, Aldus
Photostyler and Paint Shop Pro. Some other useful packages of that kind are
Fractal Designs Painter, Uleads PhotoImpact and PhotoExpress, Picture
Publisher etc. The Windows Paint accessory provides rudimentary bitmap editing
and painting.

Adobe Photoshop
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Recognized as one of the world-standard image-editing solution in the market
today. Adobe photoshop can open and edit a wide variety of digital images –
images created in Photoshop  or another software or scanned photographs.
Photoshop’s core set of image-editing tools help you mask complex images and
provides a comprehensive environment to expand your creative power with the
most powerful painting and special effect tools. Its cutting-edge Web features,
lets you create dynamic Web graphics and Web animations also.

Today bitmaps are used in multimedia more often than vector drawn objects.
Because bitmapped images, typically, provide the greatest choice and power to
the professional designers for rendering fine detail and effects. Yet packages like
CorelDraw, FreeHand, Illustrator, Designer and Canvas, dedicated to
producing vector-based line art, are still popularly used in the DTP industry.

Powerful modeling packages with improved GUI are increasingly entering
the mainstream of graphic design and multimedia production. Some of the best
softwares widely used  by multimedia developers are AutoDesk’s  3D Studio
Max and AutoCAD, Macromedia’s Extreme 3D, 3D Home Architect etc.

AutoCAD

Still the market leader in CAD softwares, AutoCAD features powerful
solid modeling and rendering tools, illumination control, texture mapping,
etc. The vector-based drawings are created through intuitive commands or
AutoLISP codes.

13.3 STREAMING AUDIO AND VIDEO

Audio or sound is one of the most gratifying elements of multimedia. It can be
defined as the meaningful speech in any language, from a very low-voiced whisper
to a high-pitched scream. The sound pressure level, or simply known as volume,
is measured in decibels, which is the ratio between a chosen reference point on a
logarithmic scale and the actually experienced voice levels.
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1. Musical Instrument Digital Identifier (MIDI)

Musical Instrument Digital Identifier (MIDI) is a communication standard which
was developed in the early 1980s for the audio storage and streaming of sound in
electronic musical instruments and computers. It is a way to connect devices which
make and control sound such as synthesizers, computers, samplers, so that these
devices can communicate with each other, using MIDI messages. In this format,
the music is stored in numeric form. MIDI is a very quick, easy and a very flexible
tool for composing original score in a multimedia project. In order to make MIDI
scores sequencer, a software and a sound synthesizer is needed. A MIDI keyboard
can also be used for the simplification of the creation of musical scores. The quality
will depend on the quality of musical instruments and the capabilities of sound
system. Or in other words, it is device dependent.

2. Digital Audio

Digitised sound is a sampled sound. In every fraction of a second, a sample of
sound is taken and stored as digital information in bits and bytes for its digitisation.
The sampling rate i.e., the rate at which the samples were taken, and the amount
of numbers used to represent the value of every sample such as sample size,
resolution, bit depth, both of these things determine the quality of the digital
recording. If the sample is taken octenyl and the data which is stored is more
about that sample, the resolution and quality of the captured sound will me finer
when it is played back again. The quality of digital audio definitely depends on the
quality of the original audio source, capturing device used, supporting software
and the type and capacity of the playback environment.

Video

Video can be defined as the display of any recorded real event on any screen such
as a television. Videos are embedded in multimedia applications in order to convey
information in a much better way. It incorporates a form of personal element,
which other form of media don’t have. It is helpful in many ways such as, in this the
personality of the presenter can also be displayed. There are two types of videos
which are given below.

1. Analog video

The video which is stored in the non-computer media like videotape, laserdisc,
film etc. are the analog videos. It can be further divided in two types namely,
composite analog video and component analog video.

The analog video contains all the video components such as brightness,
colour, and synchronization, combined into one signal is called composite analog
video. Due to the composition or combining of the video components, the quality
of the composite video is seen as bleeded colour, low clarity and high generational
loss. Generational loss means the loss of quality when the main video is copied for
other purposes such as editing. This format of recording was earlier used for
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customer analog video recording tape formats such as Betamax and VHS and
was never adequate for most multimedia presentations. Composite videos also
suffer from quality loss from one generation to the other.

Component analog video is more advanced in technology than that of
composite analog video. It takes all the different components of the video such as
colour, brightness and synchronization and then breaks them into separate signals.

2. Digital video

It is one of the most engaging of multimedia tools, and it is a powerful tool for
bringing computer users nearer to the real world. Digital video is very storage
intensive. A high-quality colour still image on a computer screen will require one
megabyte or more of storage memory. To provide the appearance of motion,
picture will have to be replaced by at least thirty times per second and the storage
memory that is required is at least thirty megabytes for one second of video. A
better quality of video is formed for a greater number of images in a given time.

Streaming

The data that everyone consumes over their computers such as music, movies,
videos, web pages, emails etc., all get to their computers by basically two different
ways.

1. By progressive downloading

2. By streaming

Earlier the Progressive downloading method was used as streaming method
was not developed. In progressive downloading, in order to use anything, such as
an app, or a game, or to watch a movie, the entire file had to be downloaded first
before it could be used on the devices.

Streaming is a newer technology and in this, the whole file need not be
downloaded first in order to be used. One can start using the content even before
it has been fully downloaded. The streaming of data is prevalent in today’s world,
be it watching videos on YouTube or playing music on Amazon music, the data
starts playing on the devices as soon as we click on the play button. In one case
both audio and video were being streamed while in the other case, only audio was
being streamed.

The streaming has proven to be very helpful for live chats such as on Skype
and on google duo where one can visually interact with another person over the
internet in real time and this type of streaming is called live streaming. In streaming,
the data is delivered as we need it.

People today can play online games in real time with each other because of
the facility of online streaming of games. Another major difference between
streaming and downloading is that the data in streaming is not stored on the devices
while in case of downloading, the data is stored on the device and has to be
deleted to free space.
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Streaming has been made possible by faster data connections. The data
connection should be faster than the rate at which data is required by the device
for playing the media. If the data speed is sufficient the media will play without any
reduction in quality, without any skip, and without any buffering delay.

There are some problems associated with streaming as well. If the data
speed is slower than required we’ll get interrupted streaming of the data. One of
the most common problems associated with streaming is buffering. The buffer is a
program’s temporary memory which stores the streamed content to be played.
The buffer is always collecting and pre-loading the data that we will need next.
For example, while watching a YouTube video, the buffer stores the next few
minutes of the video while we are watching the current part of the video. If the
internet connection gets slow, the buffer will not be able to fill up as quickly as it is
being used up and hence that will cause the streaming to either stops or will cause
the quality of the audio or video to deteriorate to compensate.

Streaming a video

The common streaming formats for videos are:

1. Real Media (.rm)

2. Quicktime (.mov)

3. Adobe flash (.flv)

4. Moving Picture Experts Group or MPEG (.mp4)

5. Windows media video format (.wmv)

For streaming a video, we need a streaming video server, which is defined
as an application which runs on the internet server. Because streaming a video
requires streaming server, the process of creating a streaming video is basically to
save it in a proper format. When we have set up true streaming server, it has the
ability to detect and adjust to the speed of the connection and it can handle a very
high traffic as well. In order to properly do the streaming, we have to properly
optimise the video, audio, and quality of video and audio, the aspect ratio, the
number of frames per second etc.

Video optimization for streaming:

 One should keep the size of images as small as possible.

 When the background is static, compression can be used in order to
keep the file size very small.

Streaming audio

The streaming of audio does not require a special kind of server so it is very easy
to stream audio and anyone can do it. In order to stream, what one needs to do is
to create a .mp3 file and then store that file on the server, after that, the entire path
is captured then on notepad, a file with the same file name as the .mp3 file is
created  with the exception of the .m3u file extension, the content of the .m3u file
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is the path of the .mp3 file, after this, the .m3u file is stored on the server, and a link
in HTML document to .m3u file is created, and finally the file automatically streams.

Video editing

Video editing is the manipulation and arrangement of video shots. Video editing is
used to structure and present all video information, including films and television
shows, video advertisements and video essays. Video editing has been dramatically
democratized in recent years by editing software available for personal computers.

Software Tools for Video Editing

Windows Movie Maker

Windows Movie Maker is a software from Microsoft for personal video editing.
It is distributed free of charge with Microsoft’s OS. You can make digital movies
at home and get footage from your personal camcorder on to your computer for
editing. You can create, edit and add special effects to your home movie and share
them with friends and family.

Windows Movie Maker

Adobe Premiere Pro

This software is a professional video editing tool from Adobe. Created for people
working in video industry, it sports real-time, timeline based video editing. Available
for both Windows and Mac, Premiere Pro is the successor to the popular Adobe
Premiere. It has been used in feature films like Superman Returns and Dust to
Glory. Premiere Pro is tightly integrated After Effects from Adobe, a capable
compositing and graphics tool for motion video.

Jahshaka

It is an open source software tool for video editing. With Jahshaka you can edit
with effects in real time, animate with unlimited features, paint and design on moving
video, create music and work in any format at any resolution.
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Jahshaka

13.4 ETHICAL ISSUES

In the new environment of multimedia, where there seems to be a general perception
that software and intellectual property is free, protection of these aspects and
assets is not an easy task. Materials which are produced for online learning and
tutorials, multimedia developments, and the websites are at the mercy of hackers
and other inquisitive computer users who have deep understanding in this field.
The technological challenge that we are facing and the coming generations will
face to protect these assets from theft, manipulation and illegal copying is a never-
ending battle. Educators play a major role in this protection of the data by giving
proper information, by discussion and by encouraging the students to think about
these issues from an ethical viewpoint. Some aspects that we need to look are as
follows: -

 Copyright

Copyright refers to the legal protection of the ideas and information of the people
against copying and any other form of illegal act such as theft and manipulation.
The most common form of copyright resembles the type of data that is used in
multimedia system such as writing, visual images, music and moving images.
Computer software are also protected by the copyright laws. While using the data
that is owned by someone else, it is important to acknowledge correctly and to
recognise the author and compensate the author. In the field of training and
education, copyright issues can arise commonly and that happens due to reasons
like in education, software is used mostly by school aged children and at that age,
concepts of copyright and plagiarism are not fully understood. Hence, copyright
issues in the form of not acknowledging copyright holders, and accepting false
ownership for work might occur. This can happen in the software like Microsoft
PowerPoint, as it is a very common multimedia platform to be used by school
children. Copyright issues in relation to images also arises very often.



Introduction to Graphics,
Audio and Video

NOTES

Self-Instructional
300 Material

 Appropriate use of the internet

The proper and productive use of the Internet is an issue of concern throughout
the society and many of the organisations monitor online activity of the internet
users and have guidelines that the users have to follow by law. With the easy
availability of multimedia content online, there is more speculations and talks about
if people are being responsible while in using the internet wisely. For this very
reason, many organisations have come up with guidelines regarding things such as
creation, transmission, downloading of any offensive, obscene and socially
unacceptable material. Proper use and utilisation of the internet is an ongoing
concern within schools and the workplace. Filtering software programs like Blue
reef, which block prescribed sites, are used by the administrators for workplace
filtering of unacceptable internet activity. It has become the need of the hour that
blocks and regulations are put in place and enforced within education and training
in order to ensure a safe learning environment.

13.5 REGULATION MECHANISM IN MULTIMEDIA

There is a need of regulation mechanism in media or media regulation. Media
regulation can define as the control or guidance of mass media and media platforms
on the internet by governments and other bodies. These regulations are intended
for the purposes such as for protecting a stated public interest, establishing common
technical standards, protecting the data of people and protecting people against
the harmful things over the internet. Other targets of media regulation may be the
press, radio and television, film, recorded music, cable, satellite, storage and
distribution technology, mobile phones etc.

The main regulations that are employed are:

 Online content regulations

 Telecommunication regulations.

 Broadcasting regulations.

 Spectrum and radio frequency management regulations.

Check Your Progress

1. What is MIDI?

2. What are the two types of analog video?

3. What are the two ways of availing the multimedia content on the system?
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QUESTIONS

1. Musical Instrument Digital Identifier (MIDI) is a communication standard
which was developed in the early 1980s for the audio storage and streaming
of sound in electronic musical instruments and computers.

2. There are two types analog video namely, composite analog video and
component analog video.

3. The data that everyone consumes over their computers such as music,
movies, videos, web pages, emails etc., all get to their computers by basically
two different ways.

(i) By progressive downloading

(ii) By streaming

13.7 SUMMARY

 Multimedia combines different forms of media for text, images, sound,
graphics, animation and video into a single presentation to create a more
enriched and entertaining message.

 A still picture, painting or photograph taken through a digital medium such
as digital camera or a scanner is called an image. The image is made up of
many pixels. The smallest unit of a digital image or graphic that can be
shown on a digital screen or displaying device is called a pixel.

 Bitmap or raster images are made up of a series of very small dots which
are called pixels. Each pixel is actually a very small square which is given a
colour, and then a collection of these pixels arranged in a pattern form the
images.

 Vector images, unlike Bitmap images, are not based on pixel patterns, they
instead use mathematical formulas to draw lines and curves which are then
combined to form an image using the geometric objects such as circles and
polygons.

 Musical Instrument Digital Identifier (MIDI) is a communication standard
which was developed in the early 1980s for the audio storage and streaming
of sound in electronic musical instruments and computers.

 The video which is stored in the non-computer media like videotape,
laserdisc, film etc. are the analog videos. It can be further divided in two
types namely, composite analog video and component analog video.

 Streaming is a newer technology and in this, the whole file need not be
downloaded first in order to be used. One can start using the content even
before it has been fully downloaded.
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 Copyright refers to the legal protection of the ideas and information of the
people against copying and any other form of illegal act such as theft and
manipulation. The most common form of copyright resembles the type of
data that is used in multimedia system such as writing, visual images, music
and moving images.

13.8 KEY WORDS

 Multimedia: It is a mix of text, graphic art, sound, animation and video
elements presented by your computer or any other electronic means.

 MIDI: It is a technical standard that describes a communications
protocol, digital interface, and electrical connectors that connect a wide
variety of electronic musical instruments, computers, and related audio
devices.

13.9 SELF ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. What is multimedia?

2. What are the popular image formats?

3. What are the common streaming formats of video?

Long-Answer Questions

1. Explain the different ways of forming the digital image.

2. Write a detailed note on streaming audio and video.

3. What is the significance of streaming? Explain.

13.10 FURTHER READINGS
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Laudon, Jane P. and Kenneth C. Laudon. Management Information System:
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14.0 INTRODUCTION

In this unit, you will learn about the usages of multimedia and its influences on
social behaviour. Multimedia is a piece of composition from different kinds of
media formats which show a dynamic nature. The most common elements of
multimedia include, text, graphics, sound, animation and video. In today’s world,
multimedia has shown its presence all over the audio visual media and thus has
become an important field for study.

14.1 OBJECTIVES

After going through this unit, you will be able to:

 Explain the multimedia usages

 Discuss the influences on social behaviour and future trends

 Discuss the adverse impacts of multimedia

14.2 MULTIMEDIA: INTRODUCTION AND USAGES

Today, we can say that we live in the era of multimedia. In every discussion, this is
the term that we use after every two to three sentences. What is multimedia and
how does it affect the social life of mankind? Actually, that is a major issue of
discussion. Before knowing how multimedia influences human behaviour, you need
to have some ideas about multimedia and its objective in the present society.
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Definition

As the name says, multimedia is the combination of multiple forms of media. The
different forms of multimedia include texts, videos, audios, graphics and lots of
other formats. Today, multimedia has become an indispensable part of modern life
as information and data are the keys to success in any field. Each multimedia
device is electronic media devices which are used to store multimedia content. In
the field of communication, the combination of different types of media or multimedia
has its great influence. Besides that, every other aspect of life has a great impact
on multimedia and it has been greatly realized with the advancement of internet
nowadays. Multimedia is used to get information through different means of media,
like text, graphics, audio, video, etc. and we can get any kind of information
through these faster than ever.

Elements of Multimedia

Multimedia comes with different building blocks which are as follows:

 Text

 Audio

 Video

 Graphics

 Still Images

 Animation

Now, we can take a look at these elements of multimedia a bit in detail.

1. Text: In any medium of communication, text, and symbols are really
very important. While it comes to online training, there are certain
advantages of text form of multimedia:

 The size of text files is small. Therefore, they can perform in lower
bandwidth

 Creating text within an authoring application is now easy.

 Creating attractive texts through anti-aliasing is now possible. Thus,
you can create texts that can blend well with designer backgrounds.

2. Audio: Learning can be enhanced to some great extent through audio.
While teaching anything in a foreign language, using audio is a great way
of teaching. Usually, there are three types of methods of audio assets
which are effective in the method of e-learning:

 Sound effects

 Music

 Narration
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3. Video: Video is the best way of conveying enough information, though it
requires a huge amount of bandwidth. Today, this is the best way to
make people get more and more information. Whether giving a
presentation in an office or teaching anything online, videos are one of
the greatest media to reach to your listeners. Once people get to see
things practically that you are preaching, they can easily understand what
you want to deliver.

4. Graphics and Images: In present society, graphics and images play
important role in changing the current scenario. Any picture that is taken
by the digital camera is part of the multimedia expression. The sample
point of images is known as pixels. The quality of images depends on
the density of pixels.

5. Animation: This means the moving images and graphics which draw
huge attention of people. Whenever anything important is presented
through animation, it catches attention abruptly.

Usage of Multimedia

Whether you want to check out the time of your train or you want to publish your
blog, there are multimedia everywhere to assist you in anything today. As you are
living in the digital era, it is impossible to think of life without it. As multimedia is
being used in a different sector, the entire world has become closer and it is expected
within a few years, the geographical distance won’t matter anything, anywhere.
Let’s find out how multimedia is used in different sectors-

1. Multimedia in Advertising

Multimedia plays a key role in advertising and through few last decades, this field
has changed a lot. Whether it is an ad for print media, electronic media or for
social media, those are prepared on computer primarily by professionals’ software
and then brought into the media.

Advertising has become very prevalent in our daily lives, so for a product to
stand apart, it is very essential to present it in a dynamic, visually stimulating manner
to grab the attention of consumers. The business world is slowly rejecting run of
the mill traditional methods (such as placing ads in yellow pages, distributing
pamphlets, etc.) and adopting solutions from the electronic era. Only companies
with a nerve to radically change their marketing strategies for the new millennium
will survive and be able to cater to the ever-changing customer’s mindset.
Applications of multimedia in the marketing field include the following:

 Presentations for launching the products of a company. Reaching the
target audience with necessary technical services or products requires
clear communication stating the benefits and features, outlining its
applications and any other product-related details, all presented in a
well-designed and interactive manner so that the users can be familiarized
faster. Multimedia presentations helps in motivating, informing and
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captivating  audiences via PCs, laptops, plasma screens or kiosks
delivered via CD-ROM or the Internet.

 Multimedia is used to create interactive product catalogues, training
tutorials, buyer guides and information directories with adequate search
and navigation facilities to guide the user to easily trace the desired
information. A buyer guide can list the nearby dealers, a comparison of
the top brands, maps of the city and other helpful guest services.

 E-mail advertising or placing banner ads on the Internet is an extremely
cost-effective method of launching a product, promoting an event or
selling services. Effective use of multimedia in advertising can make
potential clients sit up and make notice.

 Multimedia applications help in building brand loyalty as well as improving
sales.  Brand loyalty will be improved as the users are provided a custom
application which entertains, informs or assists them.

 Graphical elements, animation,  as well as audio and video can be used
to more effectively deliver sales instructional or marketing messages,
thereby differentiating a firm from its competitors.

2. Mass Media

In the field of mass media, multimedia is used extensively. Whether it is to design
newspapers and magazines or adding pictures to them, multimedia is the best way
to do these things.

3. Education

Today, the style of education has been changed a lot. The use of multimedia has
changed the scenario where students can get enough help in their studies. In schools,
if the education system depends on audio and video lessons, charts, graphs, and
models, students can learn faster and they can also remember things well.

4. Gaming Industry

Today, gaming is not confined only within the means of recreation. It is a huge
industry where multimedia is the most important part. To make the games more
interesting, different audio and videos of high quality are attached and thus, the
industry is flourishing day by day.

5. Science and Technology

Without the usage of multimedia, the development of science and technology may
not be so speedy. Whether it is the field of medical science, or it is the automobile
industry, designing plans, executing them, transferring audio and videos, etc. won’t
be possible if there were no multimedia. Even, due to multimedia, the cost and
complications can be reduced a lot.
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6. Research

Multimedia is also an integral part in the sector of mathematical and scientific
research. For modulation and simulation, multimedia is used primarily. The use of
multimedia has made researches easier in any other field than these two.

7. Fine Arts

Multimedia artists have brought revolution in the field of fine arts. They use a
computer and lots of other devices to create a new genre of art and thus, the
world of art has become more advanced and modernized. Whether it is different
forms of digital art or blending cinema with opera, things are possible only because
of multimedia.

So, here you get the usage of multimedia in different sector those are only
getting advanced and in the future, there will be a revolution in every field. These
rapid changes have its clear impact on the social life of people.

14.3 INFLUENCES OF SOCIAL BEHAVIOUR

We are living in a world where communication has become our basic need, no
matter for what and the communication between people around the world is
expanding exponentially day by day. As we all aware that pictures when delivered
with words are greatly appreciated instead of words alone. So, graphical
representation and illustration is a technique, if used correctly with spoken and
written content gives more effect on the viewer or listener. Communicating through
multimedia channels are much more effective in order to negotiate more productively.
Hence, multimedia communication is the most essential need for modern age. This
study is proposed to give a brief review of impacts of interactive media on diverse
fields. The thought process of this research paper is to discuss various aspects of
multimedia and its impacts in our lives.

Today, we stand toward the beginning of a new data and communication
technologies which has been affecting our way of life. Since the man figured out
how to compose, he found another mode of communication too. This new discovery
lets him to arrange everything more effectively than expected. But, as the time
passed everything gets old and more established or we can say that our desires
and prerequisites increased day by day and of course, with only writing method
we can’t satisfy the increasing necessity of individuals. Presently there is a need of
new strategy for correspondence raised. So, here come the new version of
correspondence and the use of illustrations and multimedia channels replaced the
old mode of communication. This strategy opened a new way the field of
communication. The man had recently accomplished the ability to utilize more than
one medium at the same time for correspondence. This was the moment, when the
man becomes ready to communicate through multi-channels and this was the start
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of the use of Multimedia. The literal importance of multimedia gets from the Roman
word MULTUS, which implies numerous or multiple and the second word medium
just means a channel for data exchange. As far as exchanging information, the
word multimedia speaks to a multidimensional method for communication.
However, what is the need of multimedia system now? Why it is so vital? What is
the reason behind this need? What is its impact on social behaviour? These are the
few questions, which we need to explore to learn about its good and bad both
impacts on our way of life or just to figure out that do we really need to improve
ourselves and how can we utilize this technology in a better way to accomplish our
future perspectives.

Impacts of Multimedia on Social Behaviour

The significance of multimedia can essentially be understood by its diverse domains.
The most vital area of multimedia that has significant effect on our society is social
behaviour.

A society forms when we all interact with one another. It is possible that it
could be generic or separation interaction. The human behaviour is exceedingly
dependent on his state of mind and the social behaviour is all what he or she sees
and gains from the environment. In this way, human mind especially reliant on
perceives learning and past experiences in which the vast majority of them originate
from the social media. So now you would be able to see the clear picture. It is the
progression in which every knot is dependent on its parent knot. The media controls
the brain and utilization of numerous mediums are the best strategy to control the
media, since when you receives only a few inputs at a specific time you marginally
altered from it, however, if you get a great deal of inputs in the meantime, at that
point you will be profoundly altered from it.

In today’s’ digital world, social media has established various new modes
of communication for us, which affected our social behaviour in numerous ways.
Multimedia channels brought people together who shares common interests and
extended the scope of ideas globally. However, multimedia has also been affected
human behaviour and society with so many ways.

Social behaviour affected more when we all dabble with digital technology
especially with social media. The regular use of social media platforms has so
much increased that it is steadily injecting a change into our behaviour.

The good impacts of multimedia:

 Multimedia has added creativity in thinking of people as people are
now able to share their thoughts and work with others around the world.

 It has made people capable enough to explore things on their own and
actively participate in that without the fear of rejection.

 While no one will be in favour of spending long hours on gaming, but still
social media games builds social networks, improves a person’s self-
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competence, boost their intellectual flexibility and self-dignity. These
mediums can be effectively used for educational purposes to teach
students how to deal with failures and successes in real life.

 Multimedia connectivity with friends, families and some government safety
associations has emerged a strong belief of safety in people while stepping
out.

 LinkedIn is one of the biggest example of how communicating on social
media has helped numerous people around the world in finding the jobs
as per their domain of interests.

Adverse Impacts of Multimedia

Personal interactions which are essential for personality development, learning
communication skills and social skills, have been expelled from the lives of
individuals, particularly more from younger generations. Youngsters are having a
difficult time interfacing with others, which may prompt to unsociable behaviour.

 Compare and contrasts with others has been made easy by multimedia
platforms. People become unhappy with their current situations, leading to
issues with their self-esteem, anxiety and depression.

 Use of multimedia has also been linked to cyber abuse and cyber bullying
by anonymous online users, which lead to issues with privacy, self-esteem
etc.

 Most researches have shown that, violent games on social media
resulted in increase in violent activities and behaviours in youngsters.

 Social media platform has also been used as a mode to spread negativity
and rumours online around the world which has led to expansion in the
violent activities in the society. For example – As per recent reports, the
rumours of kidnappers on What’s App Messenger have led to suicidal deaths
of numerous innocent people in various parts of India.

 With multimedia platforms we can’t make it possible to avoid the negative
influences on our lives and we can’t help hearing or listening bad news
rumoured on those platforms. These circumstances can lead to long-lasting
psychological impacts and ultimately lead to thinking of our world around
falling apart, anxiety, stress and depression. In short, poor effect on social
behaviour.

14.4 FUTURE TRENDS OF MULTIMEDIA

Even as new technologies are developing, innovation around the application of
existing technology is also rapidly changing how organizations operate and how
we interact with the world. Jumps in computing capacity, connectivity and data
capture are accelerating this change. Here are five areas that are currently in trend.
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1. Artificial Intelligence

Artificial Intelligence (AI) is all about machines with human characteristics like
speaking, seeing, reading and even observing emotions, completing tasks quickly
while also learning from repeated communications. Using intelligent algorithms that
adapt to speech, location or even user-history devices can perform tasks that are
tedious or dangerous, in a more accurate way or much faster as compared to humans.

Within the next few years, analysts predict that all programming software’s
will be formed by the use of AI at some extent. Importantly Artificial Intelligence
(AI) provides the chance to consistently tailor services and products providing an
ambitious advantage over competitors that cannot be easily copied in any form.
The question to ask for the further inquiry will be-How can Artificial Intelligence
support my organization?

2. Progressive Reality

Platforms that combine real-time 3D vision, sound, haptic (kind of touch felt by
senses), location information and even different senses, for example, smell empower
individuals to immerse themselves elsewhere, respond to what’s around them and
change their virtual condition progressively. Associations are progressively applying
this innovation over a wide range of human movement from art and entertainment
to business, military and education. It’s utilized to prepare specialists, doctors,
instructors and cops and will soon be accessible on your smart devices.

3. Audio is the new form of Media

The voice will turn into the gateway to multimedia going a step ahead. Voice assistants
are getting more functional and smarter consistently. The voice-activated bots are
now growing faster than smartphones at a comparable phase. Even if whether
news utilization is for the time being restricted on these gadgets, there is a developing
trend appearing content consumption should be adapted for mobility. Multi-Media
platforms are as of now beginning to use the chat bots to spread news flash,
sports results, climate reports etc. and this exclusive trend is rising progressively.

4. Premium Content is gaining popularity

Premium content will be a state of the perpetuation of news enterprises. Media
utilization is entering another cycle. Readers are increasingly more aware of the
significance of trusted data, importance and meaning of the relevant news. If quality
content suggests a value, it might likewise imply high-quality content like investigative
revealing or getting to the actual facts. Adapting data will apply for differentiated
news coverage experiences, an additional esteem that readers are looking for
now, particularly with creative technologies connected to mobility and sound.

5.Media Education

Prsbomoting the learning and teaching of media proficiency to students and beyond,
is today more vital than ever. There is an urgency to apply basic reasoning to news
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& media messages and to use social media to form innovative content. Numerous
students are not able to distinguish the real facts from fiction on the web and in an
avalanche of information, it should be instructed if a source of information can be
trusted or not. Media education is a specific participation in the economic and
civic life of democracy, and we all who are involved in the media industry must
play a role in educating.

Check Your Progress

1. What are the building blocks of multimedia?

2. What is artificial intelligence?

14.5 ANSWERS TO CHECK YOUR PROGRESS
QUESTIONS

1. Multimedia comes with different building blocks which are as follows:

 Text

 Audio

 Video

 Graphics

 Still Images

 Animation

2. Artificial Intelligence (AI) is all about machines with human characteristics
like speaking, seeing, reading and even observing emotions, completing
tasks quickly while also learning from repeated communications.

14.6 SUMMARY

 Multimedia is the combination of multiple forms of media. The different
forms of multimedia include texts, videos, audios, graphics and lots of other
formats.

 Whether you want to check out the time of your train or you want to publish
your blog, there are multimedia everywhere to assist you in anything today.

 A society forms when we all interact with one another. It is possible that it
could be generic or separation interaction. The human behaviour is
exceedingly dependent on his state of mind and the social behaviour is all
what he or she sees and gains from the environment.

 Multimedia channels brought people together who shares common interests
and extended the scope of ideas globally.
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 One of the adverse impact of multimedia is that personal interactions which
are essential for personality development, learning communication skills and
social skills, have been expelled from the lives of individuals, particularly
more from younger generations.

 Artificial Intelligence (AI) is all about machines with human characteristics
like speaking, seeing, reading and even observing emotions, completing
tasks quickly while also learning from repeated communications.

14.7 KEY WORDS

 Multimedia: It is the combination of multiple forms of media.

 Artificial Intelligence: It is an area of computer science that emphasizes
the creation of intelligent machines that work and react like humans. 

14.8 SELF ASSESSMENT QUESTIONS AND
EXERCISES

Short Answer Questions

1. Discuss the usage of multimedia.

2. Discuss the adverse impacts of multimedia.

Long Answer Questions

1. Explain the influences of multimedia on social behaviour.

2. Describe the future trends of multimedia.

3. Explain the impacts of multimedia on social behaviour.
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